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Foreword 

 
The National Vocational & Technical Training Commission (NAVTTC) developed a National Skills Strategy (NSS) 

after extensive research and consultation with experts and stakeholders including policy makers and 

representatives from Industry, Academia and the Provincial Government departments dealing with technical and 

vocational training. The strategy aims at establishing a regime that facilitates competency-based and demand-

driven training and assessment.  

 

NAVTTC has developed competency-based training programs with the technical support of TVET Reform Support 

Programme (TVET-RSP), which is funded by the European Union, the Kingdom of the Netherlands, the Federal 

Republic of Germany and the Royal Norwegian Embassy. The Programme has been commissioned by the German 

Federal Ministry for Economic Cooperation and Development (BMZ) and is being implemented by the Deutsche 

Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH in close collaboration with NAVTTC. These vocational 

training programs have been approved by the National Curriculum Review Committee (having representation from 

all over the country from TEVTAs and industry) for implementation in Public and Private Training institutions. 

 

The purpose of developing competency-based training programs is to equip the learners with modern skills and 

knowledge for each of the trades to meet the requirements of local as well as international markets. These training 

programs include competency standards, qualification, curriculum, assessment material and teaching & learning 

material that will aid in implementation of competency-based and demand driven training in the country.  

 

This Teaching and Learning Material is part of the competency based training program exclusively developed to 

support the implementation of CBT curricula. This Material is intended for the use of learners undertaking training 

in National Vocational Certificate Level-3 in Information Technology (Web Designing and Development) under the 

guidance of experts and appropriate trainers. This Teaching and Learning Material has been designed in 

consultation with industry, academia and researchers to ensure that the material is relevant and current.  

 

On behalf of the Federal Government/NAVTTC, I wish to express my sincere appreciation and gratitude to all 

subject matter experts, industry representatives and TVET-RSP experts who have diligently contributed in 

producing this valuable Teaching and Learning Material. 

 

 

 

 

 

 

 

 

Executive Director 

National Vocational & Technical Training Commission 

(NAVTTC) 

  



Introduction 

A website is an effective and efficient tool for promoting, selling and buying a product or service. For many 
organizations, it is the only point of contact with customer through which a customer buys and product or service 
and also gives feedback. The role of a Web Designer is crucial because it is his responsibility to develop a website 
and update its sections on routine basis to make it productive and user friendly for the users.  
 
The National Vocational & Technical Training Commission (NAVTTC) has developed a national qualification 
entitled, “National Vocational Certificate Level-3 in Information Technology  
(Web Designing and Development)”. Relevant industry and employers were consulted in the design and validation 
processes in order to come up with a national qualification that fulfills the requirements of the sector in general and 
the occupation in particular.  
 
This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum of the 
Web Designing and Development national qualification. It carries a learning volume of 80 credits and includes nine 
learning modules which are as under:  
 

Module 1: Explain Internet Working  
Module 2: Elaborate World Wide Web 
Module 3: Design a Website  
Module 4: Plan Website and Explain Software Development Life Cycle for Web Applications 
Module 5: Use Databases in Web Development  
Module 6: Develop Website using Client Side Scripting Languages  
Module 7: Develop Website using Server Side Scripting Languages  
Module 8: Design and Present Final Project 
Module 9: Perform Duties and Exhibit rights at the Workplace 

 
This TLM provides support for more effective training and productive learning. Each of the learning modules 
contains learning outcomes and information regarding learning elements in the form of knowledge, skills and 
attitudes. At the end of every learning module are Frequently Asked Questions (FAQs) and Test Yourself which will 
help learners in self-assessment before proceeding to modular or final assessment. 
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Module 1: Explain Internet Working 

Learning Outcomes 

 After completion of this learning module, you will be able to: 

 Explain the history evolution of internet 

 Define and differentiate hardware and software  

 Elaborate the working of different computer networks 

 Differentiate different type of computer networks 
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Learning Unit 1: Discuss the History Evolution of Internet 
 

Overview 

In this learning unit, you will be introduced to basic concept of internet and computer 
networking. After the completion of this unit, you will able to understand definition of 
internet, comprehend working of internet, history and evolution of internet.  
 

1. Definition of Internet 

Internet is Worldwide collection of networks that connects millions of businesses, 
government agencies, educational institutions, and individuals. The Internet, 
sometimes called simply "The Net,"  
 
The Internet is a global network connecting millions of computers across the world to 
exchange information, news and opinions. 
 

 
Internet Overview 

 

2. Comprehend Working of Internet 

How the Internet works: 
 
The Internet works because open standards allow networks all over the world to interconnect. 
 
How to connect? 
 
Two ways to connect with internet 
 
1-Slow-speed Technology 

 
Modem in your computer uses a standard telephone line to connect to the Internet. Connection must be 
established each time you log on. 
 

Internet Assigned 
Numbers Authority 
(IANA), delegates 
the actual 
administration of 
most functions to 
other bodies for 
managing Internet 
Protocol address or 
domain names. 

Do you know! 

Internet stands for 
International 
network 

Do you know! 
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2- High-speed Connection  
 
DSL, cable modem, FTTP, fixed wireless, wireless modem, Wi-Fi, and satellite modems. Connection is always 
on whenever the computer is running.  
What are ways to access the Internet? 
 
ISP (Internet service provider) 
 
An Internet Service Provider (ISP) is a company that gives you access to the Internet and charge fee against it.  
 

 
 

Data Travelling over Internet 

 

 
IP address & Domain name 

 

3. History and Evolution of Internet 

The Internet originated as ARPANET in September 1969 and had two main goals: 

• Allow scientists at different physical locations to share information and work together. 
• Function even if part of the network were disabled or destroyed by a disaster. 

 

An IP address is a 
number that 
uniquely identifies 
each computer or 
device connected to 
the internet. 

Do you know! 

The DNS server 
translates the 
domain name into its 
associated IP 
address. 

Do you know! 
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Evolution of Internet 
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Learning Unit 2: Define and Differentiate Software and 
Hardware 

Overview 

In this learning unit you will be introduced to hardware and software. After completion 
of this unit, you will able to understand about: Definition of software, History of software, 
Definition of hardware, History of hardware,  Identify types of hardware, Role of 
hardware in computer system, Identify Different hardware components in a computer 
,Examine hardware of a network, Compare software and hardware. 
 
 

1. Definition of Software 

Software is a set of instructions that tells the computer what to do and how to do it.   

2. History of Software 

The term “software” was introduced in the late 1950s and was soon adopted throughout 
the industry. Coined by statistician John Tukey, the term became a catchall, user-
friendly term for the work of computer programmers who were using terminology 
ranging from “computer program” to “code.” 

 

Software has two 
major types: System 
software and 
application software. 

Do you know! 

Operating system is 
sub-category of 
system software. A 
Domain name is the 
text version of an IP 
address. 

Remember  
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Application software 
help users to 
complete complex 
task such as 
creating documents, 
spreadsheets, 
databases, and 
publications, doing 
online research, 
sending email, and 
designing graphics 
etc.  

Application 

Software 
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3. Definition of Computer Hardware 

Physical parts of computer are called hardware. 
 

4. History of Computer Hardware 

Since civilizations began, many of the advances made by science and technology have 
depended upon the ability to process large amounts of data and perform complex 
mathematical calculations. For thousands of years, mathematicians, scientists and 
businessmen have searched for computing machines that could perform calculations 
and analyze data quickly and efficiently. One such device was the abacus. 

The abacus was an important counting machine in ancient Babylon, China, and 
throughout Europe where it was used until the late middle ages. It was followed by a 

series of improvements in mechanical counting machines that led up to the development of accurate mechanical 
adding machines in the 1930’s. These machines used a complicated assortment of gears and levers to perform 
the calculations but they were far too slow to be of much use to scientists.  Also, a machine capable of making 
simple decisions such as which number is larger was needed. A machine capable of making decisions is called 
a computer. 

The first computer like machine was the Mark I developed by a team from IBM and Harvard University. It used 
mechanical telephone relays to store information and it processed data entered on punch cards. This machine 
was not a true computer since it could not make decisions. 

In June 1943, work began on the world's first electronic computer. It was built at the University of Pennsylvania 
as a secret military project during World War II and was to be used to calculate the trajectory of artillery shells. It 
covered 1500 square feet and weighed 30 tons. The project was not completed until 1946 but the effort was not 
wasted. In one of its first demonstrations, the computer solved a problem in 20 seconds that took a team of 
mathematicians three days.  This machine was a vast improvement over the mechanical calculating machines of 
the past because it used vacuum tubes instead of relay switches. It contained over 17,000 of these tubes, which 
were the same type tubes used in radios at that time.   

The invention of the transistor made smaller and less expensive computers possible.  Although computers shrank 
in size, they were still huge by today’s standards. Another innovation to computers in the 60’s was storing data 
on tape instead of punch cards. This gave computers the ability to store and retrieve data quickly and reliably.  

 

5. Identify Types of Hardware 

A generic term used to describe any component of a computer system with a physical presence and which can, 
therefore, been seen and touched. 

Hardware components are often categorized as being input, output, storage or processing components. Devices 
which are not an integral part of the CPU are referred to as being peripherals. Peripherals are usually used for 
input, storage or output (such as a hard disk, keyboard or printer). A device does not necessarily have to be 
outside the same physical box as the CPU. The best example of this is the hard disk, which is a peripheral even 
though it is not usually housed within the main case. 

The first computer 
like machine Mark-1 
developed by IBM at 
Harvard University. 

Do you know! 

https://en.wikipedia.org/wiki/computer_system
https://en.wikipedia.org/wiki/CPU
https://en.wikipedia.org/wiki/Peripheral
https://en.wikipedia.org/wiki/hard_disk
https://en.wikipedia.org/wiki/computer_keyboard
https://en.wikipedia.org/wiki/printer_(computing)
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The Main Hardware Components of a Computer System 

Input devices are hardware devices which take information from the user of the computer system, convert it into 
electrical signals and transmit it to the processor. The primary function of input devices is to allow humans to 
interact with the computer system. For instance a mouse allows the user to control the movement of the pointer 
(a common element in user interface design). 

Output devices take data from the computer system and convert it to a form that can be interpreted by humans. 
For instance a monitor creates a visual electronic display to output information created by the processor to the 
user. 

Processing devices are the components responsible for the processing of information within the computer 
system. This includes devices such as the CPU, memory and motherboard. 

Storage devices are components which allow data to be stored within a computer system. This includes devices 
such as hard disk drives and compact disk drives. 
 

6. Role of Hardware in Computer System 

Computer hardware plays a vital role in computer system. 

Hardware refers to the physical elements of a computer. Also referred to as the 
machinery or the equipment of the computer. Examples of hardware in a computer are 
the keyboard, the monitor, the mouse and the processing unit However, most of a 
computer's hardware cannot be seen; It's inside the computer case. 

I/O lets the computer talk with the world around it. Sometimes it’s necessary to add 
functionality to a computer to keep it up to date, or make it better. The amount of I/O a 
computer has can be changed, by adding expansion cards that support I/O. A graphics 
card can be added to a computer to let it talk with a display, or a Wi-Fi card can be 
added, which will let a computer talk to other computers without a connecting wire. 
Sometimes functionality can be added through a universal port, a port that supports 
multiple kinds of I/O. USB, FireWire, and Thunderbolt (Types of I/O) support multiple 
data types. Your keyboard, mouse, and monitor all connect to a computer's I/O. 

CPUs or processors perform computations. They do the math for your calculator application, they compare the 
size of numbers; people have likened the CPU to the "brain" of a computer. 

Memory is what allows a computer to remember things. Similar to human memory, there's long term memory (a 
hard disc or optical media (like a CD)) and short term memory (RAM). When a computer is turned off, it forgets 
everything in the RAM, so the computer saves everything it knows it will need later on in the long term memory. 
The short term memory is easier to use because it can do I/O faster, so when a data is needed by the CPU, it's 
sent from the hard disk drive (HDD) to the RAM. The short term memory lives on RAM, while the long term 

RAM consists of 
microchips that 
allow for the 
temporary storage of 
data. RAM functions 
as the work place for 
the CPU. It is 
common for a 
computer to have 

512 MB to 4 GB of 
RAM. 

RAM 

https://en.wikipedia.org/wiki/computer_mouse
https://en.wikipedia.org/wiki/computer_monitor
https://en.wikipedia.org/wiki/computer_memory
https://en.wikipedia.org/wiki/motherboard
https://en.wikipedia.org/wiki/compact_disk
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memory is in the hard disk drive (HDD). Optical disks let you change certain parts of the memory, it's kind of like 
having a book or notebook that you might read and get information from. 

Motherboard is a piece of hardware that makes connections in the right places between all of the other 
components in a computer. It tells data where it should go. When the CPU finishes processing some data, it 
might say to the CPU, OK, put this in the HDD, and the motherboard will figure out where the HDD is and send 
the data there. 
 

7. Hardware Components in a Computer 

System unit 

Case that contains electronic components of the computer used to process data. 

  
 

Common Components Inside the System Unit 

 Mother Board 

 Processor 

 Memory 

 Adapter cards 

o Sound card 

o Video card 

 Drive bays 

 Power supply 
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Component inside of system unit 

1. Motherboard 

Motherboard/system board is main circuit board of the system unit. It Contains expansion slots, processor chips, 
memory slots and system Bus. 

 

2. Slot for Processor: 

This slot is used to add CPU. 

3. Expansion Slots: 

Expansion slots are used to add graphic cards, modems and networks cards. 

4. Memory Slots: 

Memory slot is used to add memory (RAM) in the computer. 
What is memory? 

Electronic components that store instructions, data, and result .Consists of one or more chips on motherboard or 
other circuit board Each byte stored in unique location called an address, similar to seats in a concert hall. 
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How is memory measured? 
 

1 Byte 23 or 8 bits 

1 Kilo Byte (KB) 210 or 1024 Bytes 

1 Million (Mega) Byte (MB) 220 or 1024 Kilo Bytes 

1 Billion (Giga) Bytes (GB) 230 or 1024 Mega Bytes 

1 Trillion (Tera) Bytes (TB) 240 or 1024 Giga Bytes 
 

8. Compare Software and Hardware 

There are several differences between computer hardware and software.  

Comparison Chart 
 

Particulars Hardware Software 

Definition Devices that are required to store and 
execute (or run) the software. 

Collection of instructions that 
enables a user to interact with 
the computer. Software is a 
program that enables a 
computer to perform a specific 
task, as opposed to the physical 
components of the system 
(hardware). 

Types Input, storage, processing, control, and 
output devices. 

System software, Programming 
software, and Application 
software. 

Examples CD-ROM, monitor, printer, video card, 
scanners, label makers, routers, and 
modems. 

Quick books, Adobe Acrobat, 
Winoms-Cs, Internet Explorer , 
Microsoft Word , Microsoft Excel 

Function Hardware serves as the delivery system 
for software solutions. The hardware of a 
computer is infrequently changed, in 
comparison with software and data, which 
are “soft” in the sense that they are readily 
created, modified, or erased on the 
computer 

To perform the specific task you 
need to complete. Software is 
generally not needed to for the 
hardware to perform its basic 
level tasks such as turning on 
and responding to input. 

Inter dependency Hardware starts functioning once software 
is loaded. 

To deliver its set of instructions, 
Software is installed on 
hardware. 

Failure Hardware failure is random. Hardware 
does have increasing failure at the last 
stage. 

Software failure is systematic. 
Software does not have an 
increasing failure rate. 
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Durability Hardware wears out over time. Software does not wear out 
over time. However, bugs are 
discovered in software as time 
passes. 

Nature Hardware is physical in nature. Software is logical in nature. 

 

9. Procedure to Install Window 7 

Following are the steps for the Installation of window 7 

STEP 1: Boot from Windows 7 DVD. The first step is to place your Windows 7 DVD into the DVD tray and boot 
the machine. Your computer needs to be configured to boot from DVD. This is done via BIOS. On most 
computers, the BIOS menu can be accessed by pressing either the F2 or Del keys while the machine is booting.  
 

 

STEP 2: Once you have completed this stage, Windows 7 will start loading. If you see the below image, you're 
doing well so far.  
 

 

STEP 3: After a few moments, you will reach the installation menu. Now you have to choose the language and 
the keyboard. 

BIOS stand for basic 
in-put out-put 
system. 

Do you know! 

Windows 7 Minimum 
System 
Requirement is: 
Processor: 1 GHz 
RAM: 1 GB  
Hard disk: 16 GB  

Remember  
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STEP 4: Now you will be taken to the Install now menu. We have already prepared for the installation, so you 
can click Install now and proceed. 
 

 

STEP 5: The next step is to accept the license agreement. 
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STEP 6:  After this, you will have to decide whether you want to Upgrade an existing installation or perform a 
Custom (advanced) installation, which is basically creating a new copy of Windows. Recommended you are to 
install a new copy. Fresh installations are always better. Your machine starts in a pristine state and does not rely 
on old leftovers. 
 

 
 

STEP 7 Partitioning: The next step is to choose where you want to install Windows 7. This is probably the most 
important part of the entire installation, so you need to be very careful here and make the right choices. 
 

 

STEP 8: We will create a new partition. According to official system requirements, Windows 7 needs 16 GB of 
free space. However, you can do with less. The minimum recommended space for a partition where you want to 
place Windows 7 is 10350MB. Eventually, the installation itself will take approx. 7GB. 
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STEP 9: Windows 7 installer will now tell you that it will have to create an additional partition for the core system 
files. This will be a small primary partition ahead of your newly created one. 

 

STEP 10: We now have a system partition and a primary partition, plus some free space. In purely technical 
terms, there is no such thing as a partition of the type system. There are only two types of partitions: primary and 
logical. The above-mentioned partition is a primary partition. 

In total, there can only be up to four primary partitions on any physical disk. Windows 7, by itself, creates and 
uses at least two primary partitions. If we created another partition in the free space, it would too, become a 
primary partition. 
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STEP 11: Recommendation Use a third-party partitioning tool to create a partition layout beforehand. This will 
allow you to place Windows 7 files on a logical partition, saving yourself the precious commodity of wasting 
primary partitions on what is essentially non-system data. 

  
If you're using ONLY Windows 7 to create a partition layout on your system, then you should just create a partition 
with a sufficient size to hold the Windows 7 data files and nothing else. 
  

 
 

STEP 12: Begin installation if you're comfortable with your setup, highlight the created partition and click Next. 
Windows 7 will be installed on this partition. Depending on your hardware, this can take some time. My testing 
shows approx. 30-40 minutes. 
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STEP 13: During the installation, your computer may restart several times. Let it be. 

User settings eventually, you will be asked to provide your username and a computer name. You will also have 
to password-protect your account. This is most advisable. You should opt for a strong password. 

 

STEP 14 Activation: The next step is to activate your Windows. Grab your key and type it here. 
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STEP 15 Updates: You will be asked to configure your updates. You can choose either setting you like. However, 
I recommend you configure this choice later, after Windows 7 is installed and running properly. 

 
 

STEP 16 Time zone: Configure your time zone: 
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STEP 17 Network Location: Your location will determine the firewall settings for your newly installed Windows 
7. You have three choices: home, work or public network. Home and work networks are supposed to be trusted, 
so you should not experience any problems adding other machines to your group or sharing data with them. 

However, the public network is meant to be untrusted. So if you have installed Windows 7 in, let's say, Internet 
cafe, then you should choose the third option. 

 
Window 7 has been installed. 

 

 

10. Procedure to Install Software on Computer 

After the installation of Operating system, user can install the application software on computer as per their 
requirements.Software generally refers to any type of executable code that can be launched in a computer 
system. It is designed to implement and complete specific functions that are required by the user in his activities. 
Software .exe will save on DVD disk or in computer memory or saved on other computer hard disk we may 
transfer with the help of USB. 

Step 1 

The first most important step in software installation is to verify that the target system meets the general hardware 
requirements of the application. Beginning the installation in a computer machine which does not possess the 
minimum requirements can lead to either an unsuccessful installation or failure of the program to run after 
installing it. 

Step 2 

Since programs in general are written to be Operating System dependent, make sure that the version of the 
application you are installing corresponds to the Operating System platform running on your machine. 

Step 3 

Aside from the general hardware requirements, some computer programs also have software requirements prior 
to installation. Double check if you need to update or upgrade your Operating System or if there is a need to 
download other tools or utilities. 
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Step 4 

Once all the initial requirements have been met, make sure that there are no unnecessary programs running 
before beginning the installation procedure. In some instances, applications may require that the antivirus 
programs be disabled. Make sure that you are installing a legitimate application before disabling your protection 
software. 

Step 5 

Software installation can be done either from the Internet (skip to step 8) or from an installation disc provided by 
the software manufacturer. To install from the disc, simply open the CD or DVD drive and insert the installer. 

Step 6 

A setup wizard window should be launched. In case there is none, open the Explorer and navigate to the optical 
drive. Double click on either the Autorun or Setup file. 

Step 7 

Once the wizard is running, simply follow the prompts until the installation process is completed. For novice users, 
accept the default values to minimize potential problems during the procedure. Jump to step 10. 

Step 8 

For installation from the Web, launch your browser application and download the setup file to your hard drive. 

Step 9 

After completion of the downloading process, run the setup program to execute the setup wizard that will handle 
the automatic installation of the software. Do step 7. 

Step 10 

After the installation procedure has been completed and the setup wizard has terminated, reboot your machine 
before launching the newly installed software. 
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Learning Unit 3: Elaborate the Working of Different 
Computer Networks 
 
Overview 

In this learning unit you will be introduced about basic concept of computer network. These are building blocks 
to connect different system and deploy web server.  

In this unit, you will introduced about basic of a computer network, History of Network, Network topologies like 
Bus, Ring, Star, Mesh Topology and Basic component of network. 
After learning this unit you will be able to define what is computer network and its topologies.  
 

1. What is Network 

“A network is a set of devices (often referred to as nodes) connected by communication links. A node can be a 
computer , printer, or any other device capable of sending and / or receiving data generated by other nodes on 
the network”  
 

2. History of Network 

The history of computer networking in chronological order is mentioned below: 

 In the late 1950s early networks of communicating computers included the military radar system Semi-
Automatic Ground Environment (SAGE). 

 In 1959 Anatolii Ivanovich Kitov proposed to the Central Committee of the Communist Party of the Soviet 
Union a detailed plan for the re-organization of the control of the Soviet armed forces and of the Soviet 
economy on the basis of a network of computing centers. 

 In 1960 the commercial airline reservation system semi-automatic business research environment 
(SABRE) went online with two connected mainframes. 

 Throughout the 1960s, Leonard Kleinrock, Paul Baran, and Donald Davies independently developed 
network systems that used packets to transfer information between computers over a network. 

 In 1962 J.C.R. Licklider developed a working group he called the "Intergalactic Computer Network", a 
precursor to the ARPANET, at the Advanced Research Projects Agency (ARPA). 

 In 1964 researchers at Dartmouth College developed the Dartmouth Time Sharing System for distributed 
users of large computer systems. The same year, at Massachusetts Institute of Technology, a research 
group supported by General Electric and Bell Labs used a computer to route and manage telephone 
connections. 

 In 1965, Thomas Marill and Lawrence G. Roberts created the first wide area 
network (WAN). This was an immediate precursor to the ARPANET, of which Roberts 
became program manager.  

 Also in 1965, Western Electric introduced the first widely used telephone switch 
that implemented true computer control. 

 In 1969 the University of California at Los Angeles, the Stanford Research 
Institute, the University of California at Santa Barbara, and the University of Utah 
became connected as the beginning of the ARPANET network using 50 kbit/s circuits. 

The Internet 
Protocol (IP) is the 
method or protocol 
by which data is 
sent from one 
computer to another 
on the internet. 

Remember  
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 In 1972 commercial services using X.25 were deployed, and later used as an underlying infrastructure 
for expanding TCP/IP networks. 

 In 1973, Robert Metcalfe wrote a formal memo at Xerox PARC describing 
Ethernet, a networking system that was based on the Aloha network, 
developed in the 1960s by Norman Abramson and colleagues at the University 
of Hawaii. In July 1976, Robert Metcalfe and David Boggs published their paper 
"Ethernet: Distributed Packet Switching for Local Computer Networks" and 
collaborated on several patents received in 1977 and 1978. In 1979 Robert 
Metcalfe pursued making Ethernet an open standard. 

 In 1976 John Murphy of Data point Corporation created ARCNET, a token-passing network first used to 
share storage devices. 

 In 1995 the transmission speed capacity for Ethernet increased from 10 Mbit/s to 100 Mbit/s. By 1998, 
Ethernet supported transmission speeds of a Gigabit. The ability of Ethernet to scale easily (such as 
quickly adapting to support new fiber optic cable speeds) is a contributing factor to its continued use as 
of 2015. 

3. Network Topologies 

Network Topology is the schematic description of a network arrangement, connecting various nodes (sender and 
receiver) through lines of connection. 
 
BUS Topology 
Bus topology is a network type in which every computer and network device is connected to single cable.  

 
 
Features of Bus Topology 

1. It transmits data only in one direction. 
2. Every device is connected to a single cable 

 
Advantages of Bus Topology 

1. It is cost effective. 
2. Cable required is least as compared to other network topology. 
3. It works well for small networks. 
4. It is easy to understand. 
5. Easy to expand joining two cables together. 

 
Disadvantages of Bus Topology 

1. Entire network shuts down if there is a break in the main cable. 
2. It is slow when more devices are added into the network. 
3. It is slower than the ring topology. 
4. Difficult to identify the problem if the entire network shuts down. 

 
RING Topology 
It is called ring topology because it forms a ring where each nod is connected to exactly two nods. Data travels 
from nod to nod, with each nod along the way handling every packet. 
 

Network Topology is 
physical 
arrangement of nods 
in the network.  

Remember  

IPv4 address is a 32 
bit numeric address 
written as four 
numbers separated 
by period’s e.g. 
192.168.1.2 

Remember  
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Features of Ring Topology 

1. A number of repeaters are used and the transmission is 
Unidirectional. 

2. Date is transferred in a sequential manner that is bit by bit. 
 

Advantages of Ring Topology 
1. No need for network server to control the connectivity between work stations. 
2. Additional components do not affect the performance of network. 
3. Each computer has equal access to resources. 

 
Disadvantages of Ring Topology 

1. Troubleshooting is difficult in ring topology. 
2. Adding or deleting the computers disturbs the network activity. 
3. Communication delay is directly proportional to the numbers of nods in the network. 
4. Network is highly dependent on the wire which connects different nods.  

 
STAR Topology 
In this type of topology all the computers are connected to a single hub through a cable. This hub is the central 
node and all others nodes are connected to the central node.  

 
 
Features of Star Topology 

1. Every node has its own dedicated connection to the hub. 
2. Hub/switch acts as a repeater for data flow. 
3. STP/UTP Ethernet cable is used to connect nods to the central point. 
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Advantages of Star Topology 
1. Fast performance with few nodes and low network traffic. 
2. Hub can be upgraded easily. 
3. Easy to detect the failure and troubleshoot. 
4. Easy to setup and modify. 
5. If single nod is destroyed then the rest will work smoothly.  

 
Disadvantages of Star Topology 

1. Cost of installation is high. 
2. Expensive to use. 
3. If the hub is affected then the whole network is stopped because all the nodes depend on the hub. 
4. Performance is based on the hub that is it depends on its capacity 

 
MESH Topology 
It is a point-to-point connection to other nodes or devices. Traffic is carried only between two devices or nodes 
to which it is connected. Mesh has n (n-2)/2 physical channels to link hn devices.  

 
 

Types of Mesh Topology 
1. Partial Mesh Topology: In this topology some of the systems are connected in the same fashion as 

mesh topology but some devices are only connected to two or three devices. 
2. Full Mesh Topology: Each and every nodes or devices are connected to each other. 

 
Features of Mesh Topology 

1. Fully connected. 
2. Robust. 
3. Not flexible. 

 
Advantages of Mesh Topology 

1. Each connection can carry its own data load. 
2. It is robust. 
3. Fault is diagnosed easily. 
4. Provides security and privacy. 

 
Disadvantages of Mesh Topology 

1. Installation and configuration is difficult. 
2. Cabling cost is more. 
3. Bulk wiring is required. 
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TREE Topology 
It has a root node and all other nodes are connected to it forming a hierarchy. It is also called hierarchical topology. 
It should at least have three levels to the hierarchy. 
 

 
 
 
Features of Tree Topology 

1. Ideal if workstations are located in groups.  
2. Used in Wide Area Network. 

 
Advantages of Tree Topology 

1. Extension of bus and star topologies. 
2. Expansion of nodes is possible and easy. 
3. Easily managed and maintained. 
4. Error detection is easily done. 

 
Disadvantages of Tree Topology 

1. Heavily cabled. 
2. Costly. 
3. If more nodes are added maintenance is difficult. 
4. Central hub fails, network fails. 

 
HYBRID Topology 
It is two different types of topologies which is a mixture of two or more topologies. For example if in an office in 
one department ring topology is used and in another star topology is used, connecting these topologies will result 
in Hybrid Topology (ring topology and star topology). 
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Features of Hybrid Topology 
1. It is a combination of two or topologies 
2. Inherits the advantages and disadvantages of the topologies included 

 
Advantages of Hybrid Topology 

1. Reliable as Error detecting and troubleshooting is easy. 
2. Effective. 
3. Scalable as size can be increased easily. 
4. Flexible. 

 
Disadvantages of Hybrid Topology 

1. Complex in design. 
2. Costly. 

 

4. Components of Computer Network 

Computer network requires the following devices (some of them are optional):-  

 Network Interface Card (NIC)  

 Hub  

 Switches  

 Cables and connectors  

 Router  

 Modem  

1. Network Interface Card 

Network adapter is a device that enables a computer to talk with other computer/network. Using unique 
hardware addresses (MAC address) encoded on the card chip, the data-link protocol employs these addresses 
to discover other systems on the network so that it can transfer data to the right destination.  

 
There are two types of network cards: wired and wireless. The wired NIC uses cables and connectors as a 
medium to transfer data, whereas in the wireless card, the connection is made using antenna that employs radio 
wave technology. All modern laptop computers incorporated wireless NIC in addition to the wired adapter.  

Network Card Speed  

Network Interface card, one of the main computer network components, comes with different speeds, 10Mbps, 
100Mbps, and 1000Mbps, so on. Recent standard network cards built with Gigabit (1000Mbps) connection 
speed. It also supports to connect slower speeds such as 10Mbps and 100Mbps. However, the speed of the card 
depends on your LAN speed.  

For example, if you have a switch that supports up to 100Mbps, your NIC will also transfer a data with this same 
speed even though your computer NIC has still the capability to transfer data at 1000Mbps (1Gbps). In modern 
computers, network adapter is integrated with a computer motherboard. However if you want advanced and fast 
Ethernet card, you may buy and install on your computer using the PCI slot found on the motherboard (desktop) 
and Express Card slots on laptop .  
 

The Network Card 
can be wired or 
wireless. 

Remember  
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2. Hub  

Hub is a device that splits a network connection into multiple computers. It is like a distribution center. When a 
computer request information from a network or a specific computer, it sends the request to the hub through a 
cable. The hub will receive the request and transmit it to the entire network. Each computer in the network should 
then figure out whether the broadcast data is for them or not.  

Currently Hubs are becoming obsolete and replaced by more advanced communication devices such as 
Switches and Routers.  

 
Hub 

3. Switch  

Switch is a telecommunication device grouped as one of computer network components. Switch is like a Hub 
but built in with advanced features. It uses physical device addresses in each incoming messages so that it 
can deliver the message to the right destination or port. 

 
Switch 

Like Hub, switch don’t broadcast the received message to entire network, rather before sending it checks to 
which system or port should the message be sent. In other words switch connects the source and destination 
directly which increases the speed of the network. Both switch and hub have common features: Multiple RJ-45 
ports, power supply and connection lights.  

4. Cables and connectors  

Cable is one way of transmission media which can transmit communication signals. The wired network typology 
uses special type of cable to connect computers on a network. 
 

 

 

Twisted Pair Cable Cable Connector 

 There are a number of solid transmission Media types, which are listed below. -  
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Twisted pair wire 

It is classified as Category 1, 2, 3, 4, 5, 5E, 6 and 7. Category 5E, 6 and 7 are high-speed cables that can transmit 
1Gbps or more. -  

Coaxial cable  

Coaxial cable more resembles like TV installation cable. It is more expensive than twisted-pair cable but provide 
high data transmission speed. 

 

Coaxial Cable 

 
Fiber-optic cable  

It is a high-speed cable which transmits data using light beams through a glass bound fibers. Fiber-optic cable is 
high data transmission cable comparing to the other cable types. But the cost of fiber optics is very expensive 
which can only be purchased and installed on governmental level. 

 

Fiber-Optic Cable 

5. Router  

When we talk about computer network components, the other device that used to connect a LAN with an 
internet connection is called Router. When you have two distinct networks (LANs) or want to share a single 
internet connection to multiple computers, we use a Router.  

Optical fibre was 

invented in 1966 by 

two British scientists 

called Charles Kao 

and George 

Hockham working 

for the British 

company Standard 

Telecommunication 

Laboratories 

Do you know! 

The Router is used 

to connect two 

different networks. 

Remember  
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Router 

In most cases, recent routers also include a switch which in other words can be used as a switch. You don’t need 
to buy both switch and router, particularly if you are installing small business and home networks.  

There are two types of Router: wired and wireless. The choice depends on your physical office/home setting, 
speed and cost.  

 
6. Modems  

A modem enables you to connect your computer to the available internet connection over the existing telephone 
line. Like NIC, Modem is not integrated with a computer motherboard. It comes as separate part which can 
be installed on the PCI slots found on motherboard. 

A modem is not necessary for LAN, but required for internet connection such as dial-up and DSL.  

There are some types of modems, which differs in speed and transmission rate. Standard PC modem or Dial-
up modems (56Kb data transmission speed), Cellular modem (used in a laptop that enables to connect while on 
the go), cable modem (500 times faster than standard modem) and DSL Modems are the most popular.   

 

Modem 
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Learning Unit 4:  Differentiate Different Types of 
Networks 
 

Overview 

In this learning unit you will be introduced about different types of networks.  This unit 
is building block to understand different type of networks. After the completion of this 
learning unit you will be able to understand about personal Area Network, Local Area 
Network, and Wide Area Network, Metropolitan area network, campus area network, 
wide area network, virtual private network and difference among network.     

 

1. Personal Area Network 

A personal area network (PAN) refers to the interconnection of information technology 
devices or gadgets within the environment of an individual user typically within 10 
meters or 33 feet’s). 

These interconnected devices might include laptop computers, PDAs, cellphones, 
printers, PCs or other wearable computer devices. Wireless personal network (WPAN), 
a network covering a very small area, usually a small room. The best known wireless 
PAN network technology is Bluetooth, and the most popular wired PAN is USB. You 
might not think of your wireless headset, your printer or your smartphones as 
components in a network, but they are definitely talking with each other. Many 
peripheral devices are actually computers in their own right. Wi-Fi also serves as a PAN 
technology, since Wi-Fi is also used over a small area. 
 

2.  Local Area Network 

A local area network, or LAN, consists of a computer network at a single site, typically 
an individual office building. A LAN is very useful for sharing resources, such as data 
storage and printers. LANs can be built with relatively inexpensive hardware, such as 
hubs, network adapters and Ethernet cables.  

The smallest LAN may only use two computers, while larger LANs can accommodate 
thousands of computers. A LAN typically relies mostly on wired connections for 
increased speed and security, but wireless connections can also be part of a LAN. High 
speed and relatively low cost are the defining characteristics of LANs.  

LANs are typically used for single sites where people need to share resources among 
themselves but not with the rest of the outside world. Think of an office building where 
everybody should be able to access files on a central server or be able to print a 
document to one or more central printers. Those tasks should be easy for everybody 
working in the same office, but you would not want somebody just walking outside to 
be able to send a document to the printer from their cell phone! If a local area network, 
or LAN, is entirely wireless, it is referred to as a wireless local area network, or WLAN. 
 

The RJ-45 is an 
eight-wire connector 
used commonly to 
connect computers 
onto a local-area 
network (LAN), 
especially Ethernets. 

Remember  

Twisted-pair cable is 

a type of cabling that 

is used for 

telephone 

communications and 

most modern 

Ethernet networks. 

Information 

Dynamic Host 

Configuration 

Protocol (DHCP) is 

a client/server 

protocol that 

automatically 

provides an Internet 

Protocol (IP) host 

with its IP address 

and other related 

configuration 

information such as 

the subnet mask 

and default gateway. 

Do you know! 
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3. Wide Area Network 

Wide Area Networks are used to connect server machines and computers across continents are countries for 
constant information updates. Wide Area Networks, are used across the globe, many networks connect with one 
another across continents to create one giant Wide Area Network. Wide Area Networks use optic fiber as their 
communication medium. The largest example of a Wide Area Network is the internet itself, which connects all 
users to the information and data that is available on the internet. 

 

Wide Area Networks 
 

4. Metropolitan Area Network 

Metropolitan Area Networks are not commonly used these days; they are used to create communication between 
systems in an entire city. Hence a Metropolitan Area Network area falls between the sizes Local Area Networks, 
and Wide Area Networks. Metropolitan Area Networks are used by city specific businesses such as Network of 
TEVTA institutes in the Lahore city. 
 

 
 

5. Campus Area Network 

Campus Area Networks are usually a connection of many small LAN networks which are often used on university 
campuses and office buildings. Campus Area Networks allow for easy file sharing between different departments 
as all the files are usually shared on the server machines of each LAN network. This type of network offers a lot 
of simplicity in the transfer and downloading of files. 
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Campus Area Networks 

 

6. Virtual Private Network 

A virtual private network (VPN) is a method for the extension of a private network across a public network, such 
as the Internet. It enables users to send and receive data across shared or public networks as if their computing 
devices were directly connected to the private network, and thus are benefiting from the functionality, security 
and management policies of the private network. A VPN is created by establishing a virtual point-to-point 
connection through the use of dedicated connections, virtual tunneling protocols, or traffic encryption. 

 

7. Difference among Network Types 

1. LAN (Local Area Network): In LAN, two or more computers and peripheral devices are connected within 
the small area, as is a room, office building or a campus. The number of computers in a LAN varies from 
2 to 1000 computers. The data transmission speed is slow as compare to WAN. A few data errors occur. 
In LAN computer terminals are physically connected with wires. 
 

2. WAN (Wide Area Network): This kind of networks can connect two or more computers present at distant 
places. In WAN computer terminals are not connected with wires. They are linked by the communication 
services like satellite signals, telecommunications. The usage of WAN network system is limited to very 
large organizations and government agencies. The main example of WAN network system in our daily 
life is telecom system. 
 

3. MAN (Metropolitan Area Network): MAN network system is larger than LAN network system. This 
system is spread across a city. The main and common example of MAN is in our daily life is Cable 
Television. 
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Summary of Module 

  In a relatively short period of time, the Internet has had an amazing impact on almost every facet of 
our lives. With it, we are able access to new ideas, more information, unlimited possibilities, and a 
whole new world of communities. It has grown and evolved to influence how we interact, how we 
conduct business, how we learn, and how we proceed day to day. And as much as it has changed 
our lives, in the process, the Internet itself has changed too.  

  Hardware refers to the physical elements of a computer. This is also sometime called the machinery 
or the equipment of the computer. Software, commonly known as programs, consists of all the 
electronic instructions that tell the hardware how to perform a task. 

  Computer networking or data communication is a most important part of the information technology. 
Today every business in the world needs a computer network for smooth operations, flexibly, instant 
communication and data access.  

Just imagine if there is no network communication in the university campuses, hospitals, multinational 
organizations and educational institutes then how difficult are to communicate with each other. 

  There are several different types of computer networks. Computer networks can be characterized by 
their size as well as their purpose.  

The size of a network can be expressed by the geographic area they occupy and the number of 
computers that are part of the network. Networks can cover anything from a handful of devices within 
a single room to millions of devices spread across the entire globe. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is the Internet? 

Answer 

A vast global network of computers connected by wires (phone lines, cable lines, DSL - digital 
subscriber lines, etc.)  
 
When people talk about the Web, that is not the Internet, just a piece of it. E-mail, chat rooms, 
newsgroups, FTP (File Transfer Protocol) - all of these things make up the Internet. 

FAQ 2:  What is an IP address? 

Answer An IP address is used to uniquely identify any computer on the network. i.e. 172.16.0.100. 

FAQ 3:  What is ARPANET?  

Answer 
Arpanet - The original name of the Internet, created by the U.S. Dept. of Defense 'Defense 
Advanced Research Projects Agency Internet Program'. 

FAQ 4:  ICANN stands for? 

Answer 
Internet Corporation for Assigned Names and Numbers - This groups administers policies for 
the Internet name and address system 

FAQ 5:  Who runs the Internet? 

Answer 

The Internet is a cooperative endeavor much like the worldwide telephone network. No single 
organization is responsible for all aspects of the Internet. The US Federal government, through 
ARPA and NSF, continues to support the Inter NIC and IETF. Equipment vendors support the 
Internet through their product development and participation in the Frame Relay Forum, the ATM 
Forum and the IETF. Internet Service Providers cooperate with each other, the NSF and ARPA 
and equipment vendors to provide ubiquitous connectivity.  
 
The sum of these cooperative efforts is the worldwide Internet, which appears to each user as a 
seamless universal access network to global Internet resources.  

FAQ 6:  What's the difference Between an Intranet and the Internet? 

Answer 

There's one major distinction between an intranet and the Internet: The Internet is an open, public 
space, while an intranet is designed to be a private space. An intranet may be accessible from 
the Internet, but as a rule it's protected by a password and accessible only to employees or other 
authorized users.  
 
From within a company, an intranet server may respond much more quickly than a typical Web 
site. This is because the public Internet is at the mercy of traffic spikes, server breakdowns and 
other problems that may slow the network. Within a company, however, users have much more 
bandwidth and network hardware may be more reliable. This makes it easier to serve high-
bandwidth content, such as audio and video, over an intranet.   

FAQ 7:  Differentiate between hub and switch 

Answer 
a) Hub is a layer 1 device while Switch is layer 2 device. 
b) Hub works on single collision and single broadcast domain while switch works on per port 

collision and single broadcast domain. 
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FAQ 8:  Define Bandwidth and Latency? 

Answer 

Bandwidth/ Throughput – It means the number of bits which can be transmitted over the network 
in a specified time. 
 
- Latency – It is the time taken by a message to travel from one side to another. 

FAQ 9:  What is VoIP and do I need it? 

Answer 

VoIP stands for Voice over Internet Protocol. This technology allows businesses to use their data 
network to carry voice traffic as well as data. This allows a company to stop having to maintain 
two separate networks: one for voice, and one for data, maintaining which adds up to huge cost 
savings in very short order. 

FAQ 10:  What is the difference between a patch cable and a cross-over cable? 

Answer 

A patch cable is basically your common everyday cable. It is used to connect your NICs or other 
devices to your hub/switch or what have you. With a patch cable the signal goes straight through. 
 
A cross over cable is a specialized cable. It basically has three roles: 1) It is used if you wish to 
connect two computers together without using a hub. 2) It can be used to uplink one hub to 
another in situations where an uplink port isn't available. 3) It is can be used to daisy chain on a 
network device like a Cable modem in some situation. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the end 
of this module. 

1. The Internet has its roots in ____, a network that became functional in 1969, linking scientific and 
academic researchers across the United States. 

a. ARPANET c. LISTSERV 

b. NSFnet d. MPEG 

2. ____ oversees research and sets standards and guidelines for many areas of the Internet. 

a. ARPANET c. LISTSERV 

b. NSFnet d. World Wide Web Consortium (W3C) 

3. ____ is collection of networks that connects millions of businesses, government agencies, 
educational institutions and individuals. 

a. Networks c. Internet 

b. Node d. WLAN 

4. The major carriers of network traffic on the Internet are known collectively as the ____. 

a. NERVEnet c. Internet backbone 

b. DARPA d. Internet artery 

5. A (n) ____ address is a number that uniquely identifies each computer or device connected to the 
Internet. 

a. IP c. POP 

b. e-mail d. DSL 

6. The group that assigns and controls top-level domains is the ____. 

a. NSF c. Network Solutions Group 

b. ICANN d. ARPANET 

7. In 1986, the National Science Foundation (NSF) connected its huge network of five supercomputer 
centers, called NSFnet, to ____. 

a. the Web c. the IPnet 

b. ARPANET d. DNS 

8. All of the following are widely used input devices except the _____. 

a. keyboard and mouse c. digital camera and PC video camera 

b. microphone and scanner d. printer and monitor 
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9. A _____ is an input device that converts printed material to a form the computer can use. 

a. mouse c. microphone 

b. keyboard d. scanner 

10. Each of the following is a commonly used output device except _____. 

a. a printer c. a scanner 

b. a monitor d. speakers 

11. Two categories of software are _____. 

a. operating system and system software c. utility programs and operating systems 

b. system software and utility programs d. system software and application software 

12. A widely used type of application software related to communications is _____, which allows users 
with an Internet connection to access Web pages. 

a. a Web browser c. database software 

b. word processing software d. spreadsheet software 

13. A computer contains many electric, electronic, and mechanical components known as ____. 

a. software c. output 

b. input devices d. hardware 

14. The ____ unit is a case that contains electronic components of the computer that are used to process 
data. 

a. Control c. arithmetic 

b. System d. base 

15. The ____ is the electronic component that interprets and carries out the basic instructions that 
operate the computer. 

a. Motherboard c. processor 

b. control unit d. arithmetic unit 

16. ____ consists of electronic components that store instructions waiting to be executed and data 
needed by those instructions. 

a. The processor c. The control unit 

b. The CPU d. Memory 

17. ____ Software consists of the programs that control or maintain the operations of the computer and 
its devices. 

a. System c. Utility 

b. Application d. Operating 
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18. One type of system software is a (n) ____ system, which is a set of programs that coordinates all the 
activities among computer hardware devices. 

a. utility c. operating 

b. hardware d. software 

19. One type of system software is a (n) ____ program, which allows a user to perform maintenance-type 
tasks usually related to managing a computer. 

a. management c. utility 

b. maintenance d. operating 

20. ____ Software consists of programs designed to make users more productive and/or assist them with 
personal tasks, and include Web browser, word processing software, and spreadsheet software. 

a. Management c. Application 

b. Utility d. System 

 

21. A _____ is a device that forwards packets between networks by processing the routing information 
included in the packet. 

a. Bridge c. Router 

b. Firewall d. All of them 
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Answers Key 
MCQ Number Correct Answer MCQ Number Correct Answer 

1 a 13 d 

2 d 14 d 

3 c 15 c 

4 c 16 d 

5 a 17 a 

6 b 18 c 

7 b 19 c 

8 d 20 c 

9 d 21 c 

10 c 

 11 d 

12 a 
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Module 2: Elaborate World Wide Web 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Elaborate different eras of web. 

 Compare static websites with dynamic websites. 

 Elaborate and differentiate different web browsers 

 Compare different types of websites. 

 Identify different web threats and security measures. 

 Elaborate the process of domain registration and web hosting. 

 Elaborate about shopping carts and e-commerce.   
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Learning Unit 1: Different Eras of Web 
 

Overview 

In this learning unit, you will learn different eras of web. After the completion of this 
learning unit, you will be able to understand the definition of World wide web, website 
and webpage, history of web, web 1.0, web 2.0, web 3.0 and comparison of web 1.0, 
2.0, 3.0. 

1. World Wide Web 

The world wide web (commonly shortened to the web) is a system of interlinked 
hypertext documents accessed via the internet. With web browser, user views web 
pages that may contain text, images, videos and other multimedia and navigates 
between them, using hyperlinks. 
  

 
 

2. Website and Webpage 

Web Page 

A webpage is a document commonly written in Hyper Text Markup Language (HTML) 
that is accessible through the Internet or other network using a browser. A web page 
is accessed by entering a URL address and may contain text, graphics, and hyperlinks 
to other web pages and files. 
 
Website 

A Web site is a collection of related Webpages and associated items, such as 
documents and pictures, multimedia stored on a Web server. 

 

 

Markup Language is 
used use to create 
web pages. 

Do you know! 

URL is an acronym 
for Uniform 
Resource Locator 
and is a reference 
(an address) to a 
resource on the 
Internet.  e.g URL 
http://example.com 

URL 

Web browser, is a 
software program 
created as a 
simplified means to 
present and explore 
content on the World 
Wide Web. 

Web Browser 

Web server is a 
computer that 
delivers requested 
Web pages to 
computer. 

Web Server 

http://www.computerhope.com/jargon/h/hypertex.htm
http://www.computerhope.com/jargon/h/html.htm
http://www.computerhope.com/jargon/b/browser.htm
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3. History of Web 

Tim Berners-Lee, a British scientist at CERN (European Organization for Nuclear 
Research), invented the World Wide Web (WWW) in 1989. The web was originally 
conceived and developed to meet the demand for automatic information-sharing 
between scientists in universities and institutes around the world. 

The website described the basic features of the web; how to access other people's 
documents and how to set up the own server.  
 
 
 

Web 1.0 

Web 1.0 refers to the first stage in the World Wide Web, which was entirely made up 
of web pages connected by hyperlinks. Although the exact definition of Web 1.0 is a 
source of debate, it is generally believed to refer to the web when it was a set of static 
websites that were not yet providing interactive content.  

 

 

The first website at 
CERN - and in the 
world was dedicated 
to the World Wide 
Web project itself 
and was hosted on 
Berners-Lee's NeXT 
computerHyper Text 
Markup Language is 
used use to create 
web pages.  

Do you know! 

CERN as part of the 
In 2013 CERN 
reinstated the 
world's first website 
to its original 
address.  

Do you know! 

In Web 1.0, 
applications were 
proprietary. Where 
Web 1.0 ends and 
Web 2.0 begins 
cannot be 
determined as this a 
change that 
happened gradually 
over time as the 
Internet became 
more interactive 
 

Remember  
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 Web 1.0 sites are static. They contain information that might be useful, but 
there's no reason for a visitor to return to the site later. An example might be a 
personal Web page that gives information about the site's owner, but never 
changes.  

 Web 1.0 sites aren't interactive. Visitors can only visit these sites; they can't 
impact or contribute to the sites. Most organizations have profile pages that 
visitors can look at but not impact or alter, whereas a wiki allows anyone to 
visit and make changes. 

 Web 1.0 applications are proprietary. Under the Web 1.0 philosophy, 
companies develop software applications that users can download, but they 
can't see how the application works or change it.  

 

Web 2.0 

Web 2.0 is the name used to describe the second generation of the World Wide Web, where it moved static 
HTML pages to a more interactive and dynamic web experience. 

Web 2.0 is focused on the ability for people to collaborate and share information online via social media, blogging 
and web based communities. 

 Web 2.0 Website Types 
 

Audio Blog-Pod Blogging Bookmarking Calendars 

Chats Collaboration Communication Community CRM 

E-commerce E-learning E-mail File-sharing Forums 

Games Images Knowledge Base Lists Mapping 

Mashups Multi-media Portals RSS Wiki 

Examples of Web 2.0 based websites 

Flickr - A photo sharing website which allows users to upload their photographs and share it with anyone and 
everyone. 

Orkut-Social networking site which allows the users to send messages and communicate with other members. 

YouTube - It allows the users to upload their videos and share it with everyone. 

Blogs - Maintained by individuals or groups, they can be used to convey anything. 

Google AD sense - Allows users to earn money through posting Google ads on their websites. 

Wikipedia - Online encyclopedia wherein the users contribute by writing the articles, definitions, etc. It is 
completely edited and maintained by the users. 

Scribd - Users can upload any documents on the website where other users can either download or view those 
documents online. 

 

 

 

Web 2.0 
Technologies such 
as weblogs, social 
bookmarking, wikis, 
podcasts, RSS 
feeds, social 
software, web APIs, 
eBay & Gmail 
provide 
enhancements over 
read-only websites 
 

Do you know! 
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Web 3.0 

 
Web 3.0 refers to a third generation of Internet-based services that collectively 
comprise what might be called ‘the intelligent Web’  such as those using semantic web, 
micro-formats, natural language search, data-mining, machine learning, 
recommendation agents, and artificial intelligence technologies which emphasize 
machine-facilitated understanding of information in order to provide a more productive 
and intuitive user experience. 
 
 
 
 
 

 
Web 2.0 Design vs. Web 3.0 Design 
 

 
 
Web 3.0, designers will continue to focus on making things simpler. The truth is, the designer has the absolute 
power to persuade viewers on where to look first and second and so forth and so on.  
 

Comparison of web 1.0 web 2.0 and web 3.0 

 
 

 

Web 4.0 is often 
characterized as the 
WebOS - the entire 
web being a single 
operating system 
where information 
flows from any one 
point to any other 

Do you know! 
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S.No Web 1.0 Web 2.0 Web 3.0 

1.  1990 2000 2009 

2.  The Web The Social Web The Semantic Web 

3.  Tim Berners Lee Tim O'Reilly Sir Tim Berners Lee 

4.  Read only web Read and write web Read, write and execute web 

5.  Information sharing Interaction Immersion. 

6.  Millions of users Billions of users Trillion of users 

7.  Ecosystem Participation Understanding itself 

8.  Connect information Connect people Connect knowledge 

9.  
Brain and Eyes (= 
Information) 

Brain, Eyes, Ears, Voice and 
Heart (= Passion) 

Brain, Eyes, Ears, Voice, Heart, 
Arms and Legs (= Freedom) 

10.  
The Hypertext/CGI Web. (the 
basics) 

The Community Web (for 
people: apps/sites connecting 
them). 

The Semantic Web (for machines). 

11.  
Pushed web, text/graphics 
based flash 

Two way web pages, Wikis, 
video, pod casts, shading, 
Personal publishing, 2D 
portals 

3D portals, avatar, Interoperable 
profits, multi-user virtual 
environment, Integrated games, 
education and business, all media 
flows in and out of virtual Web 
worlds 

12.  
Companies publish content 
that people consume (e.g. 
CNN) 

People publish content that 
other people can consume, 
companies build platforms 
that let people publish content 
for other people (e.g. Flickr, 
YouTube, Adsense, 
Wikipedia, Blogger, 
MySpace, RSS, Digg) 

People build applications that 
people can interact with, companies 
build platforms that let people 
publish services by leveraging the 
associations between people or 
special content (e. g. Facebook, 
Google Maps, My Yahoo!) 

13.  

In Web 1.0 search engines 
retrieve macro contents. 
Search is very fast but many 
times results are inaccurate 
or more than users can chew. 

In Web 2.0 search engines 
retrieve tags with micro 
contents (Furl even retrieves 
tags with macro contents). 
The process of tagging is 
manual, tedious and covers 
negligible percent of the 
WWW. Web 2.0 tags every-
thing: pictures, links, events, 
news, Blogs, audio, video, 
and so on. Google Base even 
retrieves micro content texts. 

In Web 3.0 search engines will 
hopefully retrieve micro content 
texts which were tagged 
automatically. This implies 
translating billions of Web 1.0 macro 
contents into micro contents. The 
result could be more precise search 
because tagging can solve part of 
the ambiguity that homonyms and 
synonyms introduce into the 
process of search. 

14.  

Web 1.0 was all about static 
content, one way publishing 
of content without any real 
interaction between readers 
or publishers or each other. 

Web 2.0 is more about 2 way 
communication through social 
networking, blogging, wikis, 
tagging, user generated 
content and video. 

Web 3.0 is curiously undefined. And 
the web learning what it want and 
delivering a personalized web 
experience. 

15.  

The web in the beginning 
when it was first 
developing 
web 1.0 

New advances that allow a 
much more sophisticated 
user interaction with web 
pages - citizen journalism, 
social networks and Wikis are 
all products of Web 2.0 

Thought to be the future - where the 
web is more interactive with 
users, leading to a kind of artificial 
intelligence web 3.0 
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16.  Personal web sites Blogs 
Semantic Blogs: Semi-Blog, 
Haystack, Structured Blogging 

17.  Content Management system Wikis, Wikipedia 
Semantic Wikis: Semantic 
MediaWiki, SemperWiki, Platypus, 
dbpedia, Rhizome 

18.  AltaVista, Google 
Google personalized, 
DumpFind, Hakia 

Semantic Search: SWSE, Swoogle, 
Intelli-dimension 

19.  Citeseer, Project Gutenberg Google scholar, Book search 
Semantic Digital Libraries: JeromDl, 
BRICKS, Longwell 

20.  Message boards Community portals 
Semantic Forums and community 
portals: SIOC, 
OpenLinkDataSpaces 

21.  Buddy Lists, Address book Online social networks 
Semantic Social Networks: FOAF, 
PeopleAggregator 

22.    
Semantic Social Information 
Spaces: Nepomuk, Gnowsis 
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Learning Unit 2: Compare Static Websites with Dynamic 
Websites 

Overview 

In this learning unit, you will learn the detail of static and dynamic websites. These 
concepts are building blocks to design and deploy a web application. After the 
completion of this learning unit, you will be able to understand the difference of static & 
dynamic website, architectural design of static and dynamic web sites.  
 
 
 

1. Static Website 

Static website is collection of web pages stored on the server in the format that is sent 
to a client web browser. It is primarily coded in Hypertext Markup Language (HTML). 
Pages typically contain text, hyperlinks, photos, graphics and multimedia.  
 

Static websites contain fixed number of pages and format of web page is fixed which 
delivers information to the client. This kind of web sites created from HTML and CSS 
coding on simple text editor like notepad. Example an organization site, institute site 
etc. 

Advantages 
 Quick and easy to put together, even by someone who doesn't have much 

experience. 
 Ideal for demonstrating how a site will look. 
 Cache friendly, one copy can be shown to many people. 
 
Disadvantages 
 Difficult to maintain when a site gets large. 
 Difficult to keep consistent and up to date. 
 Offers little visitor personalization (all would have to be client side). 
 The basic disadvantage of static web sites is the web pages are developed 

at the time of constructing the site. As such, all static website owners have 
to be abjectly dependent on Web professionals whenever any changes 
become necessary. Though the initial cost of setting up a static Website 
may not be costly, its long term maintenance will be expensive – more so, 
if the site owner wishes to effect changes at regular intervals. 

 
 
 
 
 
 
 

2. Dynamic Website 

Dynamic Websites one that changes or customizes content automatically and/or frequently based on certain 
criteria. The page composition is usually data-driven and collates information each time a page is requested. It 
is primarily coded using server scripting such as PHP, ASP.NET and SQL and so on. 

Web Server 
Software is required 
to run and test the 
dynamic web sites 

Remember  
 

HTML, is the 
standard markup 
language used to 
create web pages. 

HTML 

Cascade style sheet 
is a web page 
derived from 
multiple sources 
with a defined order 
of precedence 
where the definitions 
of any style element 
conflict. 

Cascade Style 
Sheet (CSS) 
 

Server-side 
scripting is a 
technique used in 
web development 
which involves 
employing scripts on 
a web server which 
produce a response 
customized for each 
user's (client's) 
request to the 
website 

Server Side 
Scripting 
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It can be dynamic in one of two ways: 

 The first is that the web page code is constructed dynamically.  
 The second is that the web page content display varies based on certain criteria. The criteria may be 

pre-defined rules or may be based on variable user input. 
 End User? 
 Application User? 

 
client server architecture 

 

3. Difference between Static and Dynamic Websites 

Difference between static and dynamic website is mentioned below: 
 

Static Websites Dynamic Websites 

Static websites contain fixed number of pages. Dynamic websites can create webpage dynamically. 

Theme of website and content of webpage are fixed. 
Webpage design and content may change on run 
time. 

Static websites load quickly on client browser 
because it has only some markup contents. 

Dynamic sites take some time to load on client 
browser because it processes the request server 
side and create contents dynamically. 

Static sites never use database connectivity. 
Dynamic sites deal with database and generate the 
contents dynamically using database queries. 

Static websites is highly secure than dynamic sites 
because it behaves as a half-duplex approach so 
only one way communication is possible i.e. server to 
client.  

Dynamic sites are less secure because it behaves as 
full duplex approach so both side communications is 
possible so user can change the server data. 

Static site use for provide some information to the 
clients like an organization or institute website.  

Dynamic website use where content changes 
frequently on run time. Like a E-commerce site, 
online examination, etc. 

Static website directly run on browser and does not 
require other server application language. Static 
website can be created from HTML and CSS. 

Dynamic website run the application on server and 
the output will display on webpage. So this is require 
server application language like PHP , Asp.NET, JSP 
etc. 

Static sites are easy to develop and a bit 
experienced people can develop it. 

Dynamic websites not easy to develop because 
require qualify developers to create it, manage it, test 
it and maintain security of application and database. 

In static website if we want to change the page 
content then we have to upload that page on server 
many times. 

Dynamic sites provide the facilities that it possible to 
change the page content using server application. 
And need not to upload the page on server. 



 Module 2: Elaborate World Wide Web 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                             | 51 

4. Design Architecture of a Static Website 

In case of static website, all pages are saved in server computer. Client system is sending requests to server to 
get specific page. At request of client server will return specific page.  

 

5. Design Architecture of a Static Website 

Dynamic web pages architecture based on 3 tire architecture  

 

Dynamic website architecture is consists of three distinct tiers or layers:  

 Presentation 

 Logic (Application) 

 Data. 

Logically, the presentation tier consists of client computers and web services that provide the user interface. The 
logic or application tier contains the business logic, the rules for information processing and the data access 
components. The data tier contains the data and data storage. 

Advantages 

 Scalable Design – The addition of new servers and load balancing can grow an environment to 
accommodate large numbers of client connections. 

 Parallel Development – Developers and DBAs can work simultaneously and independently on the 
different layers (tiers). 

 Superior Performance – Separation of CPU-intensive, memory-intensive and I/O-intensive operations 
increases and extends performance of all components. 

 Increased Security – Physical and logical separation of components can increase security. 

 Improved Availability – Redundant server members decrease the severity of outages. 

Disadvantages 

 Design Complexity – Multi-tier architecture is more difficult to implement than single tier. 

 Increased Maintenance – Designated systems (Web, Application and Database) often have their own 
maintenance schedules and windows that might prove cumbersome to production. 
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Learning Unit 3: Web Browsers 

Overview 

In this learning unit, you will be introduced different web browsers. After the completion 
of this learning unit, you will be able to understand working & installation of web browser 
(Mozilla, Google Chrome & Internet Explorer)  

 

1. Web Browser 

A browser, also referred to as a web browser, is a software program created as a simplified means to present 
and explore content on the World Wide Web.  

These pieces of content, including pictures, videos, and web pages, are connected using hyperlinks and 
classified with Uniform Recourse Identifiers (URLs).  Most popular browser software are Mozilla Firefox, Google 
chrome , Internet Explorer, Opera and safari  

2. Working of Web Browser 

Browser is a application software that act as user agent for web server detailed working of browser with help of 
diagram is mentioned below: 

 

 

3. Installation of Mozilla Firefox 

1. Visit the Firefox download page (http://www.getfirefox.com/) in any browser (e.g. Microsoft Internet 
Explorer). The page will automatically recommend the best version of Firefox. 

The first commonly 
available web 
browser with a 
graphical user 
interface was 
Netscape. 

Do you know! 
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2. Click on the green download button to download the Firefox installer. Depending on the connection 
speed, the download may take up to a few minutes. 

3. Start the process by clicking RUN.  
 

 
 

4. Then, just Click Install 
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Congratulations, installing Firefox! 

1. Double-click on the Firefox icon.  

 

4. Features / Options of different Web Browsers 

Google Chrome 

1. Task Manager for Websites 

Inside Google Chrome, press Shift+Esc and it will open up a ‘task manager’ with a list of all websites currently 
open inside Chrome. 
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2. Visual Browser History 

This is a feature Chrome borrowed from Google Desktop / Google Web History. Type Ctrl+H to open the browser 
history and search for a term. 

 

 

3. Super Save Images 

Right click on any picture/image and get only five relevant options to deal with that link.  

 

4. Favorite Websites from the Address Bar 

Chrome browser add favorites under address bar   
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5. See Memory Used by Different Browsers 

Open a new tab inside Chrome browser and type "about:memory" (without quotes) – somewhere at the top, a 
list of browser processes that are currently running on the system and the amount of memory they are using. 

 

6. Reopen Website tabs that closed by mistake 

Firefox 3 has this "Undo Closed Tab" option in the menu, in Opera web browser press the Ctrl+Z shortcut. 

 

To re-open a closed tab in Google Chrome, just hit Ctrl+T and an option that says "Recently closed tabs" – click. 

7. Launch Websites from the Start Menu / Quick Launch Bar 

Desktop shortcuts for web pages are possible with other browsers as well but Google Chrome makes the whole 
flow very easy. Open any site and choose "Create application shortcut" from the File menu.  

 

This will essentially create a desktop shortcut that looks something like this:  

C:\Users\labnol\AppData\Local\Google\Chrome\Application\chrome.exe  
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    --app=http://www.labnol.org/ 

Clicking the shortcut will launch that web page in a new instance of Chrome that may 
not contain have any more new tabs. 

Chrome offers to move tabs around different windows, In Firefox tags can be drag onto 
the desktop and turn them into web shortcuts. 

Mozilla Firefox 

Largely developed by the Mozilla Foundation, Firefox is an open source Web browser available on Windows, 
Mac and Linux. It is the second most popular Web browser on the Internet as of 2013. The browser has a number 
of unique features designed to enhance the browsing experience. 

1.Open Source 

Firefox is the only open source Web browser among the most used browsers on the Web as of March 2013. The 
open source nature of Firefox enables developers from all over the world to contribute code to the browser and 
extend the functionality of Firefox with add-ons and themes 

2.Add-ons and Personas 

Firefox is one of the most easily customized browsers thanks to its extensive library of add-ons and personas. 
From blocking advertisements and Flash content, to integrating social networks and email, to assisting Web 
developers debug and review live code, add-ons offer the ability to configure Firefox exactly as one like it 

3.Tab Management 

Tab Groups is a built-in feature that offers a simple way to cluster tabs into different categories. This is particularly 
useful if one have a large number of tabs open. 

4.Security 

Firefox features a number of tools designed to prevent malicious websites from causing harm. In particular, 
Firefox features a pop-up blocker, anti-phishing and anti-malware warnings that are updated 48 times per day to 
prevent from accessing fraudulent websites and thorough website identity information that is easily accessible 
from the address bar, making it easy to validate a website before enter private information.  

5.The New User Interface 

 

Add-ons are small 
bits of code that can 
extend the 
functionality of 
Firefox in an almost 
infinite number of 
ways. 

Add-Ons 
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The first thing users will notice is the drastic changes to the user interface. For starters, the traditional File Menu 
is gone, replaced by a single “Firefox” button located at the top left corner of the window. Not liking the all-in-one 
button? Users can easily change back to the old file menu by clicking the Firefox button, hovering over Options 
and clicking Menu Bar. 

6.Better Add-on Manager 

 

The bread and butter of Firefox have always been its extensions and themes. The new add-on manager cleans 
up the experience making it easier for users to find different add-ons as well as organizing existing ones. The 
new organization tool opens a new tab, giving users a full window view instead of a small popup. With a separate 
dedicated tab for the add-ons manager Mozilla makes it easy to keep everything in a single window, however, it 
would have been great if this translated to the options section as well. Earlier this year Google released Chrome 
10 which opens the options menu in a separate tab, hopefully Mozilla will be able to add this feature soon. 

Internet Explorer 

Even though not many websites cover Internet Explorer extensively and write interesting articles and tutorials 
about it, this browser still manages to hold the title of the most used browser. One of the reasons for it is that it 
provides some interesting functionality that other browsers don’t have or have not fully adopted. Here is a list of 
5 great features Internet Explorer has and other browser do not, which I would love to see being adopted by 
everybody. 

1.Visual Search Providers 

Internet Explorer have the ability to install and use visual search providers. It allows not only to see suggestions 
for searches but it also accompanied by a visual preview that includes a picture and some text description. 

 



 Module 2: Elaborate World Wide Web 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                             | 59 

2.Stats about the Performance Impact of Add-ons 

As highlighted in the article Internet Explorer 9 - How to Improve the Load & Navigation Speed, the browser 
monitors the performance impact of all add-ons and encourages users to disable those that slow things down. 

 

3.Improved Security 

Internet Explorer provides better identification and reporting of malicious websites and downloads, when 
compared to other browsers and even some security suites. Another great feature is that Internet Explorer allows 
users to easily report malicious websites, directly from the main interface of the browser, thus helping increase 
security for all users. 

 

4.Power Saving Features 

Internet Explorer allows to squeeze a bit more juice from the battery, when running unplugged. It get less 
hardware acceleration while browsing, without making things terribly slow and a bit more battery time. 
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5.Pinning Websites to the Windows Taskbar or the Start Menu 

This feature is not new and it has been adopted by some browsers, such as Google Chrome. It useful and all 
browsers should offer such capabilities to their users. 

 

5. Comparisons of Different Web Browsers 

 

Performance: Firefox Chrome IE 

Fast startup and shutdown Yes Yes Yes 

Fast JavaScript engine for better performance Yes Yes Yes 

Popular websites load quickly Yes Yes Yes 

Full hardware acceleration for text, graphics, and video 
provided by default 

  Yes 

Notification when add-ons slow browser performance   Yes 

Ease of Use:    
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Simple browsing controls for a better browsing experience Yes Yes Yes 

Change and add search providers within the search box Yes Yes Yes 

Search provider suggestions as type in the search box Yes Yes Yes 

New Tab page includes quick access to common tasks and 
websites 

 Yes Yes 

Websites can be pinned to the taskbar in Windows 7  Yes Yes 

Tear-off tabs with Windows 7? Aero Snap  Yes Yes 

Reopen accidentally closed tabs  Yes Yes 

Combined search and Address bar  Yes Yes 

Visual search suggestions shown as type   Yes 

Jump Lists and thumbnail preview controls for pinned sites   Yes 

Accelerators for quick access to web services without 
leaving the page 

  Yes 

Security:    

Protection from malicious cross-site scripting attacks Yes Yes Yes 

Best protection against phishing attacks Yes  Yes 

Domain name highlighting in the Address bar  Yes Yes 

Most protection against socially engineered malware   Yes 

Reliability:    

Crashed tabs stay isolated from all other tabs Yes Yes Yes 

Automatic recovery of crashed tabs Yes Yes Yes 

Tab recovery with messaging and prompting when websites 
time out 

  Yes 

Privacy:    

Prevent others from seeing what sites have visited on PC Yes Yes Yes 

Control whether certain third parties can track browsing 
activity 

Yes Yes Yes 

Web Standards and Compatibility:    

Supports common and future standards including HTML5 Yes Yes Yes 

WebM-encoded HTML5 video supported when a VP8 codec 
is installed 

Yes Yes Yes 

H.264-encoded HTML5 video support   Yes 

Compatibility mode to view websites designed for older 
browsers 

  Yes 

Developer Tools:    

Tool set (HTML, CSS, JavaScript editing, profiling, network 
inspection) 

Yes Yes Yes 

Developer tools built-in to the browser  Yes Yes 

Tools that show pages in different rendering engines   Yes 

 
 

6. Cross Browser Compatibility of Websites 

When a software program is developed for multiple computer platforms, it is called a cross platform program. 
Similarly, when a website is developed for multiple browsers, it is called a cross-browser website. Cross-browser 
compatibility is an issue faced by designers/developers when creating websites. 
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How should fix compatibility issue? 

The first step in fixing a browser compatibility problem is to check the code to see if it passes "validation". Code 
validation will show where website has incorrectly coded HTML tags, missing tags, non W3c compliant tags, and 
more. It can validate the website for free at the W3c site. See the following links on this. 

HTML Validator 
http://validator.w3.org/ 

CSS Validator 
http://jigsaw.w3.org/css-validator/ 

Once it validate the HTML and have no errors on the website, it should see the browser look more uniform. If it 
need to continue looking through the website code and fixing code problems until all browsers look the same. 
This process will require being able to check the website in each browser. 

How can test for browser compatibility? 

There are different ways to test the website for cross browser compatibility. It can install all the known browsers 
on the computer and then view the website in each browser as develop it. The downfall to this is not be able to 
see what the older versions of a browser looks like. 

Browser Shots 
http://browsershots.org/ 

IE Tester 
http://www.my-debugbar.com/wiki/IETester/HomePage 

Adobe Browser Lab 
https://browserlab.adobe.com/en-us/index.html 

Quirks Mode 
http://www.quirksmode.org/compatibility.html 
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Learning Unit 4: Types of Websites  

Overview 

In this learning unit, you will learn different types of website. After completion of this learning unit, you will be able 
to understand the different type of web sites e.g. personal, social, Blog, forums, wiki, news, e-commerce, and 
government. 

1. Different Types of Websites with Examples 

Personal Websites 

Personal websites are owned by individuals, with their personal profile featured on it, and the things that they 
are interested in. These websites have a limited scope, and it doesn't take too much capital to put one of them 
on the Internet like www.draqkhan.com.pk 

Social Networking Websites 

Social networking websites are the top visited ones, as they are created purely for socializing and catching up 
with friends, etc. Few of these websites include networking for both business and personal use. For example, 
Facebook, LinkedIn, etc. 

Blogs 

Blog is a short form for web logs. Blogging is very popular as it provides an individual direct communication with 
the readers, their feedback, thought sharing, etc. Blogging has become one of the marketing strategies for many 
companies, and many sportspersons, businessmen, and actors are using it to connect with their audiences. 
Some of the best blogging websites are huffingtonpost, tmz, etc. 

Forums 

A Web forum is a website or section of a website that allows visitors to communicate with each other by posting 
messages. Most forums allow anonymous visitors to view forum postings, but require to create an account in 
order to post messages in the forum. When posting in a forum,   creating new topics (or "threads") or post replies 
within existing threads. 

Web forums are available for all kinds of topics. Examples include software support, help for webmasters, and 
programming discussions. While lots of Web forums focus on IT topics, they are not limited to information 
technology. There are forums related to health, fitness, cars, houses, teaching, parenting, and thousands of other 
topics. Some forums are general, like a fitness forum etc. 

Wiki Websites 

A wiki is a Web site that allows users to add and update content on the site using their 
own Web browser. This is made possible by Wiki software that runs on the Web server. 
Wikis end up being created mainly by a collaborative effort of the site visitors. A great 
example of a large wiki is the Wikipedia, a free encyclopedia in many languages that 
anyone can edit. Thousands of users adding content to wiki web site on a regular basis, 
the site could grow "super-fast." 

News Websites 

Nowadays, every newspaper, magazine and TV channel has its own online edition. These websites allow users 
from all over the world to have access to the latest news and they are also providing e-newspapers online. Now 

The term "wiki" 
comes from the 
Hawaiian phrase, 
"wiki wiki," which 
means "super-fast." 

Do you know! 

http://www.draqkhan.com.pk/
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users can also view newspaper online instead of purchasing newspaper in hard form. Some of the examples are, 
din news, jang News (e.jang.com.pk).   

E-commerce Websites 

They are mainly transactional ones, which allow to shop from home. For many consumers, they are like an online 
store, and for businessmen, they are a great way of conducting business without the need of an expensive outlet. 
Some of the websites that make money from E-commerce are Amazon, eBay, etc. 

Government Websites 

All the government department of almost every country in the world has their own websites so that information 
can be given to the public on a regular basis. They have a suffix .gov at the end; for instance, the website 
department punjab.gov.pk 
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Learning Unit 5: Web Threats and Their Security 
Measures 
 

Overview 

In this learning unit, you will learn different type of web threats and their security 
measures. After the completion of this learning unit, you will be able understand 
different web threats like worms, Trojans, Malware, SQL injection, cross-site scripting, 
phishing, and denial of service attack, Security measures for different web threats and 
installation of antivirus. 

 

 
 

1. Different Web Threats 

Computer Virus 

A computer virus is a program or piece of code that is loaded onto the computer without 
the knowledge, & permission and runs against the wishes and harmful for computer. 
Almost all viruses can replicate themselves. All computer viruses are man-made.  

A simple virus that can make a copy of it over and over again is relatively easy to 
produce. Even such a simple virus is dangerous because it will quickly use all available memory and bring the 
system to a halt. An even more dangerous type of virus is one capable of transmitting itself across networks and 
bypassing security systems. 

Computer worms 

A computer worm is a self-replicating computer program that penetrates an operating system with the intent of 
spreading malicious code. Worms utilize networks to send copies of the original code to other computers, causing 
harm by consuming bandwidth or possibly deleting files or sending documents via email. Worms can also install 
backdoors on computers. 

Worms are often confused with computer viruses; the difference lies in how they spread. Computer worms self-
replicate and spread across networks, exploiting vulnerabilities, automatically; that is, they don’t need a 
cybercriminal’s guidance, nor do they need to latch onto another computer program.  

As such, computer worms pose a significant threat due to the sheer potential of damage they might cause. A 
particularly notorious incident occurred in 1988. A computer worm since named the Morris worm caused 
hundreds of thousands, if not millions, of dollars in damage, and its creator was convicted under the Computer 
Fraud and Abuse Act. 

Trojans Horse  

A Trojan horse is a program or utility that appears to be something useful or safe, but in reality is performing 
background tasks such as giving access to the computer or sending personal information to other computers. 
Trojan horses are one of the most common methods a criminal uses to infect the computer and collect personal 
information from the computer. Below are some basic examples of how the computer could become infected with 
a Trojan horse. 

Brain, a malicious 
code created in 
Pakistan which 
infected boot sectors 
of disks so that their 
contents could not 
be accessed. 

Remember  
 

The term “computer 
virus'' was formally 
defined by Fred 
Cohen in 1983 

Do you know! 
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Malware 

Malware is an abbreviated term meaning “malicious software.” This is software that is 
specifically designed to gain access or damage a computer without the knowledge of 
the owner. There are various types of malware including spyware, keyloggers, true 
viruses, worms, or any type of malicious code that infiltrates a computer. Generally, 
software is considered malware based on the intent of the creator rather than its actual 
features.  

SQL Injection 

SQL Injection is one of the many web attack mechanisms used by hackers to steal data 
from organizations. It is perhaps one of the most common application layer attack 
techniques used today. It is the type of attack that takes advantage of improper coding 

of the web applications that allows hacker to inject SQL commands into say a login form to allow them to gain 
access to the data held within the database. 

In essence, SQL Injection arises because the fields available for user input allow SQL statements to pass through 
and query the database directly. 

Cross-site Scripting (XSS) 

Hackers are constantly experimenting with a wide range of hacking techniques to compromise websites and web 
applications and make off with a treasure trove of sensitive data including credit card numbers, social security 
numbers and even medical records. 

Cross-site Scripting (also known as XSS or CSS) is generally believed to be one of the most common application 
layer hacking techniques. 

Email Spam 

Spam email is a form of commercial advertising which is economically viable because email is a very cost-
effective medium for the sender. If just a fraction of the recipients of a spam message purchase the advertised 
product, the spammers are making money and the spam problem is perpetuated. 

Receiving an e-mail that appears to be from a friend asking to view this fantastic new program or look at a 
file. Opening the file infects the computer with a Trojan horse. 

A popular screen saver website has become infected or uploaded infected screen savers. Downloading the 
screen saver to the computer also installs a Trojan horse onto the computer. 
 

A friends Facebook account is hacked and has sent out personalized messages telling all their friends to see 
this exciting new video. Opening the video requests a download that has a hidden Trojan horse that infects 
the computer. 
 

A Website offers a free download to a program or game that normally costs money. Downloading the pirated 
version of a program or game allows illegally using or playing it, however, during the install it also installed a 
Trojan horse onto the computer. 
 

Key logger is small 
programs or 
hardware devices 
that monitor each 
keystroke typed on a 
specific computers 
keyboard, including 
typos, backspacing 
and retyping 

Key Logger 
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Spammers harvest recipient addresses from publicly accessible sources, use programs to collect addresses 
on the web, and simply use dictionaries to make automated guesses at common usernames at a given domain. 

Spamming is politically debated in several countries, and has been legislated some places with varying results. 
Spammers often conceal or forge the origin of their messages to circumvent laws, service provider regulations, 
and anti-spammer lists used by anti-spam software. 

At the present more than 95% of email messages sent worldwide is believed to be spam, making spam fighting 
tools increasingly important to all users of email. 

Hijacking of real users’ addresses or email accounts is also common. Typically these messages will have the 
From field showing something like “Lisa W Harold” <info@runbox.com>. Please note that such messages have 
no actual connection to Run box (to see what a real Run box header looks like, look at this example). Run box 
does not in any way distribute our customers’ email addresses, and is not a source of spam — directly or 
indirectly. 

Phishing 

An increasingly common phenomenon is “phishing”, where messages appearing to be sent from e.g. legitimate 
financial institutions attempt to trick recipients into “verifying” sensitive data (such as credit card information) on 
fraudulent web sites. 

Legitimate services will rarely (if ever) send messages requesting to click a link and provide personal or sensitive 
information. Be sure to verify the source of the message before complying with such a request. 

If receiving messages claiming to originate with payment services such as PayPal, eBay, financial institutions, 
or even Run box, please verify that the message is indeed sent from the service in question: 

 Look at the links in the message in plain text (not HTML) view. Verify that the actual link contains the 
domain name (e.g. runbox.com or paypal.com), and not another domain name or IP address, by hovering 
the mouse pointer over the link while looking at the status bar of the browser. Remember that links in an 
HTML message may be “disguised” and link to a different server than it appears to do. 

 Check the message headers. Look at the IP address of the sending server and verify that it resolves to 
the correct domain and country by using a service such as DNS stuff. 

 Falsified messages will rarely address by name or provide any personal information about to except the 
email address, because the senders do not have access to such information. 

Denial of Service Attack 

Denial of Service (DoS) attacks against web sites occur when an attacker attempts to make the web server, or 
servers, unavailable to serve up the web sites they host to legitimate visitors. For some time, it was thought that 
these types of attacks were generally used against large corporations, government sites, and activist sites as a 
form of protest to disrupt their web presence. 

Examples of Denial of Service attacks launched against web applications include:  

 Attempts to "flood" web applications, thereby preventing legitimate user traffic 

 Attempts to disrupt service to a specific system or person, e.g., blocking user access by repeated 
invalid login attempts resulting in the account's suspension 

 Jamming the application-database connection by crafting CPU-intensive SQL queries 
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2. Security Measures for Different Web Threats 

General Rules to avoid from Virus: 

 Never download files from any suspicious websites. 

 Use the best available Anti- virus tool and scan hard drive regularly. 

 Deactivate the Auto run function for external drives. 

 Always scan any documents from the external drive before open or save them. 

 Keep the operating system updated from time to time. 

In order to avoid worms attack: 

 Configure a proper firewall to restrict the network traffic. 

 Set the firewall to cloak the computer from the network. 

 Never open Emails before scanning them with updated anti-virus software. 

 Scan the computer regularly and keep the anti-virus updated 

Follow the rules to avoid any internet scams: 

 Do not respond believe in any unrealistic mails 

 Also do not respond to such mails or advertisement letters. 

 Always do some research about the company mentioned in the mail before reply to it 

 Never respond to mails which has any banks or government agencies name in the sender details. 

To avoid Phishing attacks: 

 Do not respond to mails that requests for the personal information. 

 Never click on any links which are emailed. 

 Do not open mail attachment with .scr, .exe & .com file extensions. 

 Avoid giving the username and password to any illegitimate source. 

 Ensuring updated anti-virus software and the operating system of the computer. 

Preventing from Trojan Horse 

Trojans is executed by users, they may be easier to avoid than other types of malware. Never download files 
and never click on links outside of trusted websites, it can significantly reduce the chances of coming into 
contact with Trojans. 

1- Never open unsolicited emails from unknown senders. Emails from people, the one don't know may 
contain links, attachments or other traps that can get him to inadvertently install Trojans. 
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2-  Avoid downloading and installing programs unless, fully trust the publisher. Some websites attempt to 
trick users into downloading programs that they claim will perform useful tasks, when in reality installation 
will only infect the computer. 

3- Use firewall software. Firewalls are programs that can block unsolicited connections, which may help 
prevent Trojans. On using Windows XP Service Pack 2 or later, Vista or Windows 7, it will have access 
to Windows Firewall. Make sure it is running properly by clicking "Start," "Control Panel," "Security," 
"Windows Firewall" and "Change Settings." Click "On" and "Apply" if it is not already on. 

4- Use a fully updated antivirus program whenever using the Internet. Antivirus software can help scan links 
for malicious data and prevent and remove malware, like Trojans. Popular antivirus programs include 
Norton, McAfee, Kaspersky, AVG Free, Avira Antivirus and Avast. 

Preventing Denial of Service Attacks 

With web application firewall (like dotDefender) it can be avoid DoS attacks because dotDefender inspects HTTP 
traffic and checks their packets against rules such as to allow or deny protocols, ports, or IP addresses to stop 
web applications from being exploited.  

Architected as plug & play software, dotDefender provides optimal out-of-the-box protection against DoS threats, 
cross-site scripting, SQL Injection attacks, path traversal and many other web attack techniques.  

The reasons dotDefender offers such a comprehensive solution to the web application security needs are:  

 Easy installation on Apache and IIS servers 

 Strong security against known and emerging hacking attacks 

 Best-of-breed predefined security rules for instant protection 

 Interface and API for managing multiple servers with ease 

 Requires no additional hardware, and easily scales with the business. 

3. Installation of Antivirus 

All popular antivirus software’s like Norton, McAfee, Kaspersky, AVG Free, Avira antivirus and Avast are paid 
software ,they only provide on month free trial after that it should be bought its license as per antivirus provider 
company plan minimum duration of license is 01 year. 

Microsoft window provide free antivirus for window 7 and window vista user Microsoft Security Essentials. For 
Windows 8, Windows RT, Windows 8.1, Windows RT 8.1 user Microsoft Windows Defender.  

If the computer has no antivirus software, it will get some dire warnings in the Security Action Center. To 
navigate the Security Action Center through the Control Panel.  
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Heed dire warnings in the Security Action Center. 

Fixing these problems in one action, by downloading and installing Microsoft Security Essentials. The first thing 
to do is go to the Web site and start the download, it should also uninstall any previously installed antivirus 
software to avoid conflicts.  

 

 

Download the client. 

When the Microsoft Security Essentials download starts, click the Run button, 
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Click Run. 

The download and install is very quick.  

 

The download happens in no time at all. 

Microsoft Security Essentials ready to install and explain what it is designed to do.  
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Microsoft Security Essentials is now ready to install. 

Accept the licensing agreement and validate the copy of the Windows operating system is genuine Accept the 
license. 
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Validate Windows. 

The ready-to-install screen reminds to uninstall previously installed antivirus applications. 

 

Finally, it ready to install. 

Once Microsoft Security Essentials is installed, it will immediately update itself with the latest antivirus definitions. 
This is an important step, as new variations of viruses and malware are released into the wild on a daily basis. 
No matter which antivirus software choose to use, always keep it up to date.  
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Microsoft Security Essentials is now installed. 

 

Update definitions. 

Once the updates are in place, test PC goes from a red warning that the computer is at risk to a green declaration 
that the PC is protected 
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PC is now protected. 

 

Security is back. 

Configure 

From the main page of the Microsoft Security Essentials client application, see the status of the computer's 
antivirus security and perform a manual scan. From the other tabs on this screen, it can manually ask for virus 
definition updates and check the history of antivirus activity performed by the application.  
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Configure the computer's antivirus security on the main page. 

On the last tab, set a scheduled time to perform a Microsoft Security Essentials scan. The default is once a week, 
but it has flexibility to set the schedule as required. 

 

Set a scanning schedule. 

Bottom Line 

Whether, an individual computer user or the manager of an entire department of Internet-connected computers, 
the need for antivirus applications is very real. While Microsoft Security Essentials may be merely basic 
protection, it is an important first line of defense that can work for almost anyone or any organization. With the 
benefit of a clean install and tight integration with the Windows operating system, it is worth a look no matter how 
many computers are involved. 
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Learning Unit 6: Process of Domain Registration and 
Web Hosting 

Overview 

In this learning unit, you will learn process of domain registration and web hosting. After the completion of this 
learning unit, you will be able to understand about Web hosting, types of web hosting, domain registration and 
how to upload website on web server.   

1. Web Hosting 

What is web hosting? 

Web hosting is a place where individuals or organizations place their websites. 

When talk about a web hosting, it means a company that provides space on a computer (server) to *host* the 
files of the website, as well as providing Internet connectivity so that other computers can access to these files 
on the website. 

2. Domain Registration 

Before hosting a website, there will be needed a domain name. 

Domain Name 

A domain is the name of the website. A domain name is not something physical that can touch or see; it is merely 
a string of characters that give the website an identity (yes, a name, like human and businesses). 

Now, here are some quick examples: Google.com is a domain name; so are Alexa.com, Linux.org, 
WebRevenue.co, eLearningEuropa.info, as well as Yahoo.co.uk. 

To have own domain names, it will need to register the domain with a domain registrar. 

Where Register a Domain? 

Here is a list of domain registrars where domain name can be registered. 

    

GoDaddy Domain.com NameCheap Network Solutions 

The Difference between Web Hosting and Domain Name 

It is very common for new individual in the field of web designer and developer to get confused between a domain 
names with a web hosting. However, it is very important to be clear on the differences between the two before 
move on to the first website. 

http://www.webhostingsecretrevealed.net/go/godaddy
http://www.webhostingsecretrevealed.net/go/domain
http://www.webhostingsecretrevealed.net/go/namecheap
http://www.webhostingsecretrevealed.net/go/networksolutions_domain
http://www.webhostingsecretrevealed.net/go/godaddy
http://www.webhostingsecretrevealed.net/go/domain
http://www.webhostingsecretrevealed.net/go/namecheap
http://www.webhostingsecretrevealed.net/go/networksolutions_domain
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To simplify: A domain name is like the address of home; web hosting on the other hand, is the space of house 
where place the furniture. 

Instead of street name and area code, set of words or/and numbers are used for the website’s naming’. The 
same goes with hosting, computer hard disk and computer memory are used instead of wood and steel for storing 
and processing data files. The idea is presented clearer with the diagram below. 

 

Conceptual diagram to understand Hosting and domain name 

Registering A Domain Name – How It Works? 

According to the body’s standards, all customers registering a domain name must be prepared to furnish contact 
information for themselves, their organization, their business, and even their employer in some cases. For those 
customers who are seeking to register a country-specific domain name option (like “.pk” or “.gov.pk”), a good 
portion of the registration process will be dedicated to determining whether or not the customer is a resident of 
that country and therefore legally permitted to purchase one of its country-specific top level domains. 

3. Uploading a Website to the Web Server 

When domain name is purchased Service provider, provide ftp user name and 
password to upload webpages on domain.  

1. Procedure to Install FileZilla 

Getting FileZilla 

FileZilla is open source software that can download for free at 
http://filezilla.sourceforge.net/. Select the download link on the left side of the page. 

1-From the list of packages on the download page, select the latest package that ends 
in “setup.exe.” For example, “Download FileZilla_x_x_x_setup.exe.” 

2-Download FileZilla to the Desktop. 

2. FileZilla Installation: 

The License Agreement screen will appear.  

It is powerful and 
free software for 
transferring files 
over the Internet. 
FileZilla is a very 
popular FTP client 
and is used by 
webmasters from all 
over the world.  

FileZilla 
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Click on the I Agree button. 

On the next screen, decide whether every user of the OS can work with the FTP client or it is allowed only for the 
admin account. 

 

Click on the Next button to proceed. 

Select the components to install. 
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Then click on the Next button. 

The next window allows to set the destination folder for the FileZilla installation. 

 

Hit the Next button to continue. 

Choose the Start Menu folder and click on the Install button. 
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The installation is completed. Start FileZilla now check box checked and click on the Finish button. This will start 
FileZilla FTP client. 

Establish FTP Connection 

Open FileZilla installation and enter the following details: 

Hostname - enter domain name or the name of the hosting server where  account resides; 

Username - enter the FTP username  

Password - enter the corresponding FTP password 

Port - enter the FTP port (by default it is 21); 

 

Click on the Quickconnect button to establish the FTP connection. 
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Manage Files Using FileZilla 

If a web site created on a local computer, to make it live by uploading its files on web 
server. The cPanel software is installed on all the SiteGround servers. The root folder 
for the web site content is httpdocs. Select the web site files in the Local site area. Drag 
and drop them in the httpdocs folder under the Remote site area.  

 

To edit a file's code and update the web site functionality, right-click on the chosen file and pick the View/Edit 
option. 

 

The other actions that can perform on the files and folders are: 

Download - this option allows to download files and folders from the remote server to local computer; 

Add files to queue - schedule a later transfer of the files; 

Create Directory - creating new folder under current location; 

Delete - delete files and folders; 

Rename - rename files and folders; 

File Permissions - change the file permissions of files and folders. 

 
  

The cPanel software 
is installed on all the 
SiteGround servers. 
The root folder for 
the web site content 
is httpdocs. 

Remember  
 

File permission, 
Download, add files 
to queue, create, 
delete, rename the 
directory options are 
available in FileZilla 
FTP Client Software.  

Do you know! 

You may use other 
than FileZilla FTP 
client software for 
uploading the 
website. 

Do you know! 
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Learning Unit 7: Discuss Shopping Carts and  
E-Commerce 

Overview 

In this learning unit, you will learn about shopping carts and electronic commerce. After 
completion of this learning unit, you will able to understand about working of e-
commerce, categories of e-commerce, popular e-commerce business in the world and 
shopping cart.    

 

 

1. E-Commerce 

E-commerce (electronic commerce or EC) is the buying and selling of goods and 
services, or the transmitting of funds or data, over an electronic network, primarily the 
Internet. The terms e-commerce and e-business are often used interchangeably. The 
term e-tail is also sometimes used in reference to transactional processes around 
online retail. 

Categories of E-Commerce 

Traditionally commerce has four principal categories. 

 B2B (Business to Business) — this involves companies doing business with 
each other. One example is manufacturers selling to distributors and 
wholesalers selling to retailers. 

 B2C (Business to Consumer) — B2C consists of businesses selling to the 
general public through shopping cart software, without needing any human 
interaction. This is what most people think of when they hear "e-commerce." 
An example of this would be Amazon, Ali Express.  

 C2B (Consumer to Business) — In C2B e-commerce, consumers post a project 
with a set budget online, and companies bid on the project. The consumer 
reviews the bids and selects the company. Elance is an example of this. 

 C2C (Consumer to Consumer) — this takes place within online classified ads, forums or 
marketplaces where individuals can buy and sell their goods. Examples of this include Craigslist, OLX, 
eBay and Etsy. 

2. Some Common Business of Ecommerce 

Amazon.com 

Amazon.com, Inc. Founded July 6, 1994; 20 years ago as an American electronic commerce company with 
headquarters in Seattle, Washington. It is the largest Internet-based retailer in the United States.Amazon.com 
started as an online bookstore, but soon diversified, selling DVDs, Blu-rays, CDs, video downloads/streaming, 
and MP3 downloads/streaming, software, video games, electronics, apparel, furniture, food, toys and jewelry. 
The company also produces consumer electronics—notably, Amazon Kindle e-book readers, Fire tablets, Fire 
TV and Fire Phone — and is a major provider of cloud computing services. Amazon also sells certain low-end 
products like USB cables under its in-house brand AmazonBasics. 

English 
entrepreneur 
Michael Aldrich 
invented online 
shopping in 1979 

Remember  
 

PayPal is one of the 
world's largest 
internet payment 
companies 

Do you know! 

PayPal is an 
American worldwide 
online payments 
system. Online 
money transfers 
serve as electronic 
alternatives to 
traditional paper 
methods like checks 
and money orders. 

PayPal 
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JD.com 

JD.com or Jingdong Mallformerly 360Buy, is a Chinese electronic commerce company headquartered in 
Beijing. It is one of the largest B2C online retailers in China by transaction volume. Its English website, for 
worldwide shipping, launched on October 18, 2012. 

The company was founded by Liu Qiangdong (a.k.a. Richard Liu) in July 1998, and its B2C platform went online 
in 2004. It started as an online magneto-optical store, but soon diversified, selling electronics, mobile phones, 
computers, etc. Jingdong Mall changed the domain name to 360buy.com in June 2007, and to JD.com in 2013. 

eBay 

eBay Inc. is an American multinational corporation and e-commerce company, providing consumer to consumer 
& business to consumer sales services via Internet. It is headquartered in San Jose, California. eBay was founded 
by Pierre Omidyar in 1995, and became a notable success story of the dot-com bubble. Today, it is a multi-billion 
dollar business with operations localized in over thirty countries. 

Alibaba Group 

Alibaba Group Holding Limited (NYSE: BABA) is a Chinese e-commerce company that provides consumer-
to-consumer, business-to-consumer and business-to-business sales services via web portals. It also provides 
electronic payment services, a shopping search engine and data-centric cloud computing services. The group 
began in 1999 when Jack Ma founded the website Alibaba.com, a business-to-business portal to connect 
Chinese manufacturers with overseas buyers. In 2012, two of Alibaba’s portals handled 1.1 trillion yuan 
($170 billion) in sales. The company primarily operates in the People’s Republic of China (PRC), and at closing 
time, on the date of its initial public offering (IPO), 19 September 2014, Alibaba's market value was measured as 
US$231 billion. 

3. Shopping Cart  

A shopping cart is a piece of software that acts as an online store's catalog and ordering process. Typically, a 
shopping cart is the interface between a company's Web site and its deeper infrastructure, allowing consumers 
to select merchandise; review what they have selected; make necessary modifications or additions; and purchase 
the merchandise.  

Shopping carts can be sold as independent pieces of software so companies can integrate them into their own 
unique online solution, or they can be offered as a feature from a service that will create and host a company's 
e-commerce site.  
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Learner’s Activities 

Installation of Browsers:  (Internet Explorer, Google Chrome, Torch, Safari) 

Description:    This activity will be performed by individual. 

 Each student has Experience of working on installation of browsers. 

Time Guideline: 1 hours 

Purpose:  To be able to understand functionality of each browser and will be able 
differentiate between them.  

Presentation:  Instructor will check each individual installation.  

Website Hosting on 000webhost.com 

Description:    This activity will be performed by individual under the supervision of instructor. 

 000webhost is free web hosting server  

Time Guideline: 2 hours 

Purpose:  To be able to understand: 

 Domain registration process 

 Web hosting 

 Pages uploading on web server while using FileZilla 

Outcomes:  

 

Each individual will have its own domain registered on 000webhost  
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Summary of Module 

  World Wide Web is a way to share resources with many people at the same time, even if some of 
those resources are located at opposite ends of the world.  

  Many sites from the last decade are static, but more and more people are realizing the advantages 
of having a dynamic website. Dynamic websites can make the most of the site and either use it as a 
tool or create a professional, interesting experience for the visitors. 

  The first computer virus, called "The Brain", was created in 1986. The Brain is a boot-sector virus, 
which occupies unused space on the disk to eliminate further use of memory space. After it was 
created, The Brain quickly spread worldwide in 1987. The Brain virus was considered first to use 
stealth techniques, making the virus difficult to detect. 

On November 1, 1987 another virus appeared. The Lehigh virus was named after Lehigh University, 
the place where this particular virus was first discovered. 

Computer manufacturers and software engineers began the public war against computer viruses 
around 1990. Corporations began to respond to growing public concern and the number of anti-virus 
products began to rise. The threat of computer viruses was finally taken seriously. McAfee, IBM, 
Digital Dispatch and Iris all introduced their anti-virus products and software in 1990. 

  A domain name is the address, or URL, of the website. Every domain name is unique across the 
entire planet and is assigned to whoever registers them on a first-come first-serve basis. It can register 
domain names followed by many extensions, such as .com, .net, .org, .info. 

  E-Commerce or Electronics Commerce is a methodology of modern business which addresses the 
need of business organizations, vendors and customers to reduce cost and improve the quality of 
goods and services while increasing the speed of delivery. 

  Difference between static and dynamic websites  

  Architectural design of static & dynamic websites. 

  Definition & working of browser  

  Installation of Google chrome, Mozilla Firefox, torch, safari and distinguished features of Google 
chrome, Firefox, torch and internet explorer.  

  Study different types of websites with example like: personal, social, wiki, blog, forum and  
ecommerce websites   

  Study in detail different types of viruses like worms, Trojan, Malware, phishing, cross-site scripting 
(XSS) and denial of service attack. Function of each virus how any specific virus may disturb.   

  Theoretical concept the process of domain registration and web Hosting. 

How to use FileZilla for uploading websites on web server. 

  E-commerce concepts, types of e-commerce. 

Shopping carts concepts  
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is a search engine? 

Answer 
A program that searches the web for keywords that required. Like (www.google.com) or 
(www.altavista.com).  

FAQ 2:  What is a Domain Name? What does it mean to have it registered? 

Answer 

A domain name is the name of the company on the web, like www.amazon.com or 
www.birds.net. It must apply for a domain name with a domain registrar. It's like registering a 
business name. Someone has to keep track of all the names out there and make sure that when 
a user types in the URL that they get to webpage. ICANN is the organization behind this. Wavian 
Web Design can do the domain name registration.  

FAQ 3:  I need my site hosted. What does that mean? 

Answer 

That's like renting virtual space for an office. It need to have the website on a computer 
somewhere so that anyone, 24 hours a day, 7 days a week, can access it. The companies that 
provide these services are often called hosting companies (ISP's (Internet Service Providers) 
often host pages as well).  
Wavian can also act as the middleman and set up hosting and email services  

FAQ 4:  What is a URL? And what does HTTP and HTML stand for? 

Answer 

URL stands for Uniform Resource Locator. It is the address of the site. My URL is 
http://www.wavian.com. 
HTTP stands for Hypertext Transfer Protocol, but there are other transfer protocols too, like FTP 
(file transfer protocol). 
Web pages are written in HTML, or Hypertext Markup Language. It is not a programming 
language, but rather a markup language. It doesn't do anything special like programming 
languages can do, it just specifies how a page should look (like what should be bold and 
whatnot). Though HTML is simple, there are lots of tricky factors to consider when making a web 
page. 

FAQ 5:  What is DNS? 

Answer 
DNS - Domain Name Server - translates Internet addresses from the name to the actual 
numerical addresses used to route messages. The numerical addresses are known as IP 
addresses (see also "what is an IP address" above). 

FAQ 6:  What is the W3 consortium? 

Answer 
The W3 consortium is an industry consortium headed by the Laboratory for Computer Science 
at the Massachusetts Institute of Technology. The W3 consortium seeks to promote standards 
and encourage interoperability between WWW products. URL:http://www.w3.org 

FAQ 7:  What is the difference between domain registration and web hosting? 

Answer 

Here is a comparison of differences between domain registration and web hosting:  
Domain Registration  
Gives the sole ownership and rights to the name of the website. No one else has access to the 
actual name of the domain and it is taken off the market.  
However, owning the domain registration is only half of the process needed to have a website 
or email at the domain – it  also need to connect that domain name to a service that offers the 
server space and bandwidth for the website content and email.  
Web Hosting  
Provides the server, its network connection, its configuration, and its upkeep. It just need to 
upload the website to the server and configure the email via an online account control panel.  
Dream Host offers both, and it can manage everything in one place via the Dream Host Panel.  

http://www.wavian.com/
http://www.w3.org/


Module 2: Elaborate World Wide Web 

88 |                                             Teaching and Learning Material: Information Technology (Web Designing and Development) 

FAQ 8:  How are computer viruses spread? 

Answer Computer viruses are usually spread through email, by sharing files, or on disks. 

FAQ 9:  What is Browser Hijacking? 

Answer 
One thing to watch out for is a virus type known as a browser hijacker, which redirects search 
engine inquiries for its own gain.  On searching for something in Google and the link directs to a 
non-Google search engine, probably have one of these.  

FAQ 10:  Where are the virus risks? 

Answer 

The Internet Downloaded programs or documents may be infected 

Programs 
Programs that carry a virus can infect  machine as soon as  run 
them 

Email 

Email can include infected attachments.  Double-click on an 
infected attachment, it risk infecting the machine.  Some emails 
even includes malicious scripts that run as soon as preview the 
mail or read the body text. 

Documents and 
Spreadsheets 

These can contain macro viruses which can infect and make 
changes to other documents or spreadsheets 

Flash drives, external 
drives (USB, Firewire, etc.) 

Floppy disks can contain a virus in the Boot Sector.  Any 
removable disk could contain infected programs or documents. 

 

FAQ 11:  What is ICANN? 

Answer 

ICANN is the new non-profit corporation that is assuming responsibility from the U.S. 
Government for coordinating certain Internet technical functions, including the management of 
Internet domain name system. More information about ICANN can be found at 
http://www.icann.org. 

FAQ 12:  What is FileZilla? 

Answer 
FileZilla is a free, fast, and reliable FTP client for Windows. Use an FTP client to transfer the 
website from the local computer to the hosting account. This transfer is often referred to as 
“uploading.” 

FAQ 13:  What is function of web forum? 

Answer 

A Web forum is a website or section of a website that allows visitors to communicate with each 
other by posting messages. Most forums allow anonymous visitors to view forum postings, but 
require creating an account in order to post messages in the forum. When posting in a forum, IT 
can create new topics (or "threads") or post replies within existing threads. 

 
  

http://www.icann.org/
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Test Yourself! 
Please mark the correct one from the given options. 

1. A Web site is _____. 
  
a. a collection of related Web pages 
b. the location from which a Web page originates 
c. the source of a Web page 
d. an author of a Web page 

 
 

2. ____ are two of the more widely accessed Internet services. 
 
a. The World Wide Web and e-mail c. Mailing lists and chat rooms 
b. FTP and message boards d. Instant messaging and newsgroups 

 
 

 

3. Visitors to a ____ can customize some or all of the content, such as stock quotes, weather, or ticket 
availability. 
 
a. static Web page c. dynamic Web page 
b. home page d. Web server 

 
 

 

4. To browse the Web, it need a ____. 
 
a. computer that is connected to the Internet and that has a Web browser 
b. wireless modem 
c. domain name 
d. home network 

 
 

5. Search engines ____. 
 
a. are particularly helpful in locating pages about certain topics 
b. require that  it enter search text 
c. allow to use operators to refine a search 
d. all of the above 

 
 

6. A business/marketing Web site ____. 
 
a. contains content that promotes or sells products or services 
b. offers exciting, challenging avenues for formal and informal teaching and learning 
c. contains content that describes a cause, opinion, or idea 
d. is maintained by a private individual or family who normally is not associated with any organization 

 
 

7. An educational Web site ____. 
 

a. contains content that promotes or sells products or services 
b. offers exciting, challenging avenues for formal and informal teaching and learning 
c. contains content that describes a cause, opinion, or idea 
d. is maintained by a private individual or family who normally is not associated with any organization 

 
 

7. A blog Web site ____. 

a. uses a diary or journal format 
b. is an informal site consisting of time-stamped articles 
c. is short for Weblog 
d. all of the above 
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9. ____ occurs when one consumer sells directly to another consumer, such as in an online auction. 
 
a. Consumer-to-business (C2B) e-commerce 
b. Business-to-consumer (B2C) e-commerce 
c. Consumer-to-consumer (C2C) e-commerce 
d. Business-to-business (B2B) e-commerce 

 

10.Amazon is best example of _____________ 
 
a. E-commerce 
b. Entertainment 
c. Blogging 
d. Social networking 
 
11. A____________ is the simple form of website, in which the site’s without the use of server side 
processing. 
 
a. Ecommerce  
b. Dynamic websites 
c. static website 
d. social networking website 
 
12.Static websites are generally designed using________________ 
 
a. Eclipse 
b. Dreamweaver 
c. Visual C++ studio 
d. Netbeans 
 
13. Software which allows user to view the webpage is called as 
 
a. website 
b. Internet Browser 
c. Operating System 
d. Interpreter 
 
14. ISP stands for_______________ 
 
a. Internet Service Provider 
b. Internet server provider 
c. none of these 
d. International service provider 
 
15. __________are used in denial of service attacks, typically against targeted web sites. 
 
a. Worm  
b. Zombie 
c. Virus 
d. Trojan horse 
 
16. Which of the following is independent malicious program that need not any host program? 
 
a. Trap doors 
b. Trojan horse 
c. Virus 
d. Worm 
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17. Which of the following malicious program do not replicate automatically? 
 
a. Trojan Horse 
b. Virus  
c. Worm 
d. Zombie 
 
18. What does the .com domain represents? 
 
a. Educational domain 
b. commercial domain 
c. Network 
d. None of the above 
 
 
 
19. What is the full form of HTTP? 
 
a. Hypertext transfer protocol 
b. Hypertext transfer package 
c. Hyphenation text test program 
d. none of the above 
 
20. The term e-commerce includes____________ 
 
a. Electronic trading of Physical goods and intangibles such as information. 
b. The electronic provision of services such as after sales support or online legal advice 
c. All the steps involved in trade, such as on-line marketing ordering payment and support for delivery. 
d. All of the above. 
 
21. Which of the following is the largest community in classification of e-commerce? 
 
a. Business to Business (B to B) 
b. Business to Consumer (B to C) 
c. Business to Government (B to G) 
d. Government to Government (G to G) 

22._______ is simply the use of electronic means to transfer funds directly from one account to 
another, rather than by cheque or cash. 
 
a. M-Banking 
b. O-Banking 
c. E-Banking 
d. D-Banking 
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Answer Key 
MCQ Number Correct Answer MCQ Number Correct Answer 

1 a 13 b 

2 a 14 a 

3 c 15 b 

4 a 16 d 

5 d 17 a 

6 a 18 b 

7 b 19 a 

8 d 20 d 

9 c 21 a 

10 a 22 c 

11 c   

12 b   
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Module 3: Design a Website 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Understand the basics of website designing 

  Analyze functionalities of different web designing software 

  Apply appropriate website templates in website 
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Learning Unit 1: Basics of Website Designing 

Overview 

In this learning unit, you will learn basic concepts of web designing. These concepts 
will help throughout web designing process. After completion of this learning unit, you 
will be able to elaborate web designing, history of web designing, types of web 
designing, difference between web design & development, difference between web 
design & graphic designing and importance of design in a website. 

 

1. Web Designing 

Web designing is the process of planning, creation and updating of websites. It also includes website structure, 
user interface, navigation ergonomics, website layout, fonts and use of graphical appearance.  

Elements of Web Design 

Web design uses many key visual elements as all types of design such as: 

Layout: This is the way the graphics, ads and text are arranged.  

Color: The choice of colors depends on the purpose and client requirement; it could be simple black-and-white 
to multi-colored design, conveying the personality of a person or the brand of an organization. 

 

 
 

Graphics: Graphics can include logos, photos, clipart or icons, all of which enhance the web design. 

Fonts:  The use of various fonts can enhance a website design. Most web browsers can only read a selected 
number of fonts, known as "web-safe fonts". 

Content: Content is the textual, visual or aural representation that is displayed to the users. It may include: text, 
images, sounds, videos and animations. Content and design can work together to enhance the message of the 
site through visuals and text. 

Website design 
should be user 
friendly and easy to 
navigate to find 
specific information. 

Remember  

TVET RSP does not secure copyright of these pictures
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2. History of Web Designing 

In 1989, whilst working at CERN Tim Berners-Lee proposed to create a global hypertext project, which later 
became known as the World Wide Web. During 1991 to 1993 the World Wide Web was born. Text-only pages 
could be viewed using a simple line-mode browser. In 1993 Marc Andreessen and Eric Bina, created the Mosaic 
browser. 

Tables – The Beginning (1995) 

The birth of browsers that could display images was the first step into web design. The closest option available 
to structure information was the concept of tables already existing in HTML. So putting tables within tables, 
figuring out clever ways to mix static cells with fluid cells was the thing, started by David's Siegel's book Creating 
Killer Sites. 

JavaScript Comes to the Rescue (1995)  

JavaScript was the answer to the limitations of HTML. For instance, need a popup 
window, want to dynamically modify the order of something? The answer was 
JavaScript. However, the main problem here is that JavaScript is layered on top of the 
fabric that makes the web work and has to be loaded separately. 

The Golden Era of Freedom – Flash (1996) 

To break the limitations of existing web design, a technology was born that promised a 
freedom never seen before. The designer could design any shapes, layouts, 
animations, interactions, use any font and all this in one tool – Flash. The end-result is 
packed as one file and then sent to the browser to be displayed. 

CSS (1998) 

Around the same time as Flash, a better approach to structuring design from a technical standpoint was born – 
Cascading Style Sheets (CSS). The basic concept here is to separate content from the presentation.  
 
Mobile Uprising – Grids and Frameworks (2007) 

Browsing the web on mobile phones was a whole challenge in itself. Besides all the 
different layouts for devices, it introduced content-parity problems – should the design 
be the same on the tiny screen or should it be stripped down? 

The first step to improvement was an idea of column grids. After a few iterations, the 
960 grid system won, and the 12-column division became something designers were 
using every day. The next step was standardizing the commonly used elements like 
forms, navigation, buttons, and to pack them in an easy, reusable way. Basically, 

making a library of visual elements that contains all the code in it. The winners here are Bootstrap and Foundation, 
which is also related to the fact that line between a website and an app is fading. The downside is that designs 
often look the same and designers still can’t access them without knowing how the code works.  

Responsive Web Design (2010)  

A brilliant guy named Ethan Marcotte decided to challenge the existing approach by 
proposing to use the same content, but different layouts for the design, and coined the 
term Responsive web design. Technically we still use HTML and CSS, so it is rather a 
conceptual advancement. Yet there are lots of misconceptions here. For a designer, 
responsive means mocking up multiple layouts.  

Bootstrap is the most popular HTML, CSS, and JavaScript framework for developing 
responsive, mobile-first web sites.  

An object-oriented 
computer 
programming 
language commonly 
used to create 
interactive effects 
within web 
browsers. 

JavaScript 

The look and 
formatting are 
defined in CSS, but 
the content in 
HTML. 

Remember  

JavaScript was 
created in 10 days in 
May 1995 by 
Brendan Eich, then 
working at Netscape 

Do you know! 
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The Times of the Flat (2010) 

Designing more layouts takes more time, so luckily we decided to streamline the 
process by ditching fancy shadow effects and getting back to the roots of design by 
prioritizing the content. Flat design is also part of the process. 

The Bright Future (2015) 

The holy grail of web design actually make it visual and bring it into the browser. 
Imagine that designers simply move things around the screen and a clean code comes out! And it doesn’t mean 
changing the order of things, but having full flexibility and control! Imagine that developers don't have to worry 
about browser compatibility and can focus on actual problem solving! 

 

3. Types of Web Designing 

Web design in term of layout can be further sub-divided into 03 categories:  

Fixed Design 

Fixed web pages have a set width that won't alter when the browser is resized, no matter what device the website 
is being viewed on. On smaller devices, such as smartphones or tablets, content is harder to view and can be 
annoying for users due to the need to scroll horizontally to view the rest of the content on a page, or continuously 
''pinch and expand'' to zoom into the page's text. When the browser on a screen is enlarged or reduced, images 
and text may visually fall apart on the screen. 

 

Liquid or Fluid Design 

When resizing the browser, the content on the page spreads itself out to fill the width of the browser when 
expanded, hence the term liquid design, and will look enlarged or as though it has shrunk. The columns containing 
the content on the webpage are built using percentages, rather than fixed columns used in fixed design, therefore 
the columns increase or decrease in size relative to each other.  

 
 

W3school is the best 

place where learner 

can learn bootstrap 

Do you know! 

A mechanism used 
by Google to Rank 
different websites in 
Search Engine 
Results. 

Google Page Rank 

Algorithm 
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Responsive Design  

An approach to web design that provides an optimal viewing experience across a wide range of devices. 

Responsive web design is about creating web sites which automatically adjust themselves to look good on all 
devices, from small phones to large desktops. According to research survey Smartphone Users Worldwide is 
Total 1.75 Billion in 2014. Now it is also a factor for Google Page Rank Algorithm.  

Bootstrap twitter library is used with html to create such design.  

Website Layout in Different Devices: 

 

4. Difference between Web Design and Web Development 

Web Design & Web Development are two different sides of a coin. But they are actually two completely different 
sciences that usually require two different professionals to get the most out of your Website in both perspectives. 

 

Web Design 

Web design is the process of creating the look, feel, and branding of a Website. Working is done on the exterior 
(front end) features of Website. Web design includes the creation of logos, graphics, and other advanced visual 
elements.  

A web designer:-  

 Focuses on appearance of a website 

 Uses HTML, CSS, and JavaScript 

 Is competent in color scheming, graphic design, and information flow 

TVET RSP does not secure copyright of these pictures
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 Creates a great user experience 

 Is right-brained: Strong intuition, creativity, & imagination 

Web Development  

Web development is the programming (data processing) of your Website. This should 
be seen as building the engine of an automobile. Web development often refers to data 
driven Websites but also refers to other automated features such as mail scripts, 
shopping cart, registration system that require a database. 

A web developer:- 

 Add the functionality to Website 

 Creates the inner workings of a website  

 Is competent in programming languages (PHP, .NET, Python, C, Ruby)  

 Develops the user interface  

 Is left-brained: logic, linear thinking, technical  

 Hands-on coding experience is required (either your own products or GitHub) 
 

5. Difference between Web Design and Graphic Designing 

On several occasions it has been found that graphic web designers have the same 
approach and mindset as that of print media designing, even when they are designing 
for web. There are many differences between the two – quite crucial to know for success 
of web designers. Here are some of such important differences which you need to know. 

Fonts: 

When designing for prints you do not have to worry about fonts displaying properly in a 
browser. A reader will see the font which you have specified in the designing process. 
In web designing a number of fonts replacing techniques are used such as @font-face and Cufón which help in 
incorporating nonstandard fonts in designing for user convenience. 

Resolution: 

This implies the image quality and measures in pixels Web images should not be more than 72 ppi since the 
image will load very slow on the screen. Designing for prints does not have such restrictions. 

Monitor Size:  

When designing for print media a specific print size is considered and design will be as per that specific page 
size. This is not the case in web designing since where different monitor sizes and screen resolutions may be 
used. 

Color Differences: 

In print projects CMYK color model is mainly used since printing jobs are mainly done using yellow, black, 
magenta and cyan inks. Websites are always viewed on a screen and hence a RGB color model. 

 
 

Designing for web 
and print are two 
different 
experiences. Just 
because a designer 
is good at one 
doesn't mean they'll 
be good at the other. 

Remember  

The maximum 
number of pixels 
that can be 
displayed on a 
monitor, expressed 
as (number of 
horizontal pixels) x 
(number of vertical 
pixels), i.e., 24x768. 

Resolution 

CMYK stand for 
Cyan, Magenta, 
Yellow and Black 
and RGB stand for 
Red, Green and 
blue 

Remember  
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File Sizes: 

File size is never an issue for prints. The more details you have in your print the better it is – these are normally 
of 10 or 20 MB and sometimes even of 100 MB. However, you cannot have such big files in a website. These 
would take hours of loading time. 
 
Layout Control: 

The controlling ability of layouts on a webpage is quite different from different designing tools like Illustrator and 
Photoshop. These programs shall help to move graphics and texts precisely and just where desired. However, 
tables and HTML do not allow such kind of flexibility. 

Web Graphic Designing Is Continuous Process: 

If designer for a printed piece it gets over once the design is sent to print. The job is over. Web graphic designing 
is different. It is all about continuous improvement, regular tweaking and continuous improvement. 

Measuring Effectiveness: 

It is difficult to measure the effectiveness of any print design, since once it is out, you will never get an idea on 
how people are reacting to it and how people are seeing it. However, a graphic designer for web can be easily 
measured through Google analytics. 

Dimensionality: 

Print design is 2 dimensional and lots of attention is given to layout. Every view is meant for a fixed canvas size 
which is not the case for web graphic designing, where it is all about scrolling the page and is just opposite the 
experience of canvas. 

Experience: 

Print designing allows walking through the information, selecting the information, enhancing and explaining all 
the page elements. Web designing is a great transient experience which is completely based on users’ 
movements. 
 

6. Importance of Design in a Website 

There are so many options out there that allow you to build a quick website. However, it’s important to remember 
that just because you can easily create a website; it doesn't mean that it is a GOOD website. 

Your website is your online Business. More people will potentially see your website than your physical location. 
A well-designed site will add more credibility to your business. Keep in mind that web users are more 
sophisticated now, and they want to be able to trust their business to a professional company. What better way 
of showing them that you are a serious business than having a clean looking and easy to navigate website. 

Some other important design characteristics to keep in mind are: 

 Use typography that is easy to read 

 Always keep in mind that the average person actually only reads about 30% of the text on a page 

 Use headings, bulleted lists, text formatting and good spacing 

 Create and follow a brand identity 

 Have a clear message and call to action 
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Learning Unit 2: Application Software’s for Designing a 
Website 
 

Overview 

In this learning unit, you will learn different web designing software’s. These software 
are used to create and design web pages. After completion of this learning unit, you 
will be able to understand about different designing software, procedure to install 
designing software’s, such as adobe Photoshop, Adobe Dreamweaver and adobe 
flash.   

 

1. List of Different Designing Software 

Number of designing software’s is available, most popular are mentioned below.  

Adobe Photoshop 

A leading paint program from Adobe Systems, Inc. For many years, Photoshop has been the model against 
which other paint programs are compared. Initially, it ran only on Macintosh systems, which was a strong selling 
point for Macs, especially among graphic artists. Today, Photoshop runs on both Macs and Windows PCs.  

Adobe Dreamweaver 

Adobe Dreamweaver is a proprietary web development tool developed by Adobe Systems. Dreamweaver was 
created by Macromedia in 1997, and was maintained by them until Macromedia was acquired by Adobe Systems 
in 2005. 

Adobe Flash  

Flash is vector base software to create animations.  
 

2. Procedure to Install Adobe Dreamweaver 

Above mentioned designing software’s have same procedure of installation, therefore only adobe Dreamweaver 
cs5 installation procedure mentioned below: 

1. Click and run the .exe  

 

Adobe 
Dreamweaver has 
multiple versions. 
Dreamweaver 8, 

CS5, CS6. 

Remember  

Photoshop was 
created in 1988 by 
Thomas and John 
Knoll 

Do you know! 



 Module 3: Design a Website 

102 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

2. Click the Accept button to accept the license and continue installation.  

 

Click Accept 

3. The license key must be entered before the installation can continue.  Click the Next button to proceed.  

 

           Input the serial number and click Next 

4. Skip This Step button to finish the installation and enter your details later.  

 

Registration gives 
you access to 
exclusive benefits 
from Adobe such as 
newsletters, 
publications, and 
invitations to Adobe 
events and 
seminars. 

Remember  

In CS6, Adobe ID 
Skip option is not 
available then do 
this; 

 Disable internet 
connection 

 Then Restart 
Setup 

Remember  

CS6 has 32-bit as 
well as 64-bit 
Versions. 

Do you know! 
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Create an ID or skip the step 

5. Choose a location and Click Install.  

 

 Click Install 

6. Dreamweaver will begin installing on your computer. When the installation is finished, click the Adobe 
Dreamweaver CS5.5 button to open Dreamweaver.  

 

           Click Adobe Dreamweaver 

7. Select which file extensions should be associated with Adobe Dreamweaver CS5.5. If unsure, leave the 
selections unchanged and click the OK button.  
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            Click OK 

8. Adobe Dreamweaver CS5.5 should now successfully open for the first time.  

 

 Dreamweaver is opened 
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3. Designing Software’s Practices 

Adobe Photoshop  

Adobe Photoshop CS5 is a popular image editing software .This section is an introduction to using Adobe 
Photoshop. Here you will learn how to get started, how to use the interface, and how to modify images with basic 
editing skills. 

GETTING STARTED 

Begin by opening Adobe Photoshop CS5. 

If already installed on a PC, 

Click Start > Programs > Adobe > Photoshop CS5, or click on the shortcut on the desktop. 

 

Setting up the Document 

Setting up your document correctly from the start will make your job much easier as 
you work through your project. This will require some advanced planning. For example, 
if your final output will be a brochure, you may need to set up your document to be 
horizontal and double-sided. 

To create a new document, click File > New. This will open the Document Setup dialog 
box (Figure 2). 

 

Here you will be able to name your file, set up the correct page size, and orientation for your document. Options 
include, but are not limited to: 

High resolution 
increases the size of 
the file. The 
standard 
recommended 
resolution for printed 
images is 150-300, 
for Web images it is 
72. 

Remember  



 Module 3: Design a Website 

106 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

Page Size and Orientation 

Change the page size by typing in new values for width and height. Page size represents the final size you want 
after bleeds or trimming other marks outside the page. In the Preset dropdown menu you can find such common 
sizes as letter, legal, tabloid, etc. Typing in exact values for Height and Width gives you more control over the 
size and orientation of your page. 

Resolution 

Resolution is the number of pixels on a printed area of an image. The higher the resolution, the more pixels there 
are on the page, the better the quality of the image. 

 

Color Mode 

Choose a color mode that will best fit your project. For example, when making a graphic for a web site choose 
RGB. When making an image for prints choose CMYK. 

Background Contents 

Choose the background: white, color or transparent. When you have entered all of your document settings click 
Ok. 

Opening an image from a disk 

If the image you have is saved on a disk, 

Select File > Open, and then navigate to the disk drive where your image is saved. Choose the image file and 
click Open. At this point, you may want to save your image under a different name so that you can always have 
the original to fall back on in case of a mistake. To save your file, select File > Save As and type in the new name 
of the file in the dialogue box. 

 

Menu Bar 

If you look at the top of the screen you will see the Menu bar which contains all the main functions of Photoshop, 
such as File, Edit, Image, Layer , Select, Filter , Analysis, 3D,View,Window, and Help. 
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Toolbar 

Most of the major tools are located in the Toolbar for easy access. 

The Image 

The image will appear in its own window once you open a file. 

Image Name 

The name of any image that you open will be at the top of the image window as shown above. 

 

Palettes 

Palettes contain functions that help you monitor and modify images. By default, palettes are stacked together in 
groups. These are the palettes that are usually visible: Color, Adjustments and Layers. If none of the palettes are 
visible, go to Window in the Menu bar and choose the palettes you need. 

Palettes 

Below is the description of the most commonly used palettes in Adobe Photoshop CS5. Palettes used for more 
advanced image editing will be covered in the Adobe Photoshop CS5 Tutorial -Intermediate. 

Color, Swatches, Style 

The Color palette (Figure 4) displays the current foreground and background colors and RGB values for these 
colors. You can use the sliders to change the foreground and background colors in different color modes. You 
can also choose a color from the spectrum of colors displayed in the color ramp at the bottom of the palette. 

 

Figure 4. Color Palette 

In the Swatches palette (Figure 5) you can choose a foreground or background color and add a customized color 
to the library. 
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Figure 5. Swatches Palette 

The Styles palette (Figure 6) allows you to view, select, and apply preset layer styles. By default, a preset style 
replaces the current layer style. You can use the styles in the palette or add your own using the Create New Style 
icon. 

 

Figure 6. Styles Palette 

History 

The History palette (Figure 7) stores and displays each action performed allowing jump to any recent stage of 
the image alteration. The alterations should be created during the current working session; after saving or closing 
the document the History palette clears all the contents. Each time you apply a change to an image, the new 
state of that image is added to the palette. It is important to know that once you click on any of the previous 
stages, all the changes that were made after it will be lost. 

 

Figure 7. History Palette 

Adjustments  

The Adjustment layers palette give you the ability to apply an effect to a group of layers in Photoshop, and then 
you can edit that effect later, while preserving the original layers. 
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Layers 

Layers let you organize your work into distinct levels that can be edited and viewed as individual units. You will 
use the Layers palette (Figure 6) often while creating a document, so it is crucial to understand what it does and 
how to use it. 

 

A) Layer Visibility -The eye shows that the selected layer is visible. Click on or off to see or to hide a layer. 

B) Layer Locking Options -Click the checkered square icon to lock Transparency; click the brush icon to lock the 
Image; click the arrow icon to lock the Position; click the lock icon to lock all options. 

Every Photoshop 
CS5 document 
contains at least one 
layer. Creating 
multiple layers lets 
you easily control 
how your artwork is 
printed, displayed, 
and edited. 

Do you know! 
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C) Layer Blending Mode -Defines how the layer’s pixels blend with underlying pixels in the image. By choosing 
a particular blending mode from the dropdown menu you can create a variety of special effects. 

D) Fill -By typing in a value or dragging the slider you can specify the transparency. Layers Palette color of the 
image or object. 

E) Opacity -By typing in a value or dragging a slider you can specify the transparency of the entire layer. 

F) Layer Lock -The icon shows when the layer is locked and disappears when it is unlocked. Double-click the 
icon to unlock the layer. 

G) Layer Options Menu -Click the black triangle to see the following options: New Layer, Duplicate Layer, 

Delete Layer, Layer Properties, etc. Some of the options are presented as icons at the bottom of the Layers 
palette. 

H) Link Layers – Can be used to link layers together. 

I) Layer Styles -If a layer has a style, an “F” icon shows at the bottom of the Layers palette. Click the little black 
triangle to see style options. 

J) Layer Mask -A grayscale image, with parts painted in black hidden, parts painted in white showing, and parts 
painted in gray shades showing in various levels of transparency. 

K) Layer Set -This option helps to organize images with multiple layers. Click the icon to create a folder for several 
layers. 

L) Create New Fill or Adjustment Layer -Have the same opacity and blending mode options as image layers and 
can be rearranged, deleted, hidden and duplicated in the same manner as image layers. Click the icon and select 
an option to create a new fill or adjustment layer. 

M) Create New Layer -Click this icon to create a new layer. 

N) Delete Layer -To delete a layer, select a layer in the Layers palette and drag it to the trash can icon; or, select 
a layer and click the icon. 

Toolbox 

If you used other Adobe products, such as Illustrator or InDesign, you should be familiar with the toolbox in Adobe 
Photoshop CS5 as it shares some of the tools from these applications. If you are a new user of Adobe products, 
you should keep in mind that you might not need to use all of the tools. In this tutorial, only the basic tools will be 
discussed in depth. 
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Selection Tools 

Move: Used to select and move objects on the page. 

Click the tool button, and then click on any object on the page you wish to move. 

Marquee: Selects an object by drawing a rectangle or an ellipse around it. 

Click the tool button, choose a rectangular or an elliptical marquee. Drag the marquee over the area 
of the image you wish to select. 

Lasso: Selects an object by drawing a freehand border around it. Click the tool button, drag 
to draw a freehand border around the area of the image you wish to select. 

Magic Wand: Selects all objects in a document with the same or similar fill color, stroke weight, 
opacity or blending mode. By specifying the color range or tolerance, you can control what the Magic 
Wand tool selects. 

Crop: Click the tool button, then click and drag the tool over the part of the image that you 
want to keep. Resize the selected area dragging the squares at the sides and corners. Then press 
Return/Enter key when your crop box is sized correctly. 

Eye Dropper:  

Takes color samples from colors on the page and displays them in the Color Boxes. 

Select the tool, click on the color in the image you wish to sample. The Color Box will display this color. 

 

Alteration Tools 

Healing Brush:  

Corrects small blemishes in scanned photos. 

Select the tool, hold down the ALT key and left-click on the base color you need to heal. Then left-
click over the blemish. 

Brush:  

Draws brush strokes of different thicknesses and colors. 

Select the tool. Then click on the selected area, drag to draw lines. Use the Options bar to change the 
brush, mode, opacity and flow. 



 Module 3: Design a Website 

112 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

Clone Stamp:  

Takes a sample of an image and applies over another image, or a part of the same image. 

Select the tool. Hold down the ALT key and left-click on a certain point of the document where you want to start 
your copy point. Then, put your mouse over whatever part of the new document you want the picture to go to. 
Hold down the left mouse button and drag the mouse across the page to copy the picture. 

Art History Brush:  

Paints over an image using the source data from a specified history state or snapshot. 

Select the tool, specify the brush, blending mode, opacity, style, area and tolerance. 

Eraser:  

Removes part of an existing path or stroke. Select the tool, click on the part of the image 
you wish to erase. Drag to erase pixels. 

 

 

Gradient:  

Applies a gradient fill to a selected part of the image or to an entire layer. 

Select an area you wish to apply gradient to, click the tool button, choose a fill in the Options bar, click on the 
starting point, and hold the mouse down and drag to the endpoint. 

Blur:  

Blurs the sharp edges of an image. 

Select an area where you wish to apply the tool. Click the tool button and choose the brush, mode, and strength. 
Drag the brush along the edges. 

Drawing and Selection Tools 

Path Selection:  

Selects paths and path segments. 

Select the tool, click anywhere on the path. 

Type:  

Type’s text on a page. Every time you click the Type Tool on a new portion of the page a new layer will be created. 

You can use the 

Erase tool on paths, 

but not on text. 

Remember  
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Select the tool, click on the page and begin to type. You can specify the font and size in the Options bar. You 
can also resize and transform the text box by dragging the squares at the sides and corners. Use the Move Tool 
to move the text on the page. 

Pen:  

Draws smooth-edged paths. 

Select the tool, click on the page and drag to draw a path. Click and drag the anchor points to modify the path. 

Line shape:  

Draws a straight line. Other shapes that are hidden in this tool are: Rounded Rectangle Tool, Ellipse Tool, 
Polygon Tool, and Custom Shape Tool. 

Select the tool, click and drag on the page to draw a line. 

Assisting Tools 

Hand:  

Allows you to move around within the image. 

Select the tool, click on the spot on the page, hold the mouse button down, and drag to move in the area. 

Magnify:  

Magnifies or reduces the display of any area in your image window. 

Select the tool, choose Zoom In or Zoom Out in the Options bar, and click on the area of the image you wish to 
magnify or reduce. 

Color Boxes and Modes 

Color Boxes:  

The foreground color appears in the upper color selection box and represents a color that is currently active. The 
background color appears in the lower box and represents an inactive color. 

1. To change the foreground color, click the upper color selection box in the Toolbox. 

2. To change the background color, click the lower color selection box in the Toolbox. 

3. To reverse the foreground and background colors, click the Switch Colors icon (the arrow) in the toolbox. 

4. To restore the default foreground and background colors, click the Default Colors icon (the little black and 
white boxes) in the toolbox. 

Cropping allows you 
to make your image 
a standard photo 
size. 

Do you know! 
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Note: If you are using the Gradient Tool, the currently selected foreground and background colors will be the 
default colors of the gradient. 

Basic Image Editing 

Now that you know how to find your way around in the Adobe Photoshop CS5 interface and are familiar with the 
most common commands, pallets, and tools, you can start doing some basic image editing. In the next few 
chapters of this tutorial you will learn how to crop, resize, correct, and sharp/blur your images. 

Crop 

Cropping is one of the most basic editing techniques that can improve your images. Cropping helps to bring out 
the most important features in your image and focus the viewers’ attention on these features. 

There are several ways to crop images in Adobe Photoshop: 

1. Cropping with the Crop Tool 

2. Cropping to a specific size 

3. Cropping with the Marquee Tool 

Cropping with the Crop Tool 

The Crop Tool allows you to make a precise selection of an image you wish to edit. To crop with the Crop 

Tool, follow these steps: 

1. Open the image you wish to crop (see Getting Started for detailed instructions). 

2. Select the Crop Tool from the Toolbox (see Selection Tools for location and description). 

3. Click on your image once and drag the mouse out to make a cropping border (See Figure 11). 

 

Figure 11: Cropping with the Crop Tool 

4. Resize the border by dragging the squares at the sides and corners till you are satisfied with the way our image 
looks. 

5. Once you are completely satisfied with your cropped image, press Enter. 

You can also rotate your cropping border. Move the cursor outside the border; you will see how it turns into a 
double-headed arrow (Figure 12). Drag the arrows in the directions you wish to rotate your selection. 
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         Figure 12: Rotate Cropped Area 

Cropping to a Specific Size 

To crop an image to a specific size, do the following: 

1. Open the image you wish to crop. 
2. Select the Crop Tool from the Toolbox. 
3. In the Options bar, specify the values for Width and Height (Figure 13). 

 

 

       Figure 13. Crop Tool Options Bar 

4. Click in your image and drag the cropping border. Notice that the border is con 
strained -you cannot make it wider or longer than the specified values (Figure 14). 
For example, if you entered 8 for Width and 10 for Height, whatever size you make 
the border, the area within it will fit on an 8x10 photo. 

 

Figure 14: Crop to Specific Size 

5. Once you are completely satisfied with your cropped image, press Enter. 

If you wish to print 
your digital photos 
or other images on 
standard size photo 
paper, you will have 
to crop your images 
to a specific size, 
such as 8x10. 

Remember  

Use of Shift & Alt 
keys in combination 
allows resizing 
proportionally. 

Remember  
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Cropping with the Marquee Tool 

If you are in a hurry and need just a simple crop, you can use the Marquee Tool and a menu command. To crop 

with the Marquee Tool, follow the steps below: 

1. Open the image you wish to crop. 
2. Select the Rectangular Marquee Tool from the Toolbox (see Selection Tools). 
3. Click and drag the mouse to draw a marquee around the area you wish to crop (Figure 15). 

 

Figure 15. Drawing a Marquee 

4. In the main menu, go to Image > Crop (Figure 16). The image will be immediately cropped 
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Resizing 

Resizing in Photoshop can help you print your images in standard photo sizes, resize and preserve the high 
quality of digital photos, and enlarge small images to a poster size. 

Resizing to a specific size 

To resize your image to a preset size, follow the steps below: 

1. In the main menu, go to File > New. 
2. In the New dialog box, click on the Preset dropdown menu. You will see several preset sizes, such as 

2x3, 4x6 and 5x7 with the preset resolution of 300 ppi (Figure 17). 

 

Figure 17: Adjust Resolution 

3. Choose the size that you wish and click OK. 

Note: All the preset sizes are in portrait orientation. If you wish to resize an image with the landscape orientation, 
You need to create 

Your own preset. 

To create your own size, do the following: 

1. Type in the values for Width and Height, for example 7x5. 

2. Type in your desired resolution (150 ppi for high quality prints, and   72 ppi is good for web images). 

3. Click the Save Preset button 

 

Resizing Digital Photos 

Digital photos usually have large dimensions but low resolution, 72 ppi, which effects their quality when their 

Size is decreased or increased. When printed, the photos with the changed size will look pixilated. To resize the 

digital photos without losing the quality, follow these steps: 

1. Open the digital photo you wish to resize. 

2. In the main menu, go to View > Rulers. You will see the dimension of your photo (Figure 18). 
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Figure 18: Ruler 

3. In the main menu, go to Image > Image Size. 

4. In the Image Size dialog box, check the Resample Image box off (Figure 19). Type in your desired Resolution 
(anything between 150 and 300 ppi). The photo is now 3.208 x 3.083 inches. 

 

Figure 19: Changing Resolution 

Enlarging 

If you want to make your digital photo into a poster size image, you can do it in the Image Size dialog box. 

However, just increasing the dimensions will make the image appear blurry and pixilated.  To enlarge the image 
without losing the quality, follow these steps: 

1. Open the digital image you wish to enlarge. 

2. In the main menu, go to Image > Image Size. 

3. In the Image Size dialog box, make sure the Resample Image box is checked off and choose Bicubic 

Smoother from the dropdown box (Figure 20). 
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Figure 20. Increasing the Size by 10 Percent 

4. Change the Document Size measurements to Percent. Type in 110; this will increase the size of the image by 
10 percent (Figure 20). 

5. Continue enlarging by 10 percent till you are satisfied with the size. 

Correcting 

Digital cameras tend to cause various problems, such as “red eye” or “hot spots”, if you use flash, or 
underexposure, if you don’t. 

In Photoshop, you can correct these problems, as well as adjust the overall color of your digital photo. 

Red Eye Removal 

The digital camera flash is located right above the lens, which causes the “red-eye”; however, you can fix your 

Photos easily in Photoshop. To remove the “red eye”, follow the steps below: 

1. Open a photo you wish to correct. 

2. Select the Zoom Tool from the Toolbox. Click and drag a rectangle around the eye (Figure 21). 

 

Figure 21. Red Eye Removal 
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3.  Make sure your default Foreground and Background colors are black and white. 

 

4. Click and hold on the little black triangle of the Healing Brush Tool button and select the Red Eye Tool. (Figure 
22). 

 

5. Click on the red part of the eye and paint, holding down the mouse button. You will see how the red will 
disappear (Figure 23). 

 

Hot Spot Removal 

Using a flash can also cause another problem -shiny areas on people’s faces or the flash reflection in the shiny 
surfaces. To correct this problem, follow the steps below: 

1. Open the photo you wish to correct. 

2. Select the Clone Stamp Tool from the Toolbox. 

3. In the Options bar, change the Blend Mode from Normal to Darken (Figure 24). 

 

4. Set the Opacity to 50 percent. 
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5. Choose a soft-edged brush, set the diameter to 40 or 50. 

6. Hold down the Shift key and click in the clean area (without “hot spots”) to get a sample of color (Figure 25).  

7. Paint over the “hot spot”, the light area will gradually darken (Figure 26). 

Adding Flash 

To fix underexposed photos, follow these steps: 

1. Open a digital photo you wish to correct (Figure 27). 

 

2. In the main menu, go to Layers > Duplicate. In the next window, name the layer 1. 

3. Make sure Layer 1 is selected in the Layers palette. In the Blending Mode drop down box, change the 

Blending Mode to Screen (Figure 28). The whole image will lighten. 

 

Color adjustment 
options in 
Photoshop CS5 can 
help you to make 
your digital photos 
look more natural. 

Remember 

Blend Modes are 
widely used in 
Photoshop. 

Remember 
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Color Adjustment 

To color correct your images, follow these steps: 

1. Open the image you wish to correct. 

2. In the main menu, go to Image > Adjustments > Levels. You will see a dialog box displaying a diagram of 
the colors in your image (Figure 30). The black triangle is for shadows, the gray is for mid tones, the white is for 
highlights. In the Channels dropdown menu, you can choose between RGB, Red, Green, or Blue. These indicate 
whether your changes affect all the colors, or just one (red, green, or blue). 

 

Make sure the Preview box is checked off. Choose the channel you wish to change and drag the triangles. 

Dragging the black triangle to the right will make the shadows in your photo darker; dragging the white triangle 
to the left will make the highlights in your photo lighter; dragging the gray triangle to the left will make the mid 
tones in your photo lighter, dragging it to the right will make the mid tones darker.  You will be able to see the 
changes in your image. 

 

 

Corrected Image 
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Remember to save your work often. Saving frequently lessens the risk of losing the work you have been doing. 

To save your Photoshop document, do the following: 

1. Click File > Save. 

2. Navigate to the place you would like your document to be saved by using the drop down menu and the 
navigation window. 

3. Enter the name of your document in the Save As text field. 

4. Choose a format to save your project in from the Format dropdown menu. (Figure 33) 

 

Figure 23. Save as Dialogue Box 

5. Click the Save button in the bottom right corner of the dialogue box. 

6. Check to make sure that your document is saved in the place you intended. 

Procedure to Use Slicing Images for the Web 

When you define a rectangular area in an image as a slice, Photoshop creates an HTML table to contain and 
align the slice. Once you create slices, you can turn them into buttons, and then program those buttons to make 
the web page work. 

Any new slice you create within an image (a user slice) automatically creates other slices (auto slices) that cover 
the entire area of the image outside the user slice. 

Figure 1 shows the Slice tools, which are located in the Crop tool group. Drag the Slice tool over the image, and 
it will create a rectangular area indicating that a slice has been made. As you slice the image, you'll notice that 
other slices are created automatically (see Figure 2). 

“Save as” is used to 
save changes in 
existing file with 
other name, format 
or location. 

Do you know? 
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Figure 1 Press and Hold Down the Tool in the Toolbar to Display the other Tools in that Tool Group. 

 

Figure 2 The Sample Website with One Slice Drawn on the Header. 

Images in HTML files from Photoshop need to be placed into a table. HTML tables 
were originally designed to show tabular data, but before long had become the 
standard way to align and position graphics on websites. Photoshop's ability to create 
automatic rows and columns with data makes it easier for designers to export graphics 
to the Web, eliminating guesswork. Just slice the graphics you need, and Photoshop 
will take care of the rest. 

The slices that you create will automatically generate their own custom names based 
on presets. However, these slices won't add HTML functionality, such as <a></a> tags, 
unless you specify that information first. 

The Slice Select tool (also located under the Crop tool) will let you highlight the 
individual slices of an image. To change the settings for the Slice Select tool, right-click the image and select 
Edit Slice Options (see Figure 3). 

The Slice Options dialog allows you to specify how you want to name the individual slices, as well as a web 
address to which you want to link the sliced image (see Figure 4). 

Photoshop default 
format is PSD, 
larger file size. 
JPEG is flattened 
image with smaller 
size. 

Remember 

If you plan to use 
the option to export 
from Photoshop as 
HTML only, adding 
your URL in slice 
options dialog is a 
good idea, as it 
eliminates the need 
to do this later. 

Do you know! 

Photoshop can 
export information in 
a layout based on 
CSS. However, it's 
much easier to cut 
the graphics with a 
table-based 
mindset, and then 
create a CSS layout 
for the images later. 

Do you know! 
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Figure 3 Right-Clicking the Slice Brings up the Slice Options Menu. 

 

Figure 4 Slice Options Dialog. 

By using the slice options to provide specific names, you'll make it a lot easier to find the graphic files that you 
need when you set up the image later, using HTML in a text editor or using Dreamweaver CS5. 

The most common problem you'll encounter when using the Slice tool is Photoshop's tendency to create too 
many slices. This is usually a result of the user making slices that don't conform to a tabled layout. In Figure 5, 
I've drawn a slice, but I didn't have the slice matching the border (as all of the other button slices on the left did), 
so Photoshop tried to help me by creating a lot of unnecessary slices. 

 

Figure 5 Our Sample Website with Slices for a Header and Menu. 

To fix a problem like this, use the Slice Select tool and click the slice. Once the slice is selected, drag the resize 
handles to align the errant slice with the other slices that you've made. You'll know that the slice is positioned 
correctly when the automatic slices disappear (see Figure 6). 

When slicing your 
website design 
remember that each 
slice will become a 
separate cell of a 
table and image so 
try to keep the slices 
as few and as 
simple as possible. 

Remember 
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Figure 6 Snap One Slice to another by Dragging the Selected Slice to Align it with the other Slice. 

At the End: Mostly used Photoshop Shortcuts 

 

Adobe Dreamweaver CS5  

Before building the pages using Dreamweaver it is a common practice to 
design the layout of the pages in an image editing software like Fireworks or 
Photoshop. You will also create and optimize any required images to be 
used in the website in Fireworks. 

Main steps to creating a website in Dreamweaver are: 

Step 1: GUI introduction 

Step 2: Define a site 

Step 3: Dreamweaver CS5 Template 

Step 4-Dreamweaver Website Layout 

Step 5:CSS Layout – Dreamweaver CS5 

In earlier versions of 
Photoshop saving a 
sliced image for the 
web could only be 
done with Image 
Ready but now it's 
all built into Adobe 
Photoshop CS3. 

Do you know! 
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Step 6: Dreamweaver DIV/ CSS Layout 

Step 7: Understand Dreamweaver Menu 

Step 8: Editing Styles in Dreamweaver 

Step 9: Editable Regions in Dreamweaver Template 

Step 10: Linking to webpages in Dreamweaver 

Step 11: Heading Styles | Dreamweaver 

Step 12: Contact Forms | Dreamweaver 

Step 13: Form Styles | Dreamweaver 

Step 14: Test Website | Dreamweaver 

Step 15: FTP/ Upload Files to Hosting Server | Dreamweaver 

Step 1: GUI Introduction 

The GUI of Dreamweaver CS 5 has the following parts:  

Parts of the Dreamweaver Window 

The Dreamweaver window contains the following main elements: 

 

Document Toolbar 

The document toolbar changes how we view the web page file. The main commands that we will use are: 

Follow the 
instructions of 
Dreamweaver CS5 
installation and 
usage to build a 
website in Module 6. 

Remember 
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Properties Inspector 

The properties inspector lets us view and change the properties of a selected object in the document window. 
Each type of object has a different set of properties. 

 

Panel Groups 

The panel groups provide information as well as methods to make changes to the web files and website. 

To open or close a panel group, click the name of a panel. If you need a panel that is not currently displayed, go 
to the Window menu and select the panel. 
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Workspaces 

Workspaces are different layouts for the Dreamweaver window. You can select a workspace from the Workspace 
selector button, or you can save a new workspace. 

 

Step 2- Define a Site 

The first step is to define the site within Dreamweaver. 

In the opening screen click ‘Dreamweaver Site’ 

In the Site Setup window give the site a name and specify the folder on your computer where all the files will be 
stored (by clicking the folder icon next to the Local Site Folder field). 

Click the ‘Save’ button when done. 

You will notice that the ‘Files’ panel will reflect the above details. 

 
From the ‘Files’ panel you will be able to easily access all the files of your website. Images must be saved in 
“Images” folder. 

Step 3- Dreamweaver CS5 Template 

Once we have defined our site it is time to create a Dreamweaver CS5 template. This template will form the basis 
for all our website pages and will contain our main layout and design elements. Once this template is created the 
website pages can be created from it, the page specific content can be added in. 

To create a Dreamweaver CS5 template, click ‘File’ on the main menu, then click ‘New…’ 
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In the ‘New Document’ window that opens: 

Select “Blanks Template” > “HTML Template” > Select “None” from layout 

Click “Create Button”.  

 

You will get the following screen: 

 

This is a split screen view of your template file. The left shows the HTML code and the right shows how the page 
will look. 

Click the ‘Design’ button at the top, to get into the Design View. 

 

If you need to see the HTML code at any point you can click on the ‘Code’ or ‘Split’ button. 

Dreamweaver has 

various prebuilt 

templates. 

Remember 

http://bestwebdesignz.com/tips/wp-content/uploads/2010/09/design-buttun.gif
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Save the file [File> Save]. 

You will get a message that the template does not have any editable regions. This is ok. Give it a name. I have 
given it the name ‘template’. 

 

If you look in your Files panel you will see that your template has been saved as template.dwt within a new 
folder entitled ‘Templates’ 

 

Step 4- Dreamweaver Website Layout 

Now let’s get ready to create the Dreamweaver website layout. 

A website layout usually consists of a header area, menu bar, content area and a footer area. 

 The header area consists of the logo and masthead. 

 The menu bar consists of the main menu items with links to the various pages.  This allows the visitor to 
navigate through the site. 

 The content area is where the main content of the page will appear. 

 The footer area will have the copyright information and may repeat the links that appear in the main 
menu area. 

Dreamweaver 
allows you to create 
the webpage without 
actually writing 
HTML code as 
Dreamweaver writes 
the HTML code for 
you. 

Do you know! 
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We will now recreate this layout in Dreamweaver. 

Step 5: CSS Layout – Dreamweaver CS5 

Before we actually get into designing the layout, it is helpful to understand what’s involved in designing a CSS 
layout using Dreamweaver CS5. 

A webpage is created using HTML code. HTML is made up of various ‘tags’. It was not too long ago when web 
pages were designed using tables [Insert > Table], however this is no longer a good practice. Now it is best to 
design CSS based webpage layouts. 

There are 2 parts to a CSS based website layout: 

1. DIV (short for division) tags divides the content into individual sections. 

2. CSS (short for Cascading Style Sheet) styles the div tags. 

DIVs can be of 2 types: 

 Class 

 ID 

The difference between ‘Class’ and ‘ID’ is that a class can be used multiple times in a page while an ID can only 
be used once. 

 The style for a class will begin with a dot ‘.’ 

 The style for an ID will begin with a hash ‘#’ 

Keeping in mind the website layout that we have planned we will need to create at least 4 DIVs create a CSS 
and specify the properties for each of the div tags by defining styles of the same names i.e. header, menu, content 
and footer. 

The style sheet can reside within the HTML page or external to the HTML page but linked to it. It is advisable to 
create an external style sheet so that changes can be made to this one file which will reflect on all the linked 
pages. 
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Dreamweaver CS5 Website Header 

Now let’s create our website header.  This is the top portion of the website with the logo and masthead. 

As per our layout it looks like this: 

 

We will need to create a div called ‘header’ and a style also by the same name ‘header’. 

 Select ‘Insert’ > Select ‘Layout Objects’ > Select ‘Div Tag’ 

 

Since we are going to have only one header on the page, we can make this an ID. 

 In the Insert Div Tag Window enter ‘header’ next to ID. 

 

 Now click on the ‘New CSS Rule’ button. 

In the New CSS Rule window: 

 You will see ‘#header’ is automatically entered by Dreamweaver. 

 Select ‘New Style Sheet File’ from the bottom drop down menu. 

 Click the OK button 

http://bestwebdesignz.com/tips/wp-content/uploads/2010/09/header.gif
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 Give the file name ‘style’ for the stylesheet. 

 Click the ‘Save’ button.  

      

You have now created a stylesheet file names style.CSS and saved it in your site’s folder. 

In the ‘Style Rule Definition for #header in style.CSS’ window we can now specify the style properties of the 
header div tag. We can specify the background color, dimensions and borders. We can also specify the path to 
the logo image as well as its position in this style. 

 Enter the following details for Background, Box and Border: 

Linking “style.css” to 
html file is called 
“External Style 
Sheet” 

Do you know! 
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 Click the ‘OK’ button. 

CSS is used for 

setting appearance 

of Website. 

Remember 
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The header div and style has been created and looks like this: 

 

 Delete the text ‘Content for id “header” Goes Here’. 

If you look at the CSS Styles panel, you will see the header style. 

 

To edit the header style: 

 Right click the ‘header’ style 

 Click ‘Edit…’ 

 This will open the “CSS Rule Definition” window where you can edit the style. 

 

 Save the template. 

Step 6: Dreamweaver DIV/ CSS Layout 

Now it is time to complete the Dreamweaver DIV/ CSS Layout. 
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Using the same principles that we used to create the header area with its associated div tag and CSS style, let 
us now create the menu area, the content area and the footer area. 

 Click the ‘Code’ or ‘Split’ buttons to see the HTML code create thus far. 

 

 Click after the header div tag ends (so that the next div tag is inserted after the header div). 

Create a menu div tag and style (the same way you created the header div and style. 

 Insert > Layout objects >Div tag 

 Enter ‘menu’ against ID 

 Click the  ‘New CSS Rule’ button 

 Make sure that the style rule will be defined in ”style.CSS’ 

 Click the OK button 

 Enter the following properties: 
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 Click the ‘OK’ button to save the CSS Rule definition for #menu in style.CSS 

 Click the ‘OK’ button to save the ‘menu’ Div tag 

 The web page and code will look like this. The menu div is created and styled. The text “Content for id 
“menu” Goes Here” is automatically inserted by Dreamweaver (though you may not be able to see it 
because of the black background of the menu area). Select and delete this text. 

 

Click after the menu close tag in the Code view 

 

Now let us create the content area: 

 Insert > Layout objects > Div tag 

 Enter ‘content’ against ID 

 Click the  ‘New CSS Rule’ button 
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 Make sure that the style rule will be defined in ”style.CSS’ 

 Click the OK button 

 Enter the following properties: 

 

 Click the OK button to store the style and then click the OK button to store the div tag. 

 Save the template and the associated CSS [File > Save all Related Files]. 

 

Finally let us create the footer area: 

 Insert > Layout objects > Div tag 

 Enter ‘footer’ against ID 
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 Click the  ‘New CSS Rule’ button 

 Make sure that the style rule will be defined in ”style.CSS’ 

 Click the OK button 

 Enter the following properties:  

o Background > Background color: #000 

o Box > Width: 100% , Height: 30 px 

 Click OK and OK 

 Select and delete the text “Content for id “footer” Goes Here” 

 Save all related files 

Now the basic layout of the webpage is ready. 

 

Step 7: Understand Dreamweaver Menu 

Now that our web layout is ready in Dreamweaver, let us work on the menu. Since the menu will appear in all the 
pages of the site it is advisable to put this into the template as well. 

Our main menu items are going to be images since the text is written in a font that may not be available on all 
the visitor’s computers. These have already been created in Fireworks and are available in your images folder. 

We will simply insert these images into the menu area now. We will link them to the associated pages after we 
create the respective pages. 

To insert the menu images: 

 Click in the menu area 

 Insert > Image > Browse to the images folder and click home.jpg 

 Click the OK button 

 You will see the Home image appears in the menu area of your layout. 

 Click after the home image 

 Repeat the above procedure for the images about-us.jpg, services.jpg and contact-us.jpg. 

 The menu layout now looks like this: 
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In case you want to use drop down menus you can use the Dreamweaver feature – 
Spry Menu Bar [Insert > Layout Objects > Spry Menu Bar> then follow the instructions] 

 

Step 8: Editing Styles in Dreamweaver 

Let us now create the footer menu and copyright information. 

The footer menu will be made of text so we simply need to type in the menu items: ‘Home’, ‘About Us’, ‘Services’ 
and ‘Contact Us’. 

The text is not visible because of the black background. Let us edit the #footer stylesheet and specify the yellow 
text color. 

 Select the footer style in the CSS styles panel 

 

 Right click on the #menu style and then select ‘Edit…’ 

Spray Menu bar is 
built in functionality 
of Adobe 
Dreamweaver CS 
versions that 
automatically adds 
drop down menu list 
in web applications. 

Spray Menu 
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 Specify the following style details: 

 

 To center the text 

 

 Click the OK button 

 The footer now looks like this: 

 

To add more than one space between the menu items you will need to add a non-breaking space [Insert > HTML 
> Special Characters > Non-Breaking Space] 
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 Insert 2 – 3 non breaking spaces between the menu items 

 The footer menu now looks like this: 

 

Now let’s add the copyright information below the footer menu: 

 Press the Shift and Enter keys to get on the next line 

 Insert the copyright symbol [Insert > HTML > Special Characters > 
Copyright] 

 
 

Website Menu can 

be on left or right 

side of layout 

instead of top. 

Remember 
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 Type in the text ’2010 Company Name’ 

 The footer now looks like this:  

 

Our webpage now looks like this in Dreamweaver: 

 

Step 9: Editable Regions in Dreamweaver Template 

Now that our template layout is more or less complete it is time to define the editable regions within the 
Dreamweaver template. 

The editable regions can be different in different web pages. Since the content of different pages will differ, we 
will create an editable region within the content area. 

To create editable regions in a Dreamweaver Template: 

Select and delete all the text in the content area i.e. delete ‘Content for id “content” Goes Here’ 

Insert > Template Objects > Editable Region 
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In the ‘New Editable Region’ window enter the name of the editable region ‘content. 

 

 

Click the OK button 

The Editable Region in the Template will look like this: 

 

Save All Related Files 

Our Dreamweaver template is now ready 

 



 Module 3: Design a Website 

146 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

Webpages in Dreamweaver 

Now that our template is ready let us make the 4 webpages of our site – home, about us, services and contact 
us. 

The homepage file is usually named ‘index’. This is recognized by your hosting server as the home page and is 
shown when someone types in your domain name into the browser. HTML pages end with the file extension .htm 
or .html and it is a good practice not to have spaces in the file names, so we will create the following files: 

 index.html 

 about-us.html 

 services.html 

 contact-us.html 

 To create a webpage in Dreamweaver select ‘File’ from the Dreamweaver Menu, then select ‘New’. 

 From the New Document Window, select ‘Page from Template’, then our website’s name under ‘Site’ 
and finally the template name under Template 

 

 Click the ‘Create’ button. 

 Dreamweaver will create an HTML page using the template. 

 Save [File > Save] the file as index.html 

 We have created our first html page. Repeat the process to create the other 3 pages. 

 The ‘Files’ panel will look like this: 
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Step 10: Linking to Webpages in Dreamweaver 

 Now that all our pages have been created we can link them from the main menu and the footer menu. 

 Since our menus are in the template, let’s open the template file and create the links to the webpages in 
Dreamweaver. 

 If your template file is not already open, double click on template.dwt in the Files panel. 

 

 Click on the  ‘Home’ image in the menu area to select it: 

 

 In the Properties panel link to index.html, by clicking on the folder icon next to the Link field and then 
selecting index.html. 

 Type 0 (zero) in the Border field otherwise there will be a blue border around the menu image. 

 

 Similarly select the other 3 menu images and link them to the respective files. 

 The main menu navigation is now ready. 
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 Save the template and all the website files created from the template [File > Save All] 

 In the Update Template Files window click the Update button. This will update all the site pages that were 
created from this template so you don’t need to go into each page and make the changes again and 
again. This is the main advantage of using a Dreamweaver template as a base for all your website files. 

 

Styles for Text Links in Dreamweaver 

Now let us link the footer menu items. Once we link them we will also need to define a style for the linked text 
otherwise they the links will turn blue. 

To link the footer menu items: 

 First select ‘Home’ in the footer area 

 Click the folder icon next to the link field in the Properties panel, and select index.html. 

 

 You will notice that the Home link and turns blue 

We need to create a style for the linked text in the footer div. To do this: 

 Click on the ‘New Style Rule’ icon at the bottom of the CSS Styles panel. 
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 In the New CSS Rule Window select ‘Compound’ under ‘Selector Type’ 

 Enter “#footer a” under Selector Name 

 

 Click the OK button 

 Enter the following style details: 
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 You will notice that the Home link looks as it did before it was linked. Link the remaining 3 menu items to 
the respective html pages. 

 

 The footer menu is ready. Save the template and update all pages. 

 

Web Page Content 

Now that we have created the pages of our site and linked them together, let us enter the web page content. 

 In the Files panel, double click index.html to open it. 

 Select and delete the word ‘content’ 

 

 Type in your website’s home page text. 

 See how your web page will look by previewing it in a browser [File > Preview in Browser > select the 
browser of your choice 

Now lets us insert an image and align it right. To do this: 

1. Click before the start of the text 

2. Insert > Image > browse to the ‘image’ folder > select photo.jpg. The image will be inserted into the 
web page. 
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3. Now we need to align it right. Click on the image. 

4. In the Properties panel, select ‘right’ from the drop down menu next to ‘Align’. 

 

5. The image will be aligned right. 

Text Styles in Dreamweaver 

1. We have added the text to out pages but the default font doesn’t really look good.  Let us specify the text 
styles in Dreamweaver. 

2. All the visible content in the web pages will be between the <body> tag in HTML. We can specify the 
properties of this body tag in our style sheet so that all the text in our web pages display in the Verdana/ 
Helvetica font and are a size 12px. 

3. To do this: 
4. Click on the ‘New CSS Rule’ icon at the bottom of the CSS Styles Panel 
5. In the ‘New CSS Rule’ window, under ‘Selector Type’, select ‘Tag’ 
6. Under ‘Selector Name’, select or type ‘body’ 
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7. Click OK 
8. In the ‘CSS Rule Definition’ window for ‘Font Family’ select ‘Verdana, Geneva, sans-serif’ 
9. For Font-size, type ’12′ and select ‘px’ 

 

10. Click OK 
11. The style of the text in the web page will change. It looks better now! 

 

There are total 6 
headings in HTML 
h1, h2, h3, h4, h5, 
h6. 

Remember 
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Step 11: Heading Styles | Dreamweaver 

Now that we have specified the text font style it is time to define the heading styles in Dreamweaver. 

HTML has various heading tags. Let us define the style of some of these specifically: 

 H1 (Heading 1) 

 H2 (Heading 2) 

To define the style for the Heading 1 tag: 

 Click the ‘New Style Rule’ icon at the bottom of the CSS styles panel. 

 Selector Type: Tag 

 Selector Name: H1 

 

 Click OK 

 In the ‘CSS Rule Definition’ window, specify the font size 18 px 

 Set the color #FFBB2D 
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 Click OK 

 Now select the heading text in your web page and apply the H1 tag by selecting Heading 1 from the 
Format drop down in the Properties panel. 

 

 You will see that the style is applied to the heading text 

 

 If you plan to have sub-headings in your webpages you can define the styles for the H2 tag and apply 
the Heading 2 format to them. Usually the font size would be smaller than the H1 tag font size. 
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Step 12: Contact Forms | Dreamweaver 

Most websites would need a contact form. Let us now create a contact form in Dreamweaver. 

 Open the contact-us.html page. 

 Click in the area that you want the form to appear 

 Insert > Form > Form 

 

 A red dashed box will be visible in your page 
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 All the form elements need to be placed within this red box 

 Insert > Form > Text field 

 Label: Name 

 Style: Attach label tag using ‘for’ attribute 

 Position: Before form item 

 

 Click OK 

 The Name text field will appear in the web page 

 

 Select the field by clicking on it 

 

http://bestwebdesignz.com/tips/wp-content/uploads/2010/09/select-field.gif
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 Type ‘name’ in the Properties panel under ‘Text Field’ 

 

 In the web page press the Enter button to go to the next line and insert another text filed labeled Email 

 Insert a Text area [Insert> Form > Textarea] labeled Comments 

 Insert a button with no label [Insert > From > Button] 

 The form will now look like this: 

 

Step 13: Form Styles | Dreamweaver 

We can make the form look more presentable by defining form styles in Dreamweaver. 

We can give a style to the <label> tag. To do this: 

 Create a style for the label tag 

 Click ‘Box’ and enter: 

 Width : 150 px 

 Float: Left 

 Click OK 
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 The form looks better now: 

 

Let’s push the submit button to align with the form fields. To do this: 

 Create a new CSS style 

 Select Class and name it ‘.btn’ 
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 Box > Left: 150 px 

 

 Select the button on the web page and select ‘btn’ from the drop down next to Class in the Properties 
panel. 

 

 The button moves to the right and aligns nicely with the other fields: 
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To program the form to be sent to specific email addresses when filled, you will need to install a php or asp form 
script and point the form to it in the action field of the Properties panel. 

 

The php / asp script is out of the scope of this tutorial. However there are free service providers that take care of 
the programming for you as well. 

Some of these free form service providers are: 

 Bravenet Email Forms 

(URL: http://www.bravenet.com/webtools/emailfwd/) 

 Response-o-Matic Forms  

(URL: http://www.response-o-matic.com/ ) 

 EmailMeForm 

(URL: http://www.emailmeform.com/ ) 

Step 14: Test Website | Dreamweaver 

Now that all our web pages are ready it time to test the website in Dreamweaver. 

The best way to test the website is to actually see how it looks in the browser. It is a good practice to check the 
site in multiple browsers as some things which might work well in some browsers might not work so well in other 
browsers. 

To test in a browser: 

 File > Preview in browser > Firefox / IExplorer 

Some things to test for: 

 Click on the main menu items and see if it links correctly to the appropriate pages 

http://www.bravenet.com/webtools/emailfwd/
http://www.response-o-matic.com/
http://www.emailmeform.com/
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 Click on the footer menu items to check if each link links to the appropriate pages. 

 Check if the headings are formatted correctly on each page 

 Check if the text fonts are looking right on all the pages 

 Check if the form fields are aligned correctly 

 If you want you can do a spell check [Commands > Check spelling] 

 Web page titles – these will appear in the top bar of the browser and by default will be ‘Untitled Document’. 
These can be changed by entering the page titles for each page in Dreamweaver in the ‘Title’ field. 

 

 Another thing you will notice is that the text is sticking to the left side of the browser. This does not look 
professional. To add some space on the left and right side of the content area you can edit the content 
style with the following details:  

o Reduce the width to 90% 

o Uncheck ‘Same for all’ below Padding 

o Enter 5% for left and right padding 

 

Save all the files including the style.CSS file [File > Save All] 

Test the site again by previewing all the pages in the browser. If everything is OK, it is time to upload the files 
and make your site live. 

File uploading 
software’s can also 
be used for 
uploading to servers 
e.g. FileZilla, 
CuteFTP. 

Remember 

Famous hosting 
websites are 
Godaddy.com, 
Hostgtor.com, 
dynadot.com, 
servage.net, 
whois.com etc.  

Do you know? 
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Step 15: FTP/ Upload Files to Hosting Server | Dreamweaver 

Now that your site is ready it is time to upload the files to your hosting server and make your site live. 

You will need to purchase a domain name and web hosting. We use Hostgator to host this site. 

To upload your files: 

 Click on the ‘Connect to remote host’ icon at the top of the files panel 

 

 Click the + button to add a new server 

 

 Enter any server name, your FTP address/ hostname, username and password (you will receive these 
when you purchase hosting). 
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 Click the ‘Test’ button 

 

 Click the ‘Save’ button 

 In the Files panel click the ‘Expand to show local and remote sites’ icon 

 

 You will see an expanded File Window: 

http://bestwebdesignz.com/tips/wp-content/uploads/2010/09/ftp-details.gif
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 Click to connect 

 

 Dreamweaver will connect to your remote hosting server. You will see your remote hosting server on the 
left side and your local files on the right side. 

 You may need to navigate to a ‘www’ or ‘public_html’ folder on your remote server. 

 Select all the local files 

 Right click and select ‘Put’ 

 

 You can also use the ‘Put’ icon at the top 
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 A copy of all your website files will be stored on your remote hosting server. 

 Using a browser, browse to your domain name. Your website should appear. 

 Test to see if everything is working file. 

 Configure your form to work using a script that will work on your server technology or a form service 
provider like those mentioned earlier. 

 

Flash CS5 Capabilities 

Adobe Flash is the best software used to create 2 – D Animation. By using Flash you can create: 

Cartoon Movies, Web Banners, Animated Clipart, Video Games, Websites Multimedia Presentations 

General Flash Workflow 

 Plan the application 

 Add media elements 

 Arrange the elements 

 Apply special effects. 

 Use ActionScript to control behavior 

 Test and publish your application. 

Flash Interface 
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Exploring Toolbar 

Types of Animation 

Flash supports the following types of animation: 

 Motion tweens  

 Classic tweens  

 Shape tweens 

 Frame-by-frame animation  
 
Frames Fundamentals 

The rate at which the illusion of animation is considered is normally between Twelve to thirty frames per seconds. 

Frame Rate: 

Persistence of vision has been claimed to be sufficient at 12 frames per second (fps) but is more often considered 
acceptable at between 18 and 24 fps. There are however, fixed display speeds associated with different media, 
which should be listed. 

Old 16-mm home movies  Frame rate 18 fps. 
Standard movies films   Frame rate 24 fps 
TV in United Kingdom   Frame rate 25 fps 
TV in USA    Frame rate 30 fps 
 

Frame and its Types 

Frame is unit of information on the stage or we can also say that it container of object. In Flash there are three 
types of frames. 

 Frame 

 Key Frame 

 Blank Key Frame 

A black dot in the first frame of the span indicates that the tween span has a target object assigned to it. Black 
diamonds indicate the last frame and any other property key frames. 

 

Symbol: 

Symbols are the key components in Flash and are essential aspect of creating animations and interactive 
elements 

Instance:   

An instance is a copy of master symbol. Rather than using the symbol on the stage we use and modify the 
instance of the symbol on the stage. 

Type of Symbols: 

  In Flash there are three types of symbols: 

1. Graphic 
2. Movie 
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3. Button 
Work with Mask Layers 

Importing Sound into Flash: 
  To import a sound file into the Flash authoring environment: 

  Choose:  File  Import 
  Select:    All Sound Formats. From the Files of Type drop-down. 
  Select:    The .MP3, .AIFF, or .WAV file that you want to import. 
  Click:      Open 
To Attach a Sound to a Timeline: 

1  Choose File  Import to import a sound. 
2  Select the sound in the library and choose Linkage from the Options menu. 
3  Select Export This Symbol and give it the identifier mySound. 

4  Select frame 1 in the main Timeline and choose Window  Actions. 
The code should look like this: 
 s = new Sound(); 
s.attachSound("mySound"); 
s.start(); 
To Create a Sliding Volume Control:  
1  Drag a button to the Stage. 

2  Select the button and choose Insert  Convert to Symbol. Choose the movie clip behavior.  
 This creates a movie clip with the button on its first frame. 

3  Select the movie clip and choose Edit  Edit Symbol. 

4  Select the button and choose Window  Actions. 
5  Enter the following actions: 
 on (press) { 
 startDrag ("", false, left, top, right, bottom); 
 dragging = true; 
} 
on (release, releaseOutside) { 
 stopDrag (); 
 dragging = false; 
} 
 The startDrag parameters left, top, right, and bottom are variables set in a clip action. 

6  Choose Edit Edit Movie to return to the main Timeline. 
7  Select the movie clip on the Stage. 
8  Enter the following actions:  
 onClipEvent (load) { 
 top=_y; 
 left=_x; 
 right=_x; 
 bottom=_y+100; 
} 
onClipEvent(enterFrame){ 
 if (dragging==true){ 
  _root.s.setVolume(100-(_y-top)); 
 } 
} 

9  Choose Control  Test Movie to use the volume slider. 
 
To Create a Balance Sliding Control:  
1  Drag a button to the Stage. 

2  Select the button and choose Insert Convert to Symbol. Choose the movie clip property. 

3  Select the movie clip and choose Edit  Edit Symbol. 

4  Select the button and choose Window  Actions. 
5  Enter the following actions: 
 on (press) { 
 startDrag ("", false, left, top, right, bottom); 
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 dragging = true; 
} 
on (release, releaseOutside) { 
 stopDrag (); 
 dragging = false; 
} 
 The startDrag parameters left, top, right, and bottom are variables set in a clip action. 

6  Choose Edit  Edit Movie to return to the main Timeline. 
7  Select the movie clip on the Stage. 
8  Enter the following actions: 
 onClipEvent(load){ 
 top=_y;S 
 bottom=_y; 
 left=_x-50; 
 right=_x+50; 
 center=_x; 
} 
onClipEvent(enterFrame){ 
 if (dragging==true){ 
  _root.s.setPan((_x-center)*2); 
 } 
} 

9  Choose Control  Test Movie to use the balance slider. 

  
on (release) { 
   unloadMovie("cont"); 
} 
on (release) { 
   loadMovie ("mov.swf", _root.cont); 
} 
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Learner’s Activities 
 

Developing Mockup of Website Using Adobe Photoshop 

 

Description:   This activity based on individual performance. Each student will develop layout of 
website in Photoshop with help of slice tool 

Time Guideline: 2 hours 

Purpose:  To be able to mockup of website  
 

Outcomes:  
 

1- Each individual , first sketch layout on paper  
2- Then will draw layout in adobe Photoshop 
3- Individual will demonstrate his/her work before class.  

 

Develop a Website Using Adobe Dreamweaver 

 

Description:   This activity consists of group of 2 participants.  

Time Guideline: 4 hours 

Purpose:  To be able to develop website in Dreamweaver and  practice in adobe Dreamweaver 

 

Developing an Image Gallery in Flash 

 

Description:   This activity consists of group of 2 participants.  
Minimum 5 image in gallery 
Gallery have option of slide show 

Time Guideline: 2 hours 

Purpose:  To be able to develop animations and galleries in flash for web pages.    

Outcomes:  
 

Group will demonstrate his/her work before class.  
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Learning Unit 3: Application of Templates in Website 

Overview 

In this learning unit, you will learn web templates. After completion of this learning unit, 
you will be able to use website Templates, how to download template, differentiate in 
free and paid templates and how to customized templates in editor.   
 

 

1. Website Template 

A website template is a pre-designed webpage or set of HTML webpages that anyone 
can use to "plug-in" their own text content and images into. Usually they are built with 
HTML and CSS code. For templates two basic Options are available 

Free Website Template 

The main benefit of a free website template is the cost. You spend no money upfront. 
Free web templates are often harder to customize and often lack certain functionalities, 
such as online shopping carts. They lack the polished look of a professional design. 
This might be fine for some websites, but business owners will probably want to 
consider something else when establishing their company's online presence. 

Paid Website Templates 

In case of paid website template, you'll find that some places will sell them for a one-time, upfront fee, while 
others will charge you a small monthly fee. Places that require a monthly fee typically give you access to a 
customer support team — a great benefit if you ever run into a problem or just want some help setting up your 
website. Most paid templates provide you with designs that can easily be customized to reflect your style or 
brand, helping you to create a website you can be proud of. 

2. Searching and Downloading Website Templates  

There are many websites which provides open source templates without any cost but some highly professional 
and prefect design are paid design.  

Free website templates are available for download on following links. 

1. http://www.opendesigns.org/ 
2. http://www.freewebsitetemplates.com/freewebsite/ 
3. http://all-free-download.com/free-website-templates/free-html-CSS-
templates.html 
4. http://designscrazed.org/free-responsive-html5-css3-templates/ 
 

50 Free Responsive HTML5 CSS3 Website Templates  

1. http://webdesigncone.com/2014/free-bootstrap-templates/ 
2. http://startbootstrap.com/template-categories/all/ 

Website templates 
allow anyone to 
setup a website 
without having to 
hire a professional 
web developer or 
designer. 

Remember 

A template is a file 
that serves as a 
starting point for a 
new document. 
When you open a 
template, it is pre-
formatted in some 
way. 

Template 

Open Designs was 
founded in 2006 as 
a community for 
sharing free open 
source web designs 
online. 

Do you know! 

http://www.opendesigns.org/
http://www.freewebsitetemplates.com/freewebsite/
http://all-free-download.com/free-website-templates/free-html-css-templates.html
http://all-free-download.com/free-website-templates/free-html-css-templates.html
http://designscrazed.org/free-responsive-html5-css3-templates/
http://webdesigncone.com/2014/free-bootstrap-templates/
http://startbootstrap.com/template-categories/all/
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Following are few links to download paid websites Templates 

1. http://www.templatemonster.com/properties/features/premium-templates/ 
2. https://wrapbootstrap.com/ 
3. http://www.pixeden.com/web-design-templates 
4. http://www.justfreetemplates.com/premium-templates/web 

 
 
 

 

 

 

 

 

 

 

Learner`s Activity 

In previous learning activity working, learners have experienced working in adobe Dreamweaver and also have 
developed an application using Dreamweaver. Now in this session class will customized Templates using 
Dreamweaver under the supervision of instruction.   

 

Developing a Website Using a Templates 
 

Description:    This activity will be performed by individual. 

 Each student has Experience of working on adobe Dreamweaver. 

 Each student will present his web project idea before class. 

 Download Free Templates from above mention link as per project design 
requirement download relevant design templates.  

 Instructor will guide and help out students in selection of designing  

 Customized Templates in Dreamweaver. 

Time Guideline: 4 hours 

Purpose:  To be able to customized templates and will try develop design like these 
professional developed design. 

Presentation:  

 

Individual will present Template and also present his/her new developed web 
application developed from templates.   

 

  

www.justfreetemplat
es.com provides 
both free and paid 
web design 
templates 

Remember 

Wrap Bootstrap is a 
marketplace for 
premium Bootstrap 
themes and 
templates. 

Wrap Bootstrap 

Bootstrap is an 
HTML5 & CSS3 
framework designed 
to help you kickstart 
the development of 
webapps and sites. 

Bootstrap 

http://www.templatemonster.com/properties/features/premium-templates/
https://wrapbootstrap.com/
http://www.pixeden.com/web-design-templates
http://www.justfreetemplates.com/premium-templates/web
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Summary of Module 

  Web Designing is an art of building web pages and technically design is a process for developing 
solutions that effectively integrate task, context of use, and “user.” 

Web design isn't the same as web development. Development involves coding the backend of your 
website but you're here for web design. For the look-and-feel. 

  Time Berners-Lee is known as father of web. In 1989 he developed a web page. 

In 1990, the first text only browsers were setup and CERN scientists could access hypertext files. 

By early 1993, there were only about 50 websites worldwide. A browser Mosaic having web’s 
graphical capabilities was developed at NCSA (National Centre for super computers). 

JavaScript was developed in 1995. 

Macromedia Flash first version was release in 1996. 

For formatting of HTML documents CSS came in use in 1998. 

Grid framework for mobile devices was developed in 2007.  

Idea of response designs was presented in 2009 but its implementation in web was possible with 
development of Bootstrap was by Mark Otto and Jacob Thornton at Twitter, and released as an open 
source product in August 2011 on GitHub. 

  Adobe Photoshop is a powerful, easy-to-use tools that let you combine and cut out images, apply 
looks, and helps us in development of webpages mockups. 

  Adobe Dreamweaver is a web design and development application tool with standard features such 
as syntax highlighting, code completion, and code collapsing as well as more sophisticated features 
such as real-time syntax checking and code introspection for generating code hints to assist the user 
in writing code. 

  Flash started its life in 1996 as Future Splash Animator. A re-branded version of the Future Splash 
Animator was introduced as Macro Media Flash-1 in 1996.  

It is a best Tool to create 2 – D Animation 

  Web templates are pre-designed templates developed by professional designers, and are available 
for free and on fee as well. Individual having little knowledge of any HTML editing tool can easily 
customized these templates as per requirement and developed web application.  Web designing 
templates are web designs developed by the professional. Individual having little knowledge of any 
HTML editor tool can easily develop web application within short time. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What are the benefits of a Website? 

Answer 

A Website acts as a promotional tool that helps you to promote your business among a global 
audience. It helps in establishing a brand identity since a Website increases credibility of your 
business. You become more competitive since most of the businesses are establishing their 
presence over the Internet and you cannot afford to stay behind. 

FAQ 2:  Who is the inventor of W3C 

Answer 

Tim Berners-Lee invented the World Wide Web in 1989. He founded and Directs the World Wide 
Consortium (W3C) the forum for technical development of the Web. He founded the Web 
Foundation whose mission is that the WWW serves Humanity, and co-founded the Open Data 
Institute in London. His research group at MIT's Computer Science and AI Lab ("CSAIL") plans 
to re-decentralize the Web. Tim spends a lot of time fighting for rights such as privacy, freedom 
and openness of the Web. 

FAQ 3:  What is responsive Web Design? 

Answer 
Responsive web design is about creating web sites which automatically adjust themselves to 
look good on all devices, from small phones to large desktops. 

FAQ 4:  CMYK stand for 

Answer CMYK is abbreviation of Cyan, Magenta ,Yellow and Black 

FAQ 5:  What is resolution? 

Answer 
Resolution is the quality of an image. It is measured in terms of pixels. If you see an image listed 
as "72 ppi", that means the image has 72 pixels per inch (ppi).  

FAQ 6:  What is JPEG? 

Answer 
JPEG stands for Joint Photographers Experts Group. It's a great format that retains color and 
detail found in photographs and graphics with lots of color blends but not well for web pages 
because of its size. 

FAQ 7:  What is CSS? 

Answer 
Cascading Style Sheets (CSS) is a mechanism for changing the appearance of HTML or XML 
elements, by assigning styles to element types, self-defined classes of elements or individual 
instances. 

FAQ 8:  Role of Adobe Photoshop in web development? 

Answer 

Photoshop is used in the modern web design workflow. Together, you'll create a mockup for a 
creative company that contains responsive templates, a fully developed color and font theme, 
and a UI kit full of buttons, navigation bars, check boxes, and other ready-to-use interface 
elements. He also shows how to optimize web graphics, create image sprites, and integrate 
other apps like Illustrator and Muse in your web design workflow. 

FAQ 9:  What is benefit of site definition in Dreamweaver? 

Answer 
Even if you don’t yet have a website or remote web server, Dreamweaver expects you to 
organize your files exactly as they would be in a real site. Before you can start working, you need 
to define a site. 

FAQ 10:  What is Spray Menu in Dreamweaver?  

Answer 
Spray Menu bar is built in functionality of Adobe Dreamweaver CS versions that automatically 
adds drop down menu list in web applications.  
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the end 
of this module. 

1.  In Photoshop The zoom tool allows you to do what? 

a.  Move around your graphic b.  Increase/decrease the magnification size of 
graphic 

c.  Select objects d.  None of above 

2.  Photoshop file default format that preserves layers is 

a.  JPEG b PSD 

c. PNG d. AI 

3.  Short key to fill the whole background with current color: 

a. Alt+B b. ALT+BACK SPACE 

c. ALT+SPACE BAR d. NONE 

4.  To cut down the size of the entire graphic design, including all layers, select the ______ tool. 
(2 points) 

a. Marquee b. Magic wand 

c. Eraser d. Crop 

5.  To fill in a layer as a background, which of the following tools would be useful? Choose all 
that apply, select all correct possibilities. (2 points) 

a. Line  b. Paint bucket 

c. Gradient d. Smudge 

6.  The ________ tool is best selected when you need to select an irregular shaped image in a 
layer.  

a. Crop b. Marquee 

c. Lasso d. Magic wand 

7.  The _______ tool allows you to select a rectangular or circular area of a layer to change or 
delete.  

a. Marquee b. Crop 

c. Hand d. Zoom 

8.  Drop shadow, inner glow and bevel are examples of _________ you need to use with text. 

a. Filters b. Bending options 

c. Image adjustment d. Layer modes 

9.  How many Sites can you define with one copy of Dreamweaver installed on your computer?  

a. unlimited b. 1 

c. 10 d. 999 
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10.  Which of the following is not supported by older browsers? 

a. CSS b. Layers 

c. Frames d. All of the above 

11.  Dreamweaver users work in the Document Window using one of how many views? 

a. 3 b. 2 

c. 5 d. 1 

12.  Dreamweaver's ____ feature allows users to select colors and make perfect color matches. 

a. Color Cube b. Palates 

c. HTML view d. Eye dropper 

13.  _________view is a hand-coding environment for writing and editing code. 

a. Design b. Split 

c. Code d. None of above 

14.  In order to define a site, users must create a both a ___________ and ____________. 

a. domain name / IP address b. login / password 

c. site name / home page d. site name / root folder 

15.  Which graphic format can you Not insert into your web page?  

a. bmp b. Gif 

c. png d. None of above 

16.  What is the proper way to manually type an email link?  

a. email:myname@austincc.edu b. mailto:myname@austincc.edu 

c. mail:myname@austincc.edu d. None of above 

17.  Dreamweaver is sold by what software company: 

a. Adobe b. Macromedia 

c. Microsoft d. None of above 

18.  Use Dreamweaver to create: 

a. HTML, XML, and CSS files b. PHP, Java, and ASP.NET 

c. The new space-time continuum format 
STCML 

d. All of the above, except the space-time 
continuum thing... 

19.  You can save images for the Web in these formats: 

a. JPG, GIF, PNG b. PSD, Tiff 

c. Flickr d. ftp, fla, jsp 
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20.  ____________ is a way to partially hide an image in the layer immediately below another 
layer. The 2 layers get “locked” together to produce the effect. 

a. Morphing  b. Twining 

c. Stacking d. Masking 

21.  In Photoshop ___________ panel contains the basic tools needed to draw and modify 
objects. 

a. Actions b. Properties 

c. Tools d. Layers 

22.  In Adobe Flash The __________ shows the frames in the movie.  

a. Toolbar b. Properties pane  

c. Timeline  d. Scene  

23.  In Adobe Flash________________ allow you to make objects move in a more random or non-
straight path.  

a Mask b Shape tween  

c Guided layer d Gravity effect  

24.  In Adobe Flash ____ is used to change an object from a circle to a square. 

a Mask  b Shape tween 

c Motion tween  d Morphing  

25.  In Adobe Flash every animation needs a starting and ending point. _______________ are 
used to set these.  

a Scenes  b Key frames  

c Blank frames d Graphic symbols 

26.  The ___________ panel contains the basic tools needed to draw and modify objects.  

a Actions  b Properties 

c Tools d Layers  

27.  In Adobe Flash Empty key frames are indicated by a _________________ circle on the timeline  

a Hollow b Black  

c Open eye  d Closed eye  

28.  In Adobe Flash a key frame that contains objects will be represented by a _________ circle.  

a Hollow b Black 

c Blue d Gray 
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Answer Key 
MCQ Number Correct Answer MCQ Number Correct Answer 

1 b 15 a 

2 b 16 b 

3 b 17 a 

4 c, d 18 d 

5 b, c 19 a 

6 c 20 d 

7 a 21 b 

8 b 22 c 

9 a 23 c 

10 d 24 b 

11 a 25 b 

12 d 26 c 

13 c 27 a 

14 d 28 b 
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Module 4: Plan Website and Explain  
Software Development Life Cycle for  
Web Applications 

Learning Outcomes 

After completion of this learning module, learner will be able to: 

  Develop website project plan 

  Utilize the software development life cycle in a web project 
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Learning Unit 1: Develop Website Project Plan 

Overview 

 
In this learning unit you will learn about project planning includes arrangement & 
management of project meetings, gathering project requirements, creating story 
boards, development of time lines and evaluation of finances.  
 
After completion of this learning unit you will able to define project meetings, story 
boarding, financial evaluations, functional and non-functional requirements and client 
management. 
 

1. Arrange and Manage Project Meetings 

 
Meetings are necessary to coordinate individual efforts, collaborate on joint projects, garner support for ideas, 
sell ideas, solve problems collectively, and make consensus-based decisions. 
 
Elements for Effective Project Meetings 
 

 Why to meet (Objective) 

 Whom to meet (Participant) 

 When & where to meet (Location & Time) 
 
Objective: for planning a meeting it should have clear objectives for example to decide the marketing strategy 
for the product of this year. 

 
Participants: are the people who attend the meeting to accomplish for the specific purpose? 
 
Structure: is the procedure for the meeting how to organize it in its best accomplish to get the specific purpose. 
Examples: guest speakers, videos, brainstorming sessions, discussion groups, demonstrations, etc. 
 
Location and Time: Select a meeting place that best matches the participant’s needs, the objective, and the 
meeting structure. When planning where to meet, give consideration to size, comfort, accessibility, adequate 
parking, room acoustics, equipment needs, etc.  
 
Agenda: Most important, to distribute to participants at least three days prior to the meeting day.  
 
An agenda is crucial to meeting success in three ways:  
 

1. It clarifies the objectives.  
2. Distributing the agenda prior to the meeting helps participants plan and prepare to make an effective 

contribution.  

In a meeting, two or 
more people come 
together to discuss 
one or more topics, 
often in a formal 
setting. 

Meeting 

Agenda is a list of 
items to be 
discussed at a 
formal meeting. 

Agenda 



Module 4: Plan Website and Explain Software Development Life Cycle for Web Applications 

182 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

3. During the meeting, the agenda provides direction and focus for the discussion. 
 
Responsibilities: is a work freedom with limitation, bound under rules. 

 
Confirmation: before the commencement of meeting must confirm. 
 

 Participant availability 

 Agenda distribution & authentication  

 Place and time 

 Arrangement, structure of meeting 
 
Requirements for a Successful Meeting 
 

 Define the purpose, goals, and objectives of the meeting 

 Determine the participant 

 Create a detailed agenda for the meeting 

 Determine the appropriate time length of the meeting 

 Determine the best meeting format and location 

 Send out the meeting invite and agenda days in advance 

 Facilitate and lead the meeting 

 Document and summarize action items 

 Send out a meeting summary 

 Follow up on action items and schedule additional meetings as  necessary 
 
Run an Effective Project Meeting 
 
Here are some suggested guidelines on how to run effective meetings: 
 

 Begin on time and end on time. 

 Use the Agenda 

 .Control dominating individuals. 

 Refreshment & beverages. 

 Compactness. 
 
 

2. Gather  Project  Requirements 

 
A requirement gathering is about creating a clear, concise and agreed set of customer requirements that allow 
to provide exactly what they are looking for. 
 
Sources of Requirements 
 
Good requirements start with good sources.  
Examples of sources of requirements include: 
 

 Customers 

 Users 

 Administrators and maintenance staff 

 Partners 

 Domain Experts 

 Industry Analysts 

 Information about competitors 
 
Rules for Successful Requirements Gathering 
 

1. Don't assume what the customer wants, ask. 
2. Involve the users from the start. 

A requirement 
gathering is an 
essential part of any 
project and project 
management. 
Understanding fully 
what a project will 
deliver is critical to 
its success. This 
may sound like 
common sense, but 
surprisingly it's an 
area that is often 
given far too little 
attention. 

Requirement  

Gathering 

Requirement 
Gathering is also an 
important 
component of 
Software 
Development Life 
Cycle (SDLC) 
Project planning is 
part of Project 
Management. 

Do you know! 
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3. Define and agree the scope of the project. 
4. Ensure requirements are specific, realistic and measurable. 
5. Gain clarity if there is any doubt. 
6. Create a clear, concise and thorough requirements document and share it with the customer. 
7. Confirm the understanding of the requirements with the customer (play them back). 
8. Avoid talking technology or solutions until the requirements are fully understood. 
9. Get the requirements agreed with the stakeholders before the project starts. 
10. Create a prototype if necessary to confirm or refine the customers' requirements. 

 
Requirements Gathering Techniques 
 

 Conduct a brainstorming session 

 Interview users 

 Send questionnaires 

 Work in the target environment 

 Study analogous systems 

 Examine suggestions and problem reports 

 Talk to support teams 

 Study improvements made by users 

 Look at unintended uses 

 Conduct workshops 

 Demonstrate prototypes to stakeholders 
 

Conduct a Brainstorming Session 
 
Brainstorming is a short group session where everyone is allowed to say whatever they feel is important to the 
topic of discussion. After that, a facilitator leads the group in organizing and prioritizing the results.   
 
The following basic rules for brainstorming ensures better results: 
 

 Start out by clearly stating the objective of the brainstorming session. 

 Generate as may ideas as possible. 

 Let imagination soar. 

 Do not allow criticism or debate while gathering information. 

 Once information is gathered, reshape and combine ideas. 
 
Interview Users 
 
Face-to-face contact with users through individual interviewing is the primary source of requirements and an 
important way to gather and validate their requirements. Remember that it is not the only possible technique.  
 

 
 
Use the system to make an effort to understand and experience the user's problem to describe it clearly and 
correctly. 
 
Send Questionnaires 
 
Sometimes, face-to-face meetings with stakeholders are not feasible (for example: when developing products for 
the consumer market). In those situations, use questionnaires.  

Brainstorming is a 
method of shared 
problem solving in 
which all members 
of a group 
spontaneously 
contribute ideas. 

Brainstorming 
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Create a set of questions (as per requirement), possibly with multiple choice instances, to the relevant 
stakeholders, and ask them to complete it and return it to.   

 

 
 
Work In the Target  Environment 

Working in an open target environment is quite easy than target base environment. It 
would be good to see the same dedication devoted to solving problems in target based 
work too. Where the work cannot easily be experienced in this way, it may still be 
possible to do a bit more than just sit quietly and observe.  
 
Study Analogous Systems 
 
The starting point for many projects is often a similar or an existing system. Sometimes, 

comparable products and systems contain working versions of good ideas for solving user problems. Even if they 
are trying to solve slightly different problems, they often provide valuable clues as to what need to do. 
 
Such a process might involve the following activities: 
 

 Read the document from seller-end to purchaser-end (several times) to comprehend what the customer 
wants and what actually has been written. 

 Classify all of the types of information in the document. (user, system requirements, design elements, 
plans, background material, irrelevant detail) 

 Mark up the original text to separate out such requirements. 

 Find a good structure for each of the different types of information such as: a scenario for the user 
requirements, functional breakdown for the system requirements, and architecture for the design. 

 Organize the information to show gaps and overlaps.  

 Create traceability links between these information elements to show the designers exactly what the 
users want. 

 Convince the customer to accept the new information as the basis for the contract. 
 

Examine Suggestions and Problem Reports 
 

Requirements can come from change suggestions and user problems. A direct road to finding requirements is to 
look at suggestions and problems as first described. Ask users some questions about these areas to clarify the 

users' actual needs. 
 
Talk to Support Teams 
 
Most large sales organizations have a help desk that keeps a log of problems and fixes, 
and support engineers who do the fixing. Many organizations have similar facilities to 
support their own operations. Also talk to the training team and installation teams about 
what users find to be difficult. 
 
Study Improvements Made by Users 
 
Users of a standard company spreadsheet may have added a few fields, or related 

different sheets together, or drawn a graph, that exactly meets their individual needs. For example, a lathe 
operator may have manufactured a special clamp, or an arm that prevents movement of the tool beyond a certain 

Questionnaire a set 
of printed or written 
questions with a 
choice of answers, 
devised for the 
purposes of a 
survey or statistical 
study. 

Questionnaire 

Analogous means 
similar or 
corresponding in 
some respect. 

Analogous 

Workshop is a 
meeting at which a 
group of people 
engage in intensive 
discussion and 
activity on a 
particular subject or 
project. 

Workshop 
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point. Any such modification points to something wrong with the existing product, which makes it a valid 
requirement for the new version. 
 
Look at Unintended Uses 
 
People often use things for purposes for which they were not designed.  This is a good way to get new ideas and 
to think of innovations. For example, an observant product manager noticed that an engineer was staying in the 
office late to use an advanced computer-aided design system to design a new kitchen layout for his home. 
Inexpensive commercial products are now widely available for home use. 
 
Conduct Workshops 
 
Workshops can rapidly pull together a good set of requirements. In two to five days, can create a set of 
requirements, and then review and improve them. If everyone in a workshop tries to estimate the cost and value 
of each requirement, the document becomes much more useful and cost-effective. 
 

 
Workshops are quicker and better at discovering requirements than other techniques, such as sending 
questionnaires.  
 

3. Perform Storyboarding 

 
Storyboarding is an iterative, interaction design methodology that uses a series of sketches or pictures to 
demonstrate an end to end solution for a user scenario. 
 
Storyboards originated in the motion picture industry to help directors and cinematographers visual a film's 
scenes in sequence. Such storyboards resemble cartoon strips. 
 
Storyboarding can strengthen the user experience elements of designs, and software for building prototypes from 
those sketches can be an invaluable tool. 
 

 
 
Storyboard for a Web Project 
  
A storyboard is the blueprint for a web project. It is a simple, flexible tool which can be used to display the 
elements on a single Web page such as images, banners, navigation, graphic elements and text. It is also an 
excellent tool for presenting a project to clients. 
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Purpose of a Website Storyboard 
 
The purpose of a website storyboard is threefold.  
 
1. It serves as an outline of the design approach. 
2. It defines the elements that need to go on each page. 
3. It shows the navigational architecture and information flow to the team and demonstrates how the pages are 
to work together to provide the user’s interactive experience. 
 
Types of Storyboards 
 
Three types of storyboards are detailed below. 
 

 Presentation Storyboard. Used to demonstrate visualization of the site and solidify the design model; 
can be compared to an architectural sketch of a new home.  

 

 Production Storyboard. Used by production teams to present a clear picture of what will be happening 
throughout the entire site, what each page will look like, and what each team member/developer will do.  

 

 Maintenance Storyboard. Used by the production team to present a clear picture of what parts of the 
site will need to be updated or maintained, as well as what parts of the website that should be left alone 
or modified by a professional. This is the plan for site upkeep, such as performing homeowner 
maintenance.  

 
The storyboard illustration should include: 
 

 A flowchart depicting the opening screen and the major sections of the website. 

 A description of the text that will be placed on each major page of the website. 

 A description of graphic images that belong on each page. 

 The navigational tools and their location. 

 The cross-links to all of the information contained on the website. 

 The external links to other websites. 

 The color scheme of the website. 
 
Storyboard Checklist 
 
A storyboard can be used to provide the details of an entire website by outlining the hierarchy or architecture of 
a site.  
 
Navigation 

 Does the site design contain numerous links on every page in an effort to keep everything “just a click 
away?” Can they be better organized?  

 Is the navigation weak? Are there few basic links that then lead to hundreds of wandering links? Do the 
elements need to be reorganized?  

 Does the navigation make sense? Will viewers be able to find their way to the information they want if 
they follow the links provided?  

 Have links been grouped logically?  

 Are there gratuitous pages added: links that lead to another page of links?  

 Is there a way back to the dominant section or home page from the subsections or do viewers have to 
use the “back” button on their browsers? 

 
Site Structure 
 

 Given the complexity of the site is it necessary to add a website map?  

 Are other referral elements such as an index needed? Table of contents? Glossary?  

 Are there too many forms that basically perform the same function? Can they be consolidated?  

 Is the site balanced or does the site contain just one really good page located in a virtual ghost town?  

 Graphics 
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 Is the site overloaded with graphics? Are they necessary? Are they annoying? Do they go with the 
content?  

 Does the site start with a strong graphic presence, only to putter out once further into the site?  

 Given the number of graphics anticipated per page and per section, are visitors forced to survive the 
longest downloads on those pages which are utilized most frequently?  

 Are graphics taking over the page? Does the content get relegated to a tiny visual space?  

 
Content 
 

 Is the “meat” of the content hidden too deep into the site to be found?  

 Is the content being updated most frequently easy to get to?  

 Are there repeating content elements, such as department Rolodexes that would be better combined into 
one section.  

 Are there too many “under constructions” flags?  

 Is there too much pointless content, fluff, or dry reading in a more dynamic section? *Is there enough 
technical information in those areas where it is warranted?  

 Does the content logically flow within the section? Between sections?  

 If providing a website as a means of answering questions, have questions been answered or are viewers 
required to email or call for more assistance?  

 Can the site be created as envisioned or is it too ambitious an undertaking? 
 

4. Develop Timelines 

 
Timelines can use any time scale, depending on the subject and data. A project timeline is an important 
component of time management planning and a useful project management tool for keeping the client informed 
and project on target.  
 

 
 
A project timeline allows an IT project manager to: 
 

 Identify potential problems before they delay the project; 

 Give customers earlier notice of potential delays or scope changes - before over estimate; 

 Provide immediate, on-demand status reports regarding which aspects of the project are complete, due 
or running behind; 

 Always keep in touch with each project, and whether out and ahead or behind financially; 

A timeline is a 
graphical 
representation of a 
period of time, on 
which important 
events are marked.  

Time Line 
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 Bill the client as project milestones are attained. 

 Track the actual time spent on all aspects of the project, so that, to make better development in future 
estimates and timelines. 

 

5. Evaluate Finances (Budgeting and Costing) 

 
Creating a Project Budget 
 
When starting a project, it is difficult to know how much it will cost. Project managers are held to account for their 
budget estimates and with so much uncertainty in projects, it can be one of the project managers' greatest 
challenges. 

 

 
The ability to create an accurate budget is an essential skill for a project manager.  
Budgeting Basics 
There are two main approaches can take when creating a budget: 
 

 Top-down approach: deciding how much the project will cost and dividing the amount between the work 
packages. 

 Bottom-up approach: estimating the total cost of the project by costing the lowest-level work packages 
and rolling up. 

 
Top-Down Budgeting Approach 
 
The decision is made, often by senior management, about how much the project should cost. The amount is 
divided between the work packages. This approach is more than guessing, it needs to explain how do the work 
within the allocated amount of budget on each work package.  
 
Prior experience from other projects will play a part in validating the budget allocation for work packages. It should 
be asked whether the budget looks realistic based on experience from past projects. 
 
The advantage. The top-down budgeting approach is focuses on achieving the project within the budget 
allocated and leads to efficiencies and reduction in wasteful practices. 
 
The disadvantage. The top-down budgeting approach is assumes the person creating the budget has enough 
knowledge and expertise to make a reasonable cost estimate. 
 
Bottom-Up Budgeting Approach 
 
The team, often involving the final budget holder, identifies the tasks and activities needed to complete the project. 
The project is based on the lowest-level work packages and rolled up to arrive at the total project cost. The direct 
and indirect costs are calculated for each work package. 
 
The Advantage.  The bottom-up budgeting approach is accurate (as long as not missed any task or activity). It 
is good for team morale because the project manager involves the team in budget creation. This approach is 
sometimes called participative budgeting. 
 
The Disadvantage. The bottom-up budgeting approach is difficult in getting a full list of tasks and activities 
needed to complete the project. It is easy to miss some that will be needed and that will later throw the budget 
out. 
 

Budget is an 
estimate of income 
and expenditure for 
a set period of time. 

Budget 
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Different Cost Types 
 
There are two cost types that concern project managers when they create budgets: direct and indirect costs. 
 
Direct Costs 
 
These costs can easily be attributed to the project and are charged to the project on an item-by-item basis. 
 
Examples are: 
 

 Labor (people) 

 Consultant fees 

 Raw materials 

 Software licenses 

 Travel 
 
Indirect Costs 
 
These costs are for items that benefit more than one project, and only a proportion of their total cost is charged 
to the project.  
 
Examples are: 
 

 Telephone charges 

 Office space (rent) 

 Office equipment 

 General administration 

 Company insurance 
 

6. Differentiate between Functional Requirements and Non-Functional Requirements 

 
Requirements may be functional or nonfunctional and both are essential to a 
successful software project. 
 
Functional Requirements 
 
Most requirements definition focuses mainly on functional requirements, which are 
based upon the expected functioning of the product or system to be created.  
Functioning typically is equated with product/system features for which might have a 
menu or button choice, such as:  identify a customer, select an item to order, and 
calculate the amount due.   
 

 

A functional 
requirement define
s a function of 
a system and its 
components. A 
function is described 
as a set of inputs, 
the behavior, and 
outputs. 

Functional 

Requirement 

Cost is an amount 
that has to be paid 
or spent to buy or 
obtain something. 

Cost 
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Examples of Functional Requirements 
 
Functional requirements may be calculations, technical details, data manipulation and processing and other 
specific functionality that define what a system is supposed to accomplish. 
 

Non-Functional Requirements 
 
Non-functional requirements are often called qualities of a system. Other terms for 
non-functional requirements are "constraints", "quality attributes", "quality goals", 
"quality of service requirements" and "non-behavioral requirements". Non-
functional requirements can be divided into two main categories: 
 

 Execution qualities, such as security and usability, which are observable at run 
time. 

 Evolution qualities, such as testability, maintainability, extensibility and 
scalability, which are embodied in the static structure of the software system. 
 
Examples of Non-Functional Requirements 

 

 Accessibility 

 Capacity, current and forecast 

 Compliance 

 Documentation 

 Disaster recovery 

 Efficiency 

 Effectiveness 

 Extensibility 

 Fault tolerance 

 Interoperability 

 Maintainability 

 Privacy 

 Portability 

 Quality  

 Reliability 

 Response time 

 Robustness 

 Scalability 

 Security 

 Stability 

 Supportability 

 Testability 
 

7. Exhibit the Significance of Client Management 

Customer Relationship Management (CRM) is a system for managing a company's 
interactions with current and future customers. It often involves using technology to 
organize, automate, and synchronize sales, marketing, customer service, and technical 
support. 

Managing client expectations is a critical skill in delivering good quality work, which 
both ends are happy with. Client expectations tie directly into the level of satisfaction a 
client will receive from the service provider work.   

If a client appears to be dissatisfied, the best place to start when looking for causes, at the client’s level of 
expectation performance is should at the outset of the project. Sometimes, even the best management 
consultants become so wrapped up in their own work processes that they lose sight of the expectations a client. 
 

A non-functional 
requirement is 
a requirement that 
specifies criteria that 
can be used to 
judge the operation 
of a system, rather 
than specific 
behaviors. 

Non-functional 

Requirement 

Client is a person or 
organization using 
the services of a 
lawyer or other 
professional person 
or company. 

Client 
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What are the Client’s Expectations? 

Key is asking questions.  For example, if a client has hired the consultant to help grow their business, ask 
questions about like, 

 “How much growth?”  

 “Over what time period to grow?”  

 “What is a realistic percentage of growth?”   

However, a client may not always verbalize their expectations.  These are implicit expectations (that client 
holds only with self).  These expectations are based upon several things: 

 Client organization standards and culture 

 Industry standards and quality benchmarks 

 Personal reputation,  

 Articulation of what is expected  

Don’t Promise What Can’t Deliver 

The client may want to perform tasks that cannot be performed, or the time frame may make it nervous.  Whatever 
do / do not promise things that cannot be delivered on.   

Prevention 

 
As a final note, it is important to be sure that both ends are on the same page when it comes to their expectations.  
Be sure to check, and double check to make sure that no minor miscommunication gets in the way of the success 
of a project. Never make any assumptions.   
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Learning Unit 2: Utilize the Software Development         
Life-Cycle in a Web Project 

Overview 

 
In this learning unit learner will be introduced about overall direction that the project will 
take to creation of project strategy documents, break down the deliverables into more 
detailed business / client requirements.  
 
After this Learning unit the learner will able to define and implement Software 
Development Life Cycle (SDLC). 
 
Recount Software Development Life Cycle: 
 
The software development life cycle (SDLC) is a sequence of events in software 
development describing tasks performed at each step. SDLC is a structure followed by 

a development team within the software organization. It consists of a detailed plan describing how to develop, 
maintain and replace specific software. The Software Development Life Cycle defines a methodology for 
improving the quality of software and the overall development process. 
 

 
 

System Development Lifecycle Steps 
 

1. Carry out the Project Analysis Phase 

 
The Analysis Phase is where the project lifecycle begins. The Analysis Phase is break down the deliverables in 
the high-level Project Charter into the more detailed business requirements. The Analysis Phase is also the part 
of the project where identify the overall direction that the project will take through the creation of the project 
strategy documents.  
 

Analysis Phase

Design

ImplementationTesting

Maintenance

The software 
development life 
cycle is a sequence 
of events in software 
development 
describing tasks 
performed at each 
step. 

SDLC 
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Series of steps followed by developers are: 

1. Collection of Facts: End user requirements are obtained through documentation, client interviews, 
observation and questionnaires, 

2. Scrutiny of the existing system: Identify pros and cons of the current system in-place, so as to carry forward 
the pros and avoid the cons in the new system. 

3. Analyzing the proposed system: Solutions to the shortcomings in step two are found and any specific user 
proposals are used to prepare the specifications. 

 

2. Design Phase 

 
Based on the client’s need and the detailed analysis of the existing system, the new system must be designed. 
This is the phase of system designing. It is the most crucial phase in the developments of a system. The logical 
system design arrived at as a result of systems analysis is converted into 
 

 Preliminary or General Design 

 Structured or Detailed Design 
 
There are several tools and techniques used for describing the system design of the system. These tools and 
techniques are: 
 

 Flowchart 

 Data flow diagram (DFD) 

 Data dictionary 

 Decision table 

 Decision tree 
 

3. Implementation Phase 

In this stage physical system specifications are converted into a working and reliable 
solution. This is where the system is developed. It is followed by testing and then 
implementation. 

Steps in Implementation Phase: 

1. Coding:  

2. Integration and Testing 

3. Installation:  
 
 
 

4. Testing Phase  

Testing Phase provides only a shorter version of the testing techniques.  

Testing is the process of evaluating a system or application, to check whether the 
application meets all requirements of the client and to detect the errors. There are two 
phases.   

 Static Testing 

 Dynamic Testing 

 Structural (or) white box testing  

 Functional (or) Black Box testing. 

 

 

Implement / coding 
the Project: Based 
on the client’s need 
and the detailed 
analysis of the 
existing system, the 
new system must be 
designed. This is the 
phase of coding the 
software.  

Implementation 

Testing is the 
process of 
evaluating a system 
or application to 
check whether the 
application meets all 
requirements of the 
client and to detect 
the errors.  

Testing 
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5. Maintenance & Support Phase 

Maintenance is necessary to eliminate errors in the system during its working life and to tune the system to any 
variations in its working environments. It has been seen that there are always some errors found in the systems 
that must be noted and corrected. It also means the review of the system from time to time. The review of the 
system is done for: 
 

  Knowing the full capabilities of the system 

  Knowing the required changes or the additional requirements 

  Studying the performance. 
 

If a major change to a system is needed, a new project may have to be set up to carry out the change. The new 
project will then proceed through all the above life cycle phases. 
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Summary of Module 

  Arranging and managing project meetings is very important in development of the software to gather 
the project requirements and Performing storyboarding Develop timelines. 

Evaluation of finances (budgeting and costing) is the technique that how to manage entire project in 
available financial resource. 

Identification of functional and non-functional requirement play vital role in any project. 

  Software Development life cycle (SDLC) is a framework to develop software. It helps you to 
analyze, execute, deploy and maintain the software. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is the significance of project meetings in project planning? 

Answer 
Meetings are necessary to coordinate individual efforts, collaborate on joint projects, garner 
support for ideas, sell ideas, solve problems collectively, and make consensus-based decisions. 

FAQ 2:  Name different sources of requirements 

Answer 
Customers, Users, Administrators, Maintenance Staff, Partners, Domain Experts, Industry 
Analysts and Competitors. 

FAQ 3:  Explain the purpose of storyboarding 

Answer 
It serves as an outline of the design approach. Defines the elements that need to go on each 
page and shows the navigational architecture and information flow to the team and demonstrates 
how the pages are to work together to provide the user’s interactive experience. 

FAQ 4:  What is the difference between functional and non-functional requirements? 

Answer 
Functional requirement defines a function of a system and its components and a non-functional 
requirement is a requirement that specifies criteria that can be used to judge the operation of a 
system, rather than specific behaviors. 

FAQ 5:  What are the main budgeting approaches? 

Answer Top-down approach & Bottom-Up Budgeting Approach 

FAQ 6:  What are the different phases in SDLC? 

Answer 

There are 5 phases in Software Development Life Cycle: 
1. Analysis 
2. Design 
3. Coding 
4. Testing 
5. Maintenance 

FAQ 7:  What is Software Life Cycle? 

Answer 
Software life cycle comprise the total life of the software developed right from the time of initial 
development to the time it is scrapped out or terminated. This includes the development phases, 
revisions and upgrades and if necessary adding it up with other software project as well. 

FAQ 8:  Is it mandatory to implement SDLC methods while developing any type of software project? 

Answer 

This is a tricky question and must be tackled smartly. Yes it can sure implement SDLC 
approaches for every type of software need to develop. But it is not a cost effective solution for 
smaller projects. For every kind of software development needs different approach and solution 
and must not be considered to be developed under mandatory SDLC guidelines. 

FAQ 9:  Can I build a software project without SDLC models? 

Answer 

Of course. There is no hard and fast requirement for a developer to implement any SDLC model 
for developing a software project. The ability to simplify project into modules and ascertain 
correct progression for completion is the only reason for which SDLC models and methodology 
was designed in the first place.  Work without SDLC is the biggest challenge and there won’t be 
any specific process to organized work. 

FAQ 10:  Which types of software’s are used to upload / manage the files / folders on web servers? 

Answer FTP Client software types are used to upload / manage the folders and files on web server.  
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Test Yourself! 
Please mark the correct one from the given options. 

1.  Which one of the following is NOT a non-functional requirement? 

a.  Documentation b.  Interoperability 

c.  Efficiency d.  Login Facility 

2.  Which of the following is a (an) requirement gathering technique? 

a.  Coding b.  Support 

c.  Design d.  Interview users 

3.  What is Analogy? 

a.  Similar b.  Opposite 

c.  Different d.  Diverse 

4.  Which is not a Storyboard? 

a.  Presentation b.  Production 

c.  Maintenance d.  Configuration  

5.  Expectations of Clients does not include 

a.  Respect b.  Communication 

c.  Aggression d.  Feedback 

6.  What is full form of SDLC? 

a.  a) System Design Life cycle b.  b) Software Design Life Cycle 

c.  c) System Development Life Cycle d.  Software Development Life Cycle 

7.  Which tool and technique is NOT used for describing the system design? 

a.  Flow Chart b.  Data Flow Diagram  (DFD) 

c.  Spiral Model d.  Decision Table 

8.  Which phase is necessary to eliminate errors in the system during its working? 

a.  Analysis b.  Deployment Phase 

c.  Design Phase d.  Maintenance Phase 

9.  Which one IS the FTP Client software from the following? 

a.  FileZilla b.  Microsoft Word 

c.  Adobe Acrobat Reader d.  Google Chrome 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 d 

3 a 

4 d 

5 c 

6 b 

7 c 

8 b 

9 a 
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Module 5: Use Databases in Web 
Development 

Learning Outcomes 

After completion of this learning module, learner will be able to: 

  Explain the basic concepts of database 

  Differentiate among different Database Management 
systems  

  Design create and manage database  in MySQL using 
PhpMyAdmin 
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 Module 5: Use Databases in Web Development 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 201 

Learning Unit 1: Basic Perspectives of Database 

Overview 

In this learning unit, you will learn basic concept of database, building blocks to 
understand and develop database in any Database Management System. After the 
completion of this learning unit you will be able to understand the database, term of 
database such as Row, Column, Table, Relationship, Quires, Normalization, 
Demoralization, Database, Relational Database Management System, Primary Key, 
Foreign key, indexing and entity Relationship Diagram etc.   
 

1. Database 

To find out what database is, it must have to start from data, which is the basic building 
block of any DBMS. 

Data: Facts, figures, statistics etc. having no particular meaning (e.g. 1, ABC, 19 etc.). 

Record: Collection of related data items, e.g. in the above example the three data items 
had no meaning. But organize them in the following way, and then they collectively 
represent meaningful information. 

Roll Name Age 

1 ABC 19 

 Relation (table): Collection of related records. 

Roll Name Age 

1 ABC 19 

2 DEF 22 

3 XYZ 28 

 The columns of this relation are called Fields, Attributes or Domains. The rows are called Tuples or Records. 

Database is an organized collection of related data that is stored in an efficient and compact manner. 

Organized means that data is stored in such a way that the user can use this data easily. 

Related means, database is normally created to store the data about a particular topic. 

Efficient means that the user can search the required data quickly. 

Compact means that the stored data occupies as little space as possible in computer. 
 

2. Database Management System 

A software system that enables users to define, creates, and maintains the database 
and which provides controlled access to this database. e.g. Oracle , MS Access, SQL 
Server and MySQL  

 

 

RDBMS stands for 
Relational Database 
Management 
System 

Remember 

Relational database 
was invented by E. 
F. Codd at IBM in 
1970 

Do you know! 

RDBMS is a 
database that is 
organized through 
the use of tables or 
files that are linked 
to each other. A 
good example of a 
RDBMS is Microsoft 
SQL or MySQL. 

RDBMS 

E.F Codd presented 
the 12 rules that all 
databases must 
follow to qualify as 
relational database. 

Do you know! 
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3. Keys in Database 

Keys are very important part of Relational database. They are used to establish and 
identify relation between tables. They also ensure that each record within a table can 
be uniquely identified by combination of one or more fields within a table. 

Super Key 

A Super key is any combination of fields within a table that uniquely identifies each 
record within that table.  

Candidate Key 

A candidate is a subset of a super key. A candidate key is a single field or the least combination of fields that 
uniquely identifies each record in the table. The least combination of fields distinguishes a candidate key from a 
super key. Every table must have at least one candidate key but at the same time can have several. 

                   Candidate Key 

 

S # Emp-ID Name CNIC City 

001 AL-DI Ahmad 35201-9696781-1 Gujrat 

002 AL-DI Qaisar 34501-3456789-0 Gujrat 

003 ALDI Mehar Muhammad 34501-0987651-1 Gujrat 

In order to be eligible for a candidate key it must pass certain criteria.  

 It must contain unique values 

 It must not contain null values 

 It contains the minimum number of fields to ensure uniqueness 

 It must uniquely identify each record in the table 

Once the candidate keys have been identified it can now select one to be primary key  

Primary Key 

Primary key is a candidate key that is most appropriate to become main key of the table. It is a key that uniquely 
identify each record in a table. 
 

Emp-ID Name Dept -Name Salary 

100 
140 
110 
150 

Munir 
Akmal 
Amir 

Shazia 

Software 
Hardware 
Marketing 
Software 

12,000 
11,000 
6,000 
45000 

Foreign Key 

A foreign key is generally a primary key from one table that appears as a field in another where the first table has 
a relationship to the second. In other words, if one had a table A with a primary key X that linked to a table B 
where X was a field in B, then X would be a foreign key in B.  

3 rules that apply to 
primary keys:            
1- Exist                      
2- Be unique.            
3- Not change over 
time (unique 
sustained existence)  

Remember 
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An example might be a student table that contains the course_id the student is attending. Another table lists the 
courses on offer with course_id being the primary key. The 2 tables are linked through course_id and as such 
course_id would be a foreign key in the student table.  
 

Student_ID Name Father’s_Name Course_Id 

LHR-03-WD-03 Qaisar Zahoor Zahoor Ahmed WD01 

LHR-02-CO-04 Ali Jaan Nawaz Ali CO02 

LHR-04-EL-05 Kawal Ali Akbar EL01 

 
         Relationship 

 

      Primary Key 

 

 

 

Composite Key 

Key that consists of two or more attributes that uniquely identify an entity occurrence is called Composite key. 
But any attribute that makes up the Composite key is not a simple key in its own. 

Registration 

Client No Branch No Staff No Date joined 

CR 76 
CR 56 
CR 74 
CR 74 

B005 
B006 
B005 
B006 

SL 41 
SG 37 
SG 37 
SA 9 

2-Jan-2005 
11-Apr-05 

17-March-05 
8-June-05 

In the Registration, relation Primary key is the combination of two attribute client No and Branch No So it is a 
composite Primary key. 

Secondary or Alternative key 

The candidate key which are not selected for primary key are known as secondary keys or alternative keys 

Non-key Attribute 

Non-key attributes are attributes other than candidate key attributes in a table. 

Non-prime Attribute 

Non-prime Attributes are attributes other than Primary attribute.  
 

4. Normalization of Database 

Database Normalization is a technique of organizing the data in the database. Normalization is a systematic 
approach of decomposing tables to eliminate data redundancy and undesirable characteristics like Insertion, 
Update and Deletion Ana molies. It is a multi-step process that puts data into tabular form by removing duplicated 
data from the relation tables. 

 

 

Course_ID Course Name 

WD01 
Web 
Development 

CO02 
Computer 
Application 

EL01 
Mobile Phone 
Repairing 

 

Foreign Key 



Module 5: Use Databases in Web Development 

204 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

Normalization is used for mainly two purpose, 

 Eliminating redundant (useless) data. 

 Ensuring data dependencies make sense i.e. data is logically stored. 

Normalization rule are divided into following normal form. 

 First Normal Form 

 Second Normal Form 

 Third Normal Form 

 BCNF 

First Normal Form (1NF) 

As per First Normal Form, no two Rows of data must contain repeating group of information i.e. each set of 
column must have a unique value, such that multiple columns cannot be used to fetch the same row. Each table 
should be organized into rows, and each row should have a primary key that distinguishes it as unique.  

The Primary key is usually a single column, but sometimes more than one column can be combined to create a 
single primary key. For example consider a table which is not in First normal form 

Student Table : 

Student Age Subject 

Adam 15 Biology, Maths 

Alex 14 Maths 

Stuart 17 Maths 

In First Normal Form, any row must not have a column in which more than one value 
is saved, like separated with commas. Rather than that, it must separate such data 
into multiple rows. 

Student Table following 1NF will be : 

 
 
 

Student Age Subject 

Adam 15 Biology 

Adam 15 Maths 

Alex 14 Maths 

Stuart 17 Maths 

Using the First Normal Form, data redundancy increases, as there will be many columns with same data in 
multiple rows but each row as a whole will be unique.  

Second Normal Form (2NF) 

As per the Second Normal Form there must not be any partial dependency of any column on primary key. It 
means that for a table that has concatenated primary key, each column in the table that is not part of the primary 
key must depend upon the entire concatenated key for its existence. If any column depends only on one part of 
the concatenated key, then the table fails Second normal form. 

Boyce and Codd 
Normal Form 
(BCNF) is a higher 
version of 3rd Normal 
Form or you can say 
4th Normal Form. 

Do you know! 
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In example of First Normal Form there are two rows for Adam, to include multiple subjects that he has opted for. 
While this is searchable, and follows First normal form, it is an inefficient use of space. Also in the above Table 
in First Normal Form, while the candidate key is {Student, Subject}, Age of Student only depends on Student 
column, which is incorrect as per Second Normal Form. To achieve second normal form, it would be helpful to 
split out the subjects into an independent table, and match them up using the student names as foreign keys. 

New Student Table following 2NF will be : 
 

Student Age 

Adam 15 

Alex 14 

Stuart 17 

In Student Table the candidate key will be Student column, because all other column i.e. Age is dependent on it. 

New Subject Table introduced for 2NF will be : 
 

Student Subject 

Adam Biology 

Adam Maths 

Alex Maths 

Stuart Maths 

In Subject Table the candidate key will be {Student, Subject} column. Now, both the above tables qualifies for 
Second Normal Form and will never suffer from Update Anomalies. Although there are a few complex cases in 
which table in Second Normal Form suffers Update Anomalies, and to handle those scenarios Third Normal Form 
is there. 

Third Normal Form (3NF) 

Third Normal form applies that every non-prime attribute of table must be dependent 
on primary key, or it can say that, there should not be the case that a non-prime 
attribute is determined by another non-prime attribute. So this transitive functional 
dependency should be removed from the table and also the table must be in Second 
Normal form. For example, consider a table with following fields.  

Student_Detail Table : 
 

Student_id Student_name DOB Street city State Zip 

In this table Student_id is Primary key, but street, city and state depends upon Zip. The dependency between zip 
and other fields is called transitive dependency. Hence to apply 3NF, it need to move the street, city and state to 
new table, with Zip as primary key. 

New Student_Detail Table : 
 

Student_id Student_name DOB Zip 

Address Table : 
 

Zip Street city state 

 
The advantage of removing transitive dependency is,  

Amount of data duplication is reduced. 

In the 1970s by IBM 
researchers 
Raymond Boyce 
and Donald 
Chamberlin 
developed SQL. 

Do you know! 
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Data integrity achieved. 

De-normalization 

De-normalization is the process of taking a normalized database and modifying table 
structures to allow controlled redundancy for increased database performance. Attempting to improve 
performance is the only reason to ever de-normalize a database. De-normalization may involve recombining 
separate tables or creating duplicate data within tables to reduce the number of tables that need to be joined to 
retrieve the requested data. A de normalized database should not be confused with a database that has never 
been normalized.  
 

5. Structure Query Language(SQL) 

What is SQL? 

SQL is a standard language for accessing databases 

 SQL stands for Structured Query Language 

 SQL gives access and manipulate databases 

 SQL is an ANSI (American National Standards Institute) standard 

What Can SQL do? 

 SQL can execute queries against a database 

 SQL can retrieve data from a database 

 SQL can insert records in a database 

 SQL can update records in a database 

 SQL can delete records from a database 

 SQL can create new databases 

 SQL can create new tables in a database 

 SQL can create stored procedures in a database 

 SQL can create views in a database 

 SQL can set permissions on tables, procedures, and views 

Using SQL in the Web Site 

To build a web site that shows data from a database, 

 An RDBMS database program (i.e. MS Access, SQL Server, MySQL) 

 To use a server-side scripting language, like PHP or ASP 

 To use SQL to get the data as required 

 To use HTML / CSS 

 

RDBMS 

RDBMS stands for Relational Database Management System. 

RDBMS is the basis for SQL, and for all modern database systems such as MS SQL Server, IBM DB2, Oracle, 
MySQL, and Microsoft Access. The data in RDBMS is stored in database objects called tables. A table is a 
collection of related data entries and it consists of columns and rows. 

Some of The Most Important SQL Commands 

 SELECT - extracts data from a database 

 UPDATE - updates data in a database 

 DELETE - deletes data from a database 

 INSERT INTO - inserts new data into a database 

 CREATE DATABASE - creates a new database 

SQL is pronounced 
as SEQUEL 

Remember 
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 ALTER DATABASE - modifies a database 

 CREATE TABLE - creates a new table 

 ALTER TABLE - modifies a table 

 DROP TABLE - deletes a table 

 CREATE INDEX - creates an index (search key) 

 DROP INDEX - deletes an index  

SELECT Statement 

The SELECT statement is used to select data from a database. The result is stored in a result table, called the 
result-set. 

SQL SELECT Syntax 

SELECT column_name,column_name 
FROM table_name; 

and SELECT * FROM table_name; 

Select * will select all columns of table while select column_name will select only specific column from table.  

WHERE Clause  

The WHERE clause is used to extract only those records that fulfill a specified criterion. 

SQL WHERE Syntax 

SELECT column_name,column_name 
FROM table_name 
WHERE column_name operator value; 

Example  

SELECT * FROM Customers 
WHERE City='lahore'; 

Operators in The WHERE Clause 

The following operators can be used in the WHERE clause: 

Operator Description 

= Equal 

<> Not equal. Note: In some versions of SQL this operator may be written as != 

> Greater than 

< Less than 

>= Greater than or equal 

<= Less than or equal 

BETWEEN Between an inclusive range 

LIKE Search for a pattern 

IN To specify multiple possible values for a column 
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AND & OR Operators 

The AND operator displays a record if both the first condition AND the second condition are true. The OR operator 
displays a record if either the first condition OR the second condition is true. 

SELECT * FROM Customers 
WHERE Country='Pakistan' 
AND City='Islamabad'; 

Combining AND & OR 

Combine AND & OR (use parenthesis to form complex expressions). 

SELECT * FROM Customers 
WHERE Country='Germany' 
AND (City='Rawalpindi' OR City='Lahore'); 

ORDER BY Keyword 

The ORDER BY keyword is used to sort the result-set by one or more columns. 

The ORDER BY keyword sorts the records in ascending order by default. To sort the records in a descending 
order, it can use the DESC keyword. 

SQL ORDER BY Syntax 

SELECT column_name,column_name 
FROM table_name 
ORDER BY column_nameASC|DESC,column_name ASC|DESC; 

Example 

SELECT * FROM Customers ORDER BY Country DESC; 

SQL INSERT INTO Statement 

The INSERT INTO statement is used to insert new records in a table. 

SQL INSERT INTO Syntax 

It is possible to write the INSERT INTO statement in two forms.  

The first form does not specify the column names where the data will be inserted, only their values: 

INSERT INTO table_name 
VALUES (value1,value2,value3,...); 

The second form specifies both the column names and the values to be inserted: 

INSERT INTO table_name (column1,column2,column3,...) 
VALUES (value1,value2,value3,...); 

INSERT INTO Example 

To insert a new row in the "Customers" table. 

Use the following SQL statement: 
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INSERT INTO Customers (CustomerName, ContactName, Address, City, PostalCode, Country) 
VALUES ('Atif','Mehmood',’E-Block F7/2’,’Islamabad’,’5400’,’Pakistan’); 

UPDATE Statement 

The UPDATE statement is used to update existing records in a table. 

SQL UPDATE Syntax 

UPDATE table_name 
SET column1=value1,column2=value2,... 
WHERE some_column=some_value; 

Example 

UPDATE Customers 
SET ContactName='Alfred Schmidt', City='Hamburg' 
WHERE CustomerName='AlfredsFutterkiste'; 

DELETE Statement 

The DELETE statement is used to delete rows in a table. 

SQL DELETE Syntax 

DELETE FROM table_name 
WHERE some_column=some_value;  

Example 

DELETE FROM Customers 
WHERE CustomerName='AlfredsFutterkiste' AND ContactName='Maria Anders'; 

CREATE DATABASE Statement 

The CREATE DATABASE statement is used to create a database. 

SQL CREATE DATABASE Syntax 

CREATE DATABASE dbname; 

SQL CREATE DATABASE Example 

The following SQL statement creates a database called "my_db": 

CREATE DATABASE my_db; 

Database tables can be added with the CREATE TABLE statement. 

CREATE TABLE Statement 

The CREATE TABLE statement is used to create a table in a database. 

Tables are organized into rows and columns; and each table must have a name. 

SQL CREATE TABLE Syntax 
CREATE TABLE table_name 
( 
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column_name1 data_type(size), 
column_name2 data_type(size), 
column_name3 data_type(size), 
.... 
); 

Example 

CREATE TABLE Persons 
( 
PersonIDint, 
LastName varchar(255), 
FirstName varchar(255), 
Address varchar(255), 
City varchar(255) 
); 

SQL Constraints 

SQL constraints are used to specify rules for the data in a table. 

 If there is any violation between the constraint and the data action, the action is aborted by the constraint. 

Constraints can be specified when the table is created (inside the CREATE TABLE statement) or after the table 
is created (inside the ALTER TABLE statement). 

SQL CREATE TABLE + CONSTRAINT Syntax 

CREATE TABLE table_name 
( 
column_name1 data_type(size) constraint_name, 
column_name2 data_type(size) constraint_name, 
column_name3 data_type(size) constraint_name, 
.... 
); 

 In SQL, following constraints are used: 

 NOT NULL - Indicates that a column cannot store NULL value 

 UNIQUE - Ensures that each row for a column must have a unique value 

 PRIMARY KEY - A combination of a NOT NULL and UNIQUE. Ensures that a column (or combination 
of two or more columns) have an unique identity which helps to find a particular record in a table more 
easily and quickly 

 FOREIGN KEY - Ensure the referential integrity of the data in one table to match values in another table 

 CHECK - Ensures that the value in a column meets a specific condition 

 DEFAULT - Specifies a default value when specified none for this column 
 

6. Entity Relationship Diagram 

An entity relationship diagram (ERD) shows the relationships of entity sets stored in a database. An entity in this 
context is a component of data. In other words, ER diagrams illustrate the logical structure of databases. 
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At first glance an entity relationship diagram looks very much like a flowchart. It is the specialized symbols, and 
the meanings of those symbols, that make it unique. 

 

The History of Entity Relationship Diagrams 

Peter Chen developed ERDs in 1976. Since then Charles Bachman and James Martin have added some slight 
refinements to the basic ERD principles. 

Structure of an Entity Relationship Diagram with Common ERD Notations 

An entity relationship diagram is a means of visualizing how the information a system produces is related. There 
are five main components of an ERD: 

 Entities, which are represented by rectangles. An entity is an object or concept about which, information 
is to be stored in databases. 

 

 A weak entity is an entity that must defined by a foreign key relationship with another entity as it cannot 
be uniquely identified by its own attributes alone.  

 

 Relationship, which are represented by diamond shapes, show how two entities share information in 
the database.  

 

 In some cases, entities can be self-linked. For example, employees can supervise other employees. 
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 Attributes, which are represented by ovals. A key attribute is the unique, distinguishing characteristic of 
the entity. For example, an employee's social security number might be the employee's key attribute. 

 

A multivalued attribute can have more than one value. For example, an employee entity can have multiple 
skill values.  

A derived attribute is based on another attribute. For example, an employee's monthly salary is based 
on the employee's annual salary.  

 

 Connecting lines, solid lines that connect attributes to show the relationships of entities in the diagram. 

 

 Cardinality specifies how many instances of an entity relate to one instance of another entity. Ordinarily 
is also closely linked to cardinality. While cardinality specifies the occurrences of a relationship, ordinarily 
describes the relationship as either mandatory or optional. In other words, cardinality specifies the 
maximum number of relationships and ordinarily specifies the absolute minimum number of relationships. 

 

There are many notation styles that express cardinality. 
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Entity Relationship Diagram Uses 

When documenting a system or process, looking at the system in multiple ways increases the understanding of 
that system. ERD diagrams are commonly used in conjunction with a data flow diagram to display the contents 
of a data store. They help us to visualize how data is connected in a general way, and are particularly useful for 
constructing a relational database. 

How to Create an Entity Relationship Diagram 

Here are some best practice tips for constructing an ERD: 

 Identify the entities. The first step in making an ERD is to identify all of the used entities. An entity is 
nothing more than a rectangle with a description of something that the system stores information about. 
This could be a customer, a manager, an invoice, a schedule, s student, a patient etc. Draw a rectangle 
for each entity. Keep them spaced out a bit. 

 

 Identify relationships. Look at two entities, are they related? If so draw a solid line connecting the two 
entities. 

 Describe the relationship. How are the entities related? Draw an action diamond between the two 
entities on the line just added. In the diamond write a brief description of how they are related. 

 Add attributes. Any key attributes of entities should be added using oval-shaped symbols.  

 Complete the diagram. Continue to connect the entities with lines, and adding diamonds to describe 
each relationship until all relationships have been described. Every entity may or may not have any 
relationships, some may have multiple relationships. 
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7. Difference between Open Source and License Database 

Open Source / free database software 

The terms "free software licenses" and "open-source licenses" are usually interchangeable. While there is no 
one universally agreed-upon definition of free software, various groups maintain approved lists of licenses. The 
Open Source Initiative is one such organization keeping a list of "open source" licenses. The Free Software 
Foundation maintains a list of what it considers free. 

Free Software provides the user's 4 essentials freedoms to use the program, to study and modify it, to copy it, 
and redistribute it for any purpose. While open-source criteria focuses only on the availability of the source code. 

License / Paid software 

Every piece of software – even free software - has some kind of software license. They’re often lengthy and 
difficult to read, and usually cover these key points: 

 Use of how many copies of the software. It is possible to install a software on to lots of computers in 
a business, or just one? 

 What organizations can use the software? Some licenses are for charities, students or home users. 
These are cheaper, but can’t be used by businesses. 

 How long a software can be used? Perpetual software licenses last forever. But some license 
agreements expire unless to renew them. 

A license agreement may also include information about upgrading or reselling the software (resale is usually 
prohibited), and any steps might to take to activate the software. 

Make sure any license agreement meets the needs, and understand the restrictions and cost implications before 
agreeing to it. 
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Learning Unit 2: Database Management Systems 

Overview 

In this leaning unit, the learner will be introduced to how to use different Relational 
Database Management Systems. After the completion of this unit, the learner will be 
able to design, create and manage database in any Database Management System 
like MS Access, MySQL and MS SQL.   
 
 

1. Comparative Study of Different Database Management System 

MS Access 

Microsoft Access is the database application from the Microsoft Office Suite of 
applications. It is a powerful personal database and data manipulation tool that is also 
widely used in many small businesses. 

Access allows the user to create “forms " and "reports". A form shows one record in a 
user-designed format and allows the user to step through records one at a time. A report shows selected records 
in a user-designed format, possibly grouped into sections with different kinds of total (including sum, minimum, 
maximum, average). 

  
There are also facilities to use links (" joins ") between tables which share a common field and to filter records 
according to certain criteria or search for particular field values. 

MS SQL Sever  

SQL Server is Microsoft's relational database management system (RDBMS). It is a full-featured database 
primarily designed to compete against competitors Oracle Database (DB) and MySQL. 

SQL Server is offered in several editions with different feature set and pricing options to meet a variety of user 
needs, including the following: 

 Enterprise: Designed for large enterprises with complex data requirements, data warehousing and Web-
enabled databases. Has all the features of SQL Server, and its license pricing is the most expensive.  

 Standard: Targeted toward small and medium organizations. Also supports e-commerce and data 
warehousing. 

 Workgroup: For small organizations. No size or user limits and may be used as the backend database 
for small Web servers or branch offices. 

 Express: Free for distribution. Has the fewest number of features and limits database size and users. 
May be used as a replacement for an Access database. 

MySQL 

MySQL is a freely available open source Relational Database Management System (RDBMS) that uses 
Structured Query Language (SQL). 

SQL is the most popular language for adding, accessing and managing content in a database. It is most noted 
for its quick processing, proven reliability, ease and flexibility of use. MySQL is an essential part of almost every 
open source PHP application. Good examples for PHP/MySQL-based scripts are phpBB, osCommerce and 
Joomla. 

MS Access has an 
.mdb extension 

Do you know! 

255 users can work 
in MS Access at 
same time.  

Remember 
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One of the most important things about using MySQL that online there are many free web hosting database 
server that provide the MySQL free hosting like www.000webhost.com. 
 

2. Procedure to Install MySQL 

XAMPP for Windows provides an easy to install Apache-MySQL-PHP-PERL-PEAR framework. XAMPP saves 
time and effort and provides the software support for web frameworks like Drupal, Joomla or Moodle on any 
Windows PC. 

Steps 

 

 

2-Click on the download link for XAMPP. 

 
 

http://www.000webhost.com/
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3-When prompted for the download, click "Save" and wait for the download to finish. 

 

4-Once the download is complete, install the program, click on "Run" 

 

5-Accept the default settings. A command will open and offer an initial installation prompt. Just hit the Enter 
key, and accept the default settings. To simplify installation, just hit ENTER when prompted on the command 
line.  

 

6-When the installation is complete, exit the command window by typing x on the command line. 

http://www.wikihow.com/Install-XAMPP-for-Windows#/Image:Install-XAMPP-for-Windows-Step-5-Version-3.jpg
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7-Start the XAMPP Control Panel. 

 

8-Start the Apache and MySQL Components.  

 

9-Verify the Apache install, by clicking on the Apache administrative link in the Control Panel. 
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10-Verify the MySQL installation, by clicking on the MySQL administrative link in the XAMPP Control Panel. 

If the verification steps are successful, XAMPP should be successfully installed on the PC. 
 

3. MYSQL 

What is PhpMyAdmin 

PhpMyAdmin is a free software tool written in PHP, intended to handle the administration of MySQL over the 
Web. PhpMyAdmin supports a wide range of operations on MySQL, MariaDB and Drizzle. Frequently used 
operations (managing databases, tables, columns, relations, indexes, users, permissions, etc.) can be performed 
via the user interface, have the ability to directly execute any SQL statement. 

In the following pages of our PhpMyAdmin describe the functionality of the software, integrated in cPanel. 

 

In the upper part, find the server hostname, the databases will manage stored on the same server as the software 
and the hostname is: localhost. 

Under it there is information regarding the MySQL server, the MySQL client and the PhpMyAdmin version. 

Next, the MySQL charset and will be able to define the MySQL connection collation. 

In the right column formatting (style, color, & font etc.) and language option come to alter and customize, also 
available option to links PhpMyAdmin resources. 

To create a new database from cPanel->MySQL Databases, navigate to the Create New Database box, enter 
the database name in the New Database text field and click on the Create Database button. The database name 
will start with the cPanel user name. For example if cPanel user name is user and have a database named test, 
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the actual database name will be user_test. In the left panel, the list of the databases for which cPanel user has 
privileges. 

The main PhpMyAdmin areas are as follows: 

Databases 

In the Databases tab, a list with all the databases which can be managed through the cPanel user, click on a 
chosen database, start its management. Please note that the enabling of the statistics will increase the load 
caused by account on the server.  

 

Status 

Open the Status tab by clicking on the Show MySQL runtime information link. There is all detailed information 
regarding the MySQL server since the last restart. 

 

The traffic handled by the MySQL server, the maximum number of simultaneous connections, the total number 
of connections, the failed and the aborted attempts, the total number of queries sent to the server and more 
related details. 

Variables 

The Variables tab will be opened after clicking on the Show MySQL system variables link. 
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Find a list with the MySQL server system variables and their values. 

Processes 

By clicking on the Processes link, find all the processes running by cPanel user. 

 

Charsets 

The Character Sets and Collations link leads to the Charset area. 

 

Engines 

The Storage Engines link opens a list with all the engines supported by the MySQL server. The default one is 
MyISAM. Another popular storage engine, used by many databases is InnoDB. More about the MySQL storage 
engines can be found in the official documentation. 
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Export 

In the Export section, export the database table’s content in different formats (CSV, SQL, PDF, Microsoft Excel, 
Microsoft Word, XML, and many more).  

 

Can be added custom comments in the header of the exported content.it can be export the database tables in a 
file and compress it or visualize the queries directly on the screen. 

Import 

Importing of the database tables from a file, saved on the local computer can be possible by Import Section. 

 

Database Management  

The main functionality of the PhpMyAdmin tool is to manage the databases. 

Click on the Databases link. Pick the preferred database need to manage and click on its name. 
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In the new screen, find a list with the database tables, the allowed actions with them, and the number of the 
records, the storage engine, the collation, the tables' sizes and the overhead. 

 

The possible actions which can be performed to a chosen table are: 

Browse 

Only the tables with existing records can be browsed. Once click on the Browse icon a new window with the 
records list will be opened. 

 

By clicking on the Pen icon, edit the chosen record, record structure and alter the values of the records as 
required. 

Structure 

The next option is named Structure. In the Structure screen of database's table structure. 
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See the fields' names, their types, collations, attributes, additional extra information, the default values and 
whether the fields' values can be NULL. Browse for distinct values by clicking on the corresponding action icon, 
also, edit a field's structure or delete a field. Can be defined different indexes: Primary, Unique, Index and Fulltext.  

In the Indexes area, the indexes assigned for the table and the fields for which they are set can be edited (update. 
Add & delete) 

Additionally, in the same screen, Space Usage and the Row Statistics can be checked. 

Search 

Through the Search action, generate a search query for the chosen table. 

 

Write the WHERE clause or use the "query by example" functionality. For example, if one wants to visualize all 
the records with a field value that starts with, fields which want to show. Pick the LIKE operator from the drop-
down menu and enter in the corresponding field value a% (% stands for a wildcard string). Click on the Go button 
to see the result. 

Insert 

Using the Insert action to insert records in the database table. 

 

Fill in the corresponding values click on the Go button and the new record will be inserted. 
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Empty 

The Empty action allows to empty the database table, removing the data and keeping the empty table. 

 

Drop 

Through the Drop action, delete the whole table and all the records stored in it. 

Create Database  

Follow the steps in order to create a new database, add a table with records, create a database backup and 
perform a database restore procedure. 

How to Create a MySQL Database? 

It cannot be possible to create a database directly through cPanel->PhpMyAdmin due to the lack of user 
privileges. However, it is easily create a new database from cPanel->MySQL Databases. Navigate to the Create 
New Database box. Enter the database name in the New Database text field and click on the Create Database 
button. 

 

 The database name will be preceded by the cPanel username.  
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How to Add MySQL Database Tables? 

Navigate to cPanel->PhpMyAdmin tool and open the newly create database. It is empty and there are no tables. 

 

 Enter the table name and the number of fields. Click on the Go button to create the table. On the next screen, 
enter the fields' names and the corresponding properties. The properties are: 

Type 

Pick the appropriate type of the data, which will be stored in the corresponding field. More details about the 
possible choices can be found in the official MySQL Data Types documentation. 

Length/Values 

Enter the appropriate length of the field.  If the field type is "enum" or "set", enter the values using the following 
format: 'a','b','c'... 

Collation 

Pick the data collation for each of the fields. 

Attributes 

The possible attributes' choices are: 

BINARY - the collation for the field will be binary, for example utf8_bin; 

UNSIGNED -  the field numeric values will be positive or 0; 

UNSIGNED ZEROFILL - the field numeric values will be positive or 0 and leading zeros will be added to a number; 

ON UPDATE CURRENT_TIMESTAMP - the value for a data type field has the current timestamp as its default 
value, and is automatically updated; 

Null 

Check whether the field value can be NULL. More about the NULL value can be found in the corresponding 
MySQL documentation. 

Default 

Allows to set the default value for the field. 
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Extra 

In the Extra property, define whether the field value is auto-increment. 

The radio buttons that come below define whether there is an Index defined for the particular field and specify 
the Index type. 

Comments 

Add comments, which will be included in the database sql code. 

At the end, include Table comments and pick the MySQL Storage Engine and the Collation, click on the Save 
button. 

 

To add more fields, specify their number and click on the Go button instead of Save. The database table will be 
created  

 

How to Add Content in a Database Table? 

In order to add records in a database table click on the Insert tab. 
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Enter the data in the corresponding fields and click on the Go button to store it. 

At the bottom of the page, see a drop-down menu labelled Restart insertion with x rows, pick the number of the 
rows that need to populate with data and insert at once. By default the value is 2. 

The Ignore check box will allow to ignore the data entered below it. It will not be added. To view the newly inserted 
record, click on the Browse tab. 

 

How to Back up a Database? 

To create a backup of the required database use the Export tab. 

 

Select the tables which are required to export, leave the radio button selection to the SQL option.  The Structure 
and the Data check boxes should remain checked. 

Select the Save as file check box and then click on the Go button. 
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In case of a large database with a lot of records, the server timeout value can be reached. In such a case, export 
the database in several batches.  

How to Restore a Database Backup? 

To restore the required database backup from the Import tab.  

Click on the Browse button to select the required database backup file from the local computer. 

Pick the charset of the file from the corresponding drop-down menu. 

 

Run MySQL Query  

There are two options to run a MySQL query.  

The one for advanced users is through the SQL tab, should enter the entire SQL query code and click on the Go 
button to execute it. 

 

The other option is to construct a MySQL query in the Query tab. 
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There one can define different search conditions, sort the results and query multiple tables. Select the tables 
used in the query from the Use Tables list. 

The fields which will be included in the SELECT MySQL statement should be picked from the Field drop-down 
menus. The Show check box should be selected. 

In the Criteria text field, enter the criteria according to which the search will be completed. Through the Sort drop-
down menu, visualize the result sorted in an ascending or a descending order. The text window located below 
allows to add extra search conditions. 

In the Modify section, to define the relations between the fields (whether they are connected through the AND or 
the OR logical operators), click on the Update Query button to complete the modifications. 

To run the query click on the Submit Query button. 

The query which have included in our example is: 

SELECT `AT_admins` . * FROM AT_admins WHERE (`AT_admins`.`login` LIKE "a%"); 

It shows all the records from the AT_admins table for which the login field starts with "a". 

PhpMyAdmin Database Operation 

There are different operations which can be performed on the whole database or on a separate table. 

Database Operations 

Select a database and navigate to the Operations tab, find all the possible actions which can be applied on a 
database. 
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 Allows to create a new table under the current database. Enter the table name and the number of the 
fields. Then click on the Go button. 

 The second option is called Rename database to. However, the action cannot be performed directly 
through the PhpMyAdmin area due to lack of privileges for the user.  

 The last option allows to change the database collation. Pick the preferred one from the drop-down menu 
and confirm the modification by clicking on the Go button. 

Database Tables Operations 

In order to perform the corresponding operations on a database table, select one and click on the Operations 
tab. 

 

The Alter table order by option allows to change the listing order for the table's records. It can be ascending or 
descending. Pick the field on which to base the sorting. Click on the Go button to confirm choice. 

The Move table to option allows to move the table with a new name under the current database or to move it 
under a different database. 

In the Table options section can be renamed the table, insert comments, change the storage engine and the 
collation, additionally, Using the pack_keys option. It takes effect only with MyISAM tables. It packs the keys. 
When the DEFAULT choice is selected, the storage engine packs only long CHAR, VARCHAR, BINARY and 
VARBINARY columns. When 1 is selected numbers columns are packed along with the strings. The 0 choice 
disables the packing of keys. 

Also, there are 2 more check-boxes. When the checksum option is enabled the table checksum is calculated. 
The delay_key_write option makes the index updates faster because they are not flushed to disk until the table 
is closed. 

Using the Copy table option to copy the table with a new name under the current database or it can be duplicated 
in another database. 

Under the Table Maintenance section, find different options which help to maintain the database table: 

 Check table - checks the table and the views associated with it for errors and problems;  

 Analyze table - analyses and stores the key distribution for the table. Then the MySQL server uses the 
stored key distribution for JOIN operations and for decisions which index to be used in a table query; 

 Repair table - repairs a possibly corrupted table; 

 Optimize table - the action should be performed when required to delete or modify many records from 
the table. It will reclaim the used space, defragment the data file removing the overhead and sort the 
indexes. 

 Flush the table - clears and reloads the internal cache related to the table. 
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Learning Unit 3: Database Designing of Website in 
Database Management System 

Overview 

In this leaning unit, learner will be introduced and demonstrate database designing for a web project. After the 
completion of this unit, the learner will be able to create Entity Relationship Diagram of any projects, create 
Database in MySQL, and create Tables in MySQL of web project. 
 

1. Database Designing for Web Project 

Databases are everywhere, including everywhere in the world of web development. Everything from the simplest 
blogs and directories and to robust user-oriented websites use databases. No matter how complex or simple the 
website and corresponding database may be though, each takes careful planning in order to run efficiently and 
also securely. 

Over the basics of how to design a good plan for a database, no matter what its final intended use. For all 
database designs, there are a set of standard rules and best practices to follow, all of which can help a database 

stay organized and help to team up with the respective site in a smart and efficient way. 

What Functionality is Needed from the Database? 

The first method for planning for a database is to simply brainstorm, on paper or otherwise, concerning what the 
database will need to store, and what the site will need out of it. Try not to think of the individual fields or tables 
that will be needed at this point - all that specific planning can take place later. The goal is to start with a general 
and complete view, and narrow down. It can often times be more difficult to add in items later, rather than get it 
right the first time. 

 

 
Think outside the Database. Try to think about what the website will need to do. For example, if a membership 
website is needed, the first instinct may be to begin thinking of all the data each user will need to store. Forget it, 
that's for later. Rather, write down that users and their information will need to be stored in the database, and 
what else? What will those members need to do on the site? Will they make posts, upload files or photos, or send 
messages? Then the database will need a place for files/photos, posts, and messages. 

What information will they need to derive from the site? Will they need to search for their favorite recipe, be able 
to access member-only content, or need to look up products and their recently purchased or viewed products? 
Then the database will need a place to hold those recipes, a place for content that is defined as members-only 
or not, or hold all products and create a method to link certain products to a specific member. 
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Determining Tables and Fields 

The next phase would be to begin determining exactly what tables and fields one would need in the database. 
This is the core of database design, and the most difficult part. Using correct methods for linking tables together, 
sorting the data within each table correctly, and grouping it or keeping it separate are all arising problems when 
it comes to database design. At this point, list out what tables and fields are clear at this point, trying to be as 
specific as possible. Through the process, items can be rearranged or reorganized to improve the database's 
efficiency and security. 

Use a Data Modeling Tool 

It’s time to organize what exact information needs to be stored. A great database design tool can be helpful for 
this; specifically one that can help set up visual database models, such as MySQL Workbench (for MySQL 
databases only). 

Relational Databases 

Almost all databases are relational databases. This means that the tables in the database are related to each 
other in some way. For example, if a there is a member on an ecommerce website, that member may be related 
to certain products based on what they ordered last, or what they have expressed they are interested in. For a 
blog database, authors would have to be somehow related to the posts they wrote, and logged in users could be 
related to any comments they've left. 

By using the techniques for relational databases, which can store plenty of information in an organized fashion 
within separate tables: one table for members, one for posts, another for comments, and yet another for products. 
Then, it can link the data between different tables together via unique keys. 

 

Every entry in every table needs a Unique Primary Key. This is the "social security 
number" or "bar code" for each entry. It is unique to each entry, and no other entry can 
have the same ID in the same table. Having unique usernames or product names in a 
database table is not enough. It is far more efficient, and best practice as well, to use 
unique primary keys. Even with other types of unique fields, a database is still 
vulnerable to duplicate records, which can later break code within the website.  

To relate two tables, use a foreign key, which is just a number ID that references a 
unique key in another table, usually our primary key. As an example, see that our first 
table (below) for authors has three authors with their own unique ID. In the separate 

articles table, we link each article to an author via that ID. Now look up the author for the first article, and vice 
versa, see that Tom has two articles, Mary has one, and Jane has none yet. 

The best way to 
improve the 
performance of 
SELECT operations 
is to create indexes 

Remember 

MySQL supports up 
to 64 indexes per 
table. Each index 
may consist of 1 to 
16 columns. The 
maximum index size 
is 1000 bytes. 

Do you know! 
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This is a simple one-to-one relationship model. There are also models for one-to-many and many-to-many 
relationships.  

Grouping or Separating Data info Fields 

Within fields, it's also important to know when to group certain pieces of data together, and when to keep them 
separate. A good way to determine which information should be in the same field or otherwise is to think about 
what it would take to change that piece of information if necessary. For example, would it be necessary to place 
a full address in separate fields, based on 1) street address, 2) city, 3) state, 4) zip code, and then 5) country? 

Is it essential for the functionality of the site (perhaps users or admins would need to search addresses by state 
only), or is it just a waste of fields and database space? If it's not essential, just to change an address the database 
would have to update five separate fields, when it could just update one field in string form. In order to keep such 
a field organized, one could take in the information via an HTML form with these fields separated, but then 
concatenate them into one single string before placing the address into the database. 

This is just one example, but always keep in mind the most efficient ways to organize table fields, and when to 
combine them, or when to keep them separate for the sake of the website's functionality. 

Database Normalization 

Database normalization is a set of guidelines created by the community for organizing data in a database 
efficiently. It mentioned a few of the most important and basic practices already, which are included in some of 
the most standard normalization forms. There are five normal forms to follow, and it's a good idea to learn about 
these five forms in order to conform any database's design to their best practices. 

2. Implementing Indexing to the Database 

Indexes are used to find rows with specific column values quickly. Without an index, MySQL must begin with the 
first row and then read through the entire table to find the relevant rows. The larger the table, the more this costs. 
If the table has an index for the columns in question, MySQL can quickly determine the position to seek to in the 
middle of the data file without having to look at all the data. This is much faster than reading every row 
sequentially.  

Most MySQL indexes (PRIMARY KEY, UNIQUE, INDEX, and FULLTEXT) are stored in B-trees. Exceptions are 
that indexes on spatial data types use R-trees, and that MEMORY tables also support hash indexes.  

MySQL uses indexes for these operations:  

 To find the rows matching a WHERE clause quickly.  

 To eliminate rows from consideration. If there is a choice between multiple 
indexes, MySQL normally uses the index that finds the smallest number of 
rows (the most selective index).  

The maximum size 

of a row in a MySQL 

table is 65,535 bytes 

Do you know! 
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 If the table has a multiple-column index, any leftmost prefix of the index can be used by the optimizer to 
look up rows. For example, if there are a three-column index on (col1, col2, col3), and have indexed 
search capabilities on (col1), (col1, col2), and (col1, col2, col3 

 To retrieve rows from other tables when performing joins. MySQL can use indexes on columns more 
efficiently if they are declared as the same type and size. In this context, VARCHAR and CHAR are 
considered the same if they are declared as the same size. For example, VARCHAR(10) and CHAR(10) 
are the same size, but VARCHAR(10) and CHAR(15) are not.  

For comparisons between no binary string columns, both columns should use the same character set. For 
example, comparing a utf8 column with a latin1 column precludes use of an index.  

Comparison of dissimilar columns (comparing a string column to a temporal or numeric column, for example) 
may prevent use of indexes if values cannot be compared directly without conversion. For a given value such as 
1 in the numeric column, it might compare equal to any number of values in the string column such as '1', ' 1', 
'00001', or '01.e1'. This rules out use of any indexes for the string column.  

 To find the MIN() or MAX() value for a specific indexed column key_col. This is optimized by a 
preprocessor that checks whether one is using WHERE key_part_N = constant on all key parts that occur 
before key_col in the index. In this case, MySQL does a single key lookup for each MIN() or MAX() 
expression and replaces it with a constant. If all expressions are replaced with constants, the query 
returns at once. For example:  

 SELECT MIN(key_part2),MAX(key_part2) 

 FROM tbl_name WHERE key_part1=10; 

 To sort or group a table if the sorting or grouping is done on a leftmost prefix of a usable index (for 
example, ORDER BY key_part1, key_part2). If all key parts are followed by DESC, the key is read in 
reverse order.  

 In some cases, a query can be optimized to retrieve values without consulting the data rows. (An index 
that provides all the necessary results for a query is called a covering index.) If a query uses from a table 
only columns that are included in some index, the selected values can be retrieved from the index tree 
for greater speed:  

 SELECT key_part3 FROM tbl_name 

   WHERE key_part1=1 

Indexes are less important for queries on small tables, or big table where report queries process most or all of 
the rows. When a query needs to access most of the rows, reading sequentially is faster than working through 
an index. Sequential reads minimize disk seeks, even if not all the rows are needed for the query. 
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Learner’s Activities 
 

Developing a ERD of Web Project 

 
Description:    This activity will be performed by individual. 

 Each student has basic concept of database and know how to develop ERD 
of any project. 

 Course Instructor will assign a web project to each student. 
 

Time Guideline: 2 hours 

Purpose:  To be able to develop entity relationship diagram of any project. 
Individual will draw ERD at chart 

Presentation:  
 

Individual will present relationship between entities of ERD before class.  

Developing a Database of Web Project in MySQL 

 
Description:    This activity will be performed by individual. 

 This activity will start upon successful completion of ERD development 
activity. 

 Each student has basic knowledge of MySQL and basic working experience 
of working in PhpMyAdmin IDE for MySQL. 
 

Time Guideline: 2 hours 

Outcome:  To be able to develop Database in MySQL using PhpMyAdmin IDE and will able 
to import and export created database in .sql file. 
Individual will keep record of .sql file and submit it teacher after showing Database 
Tables before class. 
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Summary of Module 

  A modern database is an efficient way to organize, and gain access to, large amounts of data. A 
relational database is able to create relationships between individual database elements, to organize 
data at a higher level than a simple table of records, avoid data redundancy and enforce relationships 
that define how the database functions. 

  RDBMS is the basis of all SQL databases like; MS SQL Server, Sysbase, Oracle, MySQL, etc. It 
works on the base of a relational database model. The RDBMS stores all its data in the form of an 
object that is called Table. A Table consists of columns, rows, and related data entry fields. 

  SQL is the standard language for Relation Database System. All relational database management 
systems like MySQL, MS Access, and Oracle, Sybase, Informix, postgres and SQL Server use SQL 
as standard database language. 

  MySQL is a free, open-source database engine available for all major platforms. (Technically, MySQL 
is a relational database management system (RDBMS).) MySQL represents an excellent introduction 
to modern database technology, as well as being a reliable mainstream database resource for high-
volume applications. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  Why a database is called as relational database model? 

Answer 

A database model represents the relationship between one or more databases. The relationship 
is known as the relational database model. It is an extension of the normal databases without 
relations. It provides flexibility and allows one database to be in relation with another database. 
It can access the data from many databases at one time over the network.  

FAQ 2:  What do you understand by relation in relational database model? 

Answer 

Relation in the relational database model is defined as the set of tuples that have the same 
attributes. Tuple represents an object and also the information that the object contains. Objects 
are basically instances of classes and used to hold the larger picture. Relation is described as a 
table and is organized in rows and columns. The data referenced by the relation come in the 
same domain and have the same constraints as well. Relations in the relational database model 
can be modified using the commands like insert, delete etc.  

FAQ 3:  What are constraints in database? 

Answer 

Constraints are kind of restrictions that are applied to the database or on the domain of an 
attribute. For example an integer attribute is restricted from 1-10 and not more than that. They 
provide the way to implement the business logic and the rules in database. In database it can be 
implemented in the form of check constraints that checks for the rules that haven’t been followed 
by the programmer. Constraint also used to restrict the data that can be stored in the relations. 
Domain constraint can be applied to check the domain functionality and keep it safe. 

FAQ 4:  What is the difference between primary and foreign key? 

Answer 

Primary key uniquely identify a relationship in a database, whereas foreign key is the key that is 
in other relation and it has been referenced from the primary key from other table. 

• Primary key remains one only for the table, whereas there can be more than one foreign 
key. 

• Primary key is unique and won’t be shared between many tables, but foreign key will be 
shared between more than one tables and will be used to tell the relationship between 
them. 

FAQ 5:  What is an index represent in relational database model? 

Answer 

Index is a way to provide quick access to the data and structure. It has indexes maintain and can 
be created to combine attributes on a relation. Index allows the queries to filter out the searches 
faster and matching data can be found earlier with simplicity. For example it is same as the book 
where by using the index it can directly jump to a defined section. In relational database there is 
a provision to give multiple indexing techniques to optimize the data distribution.  

FAQ 6:  What do understand by database Normalization? 

Answer 

Normalization is very essential part of relational model. It consists of set of procedures that 
eliminates the domains that are non-atomic and redundancy of data that prevents data 
manipulation and loss of data integrity. Normal forms are the common form of normalization. It 
helps in reducing redundancy to increase the information overall. It has some disadvantages as 
it increases complexity and have some overhead of processing. 
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FAQ 7:  How de-normalization is different from normalization? 

Answer 

Analytical processing databases are not very normalized. The operations which are used are 
read most databases. It is used to extract the data that are ancient and accumulated over long 
period of time. For this purpose de-normalization occurs that provide smart business 
applications. Dimensional tables in star schema are good example of de-normalized data. The 
de-normalized form must be controlled while extracting, transforming, loading and processing. 
There should be constraint that user should not be allowed to view the state till it is consistent. It 
is used to increase the performance on many systems without RDBMS platform. 

FAQ 8:  Why E-R models are used? 

Answer 

E-R model stands for entity-relationship model and it is used to represent a model with their 
relationships. This is an object oriented approach and it is based on real world that consists of 
objects which are called entities and relationship between them. Entities are further used inside 
the database in the form of attributes. 

FAQ 9:  What is the difference between DBMS and RDBMS? 

Answer 

DBMS is persistent and accessible when the data is created or exists, but RDBMS tells about 
the relation between the table and other tables. 

• RDBS supports a tabular structure for data and relationship between them in the system 
whereas DBMS supports only the tabular structure. 

• DBMS provide uniform methods for application that has to be independently accessed, 
but RDBMS doesn’t provide methods like DBMS but provide relationship which link one 
entity with another. 

FAQ 10:  What is SQL and where does it come from? 

Answer 

Structured Query Language (SQL) is a language that provides an interface to relational database 
systems. The proper pronunciation of SQL, and the preferred pronunciation within Oracle Corp, 
is "sequel" and not "esscue ell".  
SQL was developed by IBM in the 1970s for use in System R, and is a de facto standard, as well 
as an ISO and ANSI standard.  
In common usage SQL also encompasses DML (Data Manipulation Language), for INSERTs, 
UPDATEs, DELETEs and DDL (Data Definition Language), used for creating and modifying 
tables and other database structures.  
The development of SQL is governed by standards. A major revision to the SQL standard was 
completed in 1992, called SQL2. SQL3 support object extension.  

 

  



 Module 5: Use Databases in Web Development 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 241 

Test Yourself! 

Please mark the correct one from the given options.  

1.  A relational database consists of a collection of 

a.  Tables b.  Fields 

c.  Records d.  Keys 

2.  A ________ in a table represents a relationship among a set of values. 

a. Column b. Key 
 

c. Row 
 

d. Entry 

3.  The term _______ is used to refer to a row. 

a. Attribute b. Tuple 
 

c. Field d. Instance 

4.  The term attribute refers to a ___________ of a table. 

a. Record b. Column 

c. Tuple d. Key 

5.  For each attribute of a relation, there is a set of permitted values, called the ________ of that 
attribute. 
 

a. Domain b. Relation 

c. Set d. Schema 

6.  Course(course_id,sec_id,semester) 
Here the course_id, sec_id and semester are __________ and course is a _________. 
 

a. Relations, Attribute b. Attributes, Relation 

c. Tuple, Relation d. Tuple, Attributes 

7.  The tuples of the relations can be of ________ order. 

a. Any 
 

b. Same 

c. Sorted d. Constant 

8.  ............................ is the powerful language for working with RDBMS. 

a. Embedded Programs b. Dynamic Programs 

c. Query Language d. Static Language Programs 

9.  Which normal form is considered adequate for relational database design? 
 

a. 2 NF 
 

b. 3 NF 

c. 4 NF d. BCNF 

10.  In an ER model…………. is described in the database by storing its data. 

a. Entity b. Attribute 
 

c. Relationship d. Notation 
 
 

http://en.wikipedia.org/wiki/Database_design
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11.  Key to represent relationship between tables is called 

a. primary key 
 

b. secondary key 

c. foreign key d. none of the above 

12.  Which of the following query is correct for using comparison operators in SQL? 

a. SELECT sname, coursename FROM 
studentinfo WHERE age>50 and <80; 
 

b. SELECT sname, coursename FROM 
studentinfo WHERE age>50 and age <80; 

c. SELECT sname, coursename FROM 
studentinfo WHERE age>50 and WHERE 
age<80; 
 

d. None of above 

13.  Which of the following SQL query is correct for selecting the name of staffs from 'tblstaff' 
table where salary is 15,000 or 25,000? 
 

a. SELECT sname from tblstaff WHERE 
salary IN (15000, 25000); 

b. SELECT sname from tblstaff WHERE 
salary BETWEEN 15000 AND 25000; 
 

c. Both A and B 
 

d. None of the above 

14.  Which query is used for sorting data that retrieves the all the fields from empinfo table and 
listed them in the ascending order? 
 

a. SELECT * FROM empinfo ORDER BY 
age; 
 

b. SELECT * FROM empinfo ORDER age; 

c. SELECT * FROM empinfo ORDER BY 
COLUMN age; 
 

d. SELECT * FROM empinfo SORT BY age; 

15.  MySQL runs on which operating systems? 

a. Linux and Mac OS-X only b. Any operating system at all 

c. Unix, Linux, Windows and others d. Unix and Linux only 

16.  To remove duplicate rows from the result set of a SELECT use the following keyword: 

a. NO DUPLICATE b. UNIQUE 

c. DISTINCT d. None of the above 

17.  To use MySQL on the computer, it'll need? 

a. FTP and Telnet b. Some sort of client program to access the 
databases 
 

c. A Browser d. Perl, PHP or Java 

18.  MySQL is 

a. a) A Programming language b. A OOP Programming language 
 

c. ) A technique for writing reliable programs 
 

d. A Relational Database Management 
System 
 

19.  Which function used to get the current time in MySQL? 

a. getTime() b. Time() 
 

c. NOW() d. None of above 
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20.  MySQL Access security is controlled through? 

a. The ID that the user logged into the 
server through and privileges set up for 
that account. 
 

b. MySQL login accounts, and privileges set 
for each account 

c. The normal login security is sufficient for 
MySQL, and it does not have any extra 
controls of its own. 
 

d. A table of valid IP addresses, and 
privileges set up for each IP address 
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Answer Key 
MCQ Number Correct Answer MCQ Number Correct Answer 

1 a 11 c 

2 c 12 b 

3 b 13 a 

4 b 14 a 

5 a 15 c 

6 b 16 c 

7 a 17 b 

8 c 18 d 

9 b 19 c 

10 a 20 b 
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Module 6: Develop Website Using Client 
Side Scripting Language 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Create a static website using HTML code 

  Use JavaScript for client side validation  

  Implement Cascading Style sheets (CSS) for website designing 
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Learning Unit 1: Client Side Scripting Languages 

Overview 

In this learning unit, you will learn client side scripting languages. These fundamental 
concepts are building blocks for the development of web site. 

After completion of this learning unit, you will be able to understand and will have 
working experience of following concepts: HTML tags, elements, Attributes, formatting, 
layout, forms, iframes, url encode , input types, media object audio and video, styling 
HTML with CSS, HTML 5 

1. HTML Elements 

HTML document is created using HTML elements. Which are individual components with a start, end tag and 
content written between the tags.  

For example  <h1> My Heading </h1>  

Start Tag  Content End Tag 

<h1>  My Heading </h1> 

HTML elements code with output example 

<!DOCTYPE html> 

<html> 

<body> 

<h1>Main heading</h1> 

<p> contents of paragraph</p> 

</body> 

</html> 

2. HTML Attributes 

HTML elements can have attributes 

 Attributes provide additional information about an element 

 Attributes are always specified in the start tag 

 Attributes come in name/value pairs like: name="value" 

The Lang Attribute 

The document language can be declared in the <html> tag. The language is declared in the lang attribute. 

A Markup Language 
is a system for 
annotating a 
document in a way 
that is syntactically 
distinguishable from 
the text. 

Markup Language 

Using quotes around 
attributes values is 
the most common. 
Omitting quotes can 
produce errors. 

Remember 

Only the <body> 
area is displayed by 
the browser. 

Remember 

The start tag is often 
called the opening 
tag. The end tag is 
often called the 
closing tag. 
 

Do you know! 
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Declaring a language is important for accessibility applications (screen readers) and search engines: 

Example 

<!DOCTYPE html> 
<html lang="en-US"> 
<body> 
<h1>My First Heading</h1> 
<p>My first paragraph.</p> 
</body> 
</html> 

The first two letters specify the language (en). If there is a dialect, use two more letters (US). 

The title Attribute 

HTML paragraphs are defined with the <p> tag. 

In this example, the <p> element has a title attribute. The value of the attribute is "About W3Schools": 

Example 

<p title="About HTML"> 

IT is a Hypertext Markup Language. 

</p> 

The href Attribute 

HTML links are defined with the <a> tag. The link address is specified in the href attribute: 

Example 

<a href="http://www.w3schools.com">This is a link</a> 

Image Tag: HTML images are defined with the <img> tag. 

The filename of the source (src), and the size of the image (width and height) are all provided as attributes: 

Example 

<img src="w3schools.jpg" width="104" height="142"> 

The image size is specified in pixels: width="104" means 104 screen pixels wide. 

The alt Attribute 

The alt attribute specifies an alternative text to be used, when an HTML element cannot be displayed. 

The value of the attribute can be read by "screen readers". This way, someone "listening" to the webpage, i.e. a 
blind person, can "hear" the element. 

Example 

<img src="w3schools.jpg" alt="W3Schools.com" width="104" height="142"> 
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Single or Double Quotes? 

Double style quotes are the most common in HTML, but single style can also be used. 

In some situations, when the attribute value itself contains double quotes, it is necessary to use single quotes: 

Example 

<p title='John "ShotGun" Nelson'> 

Or vice versa: 

Example 

<p title="John 'ShotGun' Nelson"> 

3. HTML Heading 

Headings are important part of the HTML code. Six levels of headings can be defined in HTML. Heading elements 
state all the font changes, before and after paragraph breaks, and any white space necessary to properly show 
the heading. The heading elements are H1, H2, H3, H4, H5, and H6 with H1 being the most important level and 
H6 the least. For example 

<H1>This is a most important heading</H1> some text. 

<H2>Second most important heading</H2> some more text. 

4. HTML Paragraphs 

Paragraph tags are most commonly used tags in HTML. Block of text between these tags is defined as paragraph. 
<p> </p> 

5. HTML Formatting 

For HTML documents formatting following elements are used: 

 Bold ( for  bold text) 

<b> here is some bold text</b> 

 Important text 

<strong> </strong> 

 Italic text 

<i> </i> 

 Emphasized text 

<emp> </emp> 

 Marked text 

Browsers 
automatically add an 
empty line before 
and after a 
paragraph. 

Do you know! 

Browsers display 
<strong> as <b>, 
and <em> as <i>. 
But the meaning of 
these tags: <b> and 
<i> defines bold and 
italic text, but 
<strong> and <em> 
means that the text 
is "important". 

Remember 
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<mark> </mark> 

 Small text 

<small> </small> 

 Subscripts 

<sub> </sub> 

 Superscripts 

 <sup> </sup> 

6. HTML Links  

HTML links are used to connect different webpages to create a website. HTML link syntax : 

<a href=http://www.google.com > Visit Google </a> 

7. HTML Heads 

Head element is a container that includes title for the document, script, styles and some 
meta tags. Head element is used right after the HTML element tag and closed before 
body tag. 

For Example 

<Head> <Title> Page Title</title></Head> 

 

 

8. HTML Images 

To add images in HTML documents <img> tag is used. Image tag doesn’t have any 
closing tag. It has attributes like src, alt, width, height to add styling to the images.  

<img src="tevta.gif" alt="TEVTA Icon" width="128px" height="128px"> 

 

Always specify the 
width and height of 
an image. If width 
and height are not 
specified, the page 
will flicker while the 
image loads. 

Remember 

When you move the 
mouse over the 
element, the title will 
be displayed as a 
tooltip. 
 

Do you know! 

http://www.google.com/
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9. HTML Table  

HTML Tables are defined with the <table> tag. Table header is defined with <th> tag, table rows are defined with 
<tr> tag and table columns are defined with <td> tag. 

For example: 

Sr. No. Student Name Class 

01 Sadia CCA 

02 Jamal DIT 

To create above table in HTML following code is used: 

<!DOCTYPE html> 
<html lang="en-US"> 
<body> 
 <table width="80%" border="1" cellpadding="1"> 
  <tr> 
    <td>Sr.No</td> 
    <td>Student Name</td> 
    <td>Class</td> 
  </tr> 
  <tr> 
    <td>01</td> 
    <td>Sadia</td> 
    <td>CCA</td> 
  </tr> 
  <tr> 
    <td>02</td> 
    <td>Jamal </td> 
    <td>DIT</td> 
  </tr> 
</table> 
 
</body> 
</html> 

In HTML table use some attributes like borders, width, cell padding and align. 

10. HTML Lists 

HTML list have three types unordered list, ordered list and description list. 

Unordered List: 

Unordered lists start with a <ul> tag and each item with <li> tag e.g. 

<h2>Courses</h2> 
<ul> 
 <li>CCNA</li> 
 <li>DIT</li> 
 <li>MCIT</li> 
</ul> 

 

Table data <td> are 
the data containers 
of the table. They 
can contain all sorts 
of HTML elements 
like text, images, 
lists, other tables, 
etc. 

Do you know! 
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Ordered List: 

Ordered lists start with a <ol> tag and each item with <li> tag. Ordered list have type attribute to define the types 
of orders.  Here is an example of ordered list  

<h2>Courses</h2> 

<ol> 
 <li>CCNA</li> 
 <li>DIT</li> 
 <li>MCITP</li> 
</ol>    

 

Descriptive List:  

A list with a term and short detail. <dt> tag is used to list the term/names in a descriptive 
order.<dd> tag is used for the short description of terms.  

For example: 

<dl> 
 <dt>CCA</dt> 
  <dd>Certificate of Computer Application</dd> 
  <dt>DIT</dt> 
  <dd>Diploma in Information Technology</dd> 
</dl> 

 

11. HTML Block  

Most of the HTML elements are defined as a block level element or inline element. 
Block Level elements start with new line Like <h1>, <p>, <ul>, <table>. 

Inline elements normally display text without breaking line.e.g. <b>, <td> <a>, <img> 
etc.  

<div> Elements: 

A block level element that can be used as a container for HTML elements. <div> element is used in a combination 
style sheet to organize the layout of webpage. 

12. HTML Layout  

<div> element is used as a layout tool because with the help of CSS we can easily position the div where we 
want to position it. 

<body> 
<div id="header"> 
<h1>Course Information</h1> 
</div> 
<div id="nav"> 
CCA<br> 
DIT<br> 
MCITP<br> 
</div> 
<div id="section"> 

Input types, not 
supported by old 
web browsers, will 
behave as input type 
text. 

Remember 

List items can 
contain new list, and 
other HTML 
elements, like 
images and links, 
etc. 

Do you know! 

HTML Tables can 
also be used as 
Block Elements 

Remember 
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<h1>CCA</h1> 
<p>CCA stands for Certifcate of Computer Application.It is a 3 months short course.</p> 
</div> 
<div id="footer">www.tevta.gop.pk</div> 
</body> 

13. HTML Forms   

Form elements are used to get input from the user. <form> tag act as a container for different form elements. 
Attributes of <form> tag are name, action=”login.php”, method=”get/post”. 

Input Element: 

Input element is important element of the form. It has many variations depending on the type of the attributes. 
e.g. For text field input.  

<input type=”text” name=”Enter  Name”> 

Radio Button 

These allow user to select one option from multiple choices. 

<input type="radio" name="sex" value="male" checked>Male 
<br> 
<input type="radio" name="sex" value="female">Female 

Select Element (Drop Down List): 

Select element shows a drop down list and allows user to select single option from multiple options <select 
name="courses"> 

<select name="courses"> 
<option value="cca">CCA</option> 
<option value="DIT">DIT</option> 
<option value="MCITP">MSCITP</option> 
</select> 

Text Area: 

Text area elements are used for multi-line inputs from users. e.g. 

<textarea name="message" rows="10" cols="30"> 

96 H Gulberg, Lahore 

</textarea> 

Checkbox: 

Checkboxes allow users to select one or more than one options from available options. Unlike radio buttons 
which allows to select only one option.  

<input type="checkbox" name="vehicle" value="Bike">I have a bike 

<br> 

140 Color Names 
are supported by All 
Browsers 

Do you know! 

Registration / Sign 
Up pages use form 
elements.  

Do you know! 

Entity Names are 
case sensitive. 

Remember 
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<input type="checkbox" name="vehicle" value="Car">I have a car 

Submit Button 

 Submit buttons are for submitting the forms data to server page. 

<input type= “submit” value=”submit”> 

Submit is used at the end of the text fields but within the form. 

14. HTML Iframes   

An Iframe is used to create a webpage within a webpage. 

Syntax for adding Iframe: 

<iframe src="contents_iframe.htm" width="400" height="400"></iframe> 

15. HTML Colors  

Colors are displayed in the combination with RGB. Color is an attribute of HTML 
elements 

16. HTML Entities 

Some characters are reserved word for HTML language e.g. less than (<) and greater 
than (>) sign. The browser will assume it is used for HTML tag. To display reserve 
words we use HTML entities.  

< less than & lt; > greater than & gt; 

17. HTML Uniform Resource Locator 

URL is used to locate a page within a directory or on web.  common scheme for the URL 

Protocol  

http, https ,ftp 

File Path 

File path reference may be absolute (http://tutotrial.com/html/url.html) or it may be a relative reference (html 
folder/url.html) 

A URL is another 
word for a web 
address. 
https://www.ask.com  

URL 

Only MP4, WebM, 
and Ogg video is 
supported by the 
newest HTML5 
standard. 

Do you know! 

http://tutotrial.com/html/url.html
https://www.ask.com/
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18. HTML Media  

HTML multimedia object on web is a sound, music, videos or movies. 

Video: 

Video tag is used to embed the videos in HTML documents. e.g.  

<video width="400" controls> 

  <source src="mov_bbb.mp4" type="video/mp4"> 

</video> 

Audio: 

Audio tag is used to embed the audios in HTML documents. e.g. audio code 

  <audio controls> 

   <source src="sound.mp3" type="audio/mpeg"> 

    The browser does not support the audio element. 

    </audio> 

19. HTML CSS   

HTML can be styled with css in different 3 ways: 

In line style : using a style attribute in HTML elements 

<h1 style="color:blue">This is a Blue Heading</h1>  

Internal style: using a <style> element in the HTML <head> section 

<head> 
<style> 
body {background-color:lightgrey} 
h1   {color:blue} 
p    {color:green} 
</style> 
</head> 

 

External style: using one or more external CSS files 

<head> 
  <link rel="stylesheet" href="styles.css"> 
</head> 
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20. HTML 5  

HTML 5 is fifth revision in html by w3c. It has many new semantic tags. The new 
features in HTML5 include specific functions for embedding graphics, audio, video, and 
interactive documents.  New elements also allow to define sections of Web page using 
new tags such as < article > which defines an article, < nav > which defines navigation 
links, < source > which defines media resources, and many others. For example, the 
navigation section of the page would be enclosed in the < nav > tags. 

Example with Output:  

<!DOCTYPE html> 
<html> 
<head> 
<meta charset="UTF-8"> 

<title>HTML 5 new document</title> 
</head> 
<body> 
This is html 5 documents 
</body> 
</html> 

21. Dreamweaver as HTML Editor          

To use Dreamweaver to create a website, first define sites.  

A. Creating a HTML page 

Open a blank HTML document in Dreamweaver. 

1. In Dreamweaver, go to File → New... 

2. In the New Document dialog box. 

3. Select the Page Type as HTML. 

4. Select the Layout as <none>. 

5. Click Create. 

The World Wide 
Web Consortium is 
the main 
international 
standards 
organization for the 
World Wide Web. 

Do you know! 

Adobe 
Dreamweaver 
complete installation 
is demonstrated in 
Module 3. 

Remember 

Dreamweaver was 
created by 
Macromedia in 1997 

Do you know! 
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B. Saving a HTML Page 

1. Go to File → Save. 

2. In the Save As dialog box, make sure that the location is the top level of Local Site folder. 

3. In the File name field, enter a file name. 

4. Click Save. 

 

C. Naming Conventions  

When saving a file to be used in a website, such as a HTML page or an image file, 
name the file using lower case and no spaces. For example, an image file should be 
named “portrait_smith.jpg” instead of “Portrait Smith.jpg”.  

When naming HTML files, find out from the web server administrator whether the file 
name extension should be .htm or .html. Different web servers require one or the other 
ending. Keep the ending consistent throughout the entire website. 

Use either .htm or 
.html as file 
extension. There is 
no difference. 

Do you know! 
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Keep in mind that all file names and folder names are public. Use appropriate and descriptive terms. 

D. Entering Text 

1. Click in the document window. 

2. Type the text. Separate paragraphs with a Return. 

 

E. Copying Text into a Page 

1. In the File panel, click the plus symbol to expand folders until required document open. 

 

2. Double click the document name. 

 If it is a file type that Dreamweaver can manage, such as a CSS file or TXT file, the document will open in 
Dreamweaver. 

 If Dreamweaver cannot manage that file type, such as a Microsoft Word file, the document will open in an 
appropriate program. 
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3. In the opened document, select and copy the text that want to put in HTML page. 

 

4. In Dreamweaver, click in the HTML document where to paste the text. 
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F. Applying Heading Formatting 

When a text change from a regular paragraph to a Heading format, apply a logical structure to the content.  

1. Select the paragraph to mark Heading. 

 Select the entire paragraph or click inside the paragraph. 

 
2. In the Properties Inspector, click HTML if necessary. 
3. For the Format, select Heading 1, Heading 2, etc. 
 

 
 
 
 

G. Page Document Title 
 
All web pages should have an appropriate and descriptive page document title. This title appears in the title bar 
of the browser and will be used as the name of a Favorite or Bookmark. 
 
1. In the Document toolbar, click inside the Title field and enter an appropriate title. 
2. Click anywhere outside the Title field or press Return to commit the changes. 

 

 
 
H. Previewing a Page 
 
1. Save the page. 
2. In the Document toolbar, click the Preview/Debug in Browser button. 

 
 
3. From the drop-down list, select the browser. 
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Basic Formatting using CSS 

To set the formatting of the paragraphs, headings, or background colors use CSS.  

A. Internal and External Stylesheets 

CSS rules can be kept in an internal stylesheet in the HTML page, in which case the formatting is only available 
within that HTML page. 

B. Creating and Saving an External CSS Stylesheet 

1. Go to File → New. 

2. In the New Document dialog box, select Blank Page from the left side. 

3. Under Page Type, select CSS. 

4. Click Create. 
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C. Attaching an External CSS Stylesheet to a HTML Page 

To use the CSS styles saved into an external stylesheet, link stylesheet from the HTML page. 

1. Click on the name of HTML page above the Document toolbar to switch back to the HTML page. 

 

2. Click the CSS Styles panel name to open the panel. 
3. At the bottom of the panel, click the Attach Style Sheet button. 

 

4. In the Attach External Style Sheet dialog box, click Browse. 
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5. In the Select Style Sheet File dialog box, select the external stylesheet. 
6. Click OK. 
7. In the Attach External Style Sheet dialog box, click OK. 

 

 

D. Basics of CSS Rules 

There are three basic types of CSS rules: 

Tag rules (also called element rules) are CSS rules that are applied to any content that has been marked with 
that particular HTML tag. For example, to make all Heading 1 text look bold and pink, create a CSS tag rule for 
the h1 tag. 

Class rules are CSS rules that are applied to any content that has been marked with that class name. For 
example, to make the club name italic and bold everywhere that the club name is used in a paragraph, create a 
class rule and apply that class rule to all the club names. 

ID rules are CSS rules that are applied to any content that has been marked with that ID name. This is similar to 
a class rules, except that ID rules can only be applied to one item per page. 

E. Creating a Tag Rule 

To change the font and background for the entire page, set a CSS rule for the body tag. 
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1. In the HTML page, click the New CSS Rule button in the CSS Styles panel. 

 

2. In the New CSS Rules dialog box, change the contextual selector type to Tag.  

3. For the Selector Name, type body or select body from the drop-down list.  

4. For the Rule Definition, select external stylesheet.  

5. Click OK. 

 

6. In the CSS Rule Definition dialog box, select the options for this rule.  

 Be minimal. Set only the options need to change.  

 For Font formatting, set options in the Type category.  
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 For Background formatting, set options in the Background category.  

 

7. Click Apply to preview changes, or OK to save. 

 To change the formatting of Heading 1, set a CSS rule for the h1 tag. 

 To change the formatting of Heading 2, set a CSS rule for the h2 tag. 

F. Modifying a Rule 

1. Find the rule in the CSS Styles panel to modify. 
2. Double-click the rule name. 
3. In the CSS Rule Definition dialog box, modify as required. 
4. Click OK. 
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G. Creating a Class Rule 

1. In the HTML page, click the New CSS Rule button in the CSS Styles panel. 

 

2. In the New CSS Rules dialog box, change the contextual selector type to class. 
3. For the Selector Name, type a name for the class. 
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 The name must start with a period and must contain no spaces. 
 

4. For the Rule Definition, select external stylesheet. 
5. Click OK. 

 

6. In the CSS Rule Definition dialog box, select the options for this rule. 
7. Click OK. 

 

H. Applying a Class Rule 

1. Select the text to apply required rule. 

 

2. In the Property Inspector, change Class to the name of the class. 
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Managing Images 

Image files must be prepared in a graphics program before its use in Dreamweaver.  

A. Inserting an image to be “in line with text” 

1. Create an empty paragraph immediately below the Heading 1 title. 
2. Go to Insert → Image. 
3. In the Select Image Source dialog box, navigate to the images folder and select image. 
4. Click OK. 

 

5. In the Image Tag Accessibility Attributes dialog box, enter an Alternate text. 

 An “Alt Text” is essential for search engine optimization and accessibility for all significant images 
that use in web pages. 

6. Click OK. 
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B. Inserting an Image to be “Floating” or “Text-Wrapped” 

1. Click at page where image need to place 
2. Go to Insert → Image. 
3. In the Select Image Source dialog box, navigate to the images folder and select image. 
4. Click OK. 
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5. In the Image Tag Accessibility Attributes dialog box, enter an appropriate Alternate Text. 
6. Click OK. 

 

7. To make the text wrap around the image, select the image. 

 

7. To make the text wrap around the image, select the image. 



 Module 6: Develop Website Using Client Side Scripting Language 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 271 

8. In the Properties Inspector, from the Align drop-down list, select Left or Right. 

 

 

Creating Lists 

The two main types of lists used in web pages are UL (unordered lists), otherwise known as bulleted lists, and 
OL (ordered lists), and otherwise known as numbered lists. 

A. Creating a New Web Page for Lists 

For our exercise, we will create a new web page for the Academics page. 

1. Create a new, blank HTML page. 
2. Save it at the top level of the Local Site folder as “academics_temp.htm”. 
3. Provide an appropriate page document title. 
4. Open the Academics.doc document from the CONTENTS folder, and copy and paste the text into the web 

page. 
5. Attach the external stylesheet. 
6. Apply any Heading 1 and Heading 2 formats as necessary. 
7. Save the file. 
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B. Inserting an Unordered List 

1. Select the paragraphs that need to convert to an unordered list. 
2. In the Properties Inspector, click the Unordered List button. 

 

 

C. Inserting an Ordered List 

1. Select the paragraphs that need to convert to an ordered list. 
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2. In the Properties Inspector, click the Ordered List button. 

 

 

X. Using Tables for Data 

To display data in a well-structured format, create a table for data.  

A. Creating a New Web Page for Tables 

For our exercise, create a new web page for the Officers page. 

1. Create a new, blank HTML page. 
2. Save it at the top level of the Local Site folder as “officers_temp.htm”. 
3. Provide an appropriate page document title. 
4. Open the officers.doc document from the CONTENTS folder, and copy and paste title and first paragraph 

into the web page. 
5. Attach the external stylesheet. 
6. Apply any Heading 1 format as necessary. 
7. Save the file. 
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B. Inserting a Table 

1. Create a new paragraph. 
2. Go to Insert → Table. 

 

3. In the Table dialog box, enter the following options: 

 Rows: 5 

 Columns: 2 

 Table width: 500 pixels 

 Border thickness: 1 pixel 

 Cell padding: 5 

 Cell spacing: 0 

 Header: None 
 

4. Click OK. 
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5. In cells on the right column, copy and paste the name and information for each officer from the officers.doc 
document. 

6. In cells on the left column, insert images for each of the officers. 

 

C. Managing Table and Cell Properties 

To set table layout setting like width, border, cell padding, cell spacing, or other properties of the table or table 
cells, select the HTML tag that controls that section. 

To make changes for the entire table, click inside the table and then select the <table> tag from the Tag Selector. 
Then, change the property in the Property Inspector. 
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To make changes for one cell, click inside the cell and then select the <td> or <th>tag from the Tag Selector. 
Then, change the property in the Property Inspector. 

 

 

To make changes for several cells, drag to select several cells in the table. The cells should become outlined. 
Then, change the property in the Property Inspector. 
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XI. Creating Links 

Create a link to an external website, or internal web page. 

A. Creating an External Link 

1. Open a browser and browse to the website. 

2. In the browser’s address bar, select the URL and copy it. 

 Right-click and select copy, or use the Ctrl-C keyboard shortcut. In most browsers, use the Edit → 
Copy command. 
 

 
 

7. select the text  

 
 

8. In the Property Inspector, paste the URL into the Link field. 

In external website to open in a separate window, select _blank from the Target field. 

 

 

B. Creating an Internal Link 

1. select the text  

 

2. In the Property Inspector, click the Browse for File button next to the Link field. 
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3. In the Select File dialog box, navigate to the file to link and select the file. The file must be inside the Local Site 
folder. 

4. Click OK. 

 

 

Basic Page Layout using CSS 

So far, we have been creating temporary pages that contain content, but they do not have the page layout that 
we sketched in our wireframe and mockup. 

To create page layout, the old way was to use table structures in HTML. However, the current method is to use 
CSS. Sections of the HTML code are surrounded by div tags which are given a specific ID name, and a CSS ID 
rule defines the size and other properties of that div group. 

A. Planning the Layout 

From the wireframe and mockup, decide how many div areas need to create.  
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B. Creating a New Web Page for Page Layout 

1. Create a new, blank HTML page. 
2. Save it at the top level of the Local Site folder as “template.htm”. 
3. Provide an appropriate page document title. 
4. Attach the external stylesheet. 
5. Save the file. 

 



Module 6: Develop Website Using Client Side Scripting Language 

280 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

C. Creating the Wrapper 

1. Click at the top of the page. 

2. Go to Insert → Layout Objects → Div tag. 

 

3. In the Insert Div Tag dialog box, click New CSS Rule. 
 

 
 

4. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #wrapper 
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 Rule Definition : styles.css 
 

5. Click ok. 
6. In the CSS Rule Definition dialog box, select the following 

 
Box category options: 

 Width: 960px 

 Padding; 0 

 Margin: 0 
7. Click OK. 

 

8. In the Insert Div Tag dialog box, make sure the ID field displays wrapper, then click OK. 

D. Creating the Header 

1. Select the contents of the wrapper div and delete it. 
 

 
 

2. Go to Insert → Layout Objects → Div tag. 
3. In the Insert Div Tag dialog box, click New CSS Rule. 
4. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #header 

 Rule Definition : styles.css 
5. Click OK. 
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6. In the CSS Rule Definition dialog box, select the following Background category options: 

 Background color: #FC3 
 

 
 

7. Select the following Box category options: 

 Width: 100% 

 Height: 70px 

 Padding; 0 

 Margin: 0 
8. Click OK. 
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9. In the Insert Div Tag dialog box, make sure the ID field displays header, then click OK. 
10. To create the structure within the header, we will use a table. Select the placeholder text and delete it. 
11. Go to Insert → Table. 
12. In the Table dialog box, select the following options: 

 Rows: 2 

 Columns: 2 

 Table width: 100 percent 

 Border thickness: 0 

 Cell padding: 0 

 Cell spacing: 0 

 Header: None 
13. Click OK. 
14. Do the following: 

 In the upper left cell, insert the image hdr_logo.gif. 

 In the upper right cell, insert the image hdr_studentclubs.gif. 

 Select both cells in the upper row and change the cell background color to #001F5B. 

 In the lower left cell, type the title “Underwater Basket Weaving Club”. 

 If there is time, create a CSS class rule called .classtitle to format the title. 

 

E. Creating the Main Area 

At this point, we have to position this next div tag precisely, within the wrapper section but outside the header 
section. The best method is to go into the Code view or Split view. 

1. In the Document toolbar, click the Split button to view both the design and the code view. 
 

 
 

2. In the code view, click between the ending </div> tag of the header div and the ending </div> tag of the 
wrapper div. Press Return to create a new blank line. 
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3. Go to Insert → Layout Objects → Div tag. 
4. In the Insert Div Tag dialog box, click New CSS Rule. 
5. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #main 

 Rule Definition : styles.css 
6. Click OK. 
7. In the CSS Rule Definition dialog box, select the following Box category options: 

 Width: 100% 

 Padding; 0 

 Margin: 0 
8. Click OK. 
9. In the Insert Div Tag dialog box, make sure the ID field displays main, then click OK. 

F. Creating the Navigation Area 

1. Select the placeholder text for the id “main” and delete it. 
2. Go to Insert → Layout Objects → Div tag. 
3. In the Insert Div Tag dialog box, click New CSS Rule. 
4. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #nav 

 Rule Definition : styles.css 
5. Click OK. 
6. In the CSS Rule Definition dialog box, select the following Box category options: 

 Width: 100px 

 Float: left 

 Padding; 5 

 Margin: 0 
7. Click OK. 
8. In the Insert Div Tag dialog box, make sure the ID field displays nav, then click OK. 
9. Select the placeholder text for id “nav”, and enter the following text: 

 Home 
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 Academics 

 Officers 

 Events 

 Join Us 
 

10. Select each text and type the name of the associated HTML file in the Links field of the Property Inspector. 

 Home = index.htm 

 Academics = academics.htm 

 Officers = officers.htm 

 Events = events.htm 

 Join Us = join.htm 

 

G. Creating the Content Area 

1. In the code view, click between the ending </div> tag of the nav div and the ending </div> tag of the main 
div. Press Return to create a new blank line. 

2. Go to Insert → Layout Objects → Div tag. 
3. In the Insert Div Tag dialog box, click New CSS Rule. 

 

 
 

4. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #content 

 Rule Definition : styles.css 
5. Click OK. 
6. In the CSS Rule Definition dialog box, select the following Box category options: 

 Width: 800px 

 Float: right 

 Padding; 5 

 Margin: 0 
7. Click OK. 
8. In the Insert Div Tag dialog box, make sure the ID field displays content, then click OK. 

H. Creating the Footer 

1. In the code view, click between the ending </div> tag of the main div and the ending </div> tag of the 
wrapper div. Press Return to create a new blank line. 
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2. Go to Insert → Layout Objects → Div tag. 
3. In the Insert Div Tag dialog box, click New CSS Rule. 
4. In the New CSS Rule dialog box, select the following options: 

 Selector type: ID 

 Selector name: #footer 

 Rule Definition : styles.css 
5. Click OK. 
6. In the CSS Rule Definition dialog box, select the following Box category options: 

 Width: 100% 

 Height: 50px 

 Clear: both 

 Padding; 5 

 Margin: 0 
7. Click OK. 
8. In the Insert Div Tag dialog box, make sure the ID field displays content, then click OK. 
9. Select the placeholder text and type a copyright statement. 

 

 
 

10. Save the file. 

Creating More Pages 

We can use the template that we created in the previous section to create our final pages. 

A. Creating the Home Page 

1. In the template.htm page, go to File → Save As. 
2. In the Save As dialog box, make sure the location is the top level of the Local Site folder. 
3. For the File name, type index.htm. 
4. Click Save. 
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5. Go to the old index_temp.htm page. 
6. Select all the content and copy it. 

 

 
 

7. Go back to the new index.htm page. 
8. Select the placeholder text for the content area, and delete it. 
9. Paste the new content into the content area. 
10. Save the file. 
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B. Creating the Academics Page 
 

1. Save another copy of the template.htm file as academics.htm. 
2. Copy the old academics_temp.htm content into the academics.htm file. 
3. Save the file 

 

 
 

C. Creating the Officers Page 
 

1. Save another copy of the template.htm file as officers.htm. 
2. Copy the old officers_temp.htm content into the officers.htm file. 
3. Save the file 
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D. Creating the Events Page 
 

1. Save another copy of the template.htm file as events.htm. 
2. From the File panel, open the events.doc file. 
3. Copy text in events.doc into the events.htm file. 
4. Save the file. 

 

E. Creating the Join Us Page 

1. Save another copy of the template.htm file as join.htm. 
2. From the File panel, open the join.doc file. 
3. Copy text from join.doc into the join.htm file. 
4. Save the file. 
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F. Previewing in a Browser 
 

1. Go to the index.htm file. 
2. In the Document toolbar, click the Preview in Browser button and select a browser. 
3. Test the links in the navigation area. 
4. If there are any problems, come back to Dreamweaver and make changes. 

 

 

 
  



 Module 6: Develop Website Using Client Side Scripting Language 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 291 

Learning Unit 2: Implementing Style Sheet (CSS) in a 
Website 

Overview 

In this learning unit, you will learn HTML elements. After completion of this learning 
unit, you will be able to understand CSS Syntax, Id and Class, Styling of Backgrounds, 
Text, Fonts, Links, Lists & and Tables, CSS Border, Outline, Margin, Padding, 
Dimension, Positioning, Floating, Align, Colours, and Colour HEX. 

1. CSS Syntax 

CSS consists of selector and declaration block. 

Selector: 

Selector                     Declaration         

 

 

                              (Property)         (Value) 

Selectors are the HTML elements/Attributes on which to apply the style.  

Declaration: 

Declarative portion of the CSS consists of set of formatting rules. 

2. Id and Class 

The id selector is an id attribute of an HTML element to select a specific element. An id is unique within a page, 
so the id selector is used to select a single, unique element. 

The style rule below will be applied to the HTML element with id="para1": 

<head> 
<style> 
   #para1 { text-align: center; color: red;} 
</style> 
</head> 
<p id="p1">Hello World!</p> 

The class selector selects elements with a specific class attribute. 

H1 {background:#039; font-family:Arial;} 

HTML was not 
developed for a 
design purpose of 
websites.CSS does 
all design work. 

Do you know! 

CSS Cascading 
Style Sheet is used 
to set look and feel 
of website. 

CSS 
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To select elements with a specific class, write a period character, followed by the name of the class: 

In the example all HTML elements with class="left" will be left-aligned: 

<head> 
<style> 
.left { 
    text-align: left; 
    color: red; 
} 
</style> 
</head> 

<h1 class="left">Red and left-aligned heading</h1> 

<p class="left">Red and left-aligned paragraph.</p> 

3. Styling of Backgrounds 

CSS background styling properties are used to define the background effects of an elements / whole html page. 

Followings are some CSS properties which are used for background effects: 

background-color  

The background-color property sets  the background color of an element e.g <style> 

body { 
    background-color: #b0c4de; 
} 
</style> 

background-image 

The background-image property sets the background image of an element. body { 
background-image: url("background.gif"); 
}  

background-repeat / no-repeat 

CSS automatically repeats an image horizontally and vertically. But user can set the image repeating values.     

e.g.  

body { 
    background-image: url("gradient_bg.png"); 
    background-repeat: repeat-x; 

    background-repeat: repeat-y; 
background-repeat: no-repeat; // this used in case where user don’t want repeat the image  

}  

background-attachment 

background-position 
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4. CSS Text 

Text Color 

The color property sets the color of the text. 

With CSS, a color is most often identified by: 

a HEX value - like "#ff0000" 

an RGB value - like "rgb(255,0,0)" 

a color name - like "red" 

The default color for a page is defined in the body selector. 

Example 

body { 
    color: blue; 
} 
h1 { 
    color: #00ff00; 
} 
h2 { 
    color: rgb(255,0,0); 
} 

Text Alignment 

The text-align property sets the horizontal alignment of a text. 

Text can be centered, or aligned to the left or right, or justified. 

When text-align is set to "justify", each line is stretched so that every line has equal width, and the left and right 
margins are straight (like in magazines and newspapers). 

Example 

h1 { 
    text-align: center; 
} 
p.date { 
    text-align: right; 
} 
p.main { 
    text-align: justify; 
} 

Text Decoration 

The text-decoration property sets or removes decorations from text. 

The text-decoration property is mostly used to remove underlines from links for design purposes: 
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Example 

a { 
    text-decoration: none; 
} 
It can also be used to decorate text: 
Example 
h1 { 
    text-decoration: overline; 
} 
h2 { 
    text-decoration: line-through; 
} 
h3 { 
    text-decoration: underline; 
} 

Text Transformation  

The text-transform property specifies uppercase and lowercase letters in a text. 

It can be used to change everything into uppercase or lowercase letters, or capitalize 
the first letter of each word. 

 

Example 

p.uppercase { 
    text-transform: uppercase; 
} 
p.lowercase { 
    text-transform: lowercase; 
} 
p.capitalize { 
    text-transform: capitalize; 
} 

Text Indentation 

The text-indent property specifies the indentation of the first line of a text. 

Example 

p { 

    text-indent: 50px; 

} 

5. Fonts 

CSS font properties define the font family, boldness, size, and the style of a text. 

If the name of a font 
family is more than 
one word, it must be 
in quotation marks, 
like: "Times New 
Roman". 

Remember 



 Module 6: Develop Website Using Client Side Scripting Language 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 295 

 

In CSS, there are two types of font family names: 

Generic Family - a group of font families with a similar look (like "Serif" or "Monospace") 

Font Family - a specific font family (like "Times New Roman" or "Arial") 

Font Family 

The font family of a text is set with the font-family property. 

The font-family property should hold several font names as a "fallback" system. If the browser does not 
support the first font, it tries the next font. 

Start with the font and end with a generic family, to let the browser pick a similar font in the generic family, if no 
other fonts are available. 

More than one font family is specified in a comma-separated list: 

Example 

p { 
    font-family: "Times New Roman", Times, serif; 
} 

Font Style 

The font-style property specifies italic text. 

This property has three values: 

normal - The text is shown normally 

italic - The text is shown in italics 

oblique - The text is "leaning" (oblique is very similar to italic, but less supported) 

Example 

p.normal { 
    font-style: normal; 
} 
p.italic { 
    font-style: italic; 
} 
p.oblique { 
    font-style: oblique; 
} 
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Font Size 

The font-size property is used to set the size of the text. Being able to manage the text size is important in web 
design. Always use the proper HTML tags, like <h1> - <h6> for headings and <p> for paragraphs. 

The font-size value can be an absolute, or relative size. 

Absolute Size: 

Sets the text to a specified size. Does not allow a user to change the text size in all browsers (bad for accessibility 
reasons). Absolute size is useful when the physical size of the output is known 

Relative size: 

Sets the size relative to surrounding elements. Allows a user to change the text size in browsers 

Set Font Size With Pixels 

Setting the text size with pixels  

Example 

h1 { 
    font-size: 40px; 
} 
h2 { 
    font-size: 30px; 
} 
p { 
    font-size: 14px; 
} 

Set Font Size With Em 

To allow users to resize the text (in the browser menu), many developers use em instead of pixels. 

The em size unit is recommended by the W3C. 

1em is equal to the current font size. The default text size in browsers is 16px. So, the default size of 1em is 
16px. 

The size can be calculated from pixels to em using this formula: pixels/16=em 

Example 

h1 { 
    font-size: 2.5em; /* 40px/16=2.5em */ 
} 
h2 { 
    font-size: 1.875em; /* 30px/16=1.875em */ 
} 
p { 
    font-size: 0.875em; /* 14px/16=0.875em */ 
} 

 



 Module 6: Develop Website Using Client Side Scripting Language 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 297 

Use a Combination of Percent and Em 

The solution that works in all browsers, is to set a default font-size in percent for the <body> element: 

Example 

body { 
    font-size: 100%; 
} 
h1 { 
   font-size: 2.5em; 
} 
h2 { 
    font-size: 1.875em; 
} 
p { 
    font-size: 0.875em; 
} 
     

6. Links 

Links can be styled in different ways. 

Styling Links 

Links can be styled with any CSS property (e.g. color, font-family, background, etc.). 

Example 

a { 
    color: #FF0000; 
} 

In addition, links can be styled differently depending on what state they are in. 

The four links states are: 

a:link - a normal, unvisited link 

a:visited - a link the user has visited 

a:hover - a link when the user mouse’s over it 

a:active - a link the moment it is clicked 

Example 

/* unvisited link */ 
a:link { 
    color: #FF0000; 
} 
/* visited link */ 
a:visited { 
    color: #00FF00; 
} 
/* mouse over link */ 
a:hover { 
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    color: #FF00FF; 
} 
/* selected link */ 
a:active { 
    color: #0000FF; 
} 

When setting the style for several link states, there are some order rules: 

a:hover MUST come after a:link and a:visited 

a:active MUST come after a:hover 

Common Link Styles 

In the example above the link changes color depending on what state it is in. 

Let’s go through some of the other common ways to style links: 

Text Decoration 

The text-decoration property is mostly used to remove underlines from links: 

Example 

a:link { 
    text-decoration: none; 
} 
a:visited { 
    text-decoration: none; 
} 
a:hover { 
    text-decoration: underline; 
} 
a:active { 
    text-decoration: underline; 
} 

Background Color 

 The background-color property specifies the background color for links: 

 
Example 

a:link { 
    background-color: #B2FF99; 
} 
a:visited { 
    background-color: #FFFF85; 
} 
a:hover { 
    background-color: #FF704D; 
} 
a:active { 
    background-color: #FF704D; 
} 
    

Do not start an id 
and class names 
with a number. 

Remember 
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7. Lists 

The CSS list properties allow to: 

 Set different list item markers for ordered lists 

 Set different list item markers for unordered lists 

 Set an image as the list item marker 

List 

In HTML, there are two types of lists: 

 unordered lists (<ul>) - the list items are marked with bullets 

 ordered lists (<ol>) - the list items are marked with numbers or letters 

With CSS, lists can be styled further, and images can be used as the list item marker. 

Different List Item Markers 

The type of list item marker is specified with the list-style-type property: 

Example 

ul.a { 
    list-style-type: circle; 
} 
ul.b { 
    list-style-type: square; 
} 
ol.c { 
    list-style-type: upper-roman; 
} 
ol.d { 
    list-style-type: lower-alpha; 
} 

Some of the values are for unordered lists, and some for ordered lists. 

An Image as The List Item Marker 

To specify an image as the list item marker, use the list-style-image property: 

Example 

ul { 
   list-style-image: url('sqpurple.gif'); 
} 

The example above does not display equally in all browsers. IE and Opera will display the image-marker a little 
bit higher than Firefox, Chrome, and Safari. 

Image-marker is placed equally in all browsers, a crossbrowser solution is explained below. 

Crossbrowser Solution 

The following example displays the image-marker equally in all browsers: 
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Example 

ul { 
    list-style-type: none; 
    padding: 0px; 
    margin: 0px; 
} 
 
ul li { 
    background-image: url(sqpurple.gif); 
    background-repeat: no-repeat; 
    background-position: 0px center;  
    padding-left: 15px;  
} 

Example Explained: 

For <ul>: 

Set the list-style-type to none to remove the list item marker 

Set both padding and margin to 0px (for cross-browser compatibility) 

For all <li> in <ul>: 

Set the URL of the image, and show it only once (no-repeat) 

Position the image (left 0px and vertical value: center) 

Position the text in the list with padding-left 

List - Shorthand Property 

The list-style property is a shorthand property. It is used to set all the list properties in one declaration: 

Example 

ul { 
    list-style: square inside url("sqpurple.gif"); 
} 

When using the shorthand property, the order of the property values are: 

 list-style-type (if a list-style-image is specified, the value of this property will be displayed if the image for 
some reason cannot be displayed) 

 list-style-position (specifies whether the list-item markers should appear inside or outside the content 
flow) 

 list-style-image (specifies an image as the list item marker) 

If one of the property values above are missing, the default value for the missing property will be inserted, if any. 

8. Tables 

The look of an HTML table can be greatly improved with CSS. 
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Table Borders 

To specify table borders in CSS, use the border property. 

The example below specifies a black border for <table>, <th>, and <td> elements: 

Example 

table, th, td { 
   border: 1px solid black; 
} 

Notice that the table in the example above has double borders. This is because both the table and the <th>/<td> 
elements have separate borders. 

To display a single border for the table, use the border-collapse property. 

Collapse Borders 

The border-collapse property sets whether the table borders are collapsed into a single border or separated: 

Example 

table { 
    border-collapse: collapse; 
} 
table, th, td { 
    border: 1px solid black; 
} 

Table Width and Height 

Width and height of a table is defined by the width and height properties. 

The example below sets the width of the table to 100%, and the height of the <th> elements to 50px: 

Example 

table { 
    width: 100%; 
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} 
th { 
    height: 50px; 
} 

Horizontal Text Alignment 

The text-align property sets the horizontal alignment, like left, right, or center. 

By default, the text in <th> elements are center-aligned and the text in <td> elements are left-aligned. 

The following example left-aligns the text in <th> elements: 

Example 

th { 
    text-align: left; 
} 

Vertical Text Alignment 

The vertical-align property sets the vertical alignment, like top, bottom, or middle. 

By default, the vertical alignment of text in a table is middle (for both <th> and <td> elements). 

Example 

td { 
    height: 50px; 
    vertical-align: bottom; 
} 

Table Padding 

To control the space between the border and content in a table, use the padding property on <td> and <th> 
elements: 

Example 

td { 
    padding: 15px; 
} 

Table Color 

The example below specifies the color of the borders, and the text and background color of <th> elements: 

Example 

table, td, th { 
    border: 1px solid green; 
} 
th { 
    background-color: green; 
    color: white; 
} 
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9. CSS Border 

The CSS border properties allow to specify the style, size, and color of an element's border. 

Border Style 

The border-style property specifies what kind of border to display. 

border-style values: 

 

Border Width 

The border-width property is used to set the width of the border. 

The width is set in pixels, or by using one of the three pre-defined values: thin, medium, or thick. 

Example 

p.one { 
    border-style: solid; 
    border-width: 5px; 
 
p.two { 
    border-style: solid; 
    border-width: medium; 
}  

Border Color 

The border-color property is used to set the color of the border. The color can be set by: 

 name - specify a color name, like "red" 

 RGB - specify a RGB value, like "rgb(255,0,0)" 

 Hex - specify a hex value, like "#ff0000" 

Set the border color to "transparent". 

If the border color is not set it is inherited from the color property of the element. 
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Note: The "border-color" property does not work if it is used alone. Use the "border-style" property to set the 
borders first. 

Example 

p.one { 
    border-style: solid; 
    border-color: red; 
} 
 
p.two { 
    border-style: solid; 
    border-color: #98bf21; 
} 

Border - Individual sides 

In CSS it is possible to specify different borders for different sides: 

Example 

p { 
    border-top-style: dotted; 
    border-right-style: solid; 
    border-bottom-style: dotted; 
    border-left-style: solid; 
} 

The example above can also be set with a single property: 

Example 

p { 
    border-style: dotted solid; 
} 

The border-style property can have from one to four values. 

 Border-Style: Dotted Solid Double Dashed; 

o top border is dotted 

o right border is solid 

o bottom border is double 

o left border is dashed 

 Border-Style: Dotted Solid Double; 

o top border is dotted 

o right and left borders are solid 

o bottom border is double 
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 Border-Style: Dotted Solid; 

o top and bottom borders are dotted 

o right and left borders are solid 

 Border-Style: Dotted; 

o all four borders are dotted 

The border-style property is used in the example above. However, it also works with border-width and border-
color. 

Border - Shorthand Property 

There are many properties to consider when dealing with borders. 

To shorten the code, it is also possible to specify all the individual border properties in one property. This is called 
a shorthand property. 

The border property is a shorthand for the following individual border properties: 

 border-width 

 border-style (required) 

 border-color 

Example 

p { 
    border: 5px solid red; 
} 

10. Outline 

An outline is a line that is drawn around elements (outside the borders) to make the element "stand out". 

The outline properties specify the style, color, and width of an outline. 

 

CSS Outline 

An outline is a line that is drawn around elements (outside the borders) to make the element "stand out". 

However, the outline property is different from the border property. 

The outline is not a part of an element's dimensions; the element's total width and height is not affected by the 
width of the outline. 
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11. Margin 

The CSS margin properties define the space around elements. 

Margin 

The margin clears an area around an element (outside the border). The margin does 
not have a background color, and is completely transparent. 

The top, right, bottom, and left margin can be changed independently using separate 
properties. A shorthand margin property can also be used, to change all margins at 
once. 

Possible Values 

Value Description 

auto The browser calculates a margin 

length Specifies a margin in px, pt, cm, etc. Default value is 0px 

% Specifies a margin in percent of the width of the containing element 

inherit Specifies that the margin should be inherited from the parent element 

Margin - Shorthand property 

To shorten the code, it is possible to specify all the margin properties in one property. This is called a shorthand 
property. 

The shorthand property for all the margin properties is "margin": 

Example 

p { 
    margin: 100px 50px; 
} 

Same four value 
styles can also be 
used while setting 
padding in CSS. 

Remember 
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The margin property can have from one to four values:- 

1. margin: 25px 50px 75px 100px; 
o top margin is 25px 
o right margin is 50px 
o bottom margin is 75px 
o left margin is 100px 

 
2. margin: 25px 50px 75px; 

o top margin is 25px 
o right and left margins are 50px 
o bottom margin is 75px 

 
3. margin: 25px 50px; 

o top and bottom margins are 25px 
o right and left margins are 50px 

 
4. margin: 25px; 

o all four margins are 25px 

12. Padding 

The CSS padding properties define the space between the element border and the element content. 

Padding 

The padding clears an area around the content (inside the border) of an element. The padding is affected by the 
background color of the element. 

The top, right, bottom, and left padding can be changed independently using separate properties. A shorthand 
padding property can also be used, to change all paddings at once. 

Possible Values 

Value Description 

length Defines a fixed padding (in pixels, pt, em, etc.) 

% Defines a padding in % of the containing element 

Padding - Individual Sides 

In CSS, it is possible to specify different padding for different sides: 

Example 

p { 
    padding-top: 25px; 
    padding-right: 50px; 
    padding-bottom: 25px; 
    padding-left: 50px; 
} 
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Padding - Shorthand Property 

To shorten the code, it is possible to specify all the padding properties in one property. This is called a shorthand 
property. 

The shorthand property for all the padding properties is "padding": 

Example 

p { 

    padding: 25px 50px; 

} 

The padding property can have from one to four values. 

1. padding: 25px 50px 75px 100px; 
2. padding: 25px 50px 75px; 
3. padding: 25px 50px; 
4. padding: 25px; 

13. Dimension 

The CSS dimension properties allow to control the height and width of an element. 

Dimension Properties 

Property Description Values 

Height Sets the height of an element 

auto 
length 
% 
inherit 

max-height Sets the maximum height of an element 

none 
length 
% 
inherit 

max-width Sets the maximum width of an element 

none 
length 
% 
inherit 

min-height Sets the minimum height of an element 
length 
% 
inherit 

min-width Sets the minimum width of an element 
length 
% 
inherit 

Width Sets the width of an element 

auto 
length 
% 
inherit 
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14. Positioning 

The CSS positioning properties allow to position an element. It can also place an element behind another, and 
specify what should happen when an element's content is too big. 

Elements can be positioned using the top, bottom, left, and right properties. However, these properties will not 
work unless the position property is set first. They also work differently depending on the positioning method. 

There are four different positioning methods. 

Static Positioning 

HTML elements are positioned static by default. A static positioned element is always positioned according to 
the normal flow of the page. 

Static positioned elements are not affected by the top, bottom, left, and right properties. 

Fixed Positioning 

An element with a fixed position is positioned relative to the browser window, and will not move even if the window 
is scrolled: 

Example 

p.pos_fixed { 
    position: fixed; 
    top: 30px; 
    right: 5px; 
} 

Fixed positioned elements are removed from the normal flow. The document and other elements behave like the 
fixed positioned element does not exist. 

Fixed positioned elements can overlap other elements. 

Relative Positioning 

A relative positioned element is positioned relative to its normal position: 

Example 

h2.pos_left { 
    position: relative; 
    left: -20px; 
} 
h2.pos_right { 
    position: relative; 
    left: 20px; 
} 

The content of relatively positioned elements can be moved and overlap other elements, but the reserved space 
for the element is still preserved in the normal flow. 

Example 

h2.pos_top { 
    position: relative; 
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    top: -50px; 
} 

Relatively positioned elements are often used as container blocks for absolutely positioned elements. 

Absolute Positioning 

An absolute position element is positioned relative to the first parent element that has a position other than static. 
If no such element is found, the containing block is <html>: 

Example 

h2 { 
    position: absolute; 
    left: 100px; 
    top: 150px; 
} 

Absolutely positioned elements are removed from the normal flow. The document and other elements behave 
like the absolutely positioned element does not exist. 

Absolutely positioned elements can overlap other elements. 

Overlapping Elements 

When elements are positioned outside the normal flow, they can overlap other elements. 

The z-index property specifies the stack order of an element (which element should be placed in front of, or 
behind, the others). 

An element can have a positive or negative stack order: 

Example 

img { 
    position: absolute; 
    left: 0px; 
    top: 0px; 
    z-index: -1; 
} 
  

15. CSS Float 

With CSS float, an element can be pushed to the left or right, allowing other elements to wrap around it. 

Float is often used with images, but it is also useful when working with layouts. 

How Elements Float 

Elements are floated horizontally, this means that an element can only be floated left or right, not up or down. 

A floated element will move as far to the left or right as it can. Usually this means all the way to the left or right of 
the containing element. 

1. The elements after the floating element will flow around it. 
2. The elements before the floating element will not be affected 
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3. If an image is floated to the right, a following text flows around it, to the left. 

Example 

img { 
    float: right; 
} 

Floating Elements Next to Each Other 

Place several floating elements after each other, they will float next to each other if there is room. 

Made an image gallery using the float property: 

Example 

.thumbnail { 
    float: left; 
    width: 110px; 
    height: 90px; 
    margin: 5px; 
} 
 

Turning off Float - Using Clear 

Elements after the floating element will flow around it. To avoid this, use the clear property. 

The clear property specifies which sides of an element other floating elements are not allowed. 

Add a text line into the image gallery, using the clear property: 

Example 

.text_line { 
    clear: both; 
} 
 

16. Align 

Aligning Block Elements 

A block element is an element that takes up the full width available, and has a line break before and after it. 

Examples of block elements: 

 <h1> 

 <p> 

 <div> 

Center Aligning Using the margin Property 

Block elements can be center-aligned by setting the left and right margins to "auto". 

Setting the left and right margins to auto specifies that they should split the available margin equally. The result 
is a centered element: 
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Example 

.center { 
    margin-left: auto; 
    margin-right: auto; 
    width: 70%; 
    background-color: #b0e0e6; 
} 

Cross browser Compatibility Issues 

When aligning elements like this, it is always a good idea to predefine margin and padding for the <body> 
element. This is to avoid visual differences in different browsers. 

There is a problem with IE8 and earlier, when using the position property. If a container element (in our case <div 
class="container">) has a specified width, and the! DOCTYPE declaration is missing, IE8 and earlier versions 
will add a 17px margin on the right side. This seems to be space reserved for a scrollbar. Always set the 
!DOCTYPE declaration when using the position property: 

Example 

body { 
    margin: 0; 
    padding: 0; 
} 
.container { 
 
    position: relative; 
    width: 100%; 
} 
.right { 
    position: absolute; 
    right: 0px; 
    width: 300px; 
    background-color: #b0e0e6; 
} 

Left and Right Aligning Using the Float Property 

One method of aligning elements is to use the float property: 

Example 

.right { 
    float: right; 
    width: 300px; 
    background-color: #b0e0e6; 
} 
   

17. CSS3 

CSS3 is the latest standard for CSS. 

CSS3 is completely backwards-compatible with earlier versions of CSS. 
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CSS3 Modules 

CSS3 has been split into "modules". It contains the "old CSS specification" (which has been split into smaller 
pieces). In addition, new modules are added. 

Some of the most important CSS3 modules are: 

 Selectors 

 Box Model 

 Backgrounds and Borders 

 Image Values and Replaced Content 

 Text Effects 

 2D/3D Transformations 

 Animations 

 Multiple Column Layout 

 User Interface 

CSS3 Recommendation 

Most of the CSS3 Modules are W3C Recommendations, and most of the new CSS3 properties are already 
implemented in modern browsers. 

Procedure to Create an Image Gallery in CSS 

Write the following code in editor  

<html> 
<head> 
<style> 
div.img { 
    margin: 5px; 
    padding: 5px; 
    border: 1px solid #0000ff; 
    height: auto; 
    width: auto; 
    float: left; 
    text-align: center; 
} 
 
div.img img { 
    display: inline; 
    margin: 5px; 
    border: 1px solid #ffffff; 
} 
 
div.img a:hover img { 
    border:1px solid #0000ff; 
} 
 
div.desc { 
    text-align: center; 
    font-weight: normal; 
    width: 120px; 
    margin: 5px; 
} 
</style> 
</head> 
<body> 
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<div class="img"> 
  <a target="_blank" href="klematis_big.htm"> 
    <img src="klematis_small.jpg" alt="Klematis" width="110" height="90"> 
  </a> 
  <div class="desc">Add a description of the image here</div> 
</div> 
<div class="img"> 
  <a target="_blank" href="klematis2_big.htm"> 
    <img src="klematis2_small.jpg" alt="Klematis" width="110" height="90"> 
  </a> 
  <div class="desc">Add a description of the image here</div> 
</div> 
<div class="img"> 
  <a target="_blank" href="klematis3_big.htm"> 
    <img src="klematis3_small.jpg" alt="Klematis" width="110" height="90"> 
  </a> 
  <div class="desc">Add a description of the image here</div> 
</div> 
<div class="img"> 
  <a target="_blank" href="klematis4_big.htm"> 
    <img src="klematis4_small.jpg" alt="Klematis" width="110" height="90"> 
  </a> 
  <div class="desc">Add a description of the image here</div> 
</div> 
</body> 
</html> 

Output of CSS 

 

Procedure to Set Layout in CSS 

Write the follow code in editor to set the layout 

<!DOCTYPE html> 
<html> 
<head> 
<title>HTML Layouts using DIV, SPAN</title> 
<style> 
* { 
    padding: 0; 
    margin: 0; 
    -moz-box-sizing: border-box; 
    -webkit-box-sizing: border-box; 
    box-sizing: border-box; 
} 
html, body 
{ 
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    height: 100%; 
} 
body 
{ 
    padding: 20px 0; 
    background-color: cadetblue; 
} 
#Container 
{ 
    width: 70%; /* or: any fixed width that required */ 
    height: 100%; 
    margin: 0 auto; 
    padding: 20px 0; 
    background-color: white; 
} 
#Header 
{ 
    height: 75px; /* or: any fixed height that required*/ 
    background-color: orange; 
    margin: 0 20px; 
} 
#Page 
{ 
    height: calc(100% - 125px); /* 100% - (Header.height + Footer.height) */ 
    width: 100%; 
    display: table; 
    border-spacing: 20px; 
} 
#SideBar 
{ 
    display: table-cell; 
    background-color: #9C6; 
    width: 20%; /* or: any fixed width that fits you */ 
} 
#Content 
{ 
    display: table-cell; 
    background-color: greenyellow; 
} 
#Footer 
{ 
    height: 50px; /* or: any fixed height that fits you */ 
    background-color: lightblue; 
    margin: 0 20px; 
} 
</style> 
</head> 
<body> 
<div id="Container"> 
    <div id="Header"> 
    </div> 
    <div id="Page"> 
        <div id="SideBar"> 
         </div> 
        <div id="Content"></div> 
    </div> 
    <div id="Footer"></div> 
</div> 
</body> 
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</html> 

 
Output of CSS 
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Learning Unit 3: Use JavaScript in a Website 

Overview 

In this learning unit you will learn Java Scripting concepts such as JavaScript 
Statements, Objects, Output, Comments, Variables, Data Types, Functions, Operators, 
Comparisons, Conditions, Switch, For Loop, While Loop, Breaks, Errors and Validation. 
After completion of this learning unit you will be able to apply JavaScript validation on 
various part of web pages. 

 
 

1. Definition of Client Side Scripting Language 

Client-side scripting usually refers to the class of computer programs on the web that 
are executed client-side, by the web browser, instead of server side (on the web 
server). 

 

 

2. Definition of JavaScript 

JavaScript is a programming language. 

JavaScript statements are separated by semicolons. 

Example 

<p id="demo"></p> 
<script> 
var x = 5; 
var y = 6; 
var z = x + y; 
document.getElementById("demo").innerHTML = z; 

3. Implementation of  the Basic JavaScript Concepts 

Java script code written in different 03 ways: 

- Inline JavaScript  
- Internal javascript 
- External javascript 

JavaScript can be placed in the <body> or <head> of an HTML page.  

The <script> Tag 

 JavaScript code must be inserted between <script> and </script> tags  

JavaScript is not the 
same thing as Java. 
Which is just a 
programming 
language. 

Remember 

JavaScript was 
released by 
Netscape and Sun 
Microsystems in 
1995. 

Do you know! 

A computer program 
is a list of 
"instructions" to be 
"executed" by the 
computer. In a 
programming 
language, these 
program instructions 
are called 
statements. 

Computer Program 
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<script> 
document.getElementById("demo").innerHTML = "My First JavaScript"; 
</script>  

4. Function and Event 

A JavaScript “function” is a block of JavaScript code that can be executed when "asked" for. For example, a 
function can be executed when an event occurs, like when the user clicks a button.  

5. Outputs 

JavaScript can display output data in different ways: 

- Alert box, using window.alert(). 

- HTML output using document.write(). 

- HTML element, using innerHTML. 

- In browser console, using console.log(). 

window.alert() 

Use an alert box to display message  

<!DOCTYPE html> 
<html> 
<body> 
<h1>My First Web Page</h1> 
<p>My first paragraph.</p> 
<script> 
window.alert(5 + 6); 
</script> 
</body> 
</html>  

document.write() 

For testing of values , it is easy to use document.write(): 

<h1>My First Web Page</h1> 
<p>My first paragraph.</p> 
<script> 
document.write(7 + 9); 
</script> 

 

innerHTML  

To access an HTML element, JavaScript can use the document.getElementById(id) method.  

The id attribute defines the HTML element. The innerHTML property defines the HTML content: <h1>My First 
Web Page</h1> 
 

Document Object 
Model DOM is used 
to select element is 
Javascript.  

Do you know? 
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<p>My First Paragraph</p> 
<p id="demo"></p> 
<script> 
document.getElementById("demo").innerHTML = 5 + 6; 
</script> 

console.log() 

In browser, use the console.log() method to display data. Activate the browser console with F12, and select 
"Console" in the menu. 

<h1>My First Web Page</h1> 
<p>My first paragraph.</p> 
<script> 
console.log(5 + 6); 
</script> 

6. Statements 

JavaScript statements are collection of: Values, Operators, Expressions, Keywords, and Comments. 

7. Values 

The JavaScript syntax defines two types of values: Fixed values and variable values. Fixed values are called 
literals. Variable values are called variables. 

8. Literals  

The rules for writing fixed values are: 

Numbers are written with or without decimals:  

<p id="demo"></p> 
<script> 
document.getElementById("demo").innerHTML = 10.50; 
</script> 

Strings are text, written within double or single quotes: 

“Ahmad ”, “Rabia” 

Expressions can also represent fixed values: 10 + 22, 54 * 44;  

9. Variables 

Variables are container to store data var keyword is used to declare the variable. var x; x=10; 

10. Operators  

Operators are used to perform arithmetic on numbers (literals or variables). 

Operator Description Operator Description 

+ Addition / Division 
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- Subtraction % Modulus 

* Multiplication ++ Increment 

Assignment Operators 

Assignment operators assign values to JavaScript variables. 

Operator Example Same As 

= x = y x = y 

+= x += y x = x + y 

-= x -= y x = x - y 

*= x *= y x = x * y 

/= x /= y x = x / y 

%= x %= y x = x % y 

The assignment operator (=) assigns a value to a variable. 

The addition assignment operator (+=) adds a value to a variable. 

var x = 10; 
x += 5; 

Comparison and Logical Operators 

Operator Description 

== equal to 

=== equal value and equal type 

!= not equal 

!== not equal value or not equal type 

> greater than 

< less than 

>= greater than or equal to 

<= less than or equal to 

  
 

11. JavaScript Data Types  

JavaScript variables have many data types: numbers, strings, arrays, objects and more 

var length = 16;                               // Number 
var lastName = "Johnson";                      // String 
var cars = ["Saab", "Volvo", "BMW"];           // Array 
var x = {firstName:"John", lastName:"Doe"};    // Object 
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JavaScript Arrays 

JavaScript arrays are written with square brackets. Array items are separated by commas. The following code 
declares (creates) an array called cars, containing three items (car names): 

<p id="demo"></p> 
<script> 
var cars = ["Saab","Volvo","BMW"]; 
document.getElementById("demo").innerHTML = cars[2];</script> 

12. JavaScript Objects 

JavaScript objects are written with curly braces. 

Object properties are written as name: value pairs, separated by commas.   

<p id="demo"></p> 
<script> 
var person = { 
    firstName : "Khalid", 
    lastName  : "Hussain", 
    age       : 50, 
    eyeColor  : "blue" 
}; 
document.getElementById("demo").innerHTML = 
person.firstName + " is " + person.age + " years old."; 
</script> 

13. JavaScript Function  

A JavaScript function is a block of code designed to perform a particular task. A JavaScript function is executed 
when "something" invokes it (calls it). 

function myFunction(p1, p2) { 
    return p1 * p2;       // The function returns the product of p1 and p2 
} 

Function Syntax 

A JavaScript function is defined with the function keyword, followed by a name, followed by parentheses (). 

Function names can contain letters, digits, underscores, and dollar signs (same rules as variables). 

The parentheses may include parameter names separated by commas: (parameter1, parameter2, …) 

The code to be executed, by the function, is placed inside curly brackets: {} 

function name(parameter1, parameter2, parameter3) { 
    code to be executed 

Function Invocation 

The code inside the function will execute when "something" invokes (calls) the function: 

 When an event occurs (when a user clicks a button) 
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 When it is invoked (called) from JavaScript code 

 Automatically (self-invoked) 

Function Return 

When JavaScript reaches a return statement, the function will stop executing. 

If the function was invoked from a statement, JavaScript will "return" to execute the code after the invoking 
statement. 

Functions often compute a return value. The return value is "returned" back to the "caller": 

var x = myFunction(4, 3);        // Function is called, return value will end up in x 
 
function myFunction(a, b) { 
    return a * b;                // Function returns the product of a and b 
} 

14. Comments 

JavaScript comments can be used to explain JavaScript code, and to make it more readable. 

JavaScript comments can also be used to prevent execution, when testing alternative code. 

Single line comments start with // text which will be comment within single line. 

Multi-line comments start with /* (text of multiline will be comment) and end with */  

15. Comparison and Logical Operators 

Comparison operators are used in logical statements to determine equality or difference between variables or 
values.  

Given that x = 5, the table below explains the comparison operators: 

Operator Description Comparing Returns 

== equal to 
x == 8 false 

x == 5 true 

=== equal value and equal type 
x === "5" false 

x === 5 true 

!= not equal x != 8 true 

!== not equal value or not equal type 
x !== "5" true 

x !== 5 false 

> greater than x > 8 false 

< less than x < 8 true 

>= greater than or equal to x >= 8 false 

<= less than or equal to x <= 8 true 
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Logical Operators 

Logical operators are used to determine the logic between variables or values. Given that x = 6 and y = 3, the 
table below explains the logical operators:  

Operator Description Example 

&& And (x < 10 && y > 1) is true 

|| Or (x == 5 || y == 5) is false 

! Not !(x == y) is true 

   
 

16. Conditional Statements 

Conditional statements are used to perform different actions based on different conditions.   

In JavaScript we have the following conditional statements: 

 Use if to specify a block of code to be executed, if a specified condition is true 

 Use else to specify a block of code to be executed, if the same condition is false 

 Use else if to specify a new condition to test, if the first condition is false 

 Use switch to specify many alternative blocks of code to be executed 

If statement 

Use the if statement to specify a block of JavaScript code to be executed if a condition is true. 

Syntax 

if (condition) { 
    block of code to be executed if the condition is true 
}  

else Statement 

Use the else statement to specify a block of code to be executed if the condition is false. 

if (condition) { 
    block of code to be executed if the condition is true 
} else {  
    block of code to be executed if the condition is false 
} 

Example 

If the hour is less than 18, create a "Good day" greeting, otherwise "Good evening": 

if (hour < 18) { 
    greeting = "Good day"; 
} else { 
    greeting = "Good evening"; 
}  
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The else if Statement 

Use the else if statement to specify a new condition if the first condition is false. 

Syntax 

if (condition1) { 
    block of code to be executed if condition1 is true 
} else if (condition2) { 
    block of code to be executed if the condition1 is false and condition2 is true 
} else { 
    block of code to be executed if the condition1 is false and condition2 is false 
} 

Example 

If time is less than 10:00, create a "Good morning" greeting, if not, but time is less than 20:00, create a "Good 
day" greeting, otherwise a "Good evening": 

if (time < 10) { 
    greeting = "Good morning"; 
} else if (time < 20) { 
    greeting = "Good day"; 
} else { 
    greeting = "Good evening"; 
}  

The result of greeting will be: 

Good day 

17. Switch Statements 

The switch statement is used to perform different actions based on different conditions. 

The JavaScript Switch Statement 

Use the switch statement to select one of many blocks of code to be executed. 

Syntax 

switch(expression) { 
    case n: 
        code block 
        break; 
    case n: 
        code block 
        break; 
    default: 
        default code block 
}  

This is how it works: 

 The switch expression is evaluated once. 

 The value of the expression is compared with the values of each case. 
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 If there is a match, the associated block of code is executed. 

Example 

The getDay() method returns the weekday as a number between 0 and 6. (Sunday=0, Monday=1, Tuesday=2 
..) 

Use the weekday number to calculate weekday name: 

switch (new Date().getDay()) { 
    case 0: 
        day = "Sunday"; 
        break; 
    case 1: 
        day = "Monday"; 
        break; 
    case 2: 
        day = "Tuesday"; 
        break; 
    case 3: 
        day = "Wednesday"; 
        break; 
    case 4: 
        day = "Thursday"; 
        break; 
    case 5: 
        day = "Friday"; 
        break; 
    case 6: 
        day = "Saturday"; 
        break; 
} 

18. For Loop 

Loops can execute a block of code a number of times.  

Instead of Writing: 

text += cars[0] + "<br>";  
text += cars[1] + "<br>";  
text += cars[2] + "<br>";  
text += cars[3] + "<br>";  
text += cars[4] + "<br>";  
text += cars[5] + "<br>";  

write the below command: 

for (i = 0; i < cars.length; i++) {  
    text += cars[i] + "<br>";} 

Different Kinds of Loops 

JavaScript supports different kinds of loops: 

for - loops through a block of code a number of times 
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for/in - loops through the properties of an object 

while - loops through a block of code while a specified condition is true 

do/while - also loops through a block of code while a specified condition is true 

The For Loop 

The for loop is often the tool use when need to create a loop. 

The for loop has the following syntax: 

for (statement 1; statement 2; statement 3) { 
    code block to be executed 
} 

Statement 1 is executed before the loop (the code block) starts. 

Statement 2 defines the condition for running the loop (the code block). 

Statement 3 is executed each time after the loop (the code block) has been executed. 

Example 

for (i = 0; i < 5; i++) { 
    text += "The number is " + i + "<br>"; 
} 

19. While Loop 

The while loop loops through a block of code as long as a specified condition is true. 

Syntax 

while (condition) { 
    code block to be executed 
} 

Example 

In the following example, the code in the loop will run, over and over again, as long as a variable (i) is less than 
10: 

Example 

while (i < 10) { 
    text += "The number is " + i; 
    i++; 
} 

Do/While Loop 

The do/while loop is a variant of the while loop. This loop will execute the code block once, before checking if the 
condition is true, then it will repeat the loop as long as the condition is true. 
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Syntax 

do { 
    code block to be executed 
} 
while (condition); 

Example 

The example below uses a do/while loop. The loop will always be executed at least once, even if the condition is 
false, because the code block is executed before the condition is tested: 

Example 

do { 
    text += "The number is " + i; 
    i++; 
} 
while (i < 10); 

Comparing For and While 

The for loop, discover that a while loop is much the same as a for loop, with statement 1 and statement 3 omitted. 

The loop in this example uses a for loop to collect the car names from the cars array: 

Example 

var cars = ["BMW", "Volvo", "Saab", "Ford"]; 
var i = 0; 
var text = ""; 
 
for (;cars[i];) { 
    text += cars[i] + "<br>"; 
    i++; 
}  

The loop in this example uses a while loop to collect the car names from the cars array: 

Example 

var cars = ["BMW", "Volvo", "Saab", "Ford"]; 
var i = 0; 
var text = ""; 
 
while (cars[i]) { 
    text += cars[i] + "<br>"; 
    i++; 
} 

20. Break and Continue 

The break statement "jumps out" of a loop. 

The continue statement "jumps over" one iteration in the loop. 
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The Break Statement 

It was used to "jump out" of a switch() statement. 

The break statement can also be used to jump out of a loop.    

The break statement breaks the loop and continues executing the code after the loop (if any): 

Example 

for (i = 0; i < 10; i++) { 
    if (i === 3) { break; } 
    text += "The number is " + i + "<br>"; 
} 

The Continue Statement 

The continue statement breaks one iteration (in the loop), if a specified condition occurs, and continues with 
the next iteration in the loop. 

This example skips the value of 3:  

Example 

for (i = 0; i < 10; i++) { 
    if (i === 3) { continue; } 
    text += "The number is " + i + "<br>"; 
}  

21. Errors Handling - Throw and Try to Catch 

The try statement lets test a block of code for errors.  

The catch statement lets handle the error. 

The throw statement lets create custom errors. 

The finally statement lets execute code, after try and catch, regardless of the result. 

JavaScript try and Catch 

The try statement allows to define a block of code to be tested for errors while it is being executed. 

The catch statement allows to define a block of code to be executed, if an error occurs in the try block. 

The JavaScript statements try and catch come in pairs: 

try { 
    Block of code to try 
} 
catch(err) { 
    Block of code to handle errors 
}  
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JavaScript Throws Errors 

When an error occurs, JavaScript will normally stop, and generate an error message. 

The technical term for this is: JavaScript will throw an error. 

The throw Statement 

The throw statement allows to create a custom error. 

The technical term for this is: throw an exception. 

The exception can be a JavaScript String, a Number, a Boolean or an Object: 

throw "Too big";    // throw a text 
throw 500;          // throw a number 

Use throw together with try and catch & control program flow and generate custom error messages. 

22. Form Validation 

 

Task 1. Write a JavaScript Program to Display the Current Day and Time. 

01: Write the follow Code in Editor: 

<!DOCTYPE html>   
  <html>   
  <head>   
  <meta charset="utf-8">   
  <title>JavaScript current day and time</title>   
  </head>   
  <body></body>   
</html>  

02- Write the JavaScript code in header of page.  

  var today = new Date(); 
  var day = today.getDay(); 
  var daylist = ["Sunday","Monday","Tuesday","Wednesday ","Thursday","Friday","Saturday"]; 
  console.log("Today is : " + daylist[day] + "."); 
  var hour = today.getHours(); 
  var minute = today.getMinutes(); 
  var second = today.getSeconds(); 
  var prepand = (hour >= 12)? " PM ":" AM "; 
  hour = (hour >= 12)? hour - 12: hour; 
  if (hour===0 && prepand===' PM ')  
  {  
  if (minute===0 && second===0) 
  {  
  hour=12; 
  prepand=' Noon'; 
  }  
  else 
  {  
  hour=12; 
  prepand=' PM'; 
  }  



Module 6: Develop Website Using Client Side Scripting Language 

330 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

  }  
  if (hour===0 && prepand===' AM ')  
  {  
  if (minute===0 && second===0) 
  {  
  hour=12; 
  prepand=' Midnight'; 
  }  
  
 else 
  {  
  hour=12; 
  prepand=' AM'; 
  }  
  }  
console.log("Current Time : "+hour + prepand + " : " + minute + " : " + second); 

03- Out Put of Program 

 

Task 2. Write a JavaScript Program to Print the Contents of the Current Window 

01- Write the follow Code in Editor: 

<!DOCTYPE html> 
<html> 
<head> 
<meta charset=utf-8 /> 
<title>Print the current page.</title> 
</head> 
<body> 
<p></p> 
<p>Click the button to print the current page.</p> 
<button onclick="print_current_page()">Print this page</button> 
</body> 
</html> 

02- Write following JavaScript Code 

function print_current_page() 
{ 
window.print(); 
} 

03- Output of Program 
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Task 3. Write a JavaScript Program to get the Current Date 

01: Write the follow Code in Editor: 

<!DOCTYPE html> 
  <html> 
  <head> 
  <meta charset="utf-8"> 
  <title>Write a JavaScript program to get the current date.</title> 
  </head> 
  <body> 
  </body> 
  </html> 

02- Write the follow Code in JavaScript 

var today = new Date(); 
var dd = today.getDate(); 
//The value returned by getMonth is an integer between 0 and 11, referring 0 to January, 1 to February, and so 
on. 
var mm = today.getMonth()+1;  
var yyyy = today.getFullYear(); 
if(dd<10)  
{ 
    dd='0'+dd; 
}  
 
if(mm<10)  
{ 
    mm='0'+mm; 
}  
today = mm+'-'+dd+'-'+yyyy; 
alert(today); 
today = mm+'/'+dd+'/'+yyyy; 
alert(today); 
today = dd+'-'+mm+'-'+yyyy; 
alert(today); 
today = dd+'/'+mm+'/'+yyyy; 
alert(today); 

03- Program Output 

 

04- Write a JavaScript Program to Calculate Multiplication and Division of two Numbers (input from 
user) 

01- Write the follow Code in Editor: 

<!DOCTYPE html> 
<html>  
<head> 
<meta charset=utf-8 /> 
<title>JavaScript program to calculate multiplication and division of two numbers </title> 
<style type="text/css"> 
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body {margin: 30px;} 
</style>  
</head> 
<body> 
<form> 
1st Number : <input type="text" id="firstNumber" /><br> 
2nd Number: <input type="text" id="secondNumber" /><br> 
<input type="button" onClick="multiplyBy()" Value="Multiply" /> 
<input type="button" onClick="divideBy()" Value="Divide" /> 
</form> 
<p>The Result is : <br> 
<span id = "result"></span> 
</p> 
</body> 
</html> 

02- Write the follow Code in javaScript 

 
function multiplyBy() 
{ 
        num1 = document.getElementById("firstNumber").value; 
        num2 = document.getElementById("secondNumber").value; 
        document.getElementById("result").innerHTML = num1 * num2; 
} 
function divideBy()  
{  
        num1 = document.getElementById("firstNumber").value; 
        num2 = document.getElementById("secondNumber").value; 
document.getElementById("result").innerHTML = num1 / num2; 
} 

03- Program Output 

 

Task 4. JavaScript Form Validation using a Sample Registration Form 

HTML form validation can be done by a JavaScript. 

If a form field (fname) is empty, this function alerts a message, and returns false, to prevent the form from being 
submitted: 

JavaScript Example 

function validateForm() { 
    var x = document.forms["myForm"]["fname"].value; 
    if (x == null || x == "") { 



 Module 6: Develop Website Using Client Side Scripting Language 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 333 

        alert("Name must be filled out"); 
        return false; 
    } 
} 

The function can be called when the form is submitted: 

HTML Form Example 

<form name="myForm" action="demo_form.asp" onsubmit="return validateForm()" method="post"> 
Name: <input type="text" name="fname"> 
<input type="submit" value="Submit"> 
</form> 

01: Write the follow Code in Editor: 

<!DOCTYPE html> 
<html lang="en"><head> 
<meta charset="utf-8"> 
<title>JavaScript Form Validation using a sample registration form</title> 
<meta name="keywords" content="example, JavaScript Form Validation, Sample registration form" /> 
<meta name="description" content="This document is an example of JavaScript Form Validation using a sample 
registration form. " /> 
<link rel='stylesheet' href='js-form-validation.css' type='text/css' /> 
<script src="sample-registration-form-validation.js"></script> 
</head> 
<body onload="document.registration.userid.focus();"> 
<h1>Registration Form</h1> 
<p>Use tab keys to move from one input field to the next.</p> 
<form name='registration' onSubmit="return formValidation();"> 
<ul> 
<li><label for="userid">User id:</label></li> 
<li><input type="text" name="userid" size="12" /></li> 
<li><label for="passid">Password:</label></li> 
<li><input type="password" name="passid" size="12" /></li> 
<li><label for="username">Name:</label></li> 
<li><input type="text" name="username" size="50" /></li> 
<li><label for="address">Address:</label></li> 
<li><input type="text" name="address" size="50" /></li> 
<li><label for="country">Country:</label></li> 
<li><select name="country"> 
<option selected="" value="Default">(Please select a country)</option> 
<option value="AF">Australia</option> 
<option value="AL">Canada</option> 
<option value="DZ">India</option> 
<option value="AS">Russia</option> 
<option value="AD">USA</option> 
</select></li> 
<li><label for="zip">ZIP Code:</label></li> 
<li><input type="text" name="zip" /></li> 
<li><label for="email">Email:</label></li> 
<li><input type="text" name="email" size="50" /></li> 
<li><label id="gender">Sex:</label></li> 
<li><input type="radio" name="msex" value="Male" /><span>Male</span></li> 
<li><input type="radio" name="fsex" value="Female" /><span>Female</span></li> 
<li><label>Language:</label></li> 
<li><input type="checkbox" name="en" value="en" checked /><span>English</span></li> 
<li><input type="checkbox" name="nonen" value="noen" /><span>Non English</span></li> 
<li><label for="desc">About:</label></li> 
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<li><textarea name="desc" id="desc"></textarea></li> 
<li><input type="submit" name="submit" value="Submit" /></li> 
</ul> 
</form> 
</body> 
</html> 

02- Style Sheet  

h1 { 
margin-left: 70px; 
} 
form li { 
list-style: none; 
margin-bottom: 5px; 
} 
form ul li label{ 
float: left; 
clear: left; 
width: 100px; 
text-align: right; 
margin-right: 10px; 
font-family:Verdana, Arial, Helvetica, sans-serif; 
font-size:14px; 
} 
form ul li input, select, span { 
float: left; 
margin-bottom: 10px; 
} 
form textarea { 
float: left; 
width: 350px; 
height: 150px; 
} 
[type="submit"] { 
clear: left; 
margin: 20px 0 0 230px; 
font-size:18px 
} 
p { 
margin-left: 70px; 
font-weight: bold; 
} 
02- Write the follow code in javaScript 
function formValidation() 
{ 
var uid = document.registration.userid; 
var passid = document.registration.passid; 
var uname = document.registration.username; 
var uadd = document.registration.address; 
var ucountry = document.registration.country; 
var uzip = document.registration.zip; 
var uemail = document.registration.email; 
var umsex = document.registration.msex; 
var ufsex = document.registration.fsex; if(userid_validation(uid,5,12)) 
{ 
if(passid_validation(passid,7,12)) 
{ 
if(allLetter(uname)) 
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{ 
if(alphanumeric(uadd)) 
{  
if(countryselect(ucountry)) 
{ 
if(allnumeric(uzip)) 
{ 
if(ValidateEmail(uemail)) 
{ 
if(validsex(umsex,ufsex)) 
{ 
} 
}  
} 
}  
} 
} 
} 
} 
return false; 
 
} function userid_validation(uid,mx,my) 
{ 
var uid_len = uid.value.length; 
if (uid_len == 0 || uid_len >= my || uid_len < mx) 
{ 
alert("User Id should not be empty / length be between "+mx+" to "+my); 
uid.focus(); 
return false; 
} 
return true; 
} 
function passid_validation(passid,mx,my) 
{ 
var passid_len = passid.value.length; 
if (passid_len == 0 ||passid_len >= my || passid_len < mx) 
{ 
alert("Password should not be empty / length be between "+mx+" to "+my); 
passid.focus(); 
return false; 
} 
return true; 
} 
function allLetter(uname) 
{  
var letters = /^[A-Za-z]+$/; 
if(uname.value.match(letters)) 
{ 
return true; 
} 
else 
{ 
alert('Username must have alphabet characters only'); 
uname.focus(); 
return false; 
} 
} 
function alphanumeric(uadd) 
{  
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var letters = /^[0-9a-zA-Z]+$/; 
if(uadd.value.match(letters)) 
{ 
return true; 
} 
else 
{ 
alert('User address must have alphanumeric characters only'); 
uadd.focus(); 
return false; 
} 
} 
function countryselect(ucountry) 
{ 
if(ucountry.value == "Default") 
{ 
alert('Select the country from the list'); 
ucountry.focus(); 
return false; 
} 
else 
{ 
return true; 
} 
} 
function allnumeric(uzip) 
{  
var numbers = /^[0-9]+$/; 
if(uzip.value.match(numbers)) 
{ 
return true; 
} 
else 
{ 
alert('ZIP code must have numeric characters only'); 
uzip.focus(); 
return false; 
} 
} 
function ValidateEmail(uemail) 
{ 
var mailformat = /^\w+([\.-]?\w+)*@\w+([\.-]?\w+)*(\.\w{2,3})+$/; 
if(uemail.value.match(mailformat)) 
{ 
return true; 
} 
else 
{ 
alert("Entered an invalid email address!"); 
uemail.focus(); 
return false; 
} 
} function validsex(umsex,ufsex) 
{ 
x=0; 
 
if(umsex.checked)  
{ 
x++; 
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} if(ufsex.checked) 
{ 
x++;  
} 
if(x==0) 
{ 
alert('Select Male/Female'); 
umsex.focus(); 
return false; 
} 
else 
{ 
alert('Form Succesfully Submitted'); 
window.location.reload() 
return true; 
} 
} 

03- Program Output 
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Summary of Module 

  HTML is the universal markup language for the Web. HTML lets format text, add graphics, create 
links. It also lets input forms, frames and tables, etc., and save it all in a text file that any browser can 
read and display. The key to HTML is the tags, which indicates what content is coming up. 

  CSS is used to control the style and layout of multiple Web pages all at once. With CSS, all formatting 
can be removed from the HTML document and stored in a separate file. CSS gives total control of 
the layout, without messing up the document content. 

  JavaScript can make web site more dynamic. A static web site is nice when just want to show flat 
content, but a dynamic web site can react to events and allow user interaction. JavaScript is the most 
popular scripting language on the internet and it works with all major browsers. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What does DOCTYPE mean?  

Answer 

The term DOCTYPE tells the browser which type of HTML is used on a webpage. In turn, the 
browsers use DOCTYPE to determine how to render a page. Failing to use DOCTYPE or using 
a wrong DOCTYPE may load the page in Quirks Mode. See example: 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 
"http://www.w3.org/TR/html4/loose.dtd"> 

FAQ 2:  How many HTML tags are should be used for the most simple of web pages? 

Answer 

8 total. 4 pairs of tags. 
<HTML> 
<HEAD> 
<TITLE>Simplest page ever!</TITLE> 
</HEAD> 
<BODY> 
Doesn’t get simpler than this. 
</BODY> 
</HTML> 

FAQ 3:  How do you make comments without text being picked up by the browser? 

Answer 
Comments are used to explain and clarify code or to prevent code from being recognized by 
the browser. Comments start with “*<!--” and end with ” -->“. 
<!-- Insert comment here. --> 

FAQ 4:  What can be done with style sheets that cannot be accomplished with regular HTML? 

Answer 

Many of the recent extensions to HTML have been tentative and somewhat crude attempts to 
control document layout. A style sheet goes several steps beyond, and introduces complex 
border, margin and spacing control to most HTML elements. It also extends the capabilities 
introduced by most of the existing HTML browser extensions. Background colors or images can 
now be assigned to ANY HTML element instead of just the BODY element and borders can now 
be applied to any element instead of just to tables. For more information on the possible 
properties in CSS, see the Index DOT CSS Property Index. 

FAQ 5:  Why use Style Sheets? 

Answer 
Style sheets allow a much greater degree of layout and display control than has ever been 
possible thus far in HTML. 

FAQ 6:  How to change the background color of website? 

Answer 

To change the background color of the website, search for the "background-color" property for 
the appropriate CSS class. Then modify its value to the desired color. If the background color is 
not set yet, you can add the following line to the CSS file: body {background-color: silver} it can 
change "silver" to the HTML code of the desired color. 

FAQ 7:  Who defines the CSS standard? Is it one person? A company? 

Answer 

The W3C (the organization in charge of defining the HTML standards) creates and develops the 
CSS specifications with public input from the W3C www-style mailing list discussion forum and 
feedback from the member companies that comprise the W3C Consortium (which include 
companies such as Apple, Microsoft, and Netscape along with over 150 others.) 
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FAQ 8:  Between JavaScript and an ASP script, which is faster? 

Answer 
JavaScript is faster. JavaScript is a client-side language and thus it does not need the assistance 
of the web server to execute. On the other hand, ASP is a server-side language and hence is 
always slower than JavaScript. 

FAQ 9:  Is it possible to break JavaScript Code into several lines? 

Answer 
Breaking within a string statement can be done by the use of a backslash, ‘\’, at the end of the 
first line 

FAQ 10:  What is a prompt box in JavaScript? 

Answer 
A prompt box is a box which allows the user to enter input by providing a text box.  Label and 
box will be provided to enter the text or number. 
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Test Yourself! 

Please mark the correct one from the given options.  

1.  A webpage displays a picture. What tag was used to display that picture? 

a.  picture b.  image 

c.  img d.  src 

2.  <b> tag makes the enclosed text bold. What is other tag to make text bold? 

a.  <strong> b.  <dar> 

c.  <black> d.  <emp> 

3.  Tags and text that are not directly displayed on the page are written in _____ section. 

a.  <html> b.  <head> 

c.  <title> d.  <body> 

4.  Which tag inserts a line horizontally on the web page? 

a. <hr> b. <line> 

c. <line direction=”horizontal”> d. <tr> 

5.  What should be the first tag in any HTML document? 

a. <head> b. <title> 

c. <html> d. <document> 

6. How can make a bulleted list? 

a. <list> b. <nl> 

c. <ul> d. <ol> 

7. Choose the correct HTML tag for the smallest size heading? 

a. <heading> b. <h6> 

c. <h1> d. <head> 

8. The ____________ selector is used to specify a style for a single, unique element 

a. Id b. class 

c. text d. Bit 
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9. The ____________ property specifies which sides of an element other floating elements are 
not allowed. 

a. cleared b. clear 

c. float d. Both A and B  above 

10. Which of the below is the correct way to set a background image? 

a. body{background-image:url(paper.gif);} b. body {background-image:url(‘paper.gif’)}; 

c. body {background-image:url(‘paper.gif’)} d. body {background-image:url(‘paper.gif’);} 

11. To specify table border in CSS, ____________ property is  used 

a. tbl-border b. table-border 

c. tb-border d. border 

12. JavaScript is _________ side scripting language. 

a. Server b. ISP 

c. Browser d. None of these. 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 b 

4 a 

5 c 

6 c 

7 b 

8 a 

9 b 

10 d 

11 d 

12 c 
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Module 7: Develop Website Using Server 
Side Scripting Languages 

Learning Outcomes 

After completion of this learning module, the you will be able to: 

  Develop a Website using ASP Dot Net  

  Develop a Website using PHP 
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Learning Unit 1: Develop a Website using ASP Dot Net 

Overview 

In this learning unit, you will be introduced about the basics of ASP.Net and will able to 
develop website using ASP.Net. After the completion of this unit, you will be able to 
understand: how to install visual studio dot Net, share detail of dot Net framework, 
environment of visual studio, visual studio toolbar and window of visual studio.net, 
illustration the design view, source view, code view of web pages. You will also learn 
HTML controls and how to execute application of Server controls such as button, 
textbox, hyperlink, radio button, calendar, panel etc. You will also learn how to 
implement data server control such as GridView, DetailView, FormView, 
SqlDatasource Access, Datasource etc. You will also learn how to use validation controls such as required field 
validator, Range validator, Validation summary, Creation of navigation control such as menu, Tree view etc. 

1. ASP.NET 

The Active Server Pages (ASP), which also known as Classic ASP, was introduced by Microsoft in 1998 as first 
server side scripting language for web servers. 

The ASP.NET has following new features: 

 It’s a new generation of old classic ASP.  

 Its pages are faster than old ASP.  

 It supports better GUI controls, XML-based components and integrated user 
authentication. 

 It pages have extension .aspx 

It supports android, iPhone and Windows phone using SignalR 

2. Install Visual Studio.NET 

Procedure for Installing Visual Studio 

1) System Requirements: 

a) Operating systems 

i) Windows 7  with service pack 1(x86 and x64) 

ii) Windows 8 or higher (x86 and x64) 

b) Hardware requirements 

i) Minimum processor 1.6 Giga hz 

ii) Minimum 1 GB Ram 

iii) 4 GB Disk space  

Signalr supports 
two way 
communications 
between server and 
client. 

Remember 

Buttons, textboxes, 
lists, combo box 
from status bar 

GUI Elements 
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c) Additional requirements 

i) This version of Visual Studio works best with Internet Explorer 10 or higher. If Internet Explorer 10 
is not installed on computer, some features might not work as expected. 

STEP BY STEP Installing Visual Studio Express 2013 for Web 

1. Start Browsing to www.microsoft.com/express and follow the instruction to download visual studio 
express for web 2013. It can be installed directly by choosing the Download and then the Install Now 
link or can be downloaded an ISO file to burn on a DVD or mount on windows as a virtual drive. Make 
sure to download visual studio express for Web and not one of the other free Express editions or older 
versions. If this link ever change then directly search the web for “install visual studio express 2013 
for web” and it will take to a download page where installation can start. 

 

 

2. When the download completes, start the installer. See a screen similar to Figure 1-1. Check the checkbox 
for the license terms and privacy Policy. If installing the full version of Visual Studio, Click the Next button 
that appeared when “I agreed to the license terms”. Similar to Figure 1-2. Make sure to select at least the 
Microsoft Web Developer Tools option. 

3. In both cases, click the install button to start the installation process. 

http://www.microsoft.com/express
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4. After a while a message comes indicating that visual studio has been installed successfully. The installer 
may need to restart computer during or after the installation. Once when the installer has finished, visual 
studio is ready to use. 
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3. Details of Dot Net Framework 

What is .NET? 

 The Microsoft .net is a complete framework for creating windows-based and web-
based applications for clients. 
 

 The Microsoft .NET is not a language but a supportive runtime library for writing 
and executing written programs in any language. 
 
 

STEP BY STEP Creating First Asp.Net Website 

1. Start visual studio from the window start menu . On the menu item it is called visual studio Express 2013 

for Web. If one have Microsoft account then will be able to use multiple support of visual studio team. 

2. Once VS is fully configured, the main screen appears as shown in figure 1. All configurations of windows, 

toolbar, panels, and menu is in next coming section now just focus is on creating first new website. 

 

Figure 1 

The .NET library has 
number of built-in 
functions which can 
be simultaneously 
used by different 
languages like 
Visual BASIC.NET, 
C#.NET etc. 

Remember 
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Figure 2 

3. The New website dialog box appears as shown in Figure2 also select destination folder where application 
store and then type application name in this tutorial WebApplication1 is default name. 

 

Figure 3 

4. In the middle of the dialog, above list of available templates, select .NET Framework 4.5.1 from the drop-down 
list. Then on left section choose a programming language to use for site. In This TLM all example are shown 
in Visual C#. 

5. In the list of templates click ASP.NET Web Form Site also verify the location where user want. 

6. Click OK. VS creates a new website that includes a numbers of file and folders (see Figure4) to jump start 

website. 

7. Open the default.aspx file and double click it and remove all the code inside the <asp:content> block that has 
it ID set to bodycontent then (it start with <div> at line 5 and ends with </div>) all the way at bottom replace it 
with the following bold code: 
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Figure 4 

<asp:Content runat="server" ID="BodyContent" ContentPlaceHolderID="MainContent"> 

<h2>Hello student in programming World</h2> 

<p>We love pakistan </p></asp:Content> 

8. Press CTRL+5 or click on  button  to open the page on default web browser to see 

a page similar to the one which show below 

 

Figure 5 

9. Notice how a small icon representing IIS Express 1.5 has appeared in the tray bar of Windows visible in figure. 
This icon is belonging to build in server called IIS Express this web server started automatically when visual 
studio starts. 

4. Environment of Visual Studio.NET 

Visual studio is the most expensive and rich in feature IDE (Integrated Development 
Environment). Instead of writing code in text editor, compiling code in command line, 
writing HTML and Css code in separate application and managing database. VS 

enable to perform the entire task and more in same environment. 

 

 

IDE separate all tool 
you need to build 
complex website 
and web application 
are integrated in 
single environment 

IDE 
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1. The Main Development Area 

 

2. The Main Menu 

At the top application below the title bar is the main menu. This menu bar contains many familiar items to find 
in much other window application. Like File, Edit and help menus. 

 

3. The Toolbar Area 

Right below the menu, see the toolbar area that give quick access to the most common functions in VS. Some 
toolbars appear automatically while working on a task that requires a particular toolbar’s presence, but there 
is option to enable and disable toolbars to liking. To enable or disable a toolbar, right-click an existing toolbar 

or the menu bar and choose the toolbar from the menu that appears. 

4. The Toolbox 

On the left of the main screen push away at the border of VS, the tab for the Toolbox is appeared. If clicked 
the tab, the Toolbox folds out, giving a chance to see what it contains. If clicked the little pin icon in the upper-
right corner of the Toolbox (or any of the other panels that have this pin icon), it gets pinned to the IDE so it 
remains open. 
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If the Toolbox is not visible on-screen, press Ctrl+Alt+X to open it or choose View ->Toolbox, provided and 
have chosen the Expert Settings option in the Tools -> Settings menu. 

5. The Solution Explorer 

At the right of the screen, see the Solution Explorer. The Solution Explorer is an important window because it 
gives an overview of the files that contain website. Instead of placing all files in one big folder, the Solution 
Explorer enables to store files in separate folders, creating a logical and organized site structure.  
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Solution Explorer can:- 

 Add new files to site 

 Move existing files around using drag and drop or cut and paste 

 Rename files 

 Delete them from the project 

Much of the functionality of the Solution Explorer is hidden behind its right-
click menu, which changes depending on the item right-click. 

One can access the Solution Explorer by choosing View -> Solution 
Explorer from the main menu or by pressing Ctrl+Alt+L. 

 

6. The Properties Grid 

Proper Grid enables to view and edit the properties of many items in Visual 
Studio, including files in the Solution Explorer, controls on a web page, 
properties of the page itself, and much more. The window constantly 
updates itself to reflect the selected item. Shortcut to open the Properties Grid and force the Properties Grid 
to show the details of a selected item is F4. 

 

7. The Document Window 

Navigation through different document of project is easy. To switch between documents, press Ctrl+Tab, click 
the tab for the document to see, or click the down arrow in the upper-right corner of the Document Window, 
next to the Solution Explorer. 

8. The Start Page 
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Whenever VS starts up, the Start Page is loaded in the Document Window. Start Page provides option to 
quickly create new and open existing websites and other projects. The Start Page also provides a number of 
links to related news and information about web development. To pin favorite projects to the Start Page, click 
the pin icon to the left of the project name in the list with recent projects. To unpin a project, right-click it and 
choose Remove from List. To reopen the Start Page, choose View -> Start Page. 

1. Informational Windows 

The windows that are visible by default when starting VS, many more windows are available.  

The Error List 

The Error List gives a list of the things that are currently somehow broken in site, including incorrect 
markup in ASPX or HTML files and programming errors in VB or C# files. This window can even show 
errors in XML and CSS files. The Error List shows its messages in three categories — Errors, Warnings, 
and Messages — that signify the severity of the problem. Figure below shows the Error List for a page 
that has some problems with its CSS and XHTML. 

 

 The Find Results Window 

The Find and Replace features of VS are invaluable tools when it comes to managing the content of 
site. Often there is need to replace some text in the current document or even in the entire site. Find in 
Files (Ctrl+Shift+F) and Replace in Files (Ctrl+Shift+H) both output their results in the Find Results 

window, as shown in Figure below. 

 

 Customizing the IDE 

Although the standard setup of Visual Studio and its tool windows is pretty useful, there’s a fair chance 
to want to customize the IDE to liking. Some of the windows can be moved to a location where they are 
easier to reach, or it can be open additional windows that are frequently used. Visual Studio is fully 

customizable and enables to tweak every little detail of the IDE.  

Rearranging Windows give each window the location it deserves; drag and drop in the main IDE can 
be done. Simply drag window title bar or its bottom tab and drag into the direction of new location. 
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5. Source View, Design View, and Split View 

1. Source View 
VS enables to look at Web Form from a few different angles. When a file with markup — like a Web Form, 
three buttons at the bottom-left corner of the window are shown. With these buttons, visible in Figure below, 
one can switch between the different views. 

 STEP BY STEP Source View   

1. Open WebApplication1 in visual Studio 
2. Click on Source View 

 

 

2. Design View 

With design view one can add html and html form tags by drag and drop. 
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STEP BY STEP Design View   

1. Open WebApplication1 in visual Studio 
2. Click on DesignView 

 

 
3. Split View 

Split view shows source code as well as design of project. 
 

STEP BY STEP Split View   

1. Open WebApplication1 in visual Studio 
2. Click on SplitView 

 

6. HTML Controls 

1. Table 
a. Two method for adding table in web page  

i. Drag and drop table tag from toolbar 



Module 7: Develop Website Using Server Side Scripting Languages 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 359 

STEP BY STEP      Table Creation by Drag and Drop/ by Coding 

1. Open WebApplication1 in visual Studio 
2. Click on toolbar and drag and drop it on first HtmlPage.Html 

 

 

ii. Type the code directly in code editor 

 

2. Div 
Div tag in html is use for setting layout of the web page. In asp.net following steps to insert div tag in webpage 
 

STEP BY STEP     Inserting Div from Toolbar/ by Coding 

1. Open WebApplication1 in visual Studio 
2. Click on toolbar and drag and drop it on first HtmlPage.Html 

 

HTML controls are 
Table, Div, Image,  
Text area 

HTML Controls 
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1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html and type the code in figure below 

 

3. Image 

 STEP BY STEP Inserting Image from Toolbar/Coding 

1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html drag image tag from toolbar see  figure below 
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1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html type the code in figure below. 

 

 

Learner’s Activity 

1. Create a webpage titled htmlcontrols 

2. Insert div tag and set css for width and height 

3. Inside div tag insert table with heading row 
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4. Insert image below the table 

5. Insert text area below the image 

 

7. Server Controls 

1. Buttons 

 STEP BY STEP     Button form Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx.Html drag button from toolbar see figure below 

 

 
 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type cod in figure 1.2 

 

      
 
 
 

 

Server Controls are 
Button, Textbox, 
Hyperlink, Radio 
But-ton, Calendar, 
Panel, Label etc. 

Server Controls 
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2. Textbox 

  STEP BY STEP     Textbox form Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html drag it from toolbar in figure below 

 

 

Figure 1.1 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure 1.2 

 

 

Figure 1.2 
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3. Hyperlink 

 STEP BY STEP     Hyperlink form Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html drag it from toolbar in figure below 

 

 
 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 
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4. Radio Button 

STEP BY STEP Radio Button form Toolbar/Code 

1. Open WebApplication1 in visual Studio 
2. Open first HtmlPage.Html drag it from toolbar in figure below 

 

 
 

1.  Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 
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5. Calendar 

 STEP BY STEP    Calendar from Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 

 

 
 
1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 

 

 
 

6. Panel 

 STEP BY STEP     Panel from Toolbar and by Typing Code                                                 .         

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 
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1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 

 

 
 

7. Label 

STEP BY STEP     Label from Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 
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1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 

 

 
 

Learner’s Activity 

1. Create webpage titled server controls 
2. Insert Div tag of main class and type code in point 3 
3. {width:100%; min-height:500px; background-color:#ff3842;} 
4. Insert panel 
5. In panel Insert 4 label 
6. In front of 4 label there is 4 textbox  
7. Below text box and label insert radio button for selecting gender 
8. Insert age field with the help of label, textbox and calendar 
9. Insert button for submit  
10. Insert link and set all state CSS like a:hover,link,visited,activ 
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8. Data Server Controls 

Data source and data-bound controls working together 

The SqlDataSource control enables quickly to create functional, database-driven web 
pages. Without writing a whole lot of code, web pages are created that enable to perform 
all four operations of the CRUD acronym: Create Read, Update, and Delete data. 
Although its name may seem to imply that the control can access only Microsoft’s SQL 
Server, that’s not the case. The control can access other databases, such as Oracle or 
MySQL, as well. 

 

1. Grid View 

In Asp.net Grid View is a control which enables developers to represent data in the form of spreadsheet like rows 
and column to select, sort and edit these items. To give an idea of how the SqlDataSource control works in 
conjunction with the databoundcontrols. 

 

STEP BY STEP   GridView with SqlDataSource from Toolbar/Code 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 

 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 

MS Access is a 
DBMS application in 
which you can 
create database as 
well as frontend like 
from and reports 

Remember 

Server Controls are 
as Grid View, 
Details View, Form 
View, 
SqlDataSource,  
AccessDataSource 
etc. 

Data Server 

Controls 
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2. Details View 

Just as displaying, updating, and deleting data with the GridView are pretty easy, so is inserting data with the 
DetailsView control. The DetailsView supports a number of templates that enables to customize the look and feel 
of the control in different modes. For example, the control has a <HeaderTemplate>, a <FooterTemplate>, and 
a <PagerTemplate> element that enables to define the look of the top and bottom parts of the control. In addition, 
the control has a <Fields> element that enables to define the rows that should appear in the control, much like the 
<Columns> element of the GridView 

STEP BY STEP DetailView with SqlDataSource from Toolbar and by Typing Code 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 
 

 
 
1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 

ODBC 

ODBC (open 
database 
connectivity) is 
standard 
programming 
language. It is 
middle ware API for 
accessing database 
management 
system 
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3. Form View 

It is similar to the DetailsView control, except that it requires the user to define the 
rendering of each item using templates, instead of using data control fields.  

The main difference between DetailsView and FormView is that DetailsView has a 
built-in tabular rendering, whereas FormView requires a user-defined template for its 
rendering. The FormView and DetailsView object model are very similar otherwise.  

 

 STEP BY STEP GridView with SqlDataSource from Toolbar  

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 

 

 

Responsive Design 

Responsive Website 
or web application 
gives response on 
any screen or media 
type 
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4. AccessDataSource 

The AccessDataSource control represents a connection to an Access database. It is 
based on the SqlDataSource control and provides simpler programming interface. 

The AccessDataSource control opens the database in read-only mode. However, it can 
also be used for performing insert, update, or delete operations. This is done using the 
ADO.NET commands and parameter collection. 

 

 

STEP BY STEP AccessDataSource  

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 
 

 

  

ADO.Net 

ADO.NET stands for 
ActiveX Data Object. 
ADO is 
programming 
interface which is 
use to access 
databases like (sql 
server, MS Access , 
Oracle etc. 

https://quickstarts.asp.net/QuickStartv20/util/classbrowser.aspx?assembly=System.Web%2c+Version%3d2.0.3600.0%2c+Culture%3dneutral%2c+PublicKeyToken%3db03f5f7f11d50a3a&namespace=System.Web.UI.WebControls&class=AccessDataSource
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Learner’s Activity 

1. Open visual studio create new website 

2. In server explorer create new database titled dataservercontrol 

3. Create table country table which have c-id and c-name field 

4. Create province table which have p-id,p-name,c-id field 

5. Create relationship of both table with the help of keys 

6. Insert data of the above tables 

7. Create new webpage in website titled dataservercontrol 

8. Retrieve all data from database using Gridview, DetailView, and FormView 

 

9. Share Details of and Implementation 

Validation controls enables to rapidly create Web Forms with validation rules that prohibit users from entering 
invalid data. For example, force users to enter values for required fields and check whether the entered data 
matches a specific format like a valid date or a number between 1 and 10. They even allow to write custom code 
to create validation routines that are not covered by the standard controls. The beauty of the validation controls is 
that they can execute both on the client and the server, enabling to create responsive and secure web applications. 

ASP.NET 4.5.1 has six controls to perform validation in website. Five of them are 
used to perform the actual validation, whereas the final control — 
ValidationSummary — is used to provide feedback to the user about any errors 
made in the page. Figure 1.1 shows the available controls in the Validation category 
of the Toolbox. 

Importance of validation controls 

These controls are extremly helpful in validating the data that a user enters in the 
system. They can easily be hooked to other controls like the TextBox or a 
DropDownList; however, they also support custom validation scenarios. Figure 1.2 
demonstrates two of the validation controls RequiredFieldValidator and 
RangeValidator — at work to prevent a user from submitting the form without 
entering required and valid data. 

 

          Figure 1.1 

 

Figure 1.2 
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1. Using the RequiredFieldValidator  
The RequiredFieldValidator is actually very simple, and yet very useful. It can be used to make sure that 
the user has entered something in a TextBox control. Let's give it a try, and add a RequiredFieldValidator to 
page. Also add a TextBox to validate, as well as a button to submit the form with. 
 

STEP BY STEP   RequiredFieldValidator 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx drag it from toolbar in figure below 
 

 
 

Out put: 

 
 
2. Range Validator 

Range validator does exactly likes its name it make sure that the user input must be within the range. 
Developer can use it to validate number, strings, date and time. 
 

STEP BY STEP   Range Validator  

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 
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Output: 
 

 
 
3. Validation Summary 

It does not perform any validation but show a summary of all errors in the page. 
The summary display the value of error messages. The ValidationSummary 
control provides the user with a list of errors that it retrieves from the individual 
validation control’s ErrorMessage properties.  
 

STEP BY STEP     Validation Summary 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx type code in figure below 
 

Error Display Ways 

Errors are displayed 
in three different 
ways:  

 list embedded in 

the page 

 JavaScript alert 

box 

 both at the same 

time 
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Output: 

 

Learner’s Activity 

1. Open WebApplication1 in visual Studio 
2. Create new webpage titled contactform.aspx 
3. Type the code for  figure below 

 

 
 

4. Apply RequirdFieldValidator, RangeValidator, and ValidationSummary 
5. The output in browser should looke like figure below 
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10. Navigation Controls 

Navigation Controls 

The controls find under the Navigation category of the Toolbox are used to let users find 
their way through site. The TreeView control presents a hierarchical display of data and 
can be used to show the structure of site, giving easy access to all the pages in the site. 
The Menu control does a similar thing and provides options for horizontal and vertical 
fold-out menus. 

The SiteMapPath control creates a “breadcrumb trail” in web pages that enables users 
to easily find their way up in the hierarchy of pages in site. Figure below demonstrate 
three navigation controls without applying any styling. 

Do you know! 

Sitemap show 
complete hierarchy 
of website pages. 
Usually show in the 
footer section of the 
web page 
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1. Menu 
 
Menu control is a navigation control used to display site navigation information. This can be used to show 
website structure horizontally or vertically.  Menu control can be used as two types static and dynamic. 
 

STEP BY STEP     Static Menu 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx page 
3. Add a new web form in solution explorer 
4. Drag and drop menu control on the form from toolbar 
5. Select View=Static as shown in figure below 

 

 
 
6. Now click Edit Menu Items...Add parent and child nodes as shown in figure below 
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7. See the output in browser shown in figure below 
 

 
 

 STEP BY STEP      Dynamic Menu 

1. Open WebApplication1 in visual Studio 
2. Open first web.aspx page 
3. Add a new web form in solution explorer 
4. Drag and drop menu control on the form 
5. Select Datasource 
6. Select XML File in figure below and press OK 

 

XML 

XML stand for 
(EXtensible Markup 
Language) it is a 
hardware and 
software 
independent tool for 
carrying information 
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7. Now click Edit Multiple DatabindingSelect each page one by one and click Add button set 
TextField =title from right side for each pageclick Apply as shown in figure below 

  

8. Output in Browser 

 

 

Do you know! 

Database is an 
organize collection 
of related data which 
is store in organize 
and compact 
manner 
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2. TreeView 
Tree View structure is use to display data logically in hierarchal manner. Developer can use it to display file 
and folder structure on the Web Pages as well as XML document, Web, Sitemap and database records. 
Items can be expanded and collapsed with the small plus and minus icons in front of items that contain child 
elements.  
 

STEP BY STEP   TreeView 

1. Open visual studioFileNewWebsiteSelect ASP.NET Empty Website OKopen solution 
explorerAdd New Web FormDrag and Drop TreeView control from Toolbox as shown in figure below 
 

 
 

2. Now go to properties of TreeView controlClick NodesAdd Root and child Node as shown in figure 1.2 

 

3. Now Run the Program(press F5) and see the output 
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Learner’s Activity 

1. Create New website in Visual Studio titled Navpractice 

2. Create 4 to 5 pages with subpages in above website 

3. Apply css style with javascript effect on navigation 

4. Apply treeview controls on submenu item and should look like in figure below 

 

 

11. Implement Login Controls 

Introducing security  

Although security can be quite a complex subject, it often revolves around three 
straightforward questions: 

1. Who are you? 

2. How can you prove that? 

3. What are you allowed to do in the system? 

Server Controls are 
Login, Login View, 
Login Name, Login 
Status and 
Password Recovery 
etc. 

Implement Login 

Controls 
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Identity: Who Are You? An identity is what makes you, you. The answer to what an identity is depends on the 
context it is used in. As a citizen of a country, your identity revolves around your person, your official name and 
birth date, and maybe even a social security number 

Asp.net login controls provides very easy way to implement complex login system without coding. It provides you 
to a ready-to-use interface and quires where the username and password from the user and offer the login button 
for login. It also provides login view, login name, and login status also password recovery is handy feature in login 
controls.  

ASP.NET 4.5.1 ships with seven login controls, each serving a distinct purpose. Figure 1.1 shows the Toolbox 
with the seven login controls (the pointer is present in all Toolbox categories and is not a login control). 

 STEP BY STEP Login 

1. Open visual studioFileNewWebsiteSelect ASP.NET Empty Website OKopen solution 
explorerAdd New Web FormDrag and Drop Login control from Toolbox in figure below 

 

 
 
2. Now Run the Program(press F5) and see the output 

 

 

2. LoginView 

The LoginView is a handy control that display different data to different users. It enables to differentiate 
between anonymous and logged-in users, and even differentiate between users in different roles. The following 
table describes the two main templates and the special RoleGroups element. 

Template Description 

AnonymousTemplate The content in this template is shown to unauthenticated users only. 

LoggedInTemplate 
The content in this template is shown to logged-in users only. This template 
is mutually exclusive with the AnonymousTemplate. Only one of the two 
can be visible at any time. 
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RoleGroups 

This control can contain one or more RoleGroup elements that, in turn, 
contain a ContentTemplate element that defines the content for the 
specified role. The role or roles that are allowed to see the content are 
defined in the Roles attribute, which takes a comma-separated list of roles.  
The RoleGroups element is mutually exclusive with the LoggedInTemplate. 
That means that if a user is a member of one of th roles for the RoleGroup, 
the content in the LoggedInTemplate is not visible. Additionally, only 
content for the first RoleGroup that matches the user’s roles is shown. 

The login view control itself doesn’t output any markup other than the content define in the Various child elements 
of the control, which means, can easily embed it between a pair of HTML Tags like <h1>and <lid> to create 
customized headings or list items. The following code snippet shows a login view control that defines content for 
three different users: 

Anonymous visitors to the site, logged-in users, and users that have logged in and are members of the Manager’s 
role: 

<asp:LoginView ID="LoginView1" runat="server"> 
<AnonymousTemplate> 
Hi there visitor. Would you be interested in signing up for an account? 
</AnonymousTemplate> 
<LoggedInTemplate> 
Hi there visitor and welcome back to PlanetWrox.com. 
</LoggedInTemplate> 
<RoleGroups> 
<asp:RoleGroup Roles="Managers"> 
<ContentTemplate> 
Hi there manager. You can proceed to the Management section. 
</ContentTemplate> 
</asp:RoleGroup> 
</RoleGroups> 
</asp:LoginView> 

3. LoginStatus 

As demonstrated in the previous Step By Step, the LoginStatus control 
provides information about the current status of the user. It provides a Login 
link when the user is not authenticated and a Logout link when the user is 
already logged in. It controls the actual text being displayed by setting the 
LoginText and LogoutText properties.  

Alternatively, it used to set the LoginImageUrl and LogoutImageUrl 
properties to display an image instead of text. When setting both an image and 

a text, the image is shown and the text is used as the alternative text for the image.  

Finally, set the LogoutAction property to determine whether the current page refreshes if the user logs out, 
or whether the user is taken to another page after logging out. User determine this destination page by setting 
the LogoutPageUrl. Besides these properties, the control is capable of raising two events, LoggingOut and 
LoggedOut, which fire right before and after the user is logged out. 

4. LoginName 

LoginName is an extremely simple control. All it does is display the name of the logged-in user. To embed 
the user’s name in some text, such as “You are logged in as Imar”, use the FormatString property. If included 
{0} in this format string, it will be replaced with the user’s name.  
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STEP BY STEP      LoginName 

This method hides the Login control on the Login.aspx page when the user is already logged in and display a 
message instead. Additionally, add text to the footer of the page that displays the name of the user together with 
an option to log out again. 

1. Open Login.aspx and switch to Design View. From the Login category of the Toolbox, drag a new 
LoginView control on top of the Login control so it’s placed right above it in the page. 

2. Open the Smart Tasks panel of the LoginView control and make sure that AnonymousTemplate is 
selected in the Views drop-down list, visible in Figure 1.1. 

3. Any content put in the control is placed in the AnonymousTemplate area, because that is now the active 
template for the control in Design View. 

4. Click the Login control once to select it and then press Ctrl+X to cut it to the clipboard. Click inside the 
small white rectangle that represents the LoginView to position the cursor in the control, and then press 
Ctrl+V to paste the Login control into LoginView. 

5. Open the Smart Tasks panel of the LoginView again and switch to the LoggedInTemplate using the 
Views drop-down list. Click inside the small white rectangle of the control again and type the text “You 
are already logged in”. 

6. Switch to Markup View and look at the code. The Login control should be placed inside the 
AnonymousTemplate, and the text typed should be displayed within the LoggedInTemplate tags: 

<asp:LoginView ID="LoginView1" runat="server"> 
<AnonymousTemplate> 
<asp:Login ID="Login1" runat="server" CreateUserUrl="SignUp.aspx" 
DestinationPageUrl="~/Default.aspx" 
CreateUserText="Sign Up for a New Account at Planet Wrox"> 
</asp:Login> 
</AnonymousTemplate> 
<LoggedInTemplate> 
You are already logged in. 
</LoggedInTemplate> 
</asp:LoginView> 

7. Save and close the page now. 

8. Open the master page Frontend.master in Markup View and locate the <footer> element at the bottom of 
the page. Remove the text Footer Goes Here and replace it with a new LoginName control by dragging it 
from the Toolbox into the <footer> element. Set its FormatString property to Logged in as {0} by typing in 
the code directly: <asp:LoginName ID="LoginName1" runat="server" FormatString="Logged in as {0}" /> 

9. From the Toolbox, drag a new LoginView control and drop it below the LoginName control, but still in the 
<footer> element. Switch to Design View, and on the Smart Tasks panel of the LoginView, choose 
LoggedInTemplate from the Views drop-down list. Then in the white rectangle for the active 
LoggedInTemplate, drag and drop a new LoginStatus control. 

10. Switch to Markup View again and wrap the code for the LoginStatus in a pair of parentheses. Now end up 
with the following code: 

 

 



Module 7: Develop Website Using Server Side Scripting Languages 

386 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

 

Figure 1.2 

<footer> 

<asp:LoginName ID="LoginName1" runat="server" FormatString="Logged in as {0}" /> 
<asp:LoginView ID="LoginView1" runat="server"> 
<LoggedInTemplate> 
(<asp:LoginStatus ID="LoginStatus1" runat="server" />) 
</LoggedInTemplate> 
</asp:LoginView> 
</footer> 

11. Open the Web.config file and modify the <authentication> element so it points the loginUrl to ~/Login/ like 
this: 

<authentication mode="Forms"> 
<forms loginUrl="~/Login"/> 
</authentication> 

12. Save all changes and request Login.aspx in browser. Log in with the account and password created in a 
previous exercise (log out first by clicking the Logout link if needed). If no need to recall the username and 
password, simply click the Sign Up link to create a new account. Note that as soon as logged in, the footer 
displays the text visible in Figure 1.2. 

13. Click the Login item in the Menu or TreeView to go to the Login page. Instead of the Login control, a 
message appears indicating that “You are already logged in”. 

14. Click the Logout link in the footer at the bottom of the page. The page refreshes and displays the Login 
control again. Additionally, the text from the footer has now disappeared. 

PasswordRecovery 

The PasswordRecovery control enables users to retrieve their existing passwords (when the system supports it) 
or to get a new auto-generated password. In both cases, the password is sent to the e-mail address that the user 
entered when signing up for an account. 

PasswordRecovery Properties: 

Text properties: 

 GeneralFailureText (shown when the password could not be recovered) 

 SuccessText, that enable to set the text that is displayed by the control.  

 ButtonType, ButtonText, and ButtonImageUrl, which enables to change the look and behavior of the various 
action buttons of the control.  

SuccessPageUrl are set to a page in site to send the user to another page when password recovery succeeds. 

As with the CreateUserWizard, the PasswordRecovery control also has a MailDefinition element that can point to 
a file that user want to send as the mail body. Same placeholders can be used for the username and password to 
customize the message. If user leave out the MailDefinition, the control uses a default mail body. 
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ChangePassword 

The ChangePassword control enables existing and logged-in users to change their passwords. It has a host of 
properties to change things like text, error messages, and buttons, similar to the CreateUserWizard and 
PasswordRecovery controls. It also has a MailDefinition element that enables to send a confirmation of the new 
password to the user’s e-mail address.  

STEP BY STEP      PasswordRecovery and ChangePassword 

This STEP BY STEP add PasswordRecovery and ChangePassword controls to the website to enable users to 
change and recover their passwords. Because changing a password makes sense only for logged-in users, add 
the ChangePassword control to its own page. In the next chapter, protect this page so only authenticated users 
can access it. 

1. Open up Login.aspx in Markup View and locate the closing </asp:Login> tag inside the 
<AnonymousTemplate>. Right after it, type two <br /> elements (use the br code snippet and press Tab 
to complete the element) to create some room below the Login control. 

2. Drag a PasswordRecovery control from the Toolbox into the code editor, right after the two <br/> 
elements added in step 1. 

3. Between the opening and closing tags of the PasswordRecovery control, add <MailDefinition> element 
and then set the Subject of the e-mail to Your New Password for website1. Code should now look like 
this: 

</asp:Login> 
<br /> 
<br /> 
<asp:PasswordRecovery ID="PasswordRecovery1" runat="server"> 
<MailDefinition Subject="Your New Password for PlanetWrox.com"></MailDefinition> 
</asp:PasswordRecovery> 

4. Save changes and close the file. 

5. In the root of site, create a new Web Form based on custom template and call it MyProfile.aspx. Set the 
Title of the page to My Profile. 

6. Make sure Markup View selected and in the cpMainContent content placeholder, create an <h1> element 
(type h1 followed by the Tab key) with its contents set to My Profile. Right below the heading, type some 
text that explains that the My Profile page is used for things like changing passwords. Wrap the text in a 
pair of <p> tags to denote a paragraph. 

7. Drag a ChangePassword control from the Toolbox and drop it after the closing </p> tag. End up with 
something like this: 

8.  

<asp:Content ID="Content2" ContentPlaceHolderID="cpMainContent" runat="Server"> 
<h1>My Profile</h1> 
<p>The My Profile page allows you to make changes to your personal profile. 
For now, all you can do is change your password below.</p> 
<asp:ChangePassword ID="ChangePassword1" runat="server"></asp:ChangePassword> 

9. Open the Web.sitemap file from the Solution Explorer and add a new element in the about section. Let the 
URL point to ~/MyProfile and set the title and description to My Profile. End up with this code: 
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Figure 1.1 

<siteMapNode url="~/About/Default" title="About" 
description="About this site"> 
<siteMapNode url="~/About/Contact" title="Contact Us" 
description="Contact Us" /> 
<siteMapNode url="~/About/AboutUs" title="About Us" 
description="About Us" /> 
<siteMapNode url="~/MyProfile" title="My Profile" 
description="My Profile" /> 
</siteMapNode> 

 

10. Save all changes and close all open files. Right-click Login.aspx in the Solution Explorer and choose View 
in Browser. Below the Login control, now see the PasswordRecovery control, visible in Figure1.1 

Note that if already logged in, user need to click the Logout link first. 

11. Enter username in the PasswordRecovery control and click the Submit button. User should get an e-
mail message with new, auto-generated password. 

12. Use this new password to log in to the site. When user logged in, choose About => My Profile from the 
Menu or the TreeView. The ChangePassword control visible in Figure 1.2 appears. 

 

Figure 1.2 

13. Enter the auto-generated password that was sent by e-mail, type a new password that is easier to 
remember, and then retype the same password. Finally, click Change Password. From now on, user can 
log in to the site using new password. 
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12. Web Form, Master Page, Web User Control, HTML Page and Style Sheet 

1. Web Form 
Web form is used to take the input from users in frontend and we can store it in database as well as for 
validation and checking variable values from one page to another. In asp.net all server controls must appear 
within a <form> tag and the form tag must contain runat=”server” attribute. The code look like this after 
creation 
 

<form name="name of form" method="post or Get" action="page.aspx" id="type id here"> 
...some code 
</form> 

 

Now Run the Program (press F5) and see the output 

 

2. Master Page: 
Master page allows to create consistent design of website/web application. It provide template for other pages 
with shared functionality and layout. Master page define placeholder for the content which can be easily 
overridden in every page. The output consist of master page and child pages contents. Every website or Web 
Application consist of some area which is same in every pages like header, navigation, footer, and sidebar so 
master gives the advantage to not type same code again and again. 

 

STEP BY STEP      Creating Master Pages 

1. Open the WebApplication1 project in Visual Studio if it is not open already. 
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2. Create a folder called MasterPages to hold master pages and then added a single master page to that 
folder. To do this, create the MasterPages folder in the root of the site, right-click the new folder, choose 
Add -> Add New Item, and select the Master Page item. Make sure that the master page uses Code 
Behind and that it is using the programming language selected for the site. Name the master page 
Frotend.master. Finally, click Add. 

3. Add the following highlighted code between the <form> tags of the master page, replacing the <div> tags 
and the ContentPlaceHolder that VS added when created the master page. Note that this is almost the 
same code added in previous exampl<asp:ContentPlaceHolder> element and the <a> element within 
the Header <div>. The <a> element takes the user back to the homepage, and will be styled later. 

<form id="form1" runat="server"> 
<div id="PageWrapper"> 
<header><a href="/">Header Goes Here</a></header> 
<nav>Menu Goes Here</nav> 
<section id="MainContent"> 
<asp:ContentPlaceHolder ID="cpMainContent" runat="server"> 
</asp:ContentPlaceHolder> 
</section> 
<aside id="Sidebar">Sidebar Goes Here</aside> 
<footer>Footer Goes Here</footer> 
</div> 
</form> 

Make sure to have the ContentPlaceHolder within the MainContent <section> tags. Drag one from the 
Toolbox onto the page or enter the code directly, using IntelliSense’s helpful hints. In both cases give the 
control an ID of cpMainContent. 

4. Next, switch the master page into Design View and then drag Styles.css from the Styles folder in the Solution 
Explorer onto the master page. As soon as drop the file, VS updates the Design View and shows the layout 
for the site that created. If the design doesn’t change, switch to Markup View and ensure there’s a <link> tag 
in the head of the page pointing to CSS file: 

<asp:ContentPlaceHolder ID="head" runat="server"> 
</asp:ContentPlaceHolder>  
<link href="../Styles/Styles.css" rel="stylesheet" type="text/css" /> 
</head> 

 The page should now look like Figure below in Design View. 

 

Note the area with the purple border around it between the menu and the footer region in Design View. This is the 
ContentPlaceHolder control that is used by the content pages. 

5. Save and close the master page now. 
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Creating Content Pages 

A master page is useless without a content page that uses it. Generally, there are only a few master pages, 
whereas many content pages are in site. To base a content page on a master page, check the Select Master 
Page option at the bottom right of the Add New Item dialog box when adding a new Web Form to site. Alternatively, 
set the MasterPageFile attribute on the page directly in the Markup View of the page.  

@ Page directive shown earlier in this chapter when master and content pages were introduced. Content pages 
can only directly contain Content controls that each map to a ContentPlaceHolder control in the master page. 
These content controls in turn can contain standard markup like HTML and server control declarations.  

Because the entire markup in a content page needs to be wrapped by <asp:Content> tags, it’s not easy to turn an 
existing ASPX page into a content page. Usually the easiest thing to do is copy the content that want to keep to 
the clipboard, delete the old page, and then add a new page based on the master page to the website. Once the 
page is added, paste the markup within the <asp:Content> tags.  

STEP BY STEP       Adding a Content Page 

In this STEP BY STEP see how to add a content page to the site that is based on the master page created earlier. 
Once the page is added, add content to the <asp:Content> regions. 

In previous exercises added standard ASPX pages to project, which should now be “upgraded” to make use of the 
new master page. If want to keep the welcome text added to Default.aspx earlier, copy all the HTML between the 
MainContent <section> tags to the clipboard <h1> and the two <p> elements that created earlier) and then delete 
the Default.aspx page from the Solution Explorer. Next, right-click the website in the Solution Explorer and choose 
Add -> Add New Item. Select the correct programming language, click Web Form, name the page Default.aspx, 
and then, at the bottom of the dialog box, select the check boxes for Place Code in Separate File and Select Master 
Page, as shown in Figure below. 

 

Finally, click the Add button. 

2. In the Select a Master Page dialog box (see Figure below), click the MasterPages folder in the lefthand pane, 
and then in the area at the right, click Frontend.master. 

 



Module 7: Develop Website Using Server Side Scripting Languages 

392 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

 

Click OK to add the page to website. 

Instead of getting a full page with HTML as got with standard ASPX pages, now only get two <asp:Content> 
placeholders as shown in this VB.NET example: 

<%@ Page Title="" Language="VB" MasterPageFile="~/MasterPages/Frontend.master" 
AutoEventWireup="false" CodeFile="Default.aspx.vb" Inherits="_Default" %> 
<asp:Content ID="Content1" ContentPlaceHolderID="head" runat="Server"> 
</asp:Content> 
<asp:Content ID="Content2" ContentPlaceHolderID="cpMainContent" runat="Server"> 
</asp:Content> 

3. Switch to Design View and note that everything is grayed out and read-only, except for the <asp:Content> 
region for cpMainContent. Figure 6-5 shows how the page should look. Also note that VS conveniently lists 
the master page that this page is based on in the top-right coner of Design View, visible in Figure 1.3. Clicking 
the name opens the master page in the editor. 

4. If still have the old markup from the Default.aspx on the clipboard, click once inside the cpMainContent 
placeholder and press Ctrl+V. (Note: this can be done both in Design View and in Markup View). This adds 
the markup to the page, right between the <asp:Content> tags. 

5. Save changes by pressing Ctrl+S and press Ctrl+F5 to open the page in browser. The browser should display 
the page very closely to what saw in Design View (see Figure below). 

 

6. Now take a look at the HTML for the page in the browser. Do this by right-clicking the page and choosing View 
Source or View Page Source. Note that the source of the final page in the browser is a combination of the 
source of the master page and the content page: 

<div id="PageWrapper"> 
<header><a href="/">Header Goes Here</a></header> 
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<nav>Menu Goes Here</nav> 
<section id="MainContent"> 

<h1>Hi there visitor and welcome to Planet Wrox</h1> 
<p class="Introduction"> 
We&#39;re glad you&#39;re paying a visit to <a 
href="http://www.PlanetWrox.com"> 
www.PlanetWrox.com</a>, the coolest music community site on the Internet. 
</p> 

The first four lines come from the master page and the bolded lines of HTML code come from the content page. 

7. Switch back to VS and create a new page called Login.aspx in the root of the site based on the master page. 
Notice how VS remembered last settings with regard to the master page and Code Behind (make sure both 
are checked in case unchecked them earlier). Switch to Markup View and create an <h1> element inside the 
cpMainContent placeholder with the text Log in to our site.  

8. Go back to Default.aspx and switch to Design View. Beneath the welcome text with the header and two <p> 
elements, create a new paragraph (press Enter in Design View) and type some text (for example, can log in 
here). Notice how this new paragraph has a class attribute called Introduction because VS applies the previous 
class to new paragraphs automatically. Remove this class using the Clear Styles option of the Apply Styles 
window, or manually remove it from the code in Markup View. 

9. Highlight the words “log in” in Design View and choose Format -> Convert to Hyperlink from the main menu. 
In the dialog box that follows, click the Browse button and select the Login.aspx page that just created. Click 
OK twice. 

10. Save all changes and press Ctrl+F5 again to view Default.aspx in the browser. Then click the link created in 
the preceding step. It should take to Login.aspx. Note that the general layout, like the header and the sidebar, 
is maintained. The only thing that changes when go from page to page is the content in the main content area. 

 

Web User Controls 
User control is seprate reusable part of a page we can put a piece of page in a user control and then can reuse in 
different location in website. It just like a regular page with an optional code behind file. User control can be included 
on multiple pages while a page can’t. 

  
HTML page and Style Sheet 
In asp.net is complete framework to develop websites and web pages with html, CSS, JavaScript and server 
scripting. Web pages are the simplest programming model for developing asp.net web pages.    

 

STEP BY STEP       HTML Page 

1. Open Solution Explorer and right click on website name  
2. Click on Add button on popup window click on HTML page and press OK 
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STEP BY STEP       Adding CSS 

1. Open Solution Explorer and right click on website name  
Click on Add button Click style sheet 
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Learning Unit 2: Develop a Website using PHP 

Overview 

In this module you will learn the definition and detail about php also how to install the php 
editor such as Macromedia Dreamweaver to computer. You will also learn the 
communication detail of the php environment and syntax. You will be also learning how 
to recognize the variable, apply the php constant, operator types, decision making in php, 
php loop type, php GET and POST method also how to upload php files and php function.  

You will also learn that how to implement php cookies and session, send php Email, 
upload php file, demonstrate php coding standards, php pre-define variable, php Regular 
expression etc. You will also learn how to handle php error, php built-in function as well 
as how to install and configure mysql database with php website also how to create dynamic web pages in php.   

1. Introduction of PHP 

PHP is a versatile server-side programming language that works hand-in-hand with 
front-end Web languages such as HTML and JavaScript.  PHP can be used to create 
all types of dynamic web interfaces, and because of its open-source robustness, has 
become one of the most widely used programming languages for the Internet. 

PHP started out as a small open source project that evolved as more and more people 
found out how useful it was. RasmusLerdorf unleashed the first version of PHP way 
back in 1994. 

 PHP is a recursive acronym for "PHP: Hypertext Preprocessor". 

 PHP is a server side scripting language that is embedded in HTML. It is used 
to manage dynamic content, databases, session tracking, even build entire 
e-commerce sites. 

 It is integrated with a number of popular databases, including MySQL, 
PostgreSQL, Oracle, Sybase, Informix, and Microsoft SQL Server. 

 PHP is pleasingly zippy in its execution, especially when compiled as an Apache module on the UNIX 
side. The MySQL server, once started, executes even very complex queries with huge result sets in 
record-setting time. 

 PHP supports a large number of major protocols such as POP3, IMAP, and LDAP. PHP4 added 
support for Java and distributed object architectures (COM and CORBA), making n-tier development 
a possibility for the first time. 

 PHP is forgiving: PHP language tries to be as forgiving as possible. 

 PHP Syntax is C-Like. 

Common Uses of PHP 

The PHP has following new features: 

 PHP performs system functions, i.e. from files on a system it can create, open, read, write, and close them. 

 PHP can handle forms, i.e. gather data from files, save data to a file, email, send data, return data to the 
user. 

 It add, delete, modify elements within database using PHP. 

 Access cookies variables and set cookies. 

Do you know! 

XAMPP? 
Everything you need 
to set up a web 
server – server 
application 
(Apache), database 
(MySQL), and 
scripting language 
(PHP) – is included 
in a simple 
extractable file 
called a XAMPP. 

PHP 

PHP stands for 
Hypertext 
Preprocessor. It is a 
server-side scripting 
language. 
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 Using PHP, restrict users to access some pages of website. 

 It can encrypt data. 

Characteristics of PHP 

Five important characteristics make PHP's practical nature possible: 

 Simplicity 

 Efficiency 

 Security 

 Flexibility 

 Familiarity 

PHP - Environment Setup 

 
Procedure for installing XAMPP 

 System Requirements: 

o Operating systems 

 Windows 7  with service pack 1(x86 and x64) 
 Windows 8 or higher (x86 and x64) 

o Hardware requirements 

 Minimum processor 1.6 Giga hz 
 Minimum 1 GB Ram 
 4 GB Disk space  

 

2. Installing Adobe Dreamweaver as a PHP Editor 

We already cover installation Dreamweaver in module 3 

3. Downloading and Configuring PHP with XAMPP Server 

To begin working with PHP access to either one of the following is necessary: 

In order to develop and run PHP Web pages three vital components need to be installed on computer system. 

1. Web Server - PHP will work with virtually all Web Server software, including Microsoft's Internet 
Information Server (IIS) but then most often used is freely available Apache Server. Download Apache for 
free here: http://httpd.apache.org/download.cgi  

2. Database - PHP will work with virtually all database software, including Oracle and Sybase but most 
commonly used is freely available MySQL database. Download MySQL for free 
here: http://www.mysql.com/downloads/index.html  

http://httpd.apache.org/download.cgi
http://www.mysql.com/downloads/index.html
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3. PHP Parser - In order to process PHP script instructions a parser must be installed to generate HTML 
output that can be sent to the Web Browser. This tutorial will guide how to install PHP parser on computer. 

 

INTRODUCTION OF XAMPP 

 What is XAMPP Server? 

XAMPP stands for Cross-Platform (X), Apache (A), MySQL (M), PHP (P) and Perl (P). It is a simple, 
lightweight Apache distribution that makes it extremely easy for developers to create a local web server 
for testing purposes. Everything need to set up a web server – server application (Apache), database 
(MySQL), and scripting language (PHP) – is included in a single and simple extractable file. 

 Why use XAMPP Server? 

XAMPP is also cross-platform, which means it works equally well on Linux, Mac and Windows. Since 
most actual web server deployments use the same components as XAMPP, it makes transitioning from a 
local test server to a live server is extremely easy as well. Web development using XAMPP is especially 
for beginners to learn and use efficiently. 

 

Details of XAMPP Server? 

XAMPP has following primary components.  

These are: 

1. X: For X-OS. X-OS means it can be used for any operating systems. This is an open source platform. 
XAMPP for major operating system including windows, mac, Linux.  

2. Apache: Apache is the actual web server application that processes and delivers web content to a 
computer. Apache is the most popular web server online, powering nearly 54% of all websites. 

3. MySQL: Every web application, howsoever simple or complicated, requires a database for storing 
collected data. MySQL, which is open source, is the world’s most popular database management system. 
It powers everything from hobbyist websites to professional platforms like WordPress.  

4. PHP: PHP stands for Hypertext Preprocessor. It is a server-side scripting language that powers some of 
the most popular websites in the world, including WordPress and Facebook. It is open source, relatively 
easy to learn, and works perfectly with MySQL, making it a popular choice for web developers. 

5. Perl: Perl is a high-level, dynamic programming language used extensively in network programming, 
system admin, etc. Although less popular for web development purposes, Perl has a lot of niche 
applications. 

XAMPP comes with additional features including support of perl, filezilla, mercury mail and some scripts. 

Different versions of XAMPP may have additional components such as phpMyAdmin, OpenSSL, etc. to create full-
fledged web servers. 

 

Why PHP 

 PHP runs on various platforms (Windows, Linux, UNIX, Mac OS X, etc.) 

 PHP is compatible with almost all servers used today (Apache, IIS, etc.) 
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 PHP supports a wide range of databases 

 PHP is free. Download it from the official PHP resource: www.php.net 

 PHP is easy to learn and runs efficiently on the server side 
 

4. Details of PHP Environment and Syntax 

Since PHP is an open source, so it does not has any proper environment to work. To develop php programs we 
use either notepad or any other IDE for web like, Dreamweaver, notepad++ etc. 

STEP BY STEP Writing PHP Program 

Step 1: Click Start then All Programs then click on XAMPP then XAMPP CONTROL PANEL 

Step 2: In XAMPP server we have a folder named “htdocs”, which contains all PHP web pages. 

“htdocs” can be opened by clicking on “Explorer” in XAMPP control panel. 

 

The explorer shows all XAMPP folders, see “htdocs” folder 

 

Step 3: save .php files in htdocs folder. 

Step 4: open Notepad, and type first PHP Program. 

http://www.php.net/
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Step 5:  Now save this file in “htdocs” folder with .php extension. 

 

Step 6: now open web browser and in address bar type “localhost/first.php”, and see the result of first PHP 
code. 

 

 

Remember 

If using the MAMP 
default ports, 
use http://localhost:8
888/ for the URL. 
SPECIFING A 
WORKING FOLDER       
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4.1. Defining a PHP site in Adobe Dreamweaver CS5 

Because PHP files need to be processed by a web server, there is need to tell Dreamweaver where the testing 
server is located. Also need to tell Dreamweaver the correct URL to use when testing files. The following 
instructions assume having established a local testing environment on computer as described in the preceding 
sections. 

Identifying the Server Document Root  

The document root is the top-level folder where the server looks for web pages. Its location depends on where and 
how installed PHP testing environment. 

 

Here are the default locations for Common PHP Setups: 

 XAMPP: C:\xampp\htdocs 

 IIS: C:\inetpub\wwwroot 

 WampServer: C:\wamp\www 

 MAMP: /Applications/MAMP/htdocs 

 

The URL for the document root is http://localhost/. 

To Specify a Working Folder: 

 In Dreamweaver, select Site > New Site. 

 In the Site Name text box, type the name of site, for example, PHP Test Site. This name identifies the 
project in Dreamweaver. 

 Click the folder icon next to the Local Site Folder text box and browse to testing server's document root. 

 Create a subfolder of the document root called php_test, and select it. 

 Click Open and then Select. 

 Verify the settings in the Site Setup dialog box (see Figure 4.1) and click Save. (The location of the Local 
Site Folder will depend on how it installed PHP). 



Module 7: Develop Website Using Server Side Scripting Languages 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 401 

 

Verify the Basic Settings for the PHP Test Site. 

That's all need to do to define a site in Dreamweaver. 

 

Specifying a Testing Server for Dreamweaver 

To specify a testing server: 

1. Select Servers in the column on the left of the Site Setup dialog box. 

2. Click the plus (+) button at the bottom left of the dialog box to add a new server. 

3. In the dialog box that opens, make sure that the Basic button is selected, and select Local/Network from 
the Connect Using list. 

4. Give the server a name, such as Local Testing. 

5. Set the Server Folder to the folder specified as the Local Site Folder; in this example, php_test inside 
server's document root. 

6. For the Web URL, type the URL would use to get to the php_test folder inside the server's document root. 
Since the document root is the equivalent of http://localhost/ , need to type http://localhost/php_test/  in 
the Web URL text field (see Figure below) 

http://localhost/
http://localhost/php_test/
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The basic settings for the testing server include the Server Folder and the Web URL. 

Note: If using the MAMP default ports, the Web URL should be http://localhost:8888/php_test/ . 

7. Select the Advanced button at the top of the dialog box. This reveals the options for both a remote server and 
a testing server. 

8. For the Server Model (in the Testing Server section) select PHP MySQL (see Figure below). 

 

Set the Server Model for the testing server to PHP MySQL. 

Remember 

The folder name 
should not include 
any spaces or 
special characters. 
You should never 
use spaces or 
special characters in 
folder or file names 
for a website, 
because they cause 
problems on most 
PHP servers 

Remember 

PHP statements end 
with a semicolon (;). 

http://localhost:8888/php_test/
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9. Click Save. 

10. This is a testing server, so make sure the Testing check box is selected in the Site Setup dialog box. If 
necessary, deselect the Remote check box (see Figure below). 

 

Make sure the Testing check box is selected. 

11. Click Save to save the changes being made. 

 

Making First PHP Program Using Dreamweaver 

PHP Syntax  

A PHP script is executed on the server, and the plain HTML result is sent back to the browser. 

Basic PHP Syntax 

A PHP script can be placed anywhere in the document. 

A PHP script starts with <?php and ends with ?>: 

<?php 
// PHP code goes here 
?> 

 

The default file extension for PHP files is ".php". 

A PHP file normally contains HTML tags, and some PHP scripting code. 
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Below, an example of a simple PHP file, with a PHP script that uses a built-in PHP function "echo" to output the 
text "BISMILLA” on a web page: 

STEP BY STEP PHP Program in Dreamweaver  

Step 1: Open” Dreamweaver” and click on “PHP” 

 

Step 2: In code view type php code same as typed above then save the file in the same” htdocs” folder of 
XAMPP.  

Step 3: save the file with “first2”. 

 

CODE: 

<!DOCTYPE html> 
<html> 
<body> 
<?php 
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echo "<h1>BISMILLAH</h1>"; 
?> 

echo “the program through <b> Dreamweaver</b>”; 
 
</body> 
</html> 

Step 4: Open web browser, in address bar enter “localhost/first2.php” and press enter. 

 

 

Comments in PHP  

A comment in PHP code is a line that is not read/executed as part of the program. Its only purpose is to be read 
by someone who is looking at the code. 

Comments can be used to: 

 Let others understand what is being done. 

 Reminder of written text - Most programmers have experienced coming back to their own work a year or 
two later and having to re-figure out what they did. Comments can remind programmers of what they were 
thinking when they wrote the code 

PHP supports several ways of commenting: 
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EXAMPLE 

 

 

PHP Case Sensitivity    

In PHP, all keywords (e.g. if, else, while, echo, etc.), classes, functions, and user-
defined functions are NOT case-sensitive. 

In the example below, all three echo statements below are legal (and equal): 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Keywords are not 

case-sensitive but 

all variable names 

are case-sensitive. 

Do you know? 
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Example 

 

RESULT:  

 

However; all variable names are case-sensitive. 

In the example below, only the first statement will display the value of the $color variable (this is because $color, 
$COLOR, and $coLOR are treated as three different variables): 
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5. PHP Variables 

Variables are "containers" for storing information. 

A variable can have a short name (like x and y) or a more descriptive name (age, carname, total_volume). 

Rules for PHP variables: 

 A variable starts with the $ sign, followed by the name of the variable 

 A variable name must start with a letter or the underscore character 

 A variable name cannot start with a number 

 A variable name can only contain alpha-numeric characters and underscores (A-z, 0-9, and _ ) 

 Variable names are case-sensitive ($age and $AGE are two different variables) 
 

Creating (Declaring) PHP Variables  

In PHP, a variable starts with the $ sign, followed by the name of the variable: 

Remember 

When you assign a 
text value to a 
variable, put quotes 
around the value. 
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After the execution of the statements above, the variable $txt will hold the value Hello world!, the variable $x will 
hold the value 5, and the variable $y will hold the value 10.5. 

 

PHP is a Loosely Typed Language   

PHP automatically converts the variable to the correct data type, depending on its value. 

In other languages such as C, C++, and Java, the programmer must declare the name and type of the variable 
before using it. 

Example: 

$abc= “hello” 

PHP automatically converts $abc to string data type 

 

PHP Variables Scope      

In PHP, variables can be declared anywhere in the script. 

The scope of a variable is the part of the script where the variable can be referenced/used. 

PHP has three different variable scopes: 

 Global 

 Local 

 Static 

Remember 

Unlike other 
programming 
languages, PHP has 
no command for 
declaring a variable. 
It is created the 
moment you first 
assign a value to it. 



Module 7: Develop Website Using Server Side Scripting Languages 

410 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

Global Variable: A global variable is accessible to all the scripts in an application.  

Local Variable: A local variable is only accessible to the script that it was defined in.  

Static Variable: A static variable exists only in a local function scope, but it does not lose its value when 
program execution leaves this scope. 

 

PHP Data Types 

Variables can store data of different types, and different data types can do different 
things. 

PHP has a total of eight data types which are used to construct our variables: 

 Integers: are whole numbers, without a decimal point, like 4195. 

 Doubles: are floating-point numbers, like 3.14159 or 49.1. 

 Booleans: have only two possible values either true or false. 

 NULL: is a special type that only has one value: NULL. 

 Strings: are sequences of characters, like 'PHP supports string operations.' 

 Arrays: are named and indexed collections of other values. 

 Objects: are instances of programmer-defined classes, which can package up both other kinds of values 
and functions that are specific to the class. 

 Resources: are special variables that hold references to resources external to PHP (such as database 
connections). 

The first five are simple types, and the next two (arrays and objects) are compound - the compound types can 
package up other arbitrary values of arbitrary type, whereas the simple types cannot. 

6. PHP Constants 

 A constant is a name or an identifier for a simple value. 

 A constant value cannot change during the execution of the script. By default a constant is case-sensitive.  

 By convention, constant identifiers are always uppercase. 

 A constant name starts with a letter or underscore, followed by any number of letters, numbers, or 
underscores.  

 If already defined a constant, it can never be changed or undefined. 
 

Create a PHP Constant 

To create a constant, use the define () function. 

Syntax 

define(name, value, case-insensitive) 

 

Remember 

Unlike variables, 
constants are 
automatically global 
across the entire 
script. 
 



Module 7: Develop Website Using Server Side Scripting Languages 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 411 

Parameters: 

 name: Specifies the name of the constant 

 value: Specifies the value of the constant 

 Case-insensitive: Specifies whether the constant name should be case-insensitive. Default is false 

7. PHP - Operator Types 

What is Operator? Simple answer can be given using expression 4 + 5 is equal to 9. Here 4 and 5 are called 
operands and + is called operator. PHP language supports following type of operators. 

 Arithmetic Operators 

 Comparison Operators 

 Logical (or Relational) Operators 

 Assignment Operators 

 Conditional (or Ternary) Operators 

 String Operators 

 Array Operators 

Let’s have a look on all operators one by one. 

 

Arithmetic Operators      

There are following arithmetic operators supported by PHP language: 

Assume variable A holds 10 and variable B holds 20 then: 

Example 

Addition Operator + 

Adds two operands 

A + B will give 30 

Subtraction Operator  - 

Subtracts second operand from the first 

A - B will give -10 

Multiplication Operator * 

Multiply both operands 

A * B will give 200 

Division Operator  / 
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Divide numerator by denumerator 

B / A will give 2 

Modules Operator    % 

Modulus Operator and remainder of after an integer division 

B % A will give 0 

Increment Operator  ++ 

Increment operator, increases integer value by one 

A++ will give 11 

Decrement Operator  -- 

Decrement operator, decreases integer value by one 

A-- Will give 9 

 

Comparison Operators     

There are following comparison operators supported by PHP language 

Assume variable A holds 10 and variable B holds 20 then 

Equal to Operator   == 

Check if the value of two operands is equal or not, if yes then condition becomes true. 

(A == B) is not true. 

Not Equal to Operator  != 

Check if the value of two operands is equal or not, if values are not equal then condition becomes true. 

(A != B) is true. 

Greater than Operator   > 

Check if the value of left operand is greater than the value of right operand, if yes then condition becomes true. 

(A > B) is not true. 

Less than Operator   < 

Check if the value of left operand is less than the value of right operand, if yes then condition becomes true. 

(A < B) is true. 

Greater than Equal to   >= 

Check if the value of left operand is greater than or equal to the value of right operand, if yes then condition 
becomes true. 
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(A >= B) is not true. 

Less than Equal to   <= 

Check if the value of left operand is less than or equal to the value of right operand, if yes then condition becomes 
true. 

(A <= B) is true. 

 

Logical Operators      

There are following logical operators supported by PHP language 

Assume variable a holds 10 and variable B holds 20 then: 

Example 

AND Operator  && 

Called Logical AND operator. If all the condition are true then condition becomes true. 

(A && B) is true. 

OR Operator   || 

Called Logical OR Operator. If one condition is true than all condition becomes true. 

(A || B) is true. 

NOT Operator   ! 

Called Logical NOT Operator. Use to reverse the logical state of its operand. If a condition is true then Logical 
NOT operator will make false. 

!(A && B) is false. 

 

Assignment Operators   

There are following assignment operators supported by PHP language: 

Example 

Assignment Operator   = 

Simple assignment operator, Assigns values from right side operands to left side operand 

C = A + B will assign value of A + B into C 

Add and assignment Operator   += 

Add AND assignment operator, It adds right operand to the left operand and assign the result to left operand 

C += A is equivalent to C = C + A 
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Subtract and Assignment Operator -= 

Subtract AND assignment operator, It subtracts right operand from the left operand and assign the result to left 
operand 

C -= A is equivalent to C = C - A 

Multiply and assignment Operator  *= 

Multiply AND assignment operator, It multiplies right operand with the left operand and assign the result to left 
operand 

C *= A is equivalent to C = C * A 

Divide and assignment Operator   /= 

Divide AND assignment operator, It divides left operand with the right operand and assign the result to left operand 

C /= A is equivalent to C = C / A 

Modulus AND assignment Operator   %= 

Modulus AND assignment operator, It takes modulus using two operands and assign the result to left operand 

C %= A is equivalent to C = C % A 

 

Operators Categories     

All the operators we have discussed above can be categorized into four categories: 

1. Unary prefix operators, which precede a single operand. 

2. Binary operators, which take two operands and perform a variety of arithmetic and logical operations. 

3. The conditional operator (a ternary operator), which takes three operands and evaluates either the second 
or third expression, depending on the evaluation of the first expression. 

4. Assignment operators, which assign a value to a variable. 

 

Precedence of PHP Operators      

Operator precedence determines the grouping of terms in an expression. This affects how an expression is 
evaluated. Certain operators have higher precedence than others; for example, the multiplication operator has 
higher precedence than the addition operator: 

For example x = 7 + 3 * 2; Here x is assigned 13, not 20 because operator * has higher precedence than + so it 
first get multiplied with 3*2 and then adds into 7. 

Here operators with the highest precedence appear at the top of the table, those with the lowest appear at the 
bottom. Within an expression, higher precedence operators will be evaluated first. 
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Unary  

! ++ --  

Right to left  

Multiplicative   

* / %  

Left to right  

Additive   

+ -  

Left to right  

Relational   

<<= >>=  

Left to right  

Equality   

== !=  

Left to right  

Logical AND  

&&  

Left to right  

Logical OR  

||  

Left to right  

Conditional  

?:  

Right to left  

Assignment  

= += -= *= /= %= 

Right to left  
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8. PHP Decision Making 

Sometimes when writing code, different actions are to be performed for different decisions. Conditional statements 
are used in code to do this. PHP allows to choose what action to take based upon the result of a condition. This 
condition can be anything to choose, and can combine conditions together to make for actions that are more 
complicated. 

The if, elseif ...else and switch statements are used to take decision based on the different condition. 

Conditional statements are used in code to make decisions. PHP supports following three decision making 
statements: 

 if...else statement - use this statement to execute a set of code when a condition is true and another if 
the condition is not true 

 elseif statement - is used with the if...else statement to execute a set of code if one of several condition 
are true 

 switch statement - is used to select one of many blocks of code to be executed, use the Switch statement. 
The switch statement is used to avoid long blocks of if..elseif..else code. 

The If...Else Statement       

To execute some code if a condition is true and another code if a condition is false, use the if....else statement. 

Syntax                                                           

if (condition) 
  code to be executed if condition is true; 
else 
  code to be executed if condition is false; 

 
Example 

The following example will output "Have a nice weekend!" if the current day is Friday, otherwise it will output "Have 
a nice day!": 
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OUTPUT: 

 

 If more than one line should be executed if a condition is true/false, the lines should be enclosed within curly 
braces: 

 

The ElseIf Statement     

To execute some code if one of several conditions are true, use the elseif statement 

Syntax 

if (condition) 
  code to be executed if condition is true; 
elseif (condition) 
  code to be executed if condition is true; 
else 
  code to be executed if condition is false; 

Example 

The following example will output "Have a nice weekend!" if the current day is Friday, and "Have a nice Sunday!" 
if the current day is Sunday. Otherwise it will output "Have a nice day!": 
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The Switch Statement      

To select one of many blocks of code to be executed, use the Switch statement. The switch statement is used to 
avoid long blocks of if..elseif..else code. 

Syntax 

switch (expression) 
{ 
case label1: 
code to be executed if expression = label1; 
  break;   
case label2: 
code to be executed if expression = label2; 
  break; 
default: 
code to be executed 
  if expression is different  
  from both label1 and label2; 
 
} 

 
Example 

The switch statement works in an unusual way. First it evaluates given expression then seeks a label to match 
the resulting value. If a matching value is found then the code associated with the matching label will be executed 
or if none of the labels match then statement will execute any specified default code. 
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Output 

 

9. PHP - Loop Types 

Loops in PHP are used to execute the same block of code a specified number of times. PHP supports following 
four loop types. 

1. for - loops through a block of code a specified number of times. 

2. while - loops through a block of code if and as long as a specified condition is true. 

3. do...while - loops through a block of code once, and then repeats the loop as long as a special condition 
is true. 

4. foreach - loops through a block of code for each element in an array. 

 

The PHP for Loop      

The for-loop is used to run the script for predetermined times. 
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Syntax 

for { init counter; test counter; increment counter) code to be executed; 
} 

Parameters: 

 init counter: Initialize the loop counter value 

 Test counter: Evaluated for each loop iteration. If it evaluates to TRUE, the loop continues. If it evaluates 
to FALSE, the loop ends. 

 increment counter: Increases the loop counter value 

The example below displays the numbers from 0 to 10: 

 

Output of Above Code 

 

 

The PHP while Loop       

The while loop executes a block of code as long as the specified condition is true. 

Syntax 
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While (conditions true) { 
    code to be executed; 
} 

The example below first sets a variable $x to 1 ($x = 1). Then, the while loop will continue to run as long as $x is 
less than, or equal to 5 ($x <= 5). $x will increase by 1 each time the loop runs ($x++): 

 

 

The PHP do...while Loop    

The do...while loop will always execute the block of code once, it will then check the condition, and repeat the loop 
while the specified condition is true. 

Syntax 

do{ 
 code to be executed; 
} while (condition is true); 

The example below first sets a variable $x to 1 ($x = 1). Then, the do while loop will write some output, and then 
increment the variable $x with 1. Then the condition is checked (is $x less than, or equal to 5?), and the loop will 
continue to run as long as $x is less than, or equal to 5: 
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Output 

 

Notice: that in a do while loop the condition is tested AFTER executing the statements within the loop. This means 
that the do while loop would execute its statements at least once, even if the condition is false the first time. 

The example below sets the $x variable to 6, then it runs the loop, and then the condition is checked: 
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The foreach Loop Statement      

The foreach statement is used to loop through arrays. For each pass the value of the current array element is 
assigned to $value and the array pointer is moved by one and in the next pass next element will be processed. 

Syntax 

foreach (array as value) 
{ 
code to be executed; 
} 

 

Example 

Try out following example to list out the values of an array. 
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Output 

 

 

The Break Statement       

The PHP break keyword is used to terminate the execution of a loop prematurely. 

The break statement is situated inside the statement block. It gives full control and whenever there is need to exit 
from the loop to come out, then immediate statement to the loop will be executed. 

Example 

In the following example condition statement becomes true when the counter value reaches 3 and loop terminates. 
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Output 

 

 

The Continue Statement       

The PHP continue keyword is used to halt the current iteration of a loop but it does not terminate the loop. 

Just like the break statement the continue statement is situated inside the statement block containing the code 
that the loop executes, preceded by a conditional test. For the pass encountering continue statement, rest of the 
loop code is skipped and next pass starts. 

Example 

In the following example loop prints the value of array but for which condition becomes true it just skips the code 
and next value is printed. 
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Output of the Above Code 

 

 

10. PHP Array (What is an Array) 

An array is a data structure that stores one or more similar type of values in a single value. For example to store 
100 numbers then instead of defining 100 variables it’s easy to define an array of 100 lengths. 

There are three different kinds of arrays and each array value is accessed using an ID c which is called array 
index. 

1. Numeric array - An array with a numeric index. Values are stored and accessed in linear fashion 

2. Associative array - An array with strings as index. This stores element values in association with key 
values rather than in a strict linear index order. 

3. Multi Dimensional array - An array containing one or more arrays and values are accessed using multiple 
indices 

Numeric Array        
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These arrays can store numbers, strings and any object but their index will be pre-presented by numbers. By 
default array index starts from zero. 

Example 

Following is the example showing how to create and access numeric arrays. 

Here we have used array () function to create array. This function is explained in function reference. 

 

Output 

Don't keep 
associative array 
inside double quote 
while printing 
otherwise it would 
not return any value. 

Remember 
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Associative Arrays                

The associative arrays are very similar to numeric arrays in term of functionality but they are different in terms of 
their index. Associative array will have their index as string so that can be established a strong association 
between key and values. 

Example: To store the salaries of employees in an array, a numerically indexed array would not be the best 
choice. Instead, we could use the employees names as the keys in our associative array, and the value would be 
their respective salary. 

There are two ways to create an associative array:  

$age = array("Peter"=>"35", "Ben"=>"37", "Joe"=>"43"); 

or: 

$age['Peter'] = "35"; 
$age['Ben'] = "37"; 
$age['Joe'] = "43"; 

 

The named keys can then be used in a script: 

Example 
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Output of the above code 

 

Loop Through an Associative Array                   

To loop through and print all the values of an associative array, foreach loop could be used a, like this: 
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Multidimensional Arrays     

A multi-dimensional array each element in the main array can also be an array. And each element in the sub-
array can be an array, and so on. Values in the multi-dimensional array are accessed using multiple indexes. 

Example 

In this example we create a two dimensional array to store marks of three students in three subjects: 
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11. PHP - Strings 

A string is a sequence of characters, like "Hello world!". 

PHP String Functions    

In this section defines commonly used functions to manipulate strings. 

Get the Length of a String             

The PHP strlen() function returns the length of a string (number of characters). 

The example below returns the length of the string "Hello world!": 

 

The output of the code above will be: 12 

Count the Number of Words in a String          

The PHP str_word_count() function counts the number of words in a string: 

 

The output of the code above will be: 2 

Reverse a String      

The PHP strrev() function reverses a string: 

Do you know? 

The first character 
position in a string is 
0 (not 1). 
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The output of the code above will be: !dlrow olleH. 

Search for a Specific Text within a String          

The PHP strpos() function searches for a specific text within a string. 

If a match is found, the function returns the character position of the first match. If no match is found, it will return 
FALSE. 

The example below searches for the text "world" in the string "Hello world!": 

 

The output of the code is: 6. 

Replace Text within a String    

The PHP str_replace() function replaces some characters with some other characters in a string. 

The example below replaces the text "world" with "Dolly": 

 

The output of the code is: Hello Dolly! 
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12. PHP - GET & POST Methods 

There are two ways the browser client can send information to the web server.  

 The GET Method 

 The POST Method 

The GET Method       

The GET method sends the encoded user information appended to the page request. 
The page and the encoded information are separated by the “?” Character. 

http://www.test.com/index.htm?name1=value1&name2=value2 

 The GET method produces a long string that appears in server logs, in the 
browser's Location: box. 

 The GET method is restricted to send up to 1024 characters only.  

 Never use GET method for password or other sensitive information to be 
sent to the server. 

 GET can't be used to send binary data, like images or word documents, to 
the server. 

 The data sent by GET method can be accessed using QUERY_STRING environment variable. 

 The PHP provides $_GET associative array to access all the sent information using GET method. 

Try out following example by putting the source code in test.php script. 

 

Outputs step by step figure 12.1 

Do you know? 

Before the browser 
sends the 
information, it 
encodes it using a 
scheme called URL 
encoding. 

In GET method, 
name/value pairs 
are joined with equal 
signs and different 
pairs are separated 
by the ampersand. 

Remember 



Module 7: Develop Website Using Server Side Scripting Languages 

434 |                                              Teaching and Learning Material: Information Technology (Web Designing and Development) 

 

Figure 12.2 

 

Figure 12.3 

 

The POST Method      

The POST method transfers information via HTTP headers. The information is encoded as described in case of 
GET method and put into a header called QUERY_STRING. 

 The POST method does not have any restriction on data size to be sent. 

 The POST method can be used to send ASCII as well as binary data. 

 The data sent by POST method goes through HTTP header so security depends on HTTP protocol. 
Secure HTTP make sure that information is secure. 

 The PHP provides $_POST associative array to access all the sent information using POST method. 

Try out following example by putting the source code in test.php script. 
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Figure 1 

Output of above code is. 

 

Figure 2 

 

Figure 3 

 

Figure 4 
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The $_REQUEST variable     

The PHP $_REQUEST variable contains the contents of both $_GET, $_POST, and $_COOKIE. The PHP 
$_REQUEST variable can be used to get the result from form data sent with both the GET and POST methods. 

Try out following example by putting the source code in test.php script. 

 

Figure 1.1 

Output figure 1.1 

 

Figure 1.2 

 

Figure 1.3 
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Figure 1.4 

13. PHP - File Inclusion 

This funcion include the content of a PHP file into another PHP file before the server executes it. There are two PHP 
functions which can be used to include one PHP file into another PHP file. 

1. The include() Function 

2. The require() Function 

This is a strong point of PHP which helps in creating functions, headers, footers, or 
elements that can be reused on multiple pages.  

 

The include() Function 

The include() function takes all the text in a specified file and copies it into the file that uses the include function. 
If there is any problem in loading a file then the include() function generates a warning but the script will continue 
execution. 

To build a common menu for your website, create a file menu.php with the following content. 

 

Figure 1.1 

Now create as many pages as needed and include this file to create header. For example now test.php file can 
have following content. 

File Inclusion help 
developers to 
change code of 
included files 
instead changing all 
pages of website.  

Remember 
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Figure 1.2 

This will produce following result 

 

Figure 1.3 

The require() Function                 

The require() function works same as include(). But If there is any problem in loading a 
file then the require() function generates a fatal error and halt the execution of the 
script. Error handling is the difference between require() and include() funtions.  

Above example can be created with require() function and it will generate same result. 
But with following two examples where file does not exist then it will get different results. 

 

<html> 

<body> 

<?php include("xxmenu.php");?> 

<p>This is an example to show how to include wrong PHP file!</p> 

</body> 

</html> 

This will produce following result 

This is an example to show how to include wrong PHP file! 

Now let’s try same example with require() function. 

<html> 

You may get plain 
warning messages 
or fatal error 
messages or 
nothing at all. This 
depends on your 
PHP Server 
configuration. 

Remember 

It is recommended 
to use the require() 
function instead of 
include(), because 
scripts should not 
continue executing if 
files are missing or 
misnamed 

Remember 
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<body> 

<?php require("xxmenu.php");?> 

<p>This is an example to show how to include wrong PHP file!</p> 

</body> 

</html> 

This time file execution halts and nothing is displayed. 

14. PHP - Functions 

PHP functions are similar to other programming languages.  

Function like fopen() and fread() are built-in functions but PHP gives option to create 
own functions as well. 

There are two parts which should be clear: 

1. Creating a PHP Function 
2. Calling a PHP Function 

In fact own created PHP functions are hardly used because built-in function are always available to call according 
to requirement. 

Creating PHP Function                 

It’s very easy to create own PHP function. Following example creates a function called writeMessage() and then 
calls it just after creating it. 

Note that while creating a function its name should start with keyword function and all the PHP code should be 
put inside { and } braces as shown in the following example below: 

 

Figure 1.1 

 

 

Function 

A function is a piece 
of code which takes 
one more in-put in 
the form of 
parameter and does 
some processing 
and returns a value. 
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Output figure 1.1 

 

PHP Functions with Parameters    

PHP gives option to pass parameters inside a function. As many as parameters can be passed to functions. These 
parameters work like variables inside function. Following example takes two integer parameters and add them 
together and then print them. 

 

Figure 1.1 

This will display following result: 

Sum of the two numbers is: 30 

Passing Arguments by Reference              

It is possible to pass arguments to functions by reference. This means that a reference to the variable is 
manipulated by the function rather than a copy of the variable's value. 

Any changes made to an argument in these cases will change the value of the original variable. An argument can 
be passed by reference by adding an ampersand to the variable name in either the function call or the function 
definition. 

Following example depicts both the cases. 
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Figure 6 

This will display following result: 

Original Value is 10 

Original Value is 16  

 
PHP Functions Returning Value  

A function can return a value using the return statement in conjunction with a value or object. Return stops the 
execution of the function and sends the value back to the calling code. 

More than one value can be returned from a function using return array(1,2,3,4). 

Following example takes two integer parameters and add them together and then returns their sum to the calling 
program. Note that return keyword is used to return a value from a function. 

 

Figure 1.1 
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This will display following result: 

Returned value from the function: 30 

Setting Default Values for Function Parameters           

A parameter can be set to have a default value if the function's caller doesn't pass it. 

Following function prints NULL in case use does not pass any value to this function. 

 

Figure 1.1 

This will produce following result: 

This is test 

Dynamic Function Calls    

It is possible to assign function names as strings to variables and then treat these variables exactly as function 
name itself. Following example depicts this behavior. 

 

Figure 1.1 
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This will display following result: 

Hello 

 

 

15. PHP - Cookies and Sessions 

Cookies 

A cookie is used to identify a user. A cookie is a small file that the server embeds on the user's computer. Each 
time the same computer requests a page with a browser, it will send the cookie too. With PHP create and retrieve 
cookie values. 

Syntax   setcookie(“mycookie”,”somevalue”,time()+3600); 

In the above statement mycookie is the name of cookie somevalue is the value of cookie and time()+3600 is the 
expiry time of cookie. 

How to get cookie value 

There is a super global variable called $_COOKIE. This function can access all value of cookies 

Syntax $cookie[‘mycookie’]; 

 

How to remove cookie 

Cookie automatically expire when its time complete but to remove cookie use the past time like below code than 
cookie expired immediately. 

Syntax: setcookie(“mycookie”,”somevalue”,time()-99999); 

STEP BY STEP  Cookies Example 

1. Open Dreamweaver create php file titled firstcookie 
2. Type the code below 

<?php 
$cookie_name = "pakistan"; 
$cookie_value = "zindabad"; 
//setcookie($cookie_name, $cookie_value, time() + (86400 * 30), "/"); // 86400 = 1 day 
//setcookie($cookie_name,"",time()-99999); 
?> 
<html> 
<body> 
<?php 
if(!isset($_COOKIE[$cookie_name])) { 
echo "Cookie named '" . $cookie_name . "' is not set!"; 
} else { 
echo "Cookie '" . $cookie_name . "' is set!<br>"; 
echo "Value is: " . $_COOKIE[$cookie_name]; 
} 
?> 
<p><strong>Note:</strong>please relode the page to see the cookie value.</p> 
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</body> 
</html> 

3. run the program on Firefox  
4. The output should look like figure 1.1 

 

5. Now reload the page and the result should look like figure 1.2 

 

16. Sessions 

Session is also a way to store information in variables to be used across multiple pages. Unlike a cookie, the 
information is not stored on the user’s computer. 

While working with an application, open it, do some changes, and then close it. This is much like a Session. The 
computer knows who is using. It knows when user start the application and when to end. But on the internet there 
is one problem: the web server does not know who you are or what you do, because the HTTP address doesn't 
maintain state. 

Session variables solve this problem by storing user information to be used across multiple pages (e.g. username, 
favorite color, etc). By default, session variables last until the user closes the browser. 

How to create Session 

Session can be easily created by php built in function session_start(). But this function also written before the 
html code like cookies. To send any data before this function then php processor shows warning message 

How to get session variable value   

By using $_session[ ] super global variable it can easily access session value 

 

STEP BY STEP  Session Example 

1. Open Dreamweaver and create php file session1.php 
2. Type the code below 

<?php 
Session_start(); 
Echo “welcome to our page”; 
$_SESSION[‘user’] = ‘Touseef’; 
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$_SESSION[‘pwd] = ‘abc; 
$_SESSION[‘time] = time(); 
//work if session cookie was accepted 
Echo ‘<br /><a href=”session2.php”>page 2</a>; 
//or maybe pass along the session id, if needed 
Echo ‘<br /><a href=”session2.php?’ .SID . ‘”> page 2 </a> 
?> 

3. Now create another file session2.php 
4. Type the code below 

<?php 
Session_start(); 
Echo “welcome to our page number 2”; 
Echo $_SESSION[‘user’]  . “<br>”; 
Echo $_SESSION[‘pwd]  .  “<br>”; 
Echo  date(‘y m d H:i:s’  ,  $session[‘time’]); 
Echo ‘<br /><a href=”page1.php”> page 1 </a> 
?> 

5. Now see the output in brower 

 

How to destroy session 

It can destroy session by using session_destroy() function which destroy all session variables. But this function 
not remove $_SESSION[] array values. If want to completely remove the value in array then simply assign blank 
array to $_SESSION like below code. 

Session_start(); 
$_SESSION[‘test’]=5; 
Session_destroy(); 
$_SESSION=array(); 
Print $_SESSION[‘test’]; 

 

17. PHP - Sending Emails 

PhP also send emails. If sendmail is not used, or if Apache is installed on a Windows 
server, then there are couple of choices. Existing SMTP service, or installed an e-mail 
server such as Mailtraq on computer, can be used. When server e-mail is up and running, 
there are a couple of parameters that need to modify in your php.ini file. Of course, when 
using a hosting service, then provider should already have these parameters set up. 

Sending an E-mail 

The actual method of sending an e-mail is quite simple. Of course, it can be made much 
more complex by sending HTML and images.  

 

 

 

SMTP stands for 
Simple Mail Transfer 
Protocol. SMTP is 
used when email is 
delivered from an 
email client, such as 
Outlook Express, to 
an email server or 
when email is 
delivered from one 
email server to 
another. SMTP uses 
port 25. 

SMTP 
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STEP BY STEP  Sending Simple E-mail 

1. Open Dreamweaver, and enter the following code (make sure to put own e - mail 
address in as the first parameter): 

< ?php 

mail(‘myaddress@example.com’, ‘Hello pakistan’, 

‘Hi, pakistan. Prepare for our arrival. We are starving!’); 

? > 

2. Save the file as firstmail.php, and load it in browser. There will be a blank page and receive an e-mail shortly 
at the address entered as the first parameter to mail() . 

STEP BY STEP  Collecting Data and Sending E-mail 

1. Open Dreamweaver and enter the following code: 

< html > 
< head > 
< title > Enter E-mail Data < /title > 
< style type=”text/css” > td { vertical-align: top; } 
< /style > 
< /head > 
< body > 
< form method=”post” action=”sendmail.php” > 
< table > 
< tr > 
< td > To: < /td > 
< td > < input type=”text” name=”to_address” size=”40”/ > < /td > 
< /tr > < tr > 
< td > From: < /td > 
< td > < input type=”text” name=”from_address” size=”40”/ > < /td > 
< /tr > < tr > 
< td > Subject: < /td > 
< td > < input type=”text” name=”subject” size=”40”/ > < /td > 
< /tr > < tr > 
< td valign=”top” > Message: < /td > 
< td > 
< textarea cols=”60” rows=”10” 
name=”message” > Enter your message here. < /textarea > 
< /td > 
< /tr > < tr > 
< td > < /td > 
< td > 
< input type=”submit” value=”Send”/ > 
< input type=”reset” value=”Reset”/ > 
< /td > 
< /tr > 
< /table > 
< /form > 
< /body > 
< /html > 

2. Save the page as postcard.php. Note that postcard.php does not actually contain any PHP code in it. It 
simply collects the required data in an HTML form. Give it a .php extension because it will add PHP code to it 
later. 

Php.ini is the main 
configuration file 
which has all 
important setting to 
setup php server 

PHP.INI 
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3. Start a new text document, and enter the following code: 

< ?php 
$to_address = $_POST[‘to_address’]; 
$from_address = $_POST[‘from_address’]; 
$subject = $_POST[‘subject’]; 
$message = $_POST[‘message’]; 
$headers = ‘From: ‘ . $from_address . “\r\n”; 
? > 
< html > 
< head > 
< title > Mail Sent! < /title > 
< /head > 
< body > 
< ?php 
$success = mail($to_address, $subject, $message, $headers);  
if ($success) { 
echo ‘ < h1 > Congratulations! < /h1 > ’; 
echo ‘ < p > The following message has been sent: < br/ > < br/ > ’; 
echo ‘ < b > To: < /b > ‘ . $to_address . ‘ < br/ > ’; 
echo ‘ < b > From: < /b > ‘ . $from_address . ‘ < br/ > ’; 
echo ‘ < b > Subject: < /b > ‘ . $subject . ‘ < br/ > ’; 
echo ‘ < b > Message: < /b > < /p > ’; 
echo nl2br($message); 
} else { 
echo ‘ < p > < strong > There was an error sending your message. < /strong > < /p > ’; 
} 
? > 
< /body > 
< /html > 

4. Save this page as sendmail.php . This second page will take the values entered into the first page and send 
them in an e - mail. 

5. Load up the first page, postcard.php , in browser and enter some data. Make sure to use a valid e - mail 
address so that can verify the e-mail’s receipt. It should look like Figure 1.1  

. 
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6. Click the Send button. A second page appears, similar to the one shown in Figure 1.2 

 

7. Open e-mail client, and check e-mail. Find the e-mail message, as shown in Figure 1.3 

 

18. PHP - File Uploading Study and Demonstrate 

 PHP Coding Standard  

Single and Double Quotes 

echo '<a href="/static/link" title="pakistan!">Link name</a>'; 
echo "<a href='$link' title='$linktitle'>$linkname</a>"; 
Indentation 
[tab]$foo   = 'somevalue'; 
[tab]$foo2  = 'somevalue2'; 
[tab]$foo34 = 'somevalue3'; 
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[tab]$foo5  = 'somevalue4'; 
 
$my_array = array( 
[tab]'foo'   => 'somevalue', 
[tab]'foo2'  => 'somevalue2', 
[tab]'foo3'  => 'somevalue3', 
[tab]'foo34' => 'somevalue3', 
); 

Brace Style 

if ( condition ) { 
    action1(); 
    action2(); 
} elseif ( condition2 && condition3 ) { 
    action3(); 
    action4(); 
} else { 
    defaultaction(); 
} 

Just another Style 

<?php if ( have_posts() ) : ?> 
    <div class="hfeed"> 
        <?php while ( have_posts() ) : the_post(); ?> 
            <article id="post-<?php the_ID() ?>" class="<?php post_class() ?>"> 
                <!-- ... --> 
            </article> 
        <?php endwhile; ?> 
    </div> 
<?php endif; ?> 

No Shorthand PHP Tag 

Correct: 

<?php ... ?> 
<?php echo $var; ?> 

Incorrect: 

<? ... ?> 
<?= $var ?> 

Remove Trailing Spaces  

Remove trailing whitespace at the end of each line of code. Omitting the closing PHP tag at the end of a file is 
preferred. After setting tag, make sure you remove trailing whitespace. 

Space Usage 

x == 23 
foo && bar 
! foo 
array( 1, 2, 3 ) 
$baz . '-5' 
$term .= 'X' 
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Just another Style 

$x = $foo['bar']; // correct 
$x = $foo[ 'bar' ]; // incorrect 
  
$x = $foo[0]; // correct 
$x = $foo[ 0 ]; // incorrect 
  
$x = $foo[ $bar ]; // correct 
$x = $foo[$bar]; // incorrect 

Ternary Operator 

// (if statement is true) ? (do this) : (else, do this); 
$musictype = ( 'jazz' == $music ) ? 'cool' : 'blah'; 
// (if field is not empty ) ? (do this) : (else, do this); 

Yoda Conditions  

if ( true == $the_force ) { 
    $victorious = you_will( $be ); 
} 

Clever Code 

isset( $var ) || $var = some_function(); 
if ( ! isset( $var ) ) { 
    $var = some_function(); 
} 

 

PHP - Predefined Variables     

PHP provides a large number of predefined variables to any script which it runs. PHP provides an additional set 
of predefined arrays containing variables from the web server the environment, and user input. These new arrays 
are called superglobals: 

All the following variables are automatically available in every scope. 

 

PHP Superglobals 

Variable Description 

$GLOBALS 
Contains a reference to every variable which is currently available within the global scope of 
the script. The keys of this array are the names of the global variables. 

$_SERVER 
This is an array containing information such as headers, paths, and script locations. The entries 
in this array are created by the web server. There is no guarantee that every web server will 
provide any of these. See next section for a complete list of all the SERVER variables. 

$_GET An associative array of variables passed to the current script via the HTTP GET method. 

$_POST An associative array of variables passed to the current script via the HTTP POST method. 
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$_FILES An associative array of items uploaded to the current script via the HTTP POST method. 

$_REQUEST An associative array consisting of the contents of $_GET, $_POST, and $_COOKIE. 

$_COOKIE An associative array of variables passed to the current script via HTTP cookies. 

$_SESSION An associative array containing session variables available to the current script. 

$_PHP_SELF A string containing PHP script file name in which it is called. 

$php_errormsg $php_errormsg is a variable containing the text of the last error message generated by PHP. 
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Learner’s Activity 

1. Create myform.php file in Dreamweaver 

2. Type the code below code 

 <html> 
<head><title>My first form</title></head> 
<body> 
<form method = “post” action=”dataform.php”> 
please type your name: 
<input type =”text” name=”txtname” /> 
<input type=”submit” value=”say hello” /> 
</form></body></html> 

3. Save the code and create another file titled dataform.php 

4. type the code below 

<html> 
<head><title>My first form</title></head> 
<body> 
<?php 
 //now get form data using post method 
$name = $post[‘txtname’]; 
Print  “hello”. $name; 
?> 
</body></html> 

5. See the result in browser window 
6. Now change the action method to GET and see what changes come by using  GET method 

Server Variables: $_SERVER 

$_SERVER is an array containing information such as headers, paths, and script locations. The entries in this 
array are created by the web server. There is no guarantee that every web server will provide any of these. 

In this learning unit we just put down some of the basic server variable theoretical because we already cover some 
of the variable in earlier units 
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Variable Description 

$_SERVER['PHP_SELF'] 
The filename of the currently executing script, relative to 
the document root 

$_SERVER['argv'] 

Array of arguments passed to the script. When the script 
is run on the command line, this gives C-style access to 
the command line parameters. When called via the GET 
method, this will contain the query string. 

$_SERVER['argc'] 
Contains the number of command line parameters 
passed to the script if run on the command line. 

$_SERVER['GATEWAY_INTERFACE'] 
What revision of the CGI specification the server is 
using; i.e. 'CGI/1.1'. 

$_SERVER['SERVER_ADDR'] 
The IP address of the server under which the current 
script is executing. 

$_SERVER['SERVER_NAME'] 
The name of the server host under which the current 
script is executing. If the script is running on a virtual 
host, this will be the value defined for that virtual host. 

$_SERVER['SERVER_SOFTWARE'] 
Server identification string, given in the headers when 
responding to requests. 

$_SERVER['SERVER_PROTOCOL']  
Name and revision of the information protocol via which 
the page was requested; i.e. 'HTTP/1.0'; 

$_SERVER['REQUEST_METHOD'] 
Which request method was used to access the page; 
i.e. 'GET', 'HEAD', 'POST', 'PUT'. 

$_SERVER['REQUEST_TIME'] 
The timestamp of the start of the request. Available 
since PHP 5.1.0. 

$_SERVER['QUERY_STRING'] 
The query string, if any, via which the page was 
accessed. 

$_SERVER['DOCUMENT_ROOT'] 
The document root directory under which the current 
script is executing, as defined in the server's 
configuration file. 

$_SERVER['HTTP_ACCEPT'] 
Contents of the Accept: header from the current request, 
if there is one. 

$_SERVER['HTTP_ACCEPT_CHARSET'] 
Contents of the Accept-Charset: header from the current 
request, if there is one. Example: 'iso-8859-1,*,utf-8'. 

$_SERVER['HTTP_ACCEPT_ENCODING'] 
Contents of the Accept-Encoding: header from the 
current request, if there is one. Example: 'gzip'. 

$_SERVER['HTTP_ACCEPT_LANGUAGE'] 
Contents of the Accept-Language: header from the 
current request, if there is one. Example: 'en'. 

$_SERVER['HTTP_CONNECTION'] 
Contents of the Connection: header from the current 
request, if there is one. Example: 'Keep-Alive'. 

$_SERVER['HTTP_HOST'] 
Contents of the Host: header from the current request, if 
there is one. 

$_SERVER['HTTP_REFERER'] 
The address of the page (if any) which referred the user 
agent to the current page. 
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$_SERVER['HTTP_USER_AGENT'] 
This is a string denoting the user agent being which is 
accessing the page. A typical example is: Mozilla/4.5 
[en] (X11; U; Linux 2.2.9 i586). 

$_SERVER['HTTPS'] 
Set to a non-empty value if the script was queried 
through the HTTPS protocol. 

$_SERVER['REMOTE_ADDR'] 
The IP address from which the user is viewing the 
current page. 

$_SERVER['REMOTE_HOST'] 
The Host name from which the user is viewing the 
current page. The reverse dns lookup is based off the 
REMOTE_ADDR of the user. 

$_SERVER['REMOTE_PORT']  
The port being used on the user's machine to 
communicate with the web server. 

$_SERVER['SCRIPT_FILENAME'] The absolute pathname of the currently executing script. 

$_SERVER['SERVER_ADMIN'] 
The value given to the SERVER_ADMIN (for Apache) 
directive in the web server configuration file. 

$_SERVER['SERVER_PORT'] 
The port on the server machine being used by the web 
server for communication. For default setups, this will be 
'80'. 

$_SERVER['SERVER_SIGNATURE'] 
String containing the server version and virtual host 
name which are added to server-generated pages, if 
enabled. 

$_SERVER['PATH_TRANSLATED'] Filesystem based path to the current script. 

$_SERVER['SCRIPT_NAME'] 
Contains the current script's path. This is useful for 
pages which need to point to themselves. 

$_SERVER['REQUEST_URI'] 
The URI which was given in order to access this page; 
for instance, '/index.html'. 

$_SERVER['PHP_AUTH_DIGEST'] 
When running under Apache as module doing Digest 
HTTP authentication this variable is set to the 
'Authorization' header sent by the client. 

$_SERVER['PHP_AUTH_USER'] 
When running under Apache or IIS (ISAPI on PHP 5) as 
module doing HTTP authentication this variable is set to 
the username provided by the user. 

$_SERVER['PHP_AUTH_PW'] 
When running under Apache or IIS (ISAPI on PHP 5) as 
module doing HTTP authentication this variable is set to 
the password provided by the user. 

$_SERVER['AUTH_TYPE'] 
When running under Apache as module doing HTTP 
authenticated this variable is set to the authentication 
type. 
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19. PHP - Regular Expressions 

Regular expressions are nothing more than a sequence or pattern of characters itself. They provide the foundation 
for pattern-matching functionality. 

Using regular expression is used to search a particular string inside another string, it can replace one string by 
another string and it can split a string into many chunks. 

PHP offers functions specific to two sets of regular expression functions, each 
corresponding to a certain type of regular expression. Use any of them based on comfort. 

 POSIX Regular Expressions 

 PERL Style Regular Expressions 

 
POSIX Regular Expressions 

The structure of a POSIX regular expression is not dissimilar to that of a typical arithmetic 
expression: various elements (operators) are combined to form more complex expressions. 

The simplest regular expression is one that matches a single character, such as g, inside strings such as g, haggle, 
or bag. 

Let’s give explanation for few concepts being used in POSIX regular expression.  

 

Brackets 

Expression Description 

[0-9] It matches any decimal digit from 0 through 9. 

[a-z] It matches any character from lowercase a through lowercase z. 

[A-Z] It matches any character from uppercase A through uppercase Z. 

[a-Z] It matches any character from lowercase a through uppercase Z. 

PHP's Regexp POSIX Functions 

Function Description 

ereg() 
The ereg() function searches a string specified by string for a string specified by pattern, 
returning true if the pattern is found, and false otherwise. 

ereg_replace() 
The ereg_replace() function searches for string specified by pattern and replaces pattern with 
replacement if found. 

eregi() 
The eregi() function searches throughout a string specified by pattern for a string specified by 
string. The search is not case sensitive. 

eregi_replace() 
The eregi_replace() function operates exactly like ereg_replace(), except that the search for 
pattern in string is not case sensitive. 

split() 
The split() function will divide a string into various elements, the boundaries of each element 
based on the occurrence of pattern in string. 

Do you know? 

Pattern-matching in 
computer science is 
a technique where 
on the basis of 
specific keywords 
we can make 
decision in any 
programming 
language 
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spliti() 
The spliti() function operates exactly in the same manner as its sibling split(), except that it is 
not case sensitive. 

sql_regcase() 
The sql_regcase() function can be thought of as a utility function, converting each character in 
the input parameter string into a bracketed expression containing two characters. 

 

Learner’s Activity 

1. Open Dreamweaver and create a html page titled regxp.html and type the following code and save it 

<html>  
<head>  
<title>regxp</title> 
 </head>  
<body>  
<form id="forml" method= "post" ac tion= "regxp.php" > <table width= "400" border="1"> <tr><tthEmail:</td> 
<td><input type= "text" name="email" /></td> <td>Please provide valid email </td> </tr> <tr><td>NIC #: </td> 
<td><input type= "text" name="nic" /></td> <td>xxxxx MICXXXXX-X </ td> </tr> <tr><td>Mobile:</td> <td><input 
type="text" name="mobile" /></td> <td>222-2222222</td> </tr> <tr><td> &tap; </td> <td><input type="subnit" 
name="Sukinit" value="Submit" /></td> <td>inbsp;</td> </tr> </table> 
 </form>  
</body>  
</html> 

2. Then type following code in regex.php 

<?php $email = trim($_POSTremaill); $nic = trim($_POSTUnic1); $mobile = trimO_POST[Imobile']);  
if(preg match("/" '@ ]+@[A@ 1+\. [^@\. ]+$/" ,$email)) ( echo "Your email is valid<br>" ; }else{ echo "Your email 
is invalid<br>" ;  
}  
if(preg match("/A\d(5)-\d(7)-\d$/" ,$nic)) { echo "Your NIC # is valid<br>" ; }else{ echo "Your NIC # is invalid<br>" 
;  
}  
if(preg match("/A\d(3,4)-\d(7)$/" ,$mobile)) echo "Your mobile is valid<br>" ; }else{ echo "Your mobile is 
invalid<br>" ;  
}  
?> 

3. See output in browser and fill  the form with  correct as well as wrong data and validate the regular expression 
function 
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20. PHP - Error Handling 

The error handling is the catch-up increases fault of program and then take appropriate action. After handling 
errors properly, it can lead to many unexpected penalty. Quite simply in PHP in error handling. 

How the Apache Web Server DealswithErrors      

Apache has a directive, the ErrorDocument that can configure in the httpd.conf file to create custom error pages 
with PHP, so visitors to site do not see the default server – based error pages, which may not be as helpful or 
descriptive as customized error messages. 

STEP BY STEP  Using Apache’s ErrorDocument Method 

First of all, make some changes to the httpd.conf file to allow developers to create a custom error page. Apache 
is usually set up by default to go to its own internal error pages, but that can’t be used. If need to set Apache to go 
to custom error page, no matter what error has occurred. To do this, just change the default settings to own specific 
settings by following these steps: 

1. Open up httpd.conf file, and find some lines that look like this: 

# Customizable error responses come in three flavors: 
# 1) plain text 2) local redirects 3) external redirects 
# 
# Some examples: 
#ErrorDocument 500 “The server made a boo boo.” 
#ErrorDocument 404 /missing.html 
#ErrorDocument 404 “/cgi-bin/missing_handler.pl” 
#ErrorDocument 402 http://www.example.com/subscription_info.html 

2. Change that information to the following, and then restart Apache: 

#Customizable error responses come in three flavors: 
# 1) plain text 2) local redirects 3) external redirects 
# 
# Some examples: 
ErrorDocument 400 /error.php?400 
ErrorDocument 401 /error.php?401 
ErrorDocument 403 /error.php?403 
ErrorDocument 404 /error.php?404 
ErrorDocument 500 /error.php?500 

What these errors are saying  

400: Bad Request 
401: Authorization Required 
403: Forbidden 
404: Not Found 
500: Internal Server Error 

 

Using die() function      

1. open notepad and create a text file and save it as test.txt 
2. open Dreamweaver type the following code without providing test .txt 

<?php 
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if(!file_exists("/tmp/test.txt")) 
 { 
 die("File not found"); 
 } 
else 
 { 
 $file=fopen("/tmp/test.txt","r"); 
 print "Opend file sucessfully"; 
 } 
 // Test of the code here. 
?> 

 

By using this way easily write efficient code using above technique that can stop program whenever it errors out 
and display more friendly message. 

Custom Error Handling Function   

Own created function can be used to handling any error. PHP provides a framework to define error handling 
function. 

Syntax 

error_function(error_level,error_message, error_file,error_line,error_context); 

Parameter Description 

error_level 
Required - Specifies the error report level for the user-defined error. Must be a value 
number. 

error_message Required - Specifies the error message for the user-defined error 

error_file Optional - Specifies the filename in which the error occurred 

error_line Optional - Specifies the line number in which the error occurred 

error_context 
Optional - Specifies an array containing every variable and their values in use when the 
error occurred 

Possible Error levels 

These error report levels are the different types of error the user-defined error handler can be used for. These 
values cab used in combination using | operator 

Value Constant Description 

1 E_ERROR Fatal run-time errors. Execution of the script is halted 

2 E_WARNING Non-fatal run-time errors. Execution of the script is not halted 

4 E_PARSE 
Compile-time parse errors. Parse errors should only be generated 
by the parser. 

8 E_NOTICE 
Run-time notices. The script found something that might be an 
error, but could also happen when running a script normally 

16 E_CORE_ERROR Fatal errors that occur during PHP's initial startup. 

32 E_CORE_WARNING Non-fatal run-time errors. This occurs during PHP's initial startup. 
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256 E_USER_ERROR 
Fatal user-generated error. This is like an E_ERROR set by the 
programmer using the PHP function trigger_error() 

512 E_USER_WARNING 
Non-fatal user-generated warning. This is like an E_WARNING set 
by the programmer using the PHP function trigger_error() 

1024 E_USER_NOTICE 
User-generated notice. This is like an E_NOTICE set by the 
programmer using the PHP function trigger_error() 

2048 E_STRICT 
Run-time notices. Enable to have PHP suggest changes to code 
which will ensure the best interoperability and forward compatibility 
of code. 

4096 E_RECOVERABLE_ERROR 
Catchable fatal error. This is like an E_ERROR but can be caught 
by a user defined handle (see also set_error_handler()) 

8191 E_ALL 
All errors and warnings, except level E_STRICT (E_STRICT will be 
part of E_ALL as of PHP 6.0) 

All the above error level can be set using following PHP built-in library function where level cab be any of the value 
defined in above table. 

int error_reporting ( [int $level] ) 

Following is the way to create one error handling function: 

<?php 
function handleError($errno, $errstr,$error_file,$error_line) 
{  
 echo "<b>Error:</b> [$errno] $errstr - $error_file:$error_line"; 
 echo "<br />"; 
 echo "Terminating PHP Script"; 
 die(); 
} 
?> 

Once custom error handler is defined then there is need to set it using PHP built-in library set_error_handler 
function. Now let’s examine example by calling a function which does not exist. 

<?php 
error_reporting( E_ERROR ); 
function handleError($errno, $errstr,$error_file,$error_line) 
{ 
 echo "<b>Error:</b> [$errno] $errstr - $error_file:$error_line"; 
 echo "<br />"; 
 echo "Terminating PHP Script"; 
 die(); 
} 
//set error handler 
set_error_handler("handleError"); 
 
//trigger error 
myFunction(); 
?> 

Exceptions Handling     

PHP 5 has an exception model similar to that of other programming languages. Exceptions are important and 
provide a better control over error handling. 
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Let’s explain three new keyword related to exceptions. 

1. Try - A function using an exception should be in a "try" block. If the exception does not trigger, the code 
will continue as normal. However if the exception triggers, an exception is "thrown". 

2. Throw - This is how to trigger an exception. Each "throw" must have at least one "catch". 

3. Catch - - A "catch" block retrieves an exception and creates an object containing the exception information. 

When an exception is thrown, code following the statement will not be executed, and PHP will attempt to find the 
first matching catch block. If an exception is not caught, a PHP Fatal Error will be issued with an "Uncaught 
Exception ... 

 An exception can be thrown, and caught ("catched") within PHP. Code may be surrounded in a try block. 

 Each try must have at least one corresponding catch block. Multiple catch blocks can be used to catch 
different classes of exceptions. 

 Exceptions can be thrown (or re-thrown) within a catch block. 

Example 

Following is the piece of code, copy and paste this code into a file and verify the result. 

<?php 
try { 
    $error = 'Always throw this error'; 
    throw new Exception($error); 
 
    // Code following an exception is not executed. 
    echo 'Never executed'; 
 
} catch (Exception $e) { 
    echo 'Caught exception: ',  $e->getMessage(), "\n"; 
} 
 
// Continue execution 
echo 'Hello World'; 
?> 

 

In the above example $e->getMessage function is used to get error message. There are following functions which 
can be used from Exception class. 

 getMessage()- message of exception  

 getCode() - code of exception 

 getFile() - source filename 

 getLine() - source line 

 getTrace() - n array of the backtrace() 

 getTraceAsString() - formatted string of trace 
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STEP BY STEP     Custom Exception Handler 

Use following code to create own exception handler. 

1. Open Dreamweaver and create a php page 
2. Type the following function code in that file 

<?php 
function exception_handler($exception) { 
  echo "Uncaught exception: " , $exception->getMessage(), "\n"; 
} 
 
set_exception_handler('exception_handler'); 
 
throw new Exception('Uncaught Exception'); 
 
echo "Not Executed\n"; 
?> 

Now checkout the result in browser 

PHP - Bugs and Debugging    

In programming language or for a programmer, Bugs finding and Debugging is a core thing which is most important.  

To make error messages to display in the browser, set the display_errors configuration directive to On. To send 
errors to the web server error log, set log_errors to On. Set them both to on if error messages are to be shown in 
both places. 

Another feature is quote and bracket matching, which helps to make sure that quotes and brackets are balanced. 
While typing a closing delimiter such as }, the editor highlights the opening { that it matches. 

There are following points which need to be verfied while debugging program. 

 Missing Semicolons - Every PHP statement ends with a semicolon (;). PHP doesn't stop reading a 
statement until it reaches a semicolon. If semicolon is left at the end of a line, PHP continues reading the 
statement on the following line. 

 Not Enough Equal Signs - When ask whether two values are equal in a comparison statement, you need 
two equal signs (==). Using one equal sign is a common mistake. 

 Misspelled Variable Names - If you misspelled a variable then PHP understands it as a new variable. 
Remember: To PHP, $test is not the same variable as $Test. 

 Missing Dollar Signs - A missing dollar sign in a variable name is really hard to see, but at least it usually 
results in an error message so that you know where to look for the problem. 

 Troubling Quotes - You can have too many, too few, or the wrong kind of quotes. So check for a balanced 
number of quotes. 

 Missing Parentheses and curly brackets - They should always be in pairs. 

 Array Index - All the arrays should start from zero instead of 1. 

Moreover, handle all the errors properly and direct all trace messages into system log file so that if any problem 
happens then it will be logged into system log file and you will be able to debug that problem. 
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21. PHP - Built-in Functions 

PHP function topic is already discussed in learning unit 14. Here is the list of various important function 
categories.  

 PHP Array Functions 

Some of php array function are listed below 

Function Description 

array() Creates an array 

array_change_key_case() Changes all keys in an array to lowercase or uppercase 

array_chunk() Splits an array into chunks of arrays 

array_column() Returns the values from a single column in the input array 

array_combine() 
Creates an array by using the elements from one "keys" array and one 
"values" array 

array_count_values() Counts all the values of an array 

array_diff() Compare arrays, and returns the differences (compare values only) 

array_diff_assoc() 
Compare arrays, and returns the differences (compare keys and 
values) 

array_diff_key() Compare arrays, and returns the differences (compare keys only) 

array_diff_uassoc() 
Compare arrays, and returns the differences (compare keys and 
values, using a user-defined key comparison function) 

array_diff_ukey() 
Compare arrays, and returns the differences (compare keys only, using 
a user-defined key comparison function) 

array_fill() Fills an array with values 

array_fill_keys() Fills an array with values, specifying keys 

array_filter() Filters the values of an array using a callback function 

array_flip() Flips/Exchanges all keys with their associated values in an array 

array_intersect() Compare arrays, and returns the matches (compare values only) 

array_intersect_assoc() Compare arrays and returns the matches (compare keys and values) 

array_intersect_key() Compare arrays, and returns the matches (compare keys only) 

array_intersect_uassoc() 
Compare arrays, and returns the matches (compare keys and values, 
using a user-defined key comparison function) 

array_intersect_ukey() 
Compare arrays, and returns the matches (compare keys only, using a 
user-defined key comparison function) 

 

 PHP Calendar Functions 

 PHP Class/Object Functions 

 PHP Character Functions 

 PHP Date & Time Functions 
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 PHP Directory Functions 

 PHP Error Handling Functions 

 PHP File System Functions 

 PHP MySQL Functions 

 PHP Network Functions 

 PHP ODBC Functions 

 PHP String Functions 

 PHP SimpleXML Functions 

 PHP XML Parsing Functions 

Note: if you need to see complete php built in function reference than visit following link 
http://in.php.net/manual/en/funcref.php 

20.1. Configure MySQL Database with a PHP Website 

We already covered the installation method of xampp server, appachi and mysql in learning unit 5, now we are 
going to configure MySQL database with php. 

Creating and Modifying Database in PHPmyadmin   
 

STEP BY STEP Using PHPmyadmin 

1. Open xampp server and start apache and mysql 
 

 

2. Open browser and type url address http://localhost/phpmyadmin  

http://in.php.net/manual/en/funcref.php
http://localhost/phpmyadmin
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3. Open existing database titled school and create table titled result 

 

4. Now click on result table on right side you all column of that table 

 

5. Below the table you can see a ribbon where you can apply different operation on table 

 

6. On the top of the window there is button title browse by using this button you can see all data of your table 
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7. Now again open result table for new record insertion click on navigation bar than you can see a form 
where in values tab you put the values and click on the go button 

 

Creating New Database in PHPmyadmin 

1. Open phpmyadmin and click on home button 
2. Type mydb in textbox for new database 

 

3. Now create new table in table ribbon title mynewtable and set 2 field 
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4. After little bit time you see the form which have two field and in that form you can set the name of column 
there data type  and key attribute as well. 

 

Set id field type int and check the auto_increment radio button. Set name field data type as varchar length 
50 and then click on save button. 

5. If you want to drop the table then from left navigation tab select the table and then from menu click on 
drop button. 

 

6. When you completely created a database form local server and want to upload database from host server 
then first you should export the database. Select the database which you want to export then from the top 
menu click on export button then you see export page like below 
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This page shows lot of format where you can import or export the database. Normally sql is selected mostly. Then 
at last check on Save as file button, give the name to file, select zip format and click on Go button. 

20.2. MySql Manipulation with PHP 

1. MySQL Connection using PHP Script: 

PHP provides mysql_connect() function to open a database connection. This function takes five parameters and 
returns a MySQL link identifier on success or FALSE on failure. 

Syntax: 

connection mysql_connect(server,user,passwd,new_link,client_flag); 

Parameter Description 

server 
Optional - The host name running database server. If not specified, then default value is 
localhost: 3036. 

user 
Optional - The username accessing the database. If not specified, then default is the 
name of the user that owns the server process. 
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passwd 
Optional - The password of the user accessing the database. If not specified, then default 
is an empty password. 

new_link 
Optional - If a second call is made to mysql_connect() with the same arguments, no new 
connection will be established; instead, the identifier of the already opened connection 
will be returned. 

Example: 

html> 
<head> 
<title>Connecting MySQL Server</title> 
</head> 
<body> 
<?php 
   $dbhost = 'localhost:3036'; 
   $dbuser = 'guest'; 
   $dbpass = 'guest123'; 
   $conn = mysql_connect($dbhost, $dbuser, $dbpass); 
   if(! $conn ) 
   { 
     die('Could not connect: ' . mysql_error()); 
   } 
   echo 'Connected successfully'; 
   mysql_close($conn); 
?> 
</body> 
</html> 

2. Creating Database 

<html> 
<head> 
<title>Creating MySQL Database</title> 
</head> 
<body> 
<?php 
$dbhost = 'localhost:3036'; 
$dbuser = 'root'; 
$dbpass = 'rootpassword'; 
$conn = mysql_connect($dbhost, $dbuser, $dbpass); 
if(! $conn ) 
{ 
  die('Could not connect: ' . mysql_error()); 
} 
echo 'Connected successfully<br />'; 
$sql = 'CREATE DATABASE pakistan'; 
$retval = mysql_query( $sql, $conn ); 
if(! $retval ) 
{ 
  die('Could not create database: ' . mysql_error()); 
} 
echo "Database pakistan created successfully\n"; 
mysql_close($conn); 
?> 
</body> 
</html> 
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3. Drop Database 

<html> 
<head> 
<title>Deleting MySQL Database</title> 
</head> 
<body> 
<?php 
$dbhost = 'localhost:3036'; 
$dbuser = 'root'; 
$dbpass = 'rootpassword'; 
$conn = mysql_connect($dbhost, $dbuser, $dbpass); 
if(! $conn ) 
{ 
  die('Could not connect: ' . mysql_error()); 
} 
echo 'Connected successfully<br />'; 
$sql = 'DROP DATABASE pakistan'; 
$retval = mysql_query( $sql, $conn ); 
if(! $retval ) 
{ 
  die('Could not delete database: ' . mysql_error()); 
} 
echo "Database pakistan deleted successfully\n"; 
mysql_close($conn); 
?> 
</body> 
</html> 

4. Selecting mysql Database 

<html> 
<head> 
<title>Selecting MySQL Database</title> 
</head> 
<body> 
<?php 
$dbhost = 'localhost:3036'; 
$dbuser = 'guest'; 
$dbpass = 'guest123'; 
$conn = mysql_connect($dbhost, $dbuser, $dbpass); 
if(! $conn ) 
{ 
  die('Could not connect: ' . mysql_error()); 
} 
echo 'Connected successfully'; 
mysql_select_db( ‘pakistan’ ); 
mysql_close($conn); 
?> 
</body> 
</html> 

Executing Query 

1. Save the following code in htdocs/mysql folder with the name of connection.php  

<?php 
//No direct access to this page  
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if (preg match (" /connection .php/" ,$_SERVER [‘SCRIPTFILENAME’ ]))  
{ 
( die ("Access denied" );  
}  
// configration variables 
 define ("HOSTNAME" , "localhost" ) ;  
define ("USERNAME" , "root" ) ;  
define ("PWD" ,"" ) ;  
define ("DBNAME" , "school" ) ;  
//link to mysql server 
 if ( !$link = mysgl_connect (HOSTNAME ,USERNAME ,PWD) ) 
{ 
 die ("Cannot connect to MySQL Server .<br> \ n" .mysgl error () ) ;  
} 
 //selecting database 
 if (!mysgl_select db (DBNAME,$link)) { 
die ("Cannot select database .<br> \ n" .mysql_error () ) ;  
} 
?> 

2. Save the following code in htdocs/mysql folder with the name of result.php 

<?php  
//connection file 
 include "connection.php" ;  
//query to execute  
$Query = "SELECT * FROM result" ;  
//executing query 
$q_result = mysql_Query($Query,$link) or die(mysql_error()); 
 if(mysql_num rows ($tResult) <= 0) 
{  
print "No record found"; }else( printnysql_pum rows ($cLEesult) . " rows in result table" ; 
 }  
Else{ 
Print  mysql_num_rows ($q_result)   . “rows in result table” ; 
} 
? > 

Getting Table Rows in Loop 

1. Save the following code in htdocs/mysql folder with the name of result.php 

<?php  
//connection file  
include "connection.php";  
//query to execute  
$Query = "SELECT * FROM result";  
//executing query 
 $q_Result = mysql_query($Query,$link) or die(mysql_error());  
if(mysql_num rows($q_Result) <= 0)  
{ 
die("No record found");  
}  
while($Row = mysql_fetch_assoc($1_Result))  
{ 
print $Row('sname'] . "<br>";  
} 
?> 
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2. The result should look like below figure 

 

Inserting New Record 

1. Now we are going to create a form in html table and inserting new record in student table. Copy the below 
code in htdocs/mysql folder with the name of new_record.php 

<?php  
//connection file 
include "connoction.php";  
//cleaning string 
 function cleanString($string) { 
$string = htndspecialchars(trim($string));  
return $string;  
}  
//function for new form  
function print_Form(){  
//new form var 
$newForm = "<form method= \ "post \ " action= \ "I $_SERVER 'PHP_SELF' j } \ ">  
<table border=l cellpadding=3 cellspacing=3> 
 <tr><td>Student Name</td> 
 <td><input type= \ "text \ " name= \ "sName\ "></td></tr> 
 <tr><td>Marks</td>  
<td><input type= \ "text \ " name= \ "sMarks \ "></td></tr> 
 <tr><td colspan=2><input type= \ "submit \ " value= \ "Add Record\ ">  
<input type= \ "hidden \ " value= \ "true \ " name= \ "post \ ">  
</td></tr></table></form>" ;  
return $newForm;  
} 
//saving record  
function save_Record()  
{ 
$Name = cleanString($_POST[‘sName’]);  
$Marks = (int) cleanString($_P0ST['sMarks']); 
 //checking for empty values  
if(empty($Name) || empty($Marks))  
{ 
error Message("Cannot insert empty record" );  
}  
//marks range 
 if($Marks < 0 || $Marks > 99)  
{ 
error Message("Marks must be between 1-99" );  
} 
//max student name  
if(strlen($Name) > 40)  
{  
error Message("Name is too long"); }  
//query 
 $query = "INSERT INTO result(sname,marks)  
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VALUES('$Name'e$Marks)" ;  
//executing query 
 if(mysql query($query))  
{ 
 print "<divstyleflackground:4FFFFCC;border:dashed 1px #cccccc’> 
 Record added successfully</div>" ;  
print print_Form(); //show form again  
} 
Else{ 
 error Message(mysql error());   //if error in query 
} 
}  
 //error message 
function error_ Message($error)  
{ 
$msg = "<div style=background:#FFFFCC;border:dashed 1px #cccccc’> 
$error <a href= ' javascript:history.go (-1) ' >Back</a></div>”; 
 die($msg); 
 }  
//what to do  
if($_POST('post']) { 
 //if form is posted 
 Save_Record(); } 
Else{  
//first time print the form 
 Print print_Form(); 
} 
?> 

The output looks like below figure 

 

  



Module 7: Develop Website Using Server Side Scripting Languages 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 473 

Learner’s Activity 

Create dynamic website using php and mysql follow the steps 

1. Open htdocs in xampp folder  

2. Create website folder titled mywebsite 

3. Inside mywebsite folder create images, css, js folders 

4. Inside the mywebsite folder create header.php, left_sidebar.php, right_sidebar.php, 

content.php, and footer.php file 

5. Inside css folder there is file which contain style of your website titled style.css 

6. Inside js folder there is file which contain form validation scrip of your website titled 

formvalidat.js 

7. Inside images folder there is all images related to your website 

8. Create index.php page and using include or require function include all php files 

9. Create contact form page which have a contact form and apply formvalidat.js file 

10. Apply CSS on all pages 
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Summary of Module 

  ASP.NET is an open-source server-side Web application framework designed for Web development 
to produce dynamic Web pages. It was developed by Microsoft to allow programmers to build 
dynamic web sites, web applications and web services. 

  Microsoft Visual Studio is an integrated development environment (IDE) from Microsoft. It is used to 
develop computer programs for Microsoft Windows, as well as web sites, web applications and web 
services.  

  Microsoft Visual Studio controls multiple controls i.e. server controls, dataserver controls, validation 
controls, navigation controls, login controls and web form controls that provides developer ease to 
develop project efficiently and within time framework. 

  PHP (recursive acronym for PHP: Hypertext Preprocessor) is a widely-used open source general-
purpose scripting language that is especially suited for web development and can be embedded into 
HTML. 

  Adobe Dreamweaver is a proprietary web development tool developed by Adobe Systems. It is 
widely used by developers to create static and dynamic website. 

  Dynamic website are developed with the use of PHP elements i.e. variables, operators, decision, 
loops, arrays, methods, files, functions, cookies and session, sending emails etc. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is PHP? 

Answer 
PHP: Hypertext Preprocessor is open source server-side scripting language that is widely used 
for web development. PHP scripts are executed on the server. PHP allows writing dynamically 
generated web pages efficiently and quickly. PHP is free to download and use. 

FAQ 2:  Echo vs. print statement. 

Answer 

cho() and print() are language constructs in PHP, both are used to output strings. The speed of 
both statements is almost the same. 
 
echo() can take multiple expressions whereas print cannot take multiple expressions. 

FAQ 3:  What is a Session in PHP? 

Answer 

Sessions allow data to be transferred from one page to another. Session information is 
temporary and information is valid until the user is using the website. A session assigns a unique 
ID, UID, to each visitor. 
A PHP session starts using: <?php session_start(); ?> 

FAQ 4:  Difference between include and require? 

Answer 
include() and require() are similar except the way they handle failures. include() produces a 
warning and require() produces a fatal error. 

FAQ 5:  Which PHP statement is used to connect PHP with MySQL? 

Answer 

The statements that can be used to connect PHP will MySQL is: 
<? 
$conn = mysql_connect('localhost'); 
echo $conn; 
?> 

FAQ 6:  What is the use of super-global arrays in PHP? 

Answer 
Super global arrays are the built-in arrays that can be used anywhere in website. Some of super 
global array are $_post, $_get, $_request etc 

FAQ 7:  What are the different types of errors in PHP? 

Answer 

There are three types of errors in PHP. 
1. Notice: These are very normal and non-critical errors and they even not displayed to users. 
For examples accessing a variable that not existed at all. 
2. Warning: These are little bit critical errors. These results are displayed to users but do not 
affect the output of code. For example trying to include any file that is not exists. 
3. Fatal errors: These are really critical errors. For example calling any nonexistence class. 

FAQ 8:  How constants are defined in a PHP script? 

Answer 
 Define () is used to define constants in PHP. 
define (“Newconstant”, 30); 

FAQ 9:  
What is the maximum size of a file that can be uploaded using php and how can we change 
this?  

Answer You can change maximum size of a file by setting upload_max_filesize variable in php.ini file. 
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FAQ 10:  How can we destroy the cookie?  

Answer Cookies can be destroyed by setting the cookie time in past. 

FAQ 11:  Describe Master page. 

Answer 

A Master page offers a template for one or more web forms. It defines placeholders for the 
content, which can be overridden by the content pages. When users request the content page, 
ASP.NET merges the layout of the master page with the content of the content page and 
produce output. 

FAQ 12:  Different Method of navigation of asp.net 

Answer 

There are many ways to navigate from one page to another in ASP.NET.  
- Client-side navigation 
- Cross-page posting 
- Client-side browser redirect 
- Client-Side Navigation 

FAQ 13:  Explain Asp.net Web Form 

Answer 

Web Forms are an extremely important part of ASP.NET.  
They are the User Interface (UI) elements which provide the desired look and feel to your web 
applications. Web Forms provide properties, methods, and events for the controls that are 
placed onto them. 

FAQ 14:  Name the mechanism that enables server controls to maintain their state. 

Answer The mechanism that enables controls to maintain their state is called View State. 

FAQ 15:  Difference between DropDownList and listbox 

Answer 
The DropDownList only allows a user to make a single selection whereas the ListBox allows for 
multiple selections. In addition, the DropDownList only shows one item in the list when it’s not 
expanded, while the ListBox is capable of displaying multiple items simultaneously. 

FAQ 16:  
The TreeView control exposes a number of style properties that enable you to change items in 
the tree. Which property do you need to change if you want to influence the background color 
of each item in the tree? What’s the best way to change the background color? 

Answer 

To change the background color of items in the TreeView control you can use the NodeStyle 
element as follows: 
<asp:TreeView ID="TreeView1" runat="server"DataSourceID="SiteMapDataSource1" 
ShowExpandCollapse="False">  <NodeStyle BackColor="White" /></asp:TreeView> 
Instead of setting the BackColor property (which results in an inline style), you’re better off 
setting the CssClass property: 
<NodeStyle CssClass="TreeViewNodeStyle" />You then need to create a separate class in 
your CSS file:.TreeViewNodeStyle{background-color: White;} 

FAQ 17:  
What options do you have to redirect a user to another page programmatically? What’s the 
difference between them? 

Answer 

To redirect a user to another page programmatically, you can use Response.Redirect, 
Response.RedirectPermanent, or Server.Transfer. The first two options send a redirect 
instruction to the browser and are thus considered client-side redirects. Server.Transfer, on the 
other hand, takes place at the server, enabling you to serve a different page without affecting 
the user’s address bar. 
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FAQ 18:  
What property do you need to set on the control to prevent users from expanding or collapsing 
items in the tree? 

Answer 
To display a TreeView that doesn’t have the ability to expand or collapse nodes, you need to 
set its Show ExpandCollapse property to False. 

FAQ 19:  
How do you tell the validation mechanism that validation succeeded or failed in your 
CustomValidator routines? 

Answer 

To tell the validation mechanism whether the data you checked is valid, you set the IsValid 
property of the args argument in your custom validation method. This applies to both client- and 
server-side code. The following snippet shows how this is done in the client-side validation 
method 
for the ContactForm.ascx control: 
if (phoneHome.value != '' || phoneBusiness.value != '') 
{ 
args.IsValid = true; 
} 
else 
{ 
args.IsValid = false; 
} 

FAQ 20:  
What’s the difference between the LoginView and LoginStatus controls? When would you use 
each one? 

Answer 

The LoginStatus simply displays a simple link that indicates whether or not the user is logged 
in. 
By default the text that is displayed is Login when the user is currently not logged in, and Logout 
when the user is already logged in. Clicking the link either sends the user to the default Login 
page, or logs the user out. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  PHP stands for? 

a.  Personal Home Page b.  Hypertext Preprocessor 

c.  Pretext Hypertext Processor d.  Preprocessor Home Page 

2.  A PHP script should start with ___ and end with ___: 

a.  < php > b.  < ? php ?> 

c.  <? ?> d.  <?php ?> 

3.  Which of the conditional statements is/are supported by PHP? 

a.  if statements b.  if-else statements 

c.  if-elseif statements d.  All of above 

4.  What will be the output of the following PHP code? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a.  2 b.  3 

c.  1 d.  no output 

5.  What will be the output of the following PHP code? 
 
 
 
 
 
 
 
 
 
 
 
 

a.  15 b.  10 + 15 

c.  $z d.  $x + $y 
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6.  Which of the below statement is equivalent to $add+=$add? 

a.  $add=$add b.  $add=$add+$add 

c.  $add=$add+1 d.  $add=$add+$add+1 

7.  Which statement will output $x on the screen? 

a.  echo “\$x”; b.  echo “$$x”; 

c.  echo “/$x”; d.  echo “$x;”; 

8.  How many ways can a session data be stored? 

a.  3 b.  4 

c.  5 d.  6 

9.  Which one of the following lines need to be uncommented or added in the php.ini file so as 
to enable mysqli extension? 

a.  extension=php_mysqli.dll b.  extension=mysql.dll 

c.  extension=php_mysqli.dl d.  extension=mysqli.dl 

10. Which one of the following methods can be used to diagnose and display information about 
a MySQL connection error? 

a.  connect_errno() b.  connect_error() 

c.  mysqli_connect_errno() d.  mysqli_connect_error() 
 

11.  Asp stands for? 

a.  All Standard page b.  A server page 

c.  Active Server page d.  Active Standard page 

12.  Which software can be used to set up a web server to run server side language? 

a.  Adobe Photoshop b.  Dreamweaver 

c.  XAMPP d.  None 

13.  Asp.net File extension? 

a.  .asmx b.  .asp 

c.  .aspx d.  .ascx 

14.  What is default scripting language in asp net(Server Side) 

a.  VB script  b.  Java script 

c.  Perl d.  Python 

15.  How do you get information from a form that is submitted using the "get" method? 

a.  Request.querystring b.  Request.querystring 

c.  $_get d.  $_get 
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16.  Which is not a database service? 

a.  SQL  b.  MySQL 

c.  Oracle d.  PHP 

17.  Which of these objects is NOT an ASP component? 

a.  Link Counter b.  counter 

c.  AD Rotator d.  File Access 
 

18.  Which of the following denote the web control associated with Table control function 

a.  DataList b.  ListBox 

c.  TableRow d.  All of Above 

19.  Which of the following denote New Data-bound Controls used with ASP.NET 

a.  GridView b.  FormView 

c.  SqlDataSourc d.  All of Above 

20.  How do we Delete, Update, Select data in a Dataset 

a.  SqlDataAdapter b.  SqlDataReader 

c.  SqlCommand d.  None of Above 
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Answer Key 
MCQ Number Answers MCQ Number Answers 

1 a, b 11 c 

2 d 12 c 

3 d 13 c 

4 a 14 a 

5 a 15 c 

6 b 16 a 

7 b 17 c 

8 a 18 d 

9 d 19 a 

10 c 20 d 
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Module 8: Design and Present Final Project 

Learning Outcomes 

After completion of this learning module, learner will be able to: 

  Develop a dynamic website in ASP.Net / PHP  

  Prepare a project document  
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Learning Unit 1: Dynamic Website in ASP.Net / PHP 

Overview 

In this learning unit, you will learn how to design and implement software development life cycle (SDLC) phases 
in any website project. After completion of this learning unit, you will be able to integrate designing skills and 
development concepts with SDLC Model to develop websites projects.    

1. Implement SDLC Phases in a Web Project 

What is SDLC?  

SDLC, Software Development Life Cycle is a process used by software industry to design, develop and test high 
quality software’s. The SDLC aims to produce a high quality software that meets or exceeds customer 
expectations, reaches completion within times and cost estimates. 

 SDLC is a framework defining tasks performed at each step in the software development process.  

 ISO/IEC 12207 is an international standard for software life-cycle processes. It aims to be the standard 
that defines all the tasks required for developing and maintaining software.  

A typical SDLC consists of the following stages: 

 Stage 1:What is the best interest of the customer 

 Stage 2: Planning and Requirement Analysis 

 Stage 3: Defining Requirements 

 Stage 4: Designing the product architecture 

 Stage 5: Building or Developing the Product 

 Stage 6: Testing the Product  

 Stage 7: Deployment in the Market and Maintenance 
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1. What is the Best Interest of the Customer: 

If the customer’s unhappy, everyone’s unhappy! Every great piece of software starts with a customer’s big idea. 
It’s your job as a professional web developer to bring those ideas to life. But taking a vague idea and turning it 
into working code that satisfies the customer isn’t so easy.  

Mortally Project has two Most Concern: 

 How much will it cost 

 

 How long will it take 

 

Practical Experience: 

In some practical experience some client/customer gives the information about ones demands in natural 
language or give some links of desire websites category. So being a designer should extract the idea behind the 
project. 
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2. Planning and Requirement Analysis 

Requirement Analysis (knowing what the customer wants) 

 

 

So the reaction of the developer for the above requirement should be like next figure 

TVET RSP does not secure copyright of these pictures

TVET RSP does not secure copyright of these pictures
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Talk to the client to get more information and also try to get additional requirements 

Brainstorming is a 
group or individual 
creativity technique 
by which efforts are 
made to find a 
conclusion for a 
specific problem by 
gathering a list of 
ideas spontaneously 
contributed by its 
member(s). The 
term was 
popularized by Alex 
Faickney Osborn in 
the 1953 book 
Applied Imagination. 

Remember 
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Blue Sky with the Customer: 

Blue sky means Think BIG when to iterate with the customer requirements. Brain storm with other people. Tow 
head are better than one head. 

 

Finally Ready to Estimate the Whole Project: 

focused user stories, dealt with all the assumption that team were making in  estimate and it have set of estimate 
that all believe in so it’s time to get back to the customer with total project estimate 

TVET RSP does not secure copyright of these pictures
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Planning for Success: 

Every piece of software starts with a great plan. So in this phase of SDLC learn how to create the plan, how to 
prioritize their requirements. Finally it creates an achievable development plan that the team can easily execute 
and monitor. 

Customer wants their Software Now: 

Customer wants their software when they need it and not a moment later. It comes to grips with the customer 
idea’s using brainstorming. 

 

 

Design is not just 
what it looks like and 
feels like. Design is 
how it works. 
—Steve Jobs 

Remember 

TVET RSP does not secure copyright of these pictures
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Work the way to a Reasonable Milestone 

1. Add two new people to the team 

 

Designing the Product Architecture: 

Good design help the deliver. A bad design was making life hard for everyone, and to make matter worse 

 

Building or Developing the Product: 

It is the time to go to work user stories capture what need to develop but now it’s time to convert the user stories 
to real life in SDLC phase, it is the time to going to learn how to break user stories into tasks, and how task 
estimate help the tracks the project from foundation to completion.  

 

Design is easy. All 
you do is stare at the 
screen until drops of 
blood form on your 
forehead. 
—Marty Neumeier 

Remember 

TVET RSP does not secure copyright of these pictures
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Do the Task and Add Up: 

Notice a problem which are possible with the estimation because it got user stories with an estimate. But now 
adding new estimate to the specified task. 

 

TVET RSP does not secure copyright of these pictures
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Add your Task to Your Board: 
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Start Working on the Tasks: 

 

The First Standup Meeting: 

 

  

 

 

 

 

 

 

TVET RSP does not secure copyright of these pictures
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Creating Dates: 

 

Testing the Product: 

Sometimes Even the Best Developer Breaks the Build. 

Test the compiled code over and over again, and test machine and committed it into 
the repository. There are many testing method like black box testing and white box 
testing 

Things are always go wrong: 

Everyone who’s ever done development knows what it’s like. Its late in some cases 
missing the small thing like ++ increment operator suddenly it elegant code goes into 
pieces 

Black-box testing is 
a method of 
software testing that 
examines the 
functionality of an 
application without 
peering into its 
internal structures or 
workings. This 
method of test can 
be applied to 
virtually every level 
of software testing: 
unit, integration, 
system and 
acceptance. 
 

Do you know? 

White box testing is 
a testing technique 
that examines the 
program structure 
and derives test 
data from the 
program logic /code. 
The other names of 
glass box testing are 
clear box testing, 
open box testing, 
logic driven 
testing or path 
driven testing or 
structural testing. 

Do you know? 
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There are three ways to look at your system…. 

 

 

 

Black Box Testing Focus on Input and Output: 

The user is on outside to the system they only see what it put into the system and what come back out. 

 

TVET RSP does not secure copyright of these pictures
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White Box Testing Use Inside Knowledge: 

At the deepest level of testing, practice the white box test. This is where exactly what is going on inside the box. 
And do the best to break the code. Ongoing to test white box testing, it should aware with the code, about to 
test. 

 

TVET RSP does not secure copyright of these pictures
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Deployment in the Market and Maintenance: 

At last deploy the project in real office of market by creating user manual that how user can be use the product. 
There should be maintaining every month or week after development date and keep mature the product if any 
bug found in real life. 
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Learner’s Activities 
 

Design the Interface of Website / Application 

Description:   This activity based on learner performance. Each will develop interface of 
website using designing tools (Photoshop / 
Dreamweaver/HTML/CSS/JavaScript etc) while following SDLC Designing 
phase concepts.  

Time Guideline: 30 hours  

Purpose:  Designing of final project 

Outcomes :  

 

1- Each learner, will present the project vision after collecting 
requirements from customer.   

2- Than will draw layout in Adobe Photoshop 

3- Learner will present the designing work before class.    
 
 
 

Develop the Functionality of Website 

Description:   This activity based on learner’s performance. Each will add programming 
functionality in the application using programming and database concept 
(PHP or ASP.Net), will develop session management, login, Data and other 
detailed functionality as per the requirements from clients.  

Time Guideline: 30 hours  

Purpose:  Development of final Project 

Outcomes :  

 

1- Each will develop and test the functionality of the project as per the 
client requirements.   

2- Each will live run the application before.    
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Learning Unit 2: Prepare a Project Document 

Overview 

In this learning unit, you will learn how to documents the website/ application. After completion of this learning 
unit, you will be able create following documents: design, Implementation, Testing, Deployment, Maintenance 
and project user manual. 

1. Web Design Document 

A Website / application design document is a written description of product, that a Web designer/Developer 
writes in order to give a software development team overall guidance to the architecture of the software project. 
Practically, a design document is required to coordinate a large team under a single vision. A design document 
needs to be a stable reference, outlining all parts of the software and how they will work. The document is 
commanded to give a fairly complete description, while maintaining a high-level view of the software. 

1. The data design describes structures that reside within the software. Attributes and relationships 
between data objects dictate the choice of data structures. 

2. The architecture design uses information flowing characteristics, and maps them into the program 
structure. The transformation mapping method is applied to exhibit distinct boundaries between incoming 
and outgoing data. The data flow diagrams allocate control input, processing and output along three 
separate modules. 

3. The interface design describes internal and external program interfaces, as well as the design of human 
interface. Internal and external interface designs are based on the information obtained from the analysis 
model. 

4. The procedural design describes structured programming concepts using graphical, tabular and textual 
notations. These design mediums enable the designer to represent procedural detail, which facilitates 
translation to code. This blueprint for implementation forms the basis for all subsequent software 
engineering worked. 

Database Design 

The major objective of database design is to map the conceptual data model to an implementation model that a 
particular DBMS can process with performance that is acceptable to all users throughout the organization. 

Context Data Flow Diagram of System 

Context DFD emphasis on the relationship between the system and its environment. The system as a whole is 
represented by a bubble and the external entities are shown as rectangle from which input flows and to which 
output is directed. No information about the structure of the system itself is pictured in a context DFD. The arrows 
going in the direction from user to system represents user’s requests and the arrow which is coming from system 
to user represent system’s response in respect of user requests. Request can be of any type relating to records 
i.e. cloth status, customer status, vendor status and relating to reports. 
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Entity Relationship Model  

The entity relationship model was developed to facilitate database design by allowing the designer to express 
the logical properties of the database in an enterprise schema. The word enterprise means the organization for 
which the database is kept. The enterprise schema is a description that corresponds to the conceptual level in 
the three level architecture. Entity relationship diagrams are used to express the logical structure of the model. 
The enterprise schema will be valid regardless of the database system chosen, and it can remain correct even if 
the DBMS is changed. Unlike a schema written in DLL, the entity relationship diagrams that we will use are not 
generally available to be used by the DBMS for creating the logical structure or doing external/conceptual or 
conceptual/internal mappings. The diagrams are basically design tools and documentation for the system. 

The items in the model represent “things” in the real world, and the relationships between the real world “things” 
are expressed by relationships in the model. The model describes the environment in terms entities, attributes, 
and relationships. 

The term entity means any object that exists and can be distinguished from other objects. It is a person, place, 
event, object or concept in the real world we wish to represent in the database. A collection of entities of the same 
type is called an entity set. The attributes of an entity set define the properties or qualities of the entity type. 
Entities are often linked by association or relationships, which are connections or interactions between the entity 
instances. By abstraction, we can identify the common properties of certain relationships and define a relationship 
type and a corresponding well defined relationship set as the collection of relationships of that type.  

The relationships that satisfy the requirements for membership in the relationship set at any moment are the 
instances or members of the relationship set. The keys of the related entities are used as attributes of the 
relationship set. As with entities and attributes, the relationship type and the well-defined relationship set are part 
of the intension and the instances are part of the extension of the model. 
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Entity Relationship Diagram of the System 

 

 

2. Web Project’s Implementation Document  

System development starts when detailed system design of proposed system created. System development is 
the renovation of system design into a genuine functioning computer system. This task is accomplished by 
coding. 

Tools and Technologies Used 

PHP, SQL, HTML, CSS, JavaScript, Xampp, Dreamviewer and their Tools development/ designing tool, Microsoft 
Word, for documentation and diagrams 

Interface Designing 

This stage of implementation provides the mean of interaction to the user with the system. The output of this 
stage will let the user be able to interact with system. The main purpose of this phase is to develop a user-friendly 
interface for the ease of customer. The quality of good interface is that it must be simple, user-friendly, and 
attractive. The interface should not be complex. 

These points should be considered while designing interface: 

 User-Friendly Interface 

The interface should be simple. Proper messages should be displayed on the screen to let the user know about 
the transactions. Transactions should be completed in stepwise manner. 
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 Simple Language 

The language used on the screen should be simple and precise. Language should not be complex or the steps 
should not be confusing to the user. 

3. Web Project Testing Document 

Test Specification Summary 

In the software development industry testing of software is essential to ensure a reliable product. The testing of 
Mobile product CMS can be done using a single Pentium 4 or higher computer with Windows XP or higher 
operating system, xampp server, Dreamviewer, etc .  

Input Specifications 

In testing the Website Forms, the input for most of test cases will be entered though keyboard and mouse.   

Output Specifications 

The output of all the tests will be displayed by windows operating system and web browser like Mozilla Firefox, 
Google chrome etc using on monitor 

Test Environment 

The testing of the Mobile product CMS will be done in an environment where we should have an Intel or any 
other machine with a Windows XP or higher version of operating system and 256 MB or higher of RAM and 2 
GHz processor or higher.    

The system should also be connected to LAN or internet for proper functioning. 

Special Procedural Requirements 

There are no extra ordinary procedures required for conducting the tests on the scientific Mobile product CMS.   

Inter-case Dependencies 

There is no interdependency between in use cases.   

Test Cases 

Test Case Item – 1 

When user press on login button then registration or login form should be appear 

By using the above technique create plan for all forms and events and check that all thing working according to 
the requirements. 

4. Web Project’s Deployment Document 

The deployment plan gives a complete understanding of how the system will be deployed and how the 
environment will be set for the system to work properly and effectively. 

Objectives: 
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The objective of the deployment plan is to give a guide line to the deployment team as how to deploy the system 
at the client website in a professional manner.  

Deployment Scope: 

The deployment scope of the Mobile product CMS is that there will be a database in mysql which store all the 
page as well as mobile product data.  

Seats: 

The main source code will be under the control of IT expert. 

Components 

1. Pentium 4 computer or higher 

2. UPS  

3. Web browser 

The point of coding will be at least Pentium4 computer with LAN connectivity or at least internet connectivity. 
There should be a UPS for electricity backup. The database should be on phpmyadmin and all the files and 
folders should be in htdocs folder  

Architecture for admin 
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It can be used at hosting server and people can access by typing the URL address on browser. 

Website Installation Process: 

The website installation starts with the hardware once the hardware is set and the systems are ready. 

5. Web Project’s Maintenance and Support Document 

The user will be given two days training on how to use the system. The user will also be given a user manual in 
which all the activities will be shown how they work. The user will also be given the training that how to maintain 
the website and common functionality issues. 

6. Web Project’s User Manual 

1. Login View 
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2. Home Page 

 

 

 

3. Cell Details 
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4. Admin Page 

 

 

 

5. Add Brand 
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6. Add Cell Details 

 

7. Cells List 
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8. Edit Cells  
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Summary of the Module 

 Designing and development are the main phases in software development. It is important to use best 
designing and development software to efficiently develop project within given time frame. 
 

 Documentation is very important to describe different software processes and user interaction with the 
software. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is SDLC? 

Answer 
SDLC, Software Development Life Cycle is a process used by software industry to design, 
develop and test high quality software’s. 

FAQ 2:  Write the phases of SDLC 

Answer 

 phase 1: Planning and Requirement Analysis 

 phase 2: Defining Requirements 

 phase 3: Designing the product architecture 

 phase 4: Building or Developing the Product 

 phase 5: Testing the Product  

 phase 6: Deployment in the Market and Maintenance 

FAQ 3:  How many important concert of the client about project 

Answer 

Client have two major concern about his project 

 How much will it cost 

 How long will it take means time 

FAQ 4:  What is the goal to requirement analysis?  

Answer The ultimate goal of requirement analysis is to knowing what the customer wants. 

FAQ 5:  What is blue sky means in SDLC 

Answer 
Blue sky means Think BIG when you iterate with you customer requirements. Brain storm with 
other people. Tow head are better than one head. 

FAQ 6:  In designing the interface section what is  the surveying the possibilities means 

Answer Surveying the possibilities is to begin considering what makes a high-quality website. 

FAQ 7:  Who are creating the web standards 

Answer 
World Wide Web Consortium (W3C) is the central organization who is responsible for creating 
and maintaining web standards 

FAQ 8:  What is ER diagram 

Answer Graphical representation of entities/tables and its relationship. 

FAQ 9:  What are use cases? 

Answer 
A use case is a narrative document that describes a set of sequences; in which each sequence 
represent the interaction of things outside the system (its actors) with the system itself (and its 
key abstractions). 

FAQ 10: What is the purpose of the project user manual?  

Answer 
The purpose of the project user manual is to give the complete brief to the user that how they 
can use the product and maintain it. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Which of the following is not a phase of SDLC? 

a.  Requirement gathering b.  Maintenance 

c.  Analysis d.  All of the above 

2.  Which of the following is not type of SDLC models? 

a.  Big bang model b.    Agile model 

c.  Capability Maturity model d.  Spiral model 

3.  In you institution student are asked to develop a dynamic website. Which model would be 
preferable? 

a.  Waterfall model b.  Spiral model 

c.  Code and fix model d.  Agile model 

4.  Testing which you check the code is? 

a.  Black box  b.  White box 

c.  Red box d.  Green box 

5.  SDLC abbreviated as? 

a.  System design lifecycle b.  Software design lifecycle 

c.  System development life cycle d.  Software development life cycle 

6.  Testing which is done without planning and documentation is?  

a.  Adhoc testing b.  Adhoc testing 

c.  Regression testing d.  Regression testing 
 

7.  Which of the following is black box testing? 

a.  Code path analysis b.  Basic path testing 

c.  Boundary value analysis d.  None of above 

8.  Which of the following are true about website designing phase? 

a.  Coloring  b.  typography 

c.  layout d.  All of the above 
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9.  CMS stand for? 

a.  Course management system b.  Content management system 

c.  Color management system d.  None of above 
 

10.  Software guru says that designing is driving activity why? 

a.  Design work extends from start of 
development to coding 
 

b.  Black box testing 

c.  The two major products of designs are 
SRS and design document 

d.  All of the above 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 c 

3 c 

4 d 

5 b 

6 a 

7 b 

8 d 

9 d 

10 b 
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Module 9: Perform Duties and Exhibit Rights 
at the Workplace 

Learning Outcomes 

After completion of this module, You will be able to: 

  Plan Business Process activities 

  Create awareness about rights 
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Learning Unit 1: Demonstrate Ethics and Professional 
Conduct  

Overview 

In this learning unit, you will learn about the exhibition of ownership in decision making process, Utilization of 
resources and tangible office equipment (assets) and appreciate them to perform the responsibilities regarding 
them. After completion of this learning unit, you will be able to understand responsibility, respect, fairness and 
honesty against the applicable territorial laws. 

1. Demonstrate Ethics and Professional Conduct 

Ethical mindfulness of a worker is a basic element of the work environment for quality of production& services of 
the business/company. 

Ethics at Work 

You should be aware of various basic concepts of ethics relating to their working 
environment. 

What is Ethics 

The word ethics comes from Greek word ethos which mean habits, thus ethics is 
science of habit of individuals in society. 

The proper rules that are implemented on a person’s behavior during the work. That demonstrates what is right 
and what is wrong at workplace, there can be some obligations to stop worker from doing what is not ethical like 
stealing, not punctual etc. 

Respecting the Co-workers, Understanding the Organizational Structure for Departmental, Higher Authorities 
and lower staff. 

Objective of Ethics: 

The objective for studying the ethics is helping the students to have practical knowledge and understanding of 
self and different ethical issues. 

Naturally Ethic can be divided in to four areas : 

1. Meta Ethics is about that what actually the right means 
2. Normative Ethics is how workers should act. 
3. Applied Ethics mean that how do we use moral knowledge and apply it in our practice 
4. Descriptive Ethics relatively mean that what do the workers think what is right.  

Ethics Training: 

Training is required to help the workers to understand the ethical aspects of decision making and to include the 
standard ethics to their daily behavior. It help employee to deal with ethical issues under pressure. 
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Code of Ethics: 

 A formal statement of principles and ethical standards that maintain a worker should place the integrity of the 
profession and the interests of clients above his own benefits, act with responsibility, honesty, proficiency, and 
respect. Sustain and progress professional competency. 

 

What is Ethical Behavior: 

Respect for humanity, respect for basic rights and be good human at work and other 
place. 

Excellence and growth based on the talent of the workers. 

 

Professional Conduct 

The standards professional conduct are guidelines similar like code of ethics but the standards of professional 
conduct guide lines are more clear and in detailed way in the professional environment. 

A professional worker should be bound by certain requirement, certain fundamental issues or principles, rules 
that govern worker behavior, whenever talk about professional that mean that there is some profession behind it 
and there is some institution that tell that how to behave like a professional. The professional status comes from 
the trust that users uses in public places in opposition. 

 A profession give us a certain set of guide lines to follow. 

 Professional conduct is the making of rules by professionals of the governing body for worker to follow 
it. 

 The professional conduct is normally taken for the private organization’s professionals for contractual 
nature of employment. 

 Professional code of conduct may vary from profession to profession like Teaching, Marketing, Accounts, 
medical doctors and administration etc. 
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Leaner’s Activity 

Questions: 

1. To think how you define ethics and then write it down. 

2. Students to share the definition with beside seated students and have the comparison and rewrite the 
definition after sharing and comparison. 

 

2. Exhibit Ownership of the Decisions 

The Exhibition of ownership in decision making can be explained as the demonstration 
of their decisions in practical life .It is not necessary that every decision that will make 
is successful and it can be failed. It encourage one to make the right decisions and 
bring the positive prospective in his mind that if “Decision are not failed then their 
process of learning will stop” and learning process works as a circulation of blood in 
practical and professional life. Important factor is that one should avoid the negative 
decision and negative expectation from a positive decision.  

3. High Regard for Resources  

Confidence and trust are major skills that the teacher transfer to students and motivate them to work. Assignment 
of different tasks and goals, Designing and development of different projects and trust them on their resources 
will encourage you to work towards success. Appreciation is also an important factor that is necessary to 
encourage the team and individual work.   

4. Make Decisions and Act Impartially/Objectively 

Decisions making process is no doubt a complicated and tough task but it is a great platform to learn the different 
activities and projects and develop the different skills .Some people are very active to complete their tasks 
individually but it is not  necessary to work completely on the decisions we can divided them in teams and start 
working accordingly. There is another factor that everyone not have the similar skills and qualities so while making 
the teams and start working you will get the pool of skills .When you set a goal then you will start working on it 
and this will enable you that how you work partially and impartially work on decisions and complete them .Self -
assessment or self-examine is a test regarding your skills in which you have to judge yourself without any interest 
and assigning projects like AutoCAD which you will be cover later in each module .Regardless to professionalism 
and other formal thinking there is a moral happiness and inner satisfaction that encourage and motivate you to 
work more and achieve the different tasks. 

5. Act in Truthful Manner in Conduct/Communication 

Communication is a major tool that play a vital role because through communication can easily explained the 
idea, point of view, thinking knowledge to others. If everyone assume that next person or collogue or co helper 
or team coordinators understands the view without any explanations or communication it is very hard to work. 
Communication provide everyone a chance to explain their thinking and ideas. Sharing different ideas and 
discussions are founder of innovations and creativity.  
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Leaner’s Activity 

Case Study 

Shumaila loves clothes.  She wishes she could have all the designer clothes she wants.  Unfortunately, she can’t; 
she has two brothers and three sisters, and her parents cannot afford to buy all their children designer clothes. 

Shumaila has a few friends that have some designer jeans.  Her friends let her borrow the jeans, even though 
this is against her parents’ wishes.  Her parents felt that Shumaila should not borrow them in case something 
were to happen to them.   In that case, they would need to purchase an outfit to replace the damaged one. 

One day on the way home from school, Shumaila tripped and fell on her knees.  She tore holes in both knees of 
the designer jeans she had borrowed from her friend, Julie.  Shumaila was crying, not only because she had 
injured her knees, but because the new jeans were ruined. 

Write down your opinion about Shumaila decision.  

1. What is Shumaila going to do?   
2. Should she tell her parents?   
3. Should she tell Julie?   
4. What decisions should Shumaila have made prior to borrowing the jeans?  
5.  Does Shumaila have an obligation to Julie? 

CASE STUDY WORKSHEET 

Use this worksheet to evaluate case study. 

Identify the problem. 

What are the person’s choices? 

a. 
b. 
c. 
d. 
e. 

Gather information: What information should gather a person that would be helpful to know before making a 
decision? 

a. 
b. 
c. 
d. 

Consider the outcome.  What would be the results of the decision? 

a. 
b. 
c. 
d. 

Make the decision.  What should the person do? 

Evaluate ones decision.  Why do one think this is the best decision possible? 
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6. Ethics in the Workplace 

Working in an organization, it should consider the following ethical approaches in mind to execute duty at 
workplace. 

Ethics in workplace either at working in higher management or lower staff, the following four points help to 
understand. 

1. Relationships at Work 

o Management/owner  toward  client/customer 

o Management/owner toward employees 

o Employee toward Employer, Co-workers, Customers 

2. Business Abuse 

Any illegal, unethical, irresponsible Act done against an Employer 

3. Results of Business Abuse 

o Show Product prices very high  

o Business Failure due to Mismanagement of an organization 

o Fewer Jobs 

o Unpleasant/Unfriendly/Hostile Working Conditions and environment of an organization. 

o Examples of Business Abuse 

o Example-1 

 Stealing of Merchandise and Money 

 Shoplift 

 Kickback 

 Conflict of Interest 

 Unauthorized Discounts 

 Time stealing: Come late and leave before timing 

o Example-2 

 Destruction of product, record, faith. 

 Falsify Records 

 Break Confidentiality 

 Ignore Safety Rules 
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 Misrepresent Merchandise 

o Example-3 

 Poor Client Service 

 Irresponsible Behavior 

 Addictions 

 Drugs 

 Alcohol 

 Tobacco 

4. How Employers Respond or rectify to Business Abuse 

o Increase Security 

o Loss prevention management. 

o Investigation 

o Networks/Helplines 

o threats of trial 

o Increase Employee Loyalty 

 Fair Remunerations & Welfares 

 Fair and Reliable Treatment 

 Recognition for Good Work 

7. Development of Individual Ethics 

An individual ethics can be develop in any environment either one is a student at any institution or employee in 
any organization, It need to consider the following stages. 
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Job Challenges On-the-Job Ethical Dilemmas: 

 
 

How Organizations Shape Ethical Conduct: 
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Ethical Awareness 

Ethical awareness is essential part of an Institution and organization which describe Code of Conduct formal 
statement that defines how the organization expects and requires employees to resolve ethical questions. 

Ethical Education 

Codes of conduct cannot detail a solution for every ethical situation, so Institution and corporations provide 
training and workshop in ethical reasoning as Character Building society in Pakistan initiated by the Director 
General (Awareness and Prevention) National Accountability Bureau (NAB). 

The Aim of this society is to following a prudent strategy to set up character building societies at grassroots level 
across the country aimed at making the younger generation useful citizens and enabling them to differentiate 
between good and bad deeds. 

Ethical Action 

Ethical education helps the employee’s recognize and reason through ethical problems and turning them into 
ethical actions. 

Ethical Leadership 

Executives in organization and Trainer in Institution must exhibit/show ethical behavior in their actions while 
dealing employees and Trainer respectively 
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Learner’s Activity 

Briefly answer the following questions: 

1. One have started working for an organization as web designer. 
 

 What might be your duties and rights in accordance with the following conduct requirements? 
 

O Integrity 

O Objectivity 

O Competence 

O Fairness 

O Confidentiality 

O Professionalism 

O Diligence 
 

What impact will policies, rules and regulations governing the work and workplace have on the employment? 
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Learning Unit 2: Plan Business Processes Activities 

Overview 

In this unit, you will be introduced about the In-line Manager role & duties. After completing this unit you will be 
able to Identify tasks by coordinating recurring meetings, intimate resource availability, create and keep 
documentations, validate applicable company defined standards. 

1. In-Line Manager 

In-Line Management is a business phenomenon which elaborates administrative 
activities that pay attention directly to the result of product or services. In a corporate 
hierarchy, a line manager holds authority in a chain of command or may be over a 
particular product line. One is responsible with meeting corporate objectives in a 
specific functional area or line business or specific task. 

Before going to introduce the business process activity we must have a look on 
communication skills. 

Communication in the Organization 
Communication in the modern organization flows downward, upward, and the 
horizontal, its destination can be either internal or external. 

 
Downward Communication: 
Downward communication flows from people at higher levels to those at lower levels in the organizational 
hierarchy. The primary function of downward communication is to inform employees about things important to 
them such as: 
 

 Information about their jobs 

 Organizational policies and procedures 

 Feedback about their performance 

 Organizational goals and objectives 

The types of downwards communication may include instructions, speeches, meetings, announcements, memos, 
notifications, letters, hand-books, pamphlets, company newsletters and periodicals, bulletin boards (notice 
boards) policy statements, and procedures. For downward communication some use written communication, 
others use oral communication. 

Upward Communication 

Upward communication travels from subordinates to superiors and continues up. Upward communication is 
extremely important, as upper management needs to know specifically about: Production performance, marketing 
information, and financial data, what lower-level employees are thinking, and so on. 

Upward internal communication is becoming increasingly important day by day. Today many executives sincerely 
seek frank comments from employees, in addition to the usual periodic reports. Successful managers listen 
closely to opinions, complaints, problems, and suggestions especially when they are clearly and effectively 
stated.  

As a response to increasing global competition, some companies are developing new management styles, which 
make input form employees an integral part of important decisions affecting the company. 

 

Communication is a 
process, which 
involves sharing of 
information between 
people through a 
Continuous activity 
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listening, and 
understanding. 

Do You Know 
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Horizontal Communication: 

It includes horizontal flow of information, with people on the same or similar organizational levels, and diagonal 
flow, with people at different levels who have no direct reporting relationships. The horizontal communication is 
used to speed up information flow, to improve understanding, and to coordinate efforts for the achievement of 
organizational objectives. 

 

 

2. Business Process 

 A business process is a collection of related activities or tasks that outputs a specific product or services what 
will designed for a specific objectives for a particular customers or client. 

There are three main types of business processes: 

Management processes: That defines the rules regulation of the operation of the system e.g. strategic 
management. 

Operational processes : That define the basic business for the creation of primary value that is to developing, 
marketing for the product or services 

Supporting processes: that defines the recruitment, financing and technical expert. 

3. Estimated Time 

Estimate time is an “Estimated time to complete” is a time projection and or effort required to complete a 
project/task activity in which the task should be completed. Estimated time to complete is a value that is 
expressed in hours of work required to complete a task or project. 

 Use the work breakdown structure to facilitate estimation. 

 Review the tasks at the bottom of the work breakdown structure and look for the longest path through 
the sequence diagram.  

 Use experience from previous projects to estimate the time it will take to complete the tasks.  

 Having any previous data, it will be the key element of precisely estimating time to complete.  

 For example, let’s assume that one is a Web Developer and have to develop a mobile product CMS 
website having create product, update product, delete product and view product on web page‘. The 
Mobile product CMS will require 15 hours on reviewing data from previous developed CMS pages in 
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which the task has taken 15 hours to complete, thus in CMS one can estimate the time of completion as 
15 hours. In this same way use past data to estimate the time of completion of an entire project. 

 In the absence of previous data or experience one would have to guesstimate, which is inefficient and 
may error occur in time guesstimated.  

 To develop a schedule, all of the tasks and estimates are placed in a calendar. The calendar would 
include a specified time period, identify resources and their allocation, how much time the task is 
expected to take and when each task is scheduled to start and finish as the scheduled shown in table 
below. 

Number Task Description Start Date Completion Date 

    

The preferred way to complete the project is to apply “Break down” structure and “Time estimation to 
complete” on the project. 

Procedure: How to apply time estimation and Breakdown Structure 

Create mobile product website which have insert, update, select and delete product option  

Breakdown: 

To develop the Mobile product CMS website in 15 days, divided the task in different stages. 

Stage-1: creating and normalizing the database  

Stage-2: creating the design of website of different pages 

Stage-3: applying PHP code to display the product  

Stage-4: testing insert, select, update, and delete product function in website 

 

Time estimation: 

Number Task Description Start Date Completion Date 

1 creating and normalizing the database 12/07/2015 13/07/2015 

2 creating the design of website of different pages 14/07/2015 14/07/2015 

3 applying PHP code to display the product 15/07/2015 15/07/2015 

4 
testing insert, select, update, and delete product 
function in website 

16/07/2015 16/07/2015 
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4. Work Load 

Workload is the amount of work an individual has to do. There is a distinction between the actual amount of 
work and the individual's perception of the workload.  

Workload can be of two types one as  

Quantitative: The amount of work to be done in office environment, in a specified period i.e. 8 hours in a day. 

The second as qualitative: The work which may difficulty by nature. 
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Learning Unit 3: Develop Awareness about Rights 

Overview 

In this unit, you will be introduced about the inspirational requirement of human rights in employment context. 
After completing this unit, you will be able to understand the different rules, regulation & right under the formation 
of Standard Operating Procedure (SOP), and proprietary protection with its  different kind, like Copyright and 
Intellectual rights etc. 

1. Rights 

Rights are legal, social, or ethical principles of freedom or entitlement; that is, rights are the 
fundamental normative rules about what is allowed of people or owed to people, according to 
some legal system, social convention, or ethical theory. 

2. Rules 

Rules define standards for activities which help the smooth operation of the Project/Task/ or organizational work 
at workplace. 

Definition: Rules is a Statement that establishes a principle or standard, and serves as a norm for guiding or 
mandating action or conduct. 

Rules may be divided into four general categories:  

1. Folklore: These rules are Unpublished that are conveyed by behavior and are implicitly understood.  

2. Guidelines: These rules are commonly published and recommended practices that allow some 

discretion with their interpretation and use.  

3. Mandates: These rules are Published commands that may not be ignored in any circumstance and 

whose violation is punished. 

4. Policies: Published rules that imply a predicted behavior and whose violation may be permitted or 

tolerated under certain circumstances. 

 

3. Responsibility 

 Definition: A moral, legal, or mental accountability.  A particular burden of obligation.  
Answerable. 

Aspects of Responsibility 

Accountability. Free to choose and makes it accountable for choices. 

Duty.  Obliged to do what is expected. 
 

Work gives you 

meaning & purpose 

and Life is empty 

without it. 

Remember 



Module 9: Perform Duties and Exhibit Rights at the Workplace 

Teaching and Learning Material: Information Technology (Web Designing and Development)                                              | 533 

Employee’s responsibility: The following responsibility must perform by the employee while working in work 
place, all these responsibilities will be mentioned in the SOP of the organization, the employee first read the SOP 
and then take care of each point in the workplace. 

Employee should 

 Be punctual in his/her duty and honor to his/her commitments for the duty time 

 Do what the employer say they will do 

 Always Listen to what the customer/client wants and treat them politely. 

 Honor service commitments 

 Treat proprietary information appropriately 

 Provide value for the paycheck 

 Always Honor the agreements with the employers either its formal job agreement or what they 
have implicitly agreed to do. 

 Behave loyally to the employers. 

o Take care of proprietary information of the organization. 

o Provide good customer/client service. 

o Be good agent of the company’s resources. 

o Commit to organizational goals and try you best to achieve that goals. 

Employer responsibility: Following are the responsibilities of the employee toward employees in workplace. 

Employer should 

 Keep business sustainable. 

 Act in accordance with laws/rules/regulations. 

 Always provide competitive wages and benefits to employee. 

 Continually enhance employee skills which will benefit for both employee and employer. 

 Provide reasonable health benefits (e.g., sick, casual, Earn, and Leave in-cashment (If possible) 
and maternity/paternity leaves). 

 Respect the employees and take care of their dignity. 

 Pay a living wage 

 Honor contracts and obligations to employees. 

 Reinforce and reward organizational loyalty. 
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4. Standard Operating Procedure (SOP) 

A Standard Operating Procedure (SOP) is a document consisting of step-by-step 
information on how to execute a task. 

Standard Operating Procedure (SOP) is a document to define rules and regulation for 
specific task / project or company profile. 

Example: An example of TEVTA short courses SOP recently developed in all TEVTA 
Institutions. 

Notification released before running the project/task by the board of management, they 
define the rules and regulation for running of the project. 

 

Breakdown: Break 

down is used to 

divide the project 

into simple modules 

or tasks to complete 

the whole project 

within different 

dates. 

Do You Know? 
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Payment Criteria Show the Payment Method which Never be Changed. 
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5. Proprietary Information 

Proprietary information is only information which only disclosed in front of owner. These information in the form 
of documents limits who can view it or know about its contents, it also called trade secret.  

Some examples of proprietary information include: 

 Financial Information 

 Employee Document and Profile information 

 New Business Plan information 

 Stock and Inventory Information 

Intellectual property (IP) is a term referring to creations of the intellect for which a monopoly is assigned to 
designated owners by law. 

Intellectual property rights include  
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 Patents: A patent is a form of right granted by the government to an inventor, giving the owner 
the right to exclude others from making, using, selling, offering to sell, and importing an invention for a 
limited period of time, in exchange for the public disclosure of the invention. 

 Copyright:  A Copyright is an exclusive rights to a producer/creator/designer of their original 
works, usually for a limited time, but can be renew by renewal law. 

 Industrial design rights: An industrial design right also called design right protects the 
visual design of objects that are not purely useful. An industrial design consists of the creation of a shape, 
configuration or composition of pattern or color, or combination of pattern and color in three-dimensional 
form containing artistic value. 
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Summary of Module 

 Ethical mindfulness of a worker is a basic element of the work environment for quality of production & 
services of the business/company. 
 

 Code of Ethics: A formal statement of principles and ethical standards that maintain a worker should 
place the integrity of the profession and the interests of clients above his own benefits, act with 
responsibility, honesty, proficiency, and respect. Sustain and progress professional competency. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  Do you know about the goodness? 

Answer The state or quality of being good in the society.Goodness is the nature and character of God. 

FAQ 2:  What are trade secrets? 

Answer The Inner Bound of Proprietary Information. 

FAQ 3:  What is leave Encashment? 

Answer 
Encashment of leave means that employee will receive the cash for leaves which are not taken 
by the employees. 

FAQ 4:  
Develop a Mobile Product CMS Website. 
What will be the “Gathering information” stage of life cycle methodology for the development of 
drawing? 

Answer 

Gathering information” stage of life cycle methodology as below 

The Web Developer should queries regarding Database, Functionality of different pages, 
security, Actors or users etc. 

For example: 

Develop Mobile Product CMS to meet supplied floor plan with the following specifications: 

 Admin can insert mobile product with user Friendly GUI approach 

 Admin can delete mobile product 

 Admin can update mobile product 

 Admin can see visitors comments and replying answers 

Visitors can see all mobiles and can comment on every product 

FAQ 5:  What is mean by guesstimate? 

Answer Make an estimate without complete information with guess work. 

FAQ 6:  What is mean by estimate? 

Answer 
Estimate gives you a general idea about the value, size, or cost of (something) with strong 
information. 
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FAQ 7:  Importance of communication? 

Answer 
Importance of communication has always been realized in all times because it is the most vital 
means by which people are connected together in the society to share information, ideas, 
without communication you will be unable to work in professional environment. 

FAQ 8:  What is involved in the communication process? 

Answer 

 Idea 

 Encoding 

 Channel 

 Decoding 

 feedback 

FAQ 9:  Level of Communication? 

Answer 
Intrapersonal Communication: When you think, you use intrapersonal communication 
Interpersonal Communication: Conversation between two or more than two person to share 
ideas and information. 

FAQ 10:  Do you know the symbol of copyright? 

Answer Yes! © 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Morality is? 

a.  Act of student in class b.  Goodness or badness of human Act 

c.  Follow Rules d.  None 

2.  The word ethics comes from ……..? 

a.  Latin b.  Germen 

c.  Greek d.  None 

3.  To test yourself by 

a.  Self-assessment b.  Other assessment 

c.  Self-examine d.  Both a and c 

4.  Which is/are the result of Business Abuse? 

a.  Show Illegal act b.  Show Product prices very high  

c.  Unauthorized Discounts d.  Both b and c 

5.  SOP Stand for? 

a.  System Operating Procedure b.  Standard Operating Process 

c.  Standard Operating Procedure d.  Standard Operation Procedure 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 c 

3 d 

4 c 

5 c 

 




